1. Creating a System with Platform Designer

1.1. Interface Support in Platform Designer

1.2. Introduction to the Platform Designer IP Catalog

1.2.1. Installing and Licensing IP Cores

1.2.2. Adding IP Cores to IP Catalog

1.2.3. General Settings for IP

1.2.4. Set up the IP Index File (.ipx) to Search for IP Components

1.2.5. Integrate Third-Party IP Components into the Platform Designer IP Catalog

1.3. Create a Platform Designer System

1.3.1. Create/Open Project in Platform Designer

1.3.2. Modify the Target Device

1.3.3. Modify the IP Search Path

1.3.4. Platform Designer System Design flow

1.3.5. Add IP Components (IP Cores) to a Platform Designer System

1.3.6. Specify Implementation Type for IP Components

1.3.7. Connect IP Components in Your Platform Designer System

1.3.8. Wire-Level Connectivity

1.3.9. Validate System Integrity

1.3.10. Propagate System Information to IP Components

1.3.11. View Your Platform Designer System

1.3.12. Navigate Your Platform Designer System

1.3.13. Specify IP Component Parameters

1.3.14. Modify an Instantiated IP Component

1.3.15. Save your System

1.3.16. Archive your System

1.4. Synchronize IP File References

1.5. Upgrade Outdated IP Components in Platform Designer

1.6. Create and Manage Hierarchical Platform Designer Systems

1.6.1. Add a Subsystem to Your Platform Designer Design

1.6.2. Drill into a Platform Designer Subsystem to Explore its Contents

1.6.3. Edit a Platform Designer Subsystem

1.6.4. Change the Hierarchy Level of a Platform Designer Component

1.6.5. Save New Platform Designer Subsystem

1.7. Specify Signal and Interface Boundary Requirements

1.7.1. Match the Exported Interface with Interface Requirements

1.7.2. Edit the Name of Exported Interfaces and Signals

1.8. Run System Scripts

1.9. View and Filter Clock and Reset Domains in Your Platform Designer System

1.9.1. View Clock Domains in Your Platform Designer System

1.9.2. View Reset Domains in Your Platform Designer System

1.9.3. Filter Platform Designer Clock and Reset Domains in the System Contents Tab

1.9.4. View Avalon Memory Mapped Domains in Your Platform Designer System

1.10. Specify Platform Designer Interconnect Requirements

1.11. Manage Platform Designer System Security

1.11.1. Configure Platform Designer Security Settings Between Interfaces

1.11.2. Specify a Default Slave in a Platform Designer System
3.7.1. Specify HDL Files for Synthesis in the Platform Designer Component Editor... 317
3.7.2. Analyze Synthesis Files in the Platform Designer Component Editor......... 318
3.7.3. Name HDL Signals for Automatic Interface and Type Recognition in the Platform Designer Component Editor......................................................... 319
3.7.4. Specify Files for Simulation in the Component Editor............................. 320
3.7.5. Include an Internal Register Map Description in the .svd for Slave Interfaces Connected to an HPS Component.......................................................... 321
3.8. Add Signals and Interfaces in the Platform Designer Component Editor........ 322
3.9. Specify Parameters in the Platform Designer Component Editor................ 323
  3.9.1. Valid Ranges for Parameters in the _hw.tcl File........................................... 325
  3.9.2. Types of Platform Designer Parameters..................................................... 326
  3.9.3. Declare Parameters with Custom _hw.tcl Commands.................................. 328
  3.9.4. Validate Parameter Values with a Validation Callback................................ 329
3.10. Declaring SystemVerilog Interfaces in _hw.tcl............................................ 330
3.11. User Alterable HDL Parameters in _hw.tcl............................................. 331
3.12. Scripting Flow for Wire-Level Expressions.............................................. 333
3.13. Control Interfaces Dynamically with an Elaboration Callback.................... 334
3.14. Control File Generation Dynamically with Parameters and a Fileset Callback 334
3.15. Create a Composed Component or Subsystem......................................... 336
3.16. Add Component Instances to a Static or Generated Component.................. 338
  3.16.1. Static Components............................................................................... 338
  3.16.2. Generated Components......................................................................... 339
  3.16.3. Design Guidelines for Adding Component Instances.......................... 342
3.17. Adding a Generic Component to the Platform Designer System................... 342
  3.17.1. Creating Custom Interfaces in a Generic Component............................ 344
  3.17.2. Instantiating RTL in a System as a Generic Component ...................... 347
  3.17.3. Implementing Generic Components Using High Level Synthesis Files..... 348
  3.17.4. Creating System Template for a Generic Component............................. 353
  3.17.5. Exporting a Generic Component.......................................................... 355
3.18. Creating Platform Designer Components Revision History....................... 355

4. Platform Designer Interconnect........................................................................ 357
  4.1. Memory-Mapped Interfaces................................................................. 357
    4.1.1. Platform Designer Packet Format................................................... 359
    4.1.2. Interconnect Domains..................................................................... 362
    4.1.3. Master Network Interfaces............................................................ 364
    4.1.4. Slave Network Interfaces.............................................................. 367
    4.1.5. Arbitration..................................................................................... 369
    4.1.6. Memory-Mapped Arbiter................................................................. 373
    4.1.7. Datapath Multiplexing Logic............................................................ 375
    4.1.8. Width Adaptation.......................................................................... 375
    4.1.9. Burst Adapter................................................................................. 377
    4.1.10. Waitrequest Allowance Adapter.................................................... 379
    4.1.11. Read and Write Responses............................................................ 380
    4.1.12. Platform Designer Address Decoding............................................. 381
  4.2. Avalon Streaming Interfaces...................................................................... 382
    4.2.1. Avalon-ST Adapters......................................................................... 384
  4.3. Interrupt Interfaces.................................................................................. 392
    4.3.1. Individual Requests IRQ Scheme.................................................... 392
    4.3.2. AssigningIRQs in Platform Designer................................................. 393
  4.4. Clock Interfaces...................................................................................... 395
Contents

4.4.1. (High Speed Serial Interface) HSSI Clock Interfaces ......................................... 396

4.5. Reset Interfaces ........................................................................................................
   4.5.1. Single Global Reset Signal Implemented by Platform Designer ......................... 401
   4.5.2. Reset Controller .............................................................................................. 402
   4.5.3. Reset Bridge .................................................................................................... 402
   4.5.4. Reset Sequencer ............................................................................................. 403

4.6. Conduits ...................................................................................................................

4.7. Interconnect Pipelining ............................................................................................
   4.7.1. Manually Control Pipelining in the Platform Designer Interconnect ................. 416

4.8. Error Correction Coding (ECC) in Platform Designer Interconnect ...................... 417

4.9. AMBA 3 AXI Protocol Specification Support (version 1.0) ..................................... 418
   4.9.1. Channels ........................................................................................................ 418
   4.9.2. Cache Support ............................................................................................... 418
   4.9.3. Security Support ............................................................................................ 419
   4.9.4. Atomic Accesses ........................................................................................... 419
   4.9.5. Response Signaling ....................................................................................... 420
   4.9.6. Ordering Model ............................................................................................. 420
   4.9.7. Data Buses .................................................................................................... 420
   4.9.8. Unaligned Address Commands ..................................................................... 420
   4.9.9. Avalon and AXI Transaction Support ............................................................. 420
   4.9.10. Channels ...................................................................................................... 420

4.10. AMBA 3 APB Protocol Specification Support (version 1.0) ..................................... 421
   4.10.1. Bridges ....................................................................................................... 421
   4.10.2. Burst Adaptation .......................................................................................... 422
   4.10.3. Width Adaptation ......................................................................................... 422
   4.10.4. Error Response ............................................................................................ 422

4.11. AMBA 4 AXI Memory-Mapped Interface Support (version 2.0) ......................... 422
   4.11.1. Burst Support ............................................................................................... 422
   4.11.2. QoS ............................................................................................................. 422
   4.11.3. Regions ....................................................................................................... 423
   4.11.4. Write Response Dependency ....................................................................... 423
   4.11.5. AWCACHE and ARCACHE ................................................................. 423
   4.11.6. Width Adaptation and Data Packing in Platform Designer ......................... 423
   4.11.7. Ordering Model ............................................................................................ 423
   4.11.8. Read and Write Allocate ............................................................................ 424
   4.11.9. Locked Transactions .................................................................................... 424
   4.11.10. Memory Types .......................................................................................... 424
   4.11.11. Mismatched Attributes ............................................................................ 424
   4.11.12. Signals ...................................................................................................... 424

4.12. AMBA 4 AXI Streaming Interface Support (version 1.0) ..................................... 424
   4.12.1. Connection Points ....................................................................................... 425
   4.12.2. Adaptation .................................................................................................. 425

4.13. AMBA 4 AXI-Lite Protocol Specification Support (version 2.0) ......................... 426
   4.13.1. AMBA 4 AXI-Lite Signals ......................................................................... 426
   4.13.2. AMBA 4 AXI-Lite Bus Width ...................................................................... 426
   4.13.3. AMBA 4 AXI-Lite Outstanding Transactions ............................................. 426
   4.13.4. AMBA 4 AXI-Lite IDs .............................................................................. 426
   4.13.5. Connections Between AMBA 3 AXI, AMBA 4 AXI and AMBA 4 AXI-Lite .... 427
   4.13.6. AMBA 4 AXI-Lite Response Merging ....................................................... 427

4.14. Port Roles (Interface Signal Types) ........................................................................
   4.14.1. AXI Master Interface Signal Types ................................................................ 427
   4.14.2. AXI Slave Interface Signal Types ............................................................... 429
Contents

4.14.3. AMBA 4 AXI Master Interface Signal Types ........................................ 430
4.14.4. AMBA 4 AXI Slave Interface Signal Types ......................................... 431
4.14.5. AMBA 4 AXI-Stream Master and Slave Interface Signal Types ............. 433
4.14.6. ACE-Lite Interface Signal Roles .......................................................... 433
4.14.7. APB Interface Signal Types .................................................................. 433
4.14.10. Avalon Clock Source Signal Roles ................................................... 438
4.14.11. Avalon Clock Sink Signal Roles ....................................................... 439
4.14.15. Avalon Interrupt Sender Signal Roles ............................................... 442

4.15. Platform Designer Interconnect Revision History .................................... 442

5. Optimizing Platform Designer System Performance .................................... 444
5.1. Designing with Avalon and AXI Interfaces ............................................. 444
5.1.1. Designing Streaming Components ..................................................... 445
5.1.2. Designing Memory-Mapped Components .......................................... 445
5.2. Using Hierarchy in Systems ................................................................. 446
5.3. Using Concurrency in Memory-Mapped Systems .................................... 449
5.3.1. Implementing Concurrency With Multiple Masters ............................... 450
5.3.2. Implementing Concurrency With Multiple Slaves ................................ 451
5.3.3. Implementing Concurrency with DMA Engines .................................... 453
5.4. Inserting Pipeline Stages to Increase System Frequency .......................... 454
5.5. Using Bridges ....................................................................................... 454
5.5.1. Using Bridges to Increase System Frequency ...................................... 455
5.5.2. Using Bridges to Minimize Design Logic .......................................... 458
5.5.3. Using Bridges to Minimize Adapter Logic ......................................... 460
5.5.4. Considering the Effects of Using Bridges ........................................... 461
5.6. Increasing Transfer Throughput ............................................................ 467
5.6.1. Using Pipelined Transfers .................................................................. 468
5.6.2. Arbitration Shares and Bursts ............................................................ 469
5.7. Reducing Logic Utilization ...................................................................... 473
5.7.1. Minimizing Interconnect Logic to Reduce Logic Unitization ............... 473
5.7.2. Minimizing Arbitration Logic by Consolidating Multiple Interfaces .... 474
5.7.3. Reducing Logic Utilization With Multiple Clock Domains ................. 476
5.7.4. Duration of Transfers Crossing Clock Domains .................................. 478
5.8. Reducing Power Consumption ............................................................... 479
5.8.1. Reducing Power Consumption With Multiple Clock Domains ............ 479
5.8.2. Reducing Power Consumption by Minimizing Toggle Rates ............... 482
5.8.3. Reducing Power Consumption by Disabling Logic ............................. 483
5.9. Reset Polarity and Synchronization in Platform Designer .......................... 484
5.10. Optimizing Platform Designer System Performance Design Examples ...... 487
5.10.1. Avalon Pipelined Read Master Example .......................................... 487
5.10.2. Multiplexer Examples ................................................................... 489
5.11. Document Revision History ................................................................. 490

6. Component Interface Tcl Reference ......................................................... 492
6.1. Platform Designer _hw.tcl Command Reference ................................... 492
6.1.2. Parameters............................................................................................511
6.1.1. Interfaces and Ports...............................................................................493
6.2. Platform Designer _hw.tcl Property Reference........................................................ 588
6.1.9. Wire-Level Expression Commands........................................................... 584
6.2.2. Interface Properties................................................................................590
6.2.1. Script Language Properties...................................................................... 589
6.2.3. SystemVerilog Interface Properties........................................................... 590
6.2.24. Units Properties....................................................................................615
6.2.23. Design Environment Type Properties....................................................... 614
6.2.16. Callback Properties............................................................................... 606
6.2.17. File Attribute Properties.........................................................................607
6.2.15. Fileset Kind Properties...........................................................................605
6.2.12. Display Item Properties......................................................................... 599
6.2.14. Fileset Properties..................................................................................602
6.2.9. Direction Properties................................................................................598
6.2.10. Display Item Properties......................................................................... 599
6.2.13. Module Properties.................................................................................602
6.2.11. Display Item Kind Properties..................................................................600
6.2.12. Display Hint Properties......................................................................... 601
6.2.11. Display Item Kind Properties..................................................................600
6.2.10. Display Item Properties......................................................................... 599
6.2.13. Module Properties.................................................................................602
6.2.14. Fileset Properties..................................................................................602
6.2.15. Fileset Kind Properties...........................................................................605
6.2.16. Callback Properties............................................................................... 606
6.2.17. File Attribute Properties.........................................................................607
6.2.18. File Kind Properties............................................................................. 608
6.2.19. File Source Properties.......................................................................... 609
6.2.20. Simulator Properties............................................................................. 610
6.2.21. Port VHDL Type Properties....................................................................611
6.2.22. System Info Type Properties................................................................ 612
6.2.23. Design Environment Type Properties....................................................... 614
6.2.24. Units Properties.................................................................................. 615
6.2.25. Operating System Properties..................................................................616
6.2.26. Quartus.ini Type Properties...................................................................617
6.3. Component Interface Tcl Reference Revision History......................................... 618

7. Platform Designer System Design Components.........................................................620

7.1. Bridges........................................................................................................620
7.1.1. Clock Bridge..........................................................................................621
7.1.2. Avalon-MM Clock Crossing Bridge..........................................................622
7.1.3. Avalon-MM Pipeline Bridge.....................................................................624
7.1.4. Avalon-MM Unaligned Burst Expansion Bridge.........................................625
7.1.5. Bridges Between Avalon and AXI Interfaces...........................................628
7.1.6. AXI Bridge............................................................................................629
7.1.7. AXI Timeout Bridge...............................................................................634
7.1.8. Address Span Extender.......................................................................... 638
7.2. Error Response Slave..................................................................................643
7.2.1. Error Response Slave Parameters............................................................644
7.2.2. Error Response Slave CSR Registers.....................................................645
7.2.3. Designating a Default Slave in the System Contents Tab ..............................648

7.3. Tri-State Components .........................................................................................649
  7.3.1. Generic Tri-State Controller..................................................................... 651
  7.3.2. Tri-State Conduit Pin Sharer.................................................................... 651
  7.3.3. Tri-State Conduit Bridge..........................................................................652

7.4. Test Pattern Generator and Checker Cores.............................................................652
  7.4.1. Test Pattern Generator............................................................................653
  7.4.2. Test Pattern Checker...............................................................................655
  7.4.3. Software Programming Model for the Test Pattern Generator and Checker Cores ................................................................................................... 656
  7.4.4. Test Pattern Generator API......................................................................660
  7.4.5. Test Pattern Checker API.........................................................................665

7.5. Avalon-ST Splitter Core.......................................................................................672
  7.5.1. Splitter Core Backpressure...................................................................... 672
  7.5.2. Splitter Core Interfaces........................................................................... 673
  7.5.3. Splitter Core Parameters......................................................................... 673

7.6. Avalon-ST Delay Core.......................................................................................... 674
  7.6.1. Delay Core Reset Signal.......................................................................... 674
  7.6.2. Delay Core Interfaces............................................................................. 674
  7.6.3. Delay Core Parameters........................................................................... 675

7.7. Avalon-ST Round Robin Scheduler........................................................................ 676
  7.7.1. Almost-Full Status Interface (Round Robin Scheduler).................................676
  7.7.2. Request Interface (Round Robin Scheduler)...............................................676
  7.7.3. Round Robin Scheduler Operation............................................................676
  7.7.4. Round Robin Scheduler Parameters.......................................................... 677

7.8. Avalon Packets to Transactions Converter.............................................................. 678
  7.8.1. Packets to Transactions Converter Interfaces..............................................678
  7.8.2. Packets to Transactions Converter Operation.............................................. 678

7.9. Avalon-ST Streaming Pipeline Stage..................................................................... 680

7.10. Streaming Channel Multiplexer and Demultiplexer Cores........................................681
  7.10.1. Software Programming Model For the Multiplexer and Demultiplexer Components ................................................................................................... 682
  7.10.2. Avalon-ST Multiplexer........................................................................... 682
  7.10.3. Avalon-ST Demultiplexer....................................................................... 684

7.11. Single-Clock and Dual-Clock FIFO Cores.............................................................. 685
  7.11.1. Interfaces Implemented in FIFO Cores.................................................... 686
  7.11.2. FIFO Operating Modes.......................................................................... 687
  7.11.3. Fill Level of the FIFO Buffer.................................................................... 688
  7.11.4. Almost-Full and Almost-Empty Thresholds to Prevent Overflow and Underflow................................................................................................... 688
  7.11.5. Single-Clock and Dual-Clock FIFO Core Parameters.................................688
  7.11.6. Avalon-ST Single-Clock FIFO Registers...................................................689

7.12. Document Revision History................................................................................ 690

A. Intel Quartus Prime Pro Edition User Guides................................................................. 692
1. Creating a System with Platform Designer

Platform Designer is a system integration tool included as part of the Intel® Quartus® Prime software.

Note: Intel now refers to Qsys Pro as Platform Designer.

Platform Designer simplifies the task of defining and integrating customized IP Components (IP Cores) into your designs. Platform Designer simplifies the task of defining and integrating customized IP Components (IP Cores) into your designs.

Platform Designer facilitates design reuse by packaging and integrating your custom IP components with Intel and third-party IP components. Platform Designer automatically creates interconnect logic from the high-level connectivity that you specify, which eliminates the error-prone and time-consuming task of writing HDL to specify system-level connections.

Platform Designer introduces hierarchical isolation between system interconnect and IP components. Platform Designer stores the instantiated IP component in a separate .ip file and the system connectivity information in the .qsys file. This hierarchical isolation ensures that changing the parameters of a single IP component does not necessitate regeneration of the enclosing system or any other IP component within that system. Likewise, a change to system connectivity does not require regeneration of any of the IP components. Platform Designer references the parameterized IP component for instantiation in the system by the component's entity name, and generates the RTL of the IP component and the RTL of the system separately.

Platform Designer is a more powerful tool if you design your custom IP components using standard interfaces available in the Platform Designer IP Catalog. Standard interfaces inter-operate efficiently with the Intel FPGA IP components, and you can take advantage of bus functional models (BFMs), monitors, and other verification IP to verify your systems.

Platform Designer supports Avalon®, Arm* AMBA* 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

Platform Designer provides the following advantages:

- Simplifies the process of customizing and integrating IP components into systems
- Provides isolation between the system and IP component, maintaining all the parameter information of the IP component in a separate .ip file.
- Supports generic components, allowing the instantiation of IP components without an HDL implementation.
- Generates an IP core variation for use in your Intel Quartus Prime software projects
- Supports incremental generation of the system and IP components.
- Allows specifying interface requirements for the system.
- Allows you to establish connections between Avalon and AXI interface by generating an interconnect logic. This logic enables you to handle the protocol difference.
- Supports up to 64-bit addressing
- Supports modular system design
- Supports visualization of systems
- Supports optimization of interconnect and pipelining within the system
- Supports auto-adaptation of different data widths and burst characteristics
- Supports inter-operation between standard protocols
- Fully integrated with the Intel Quartus Prime software

**Note:** For information on how to define and generate stand-alone IP cores for use in your Intel Quartus Prime software projects, refer to *Introduction to Intel FPGA IP Cores* and *Managing Intel Quartus Prime Projects*.

**Related Information**
- Introduction to Intel FPGA IP Cores
- Managing Intel Quartus Prime Projects
- Avalon Interface Specifications
- AMBA Protocol Specifications

### 1.1. Interface Support in Platform Designer

IP components (IP Cores) can have any number of interfaces in any combination. Each interface represents a set of signals that you can connect within a Platform Designer system, or export outside of a Platform Designer system.

Platform Designer IP components can include the following interface types:

<table>
<thead>
<tr>
<th>Interface Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory-Mapped</td>
<td>Connects memory-referencing master devices with slave memory devices. Master devices may be processors and DMAs, while slave memory devices may be RAMs, ROMs, and control registers. Data transfers between master and slave may be uni-directional (read only or write only), or bi-directional (read and write).</td>
</tr>
<tr>
<td>Streaming</td>
<td>Connects Avalon Streaming (Avalon-ST) sources and sinks that stream unidirectional data, as well as high-bandwidth, low-latency IP components. Streaming creates datapaths for unidirectional traffic, including multichannel streams, packets, and DSP data. The Avalon-ST interconnect is flexible and can implement on-chip interfaces for industry standard telecommunications and data communications cores, such as Ethernet, Interlaken, and video. You can define bus widths, packets, and error conditions.</td>
</tr>
<tr>
<td>Interrupts</td>
<td>Connects interrupt senders to interrupt receivers. Platform Designer supports individual, single-bit interrupt requests (IRQs). In the event that multiple senders assert their IRQs simultaneously, the receiver logic (typically under software control) determines which IRQ has highest priority, then responds appropriately</td>
</tr>
</tbody>
</table>

*continued...*
### Interface Type | Description
--- | ---
Clocks | Connects clock output interfaces with clock input interfaces. Clock outputs can fan-out without the use of a bridge. A bridge is required only when a clock from an external (exported) source connects internally to more than one source.
Resets | Connects reset sources with reset input interfaces. If your system requires a particular positive-edge or negative-edge synchronized reset, Platform Designer inserts a reset controller to create the appropriate reset signal. If you design a system with multiple reset inputs, the reset controller ORs all reset inputs and generates a single reset output.
Conduits | Connects point-to-point conduit interfaces, or represent signals that are exported from the Platform Designer system. Platform Designer uses conduits for component I/O signals that are not part of any supported standard interface. You can connect two conduits directly within a Platform Designer system as a point-to-point connection, or conduit interfaces can be exported and brought to the top-level of the system as top-level system I/O. You can use conduits to connect to external devices, for example external DDR SDRAM memory, and to FPGA logic defined outside of the Platform Designer system.

### 1.2. Introduction to the Platform Designer IP Catalog

The Platform Designer IP Catalog offers a broad range of configurable IP Cores optimized for Intel devices to use in your Platform Designer designs.

The Intel Quartus Prime software installation includes the Intel FPGA IP library. You can integrate optimized and verified Intel FPGA IP cores into your design to shorten design cycles and maximize performance. The IP Catalog can include Intel-provided IP components, third-party IP components, custom IP components that you create in the Platform Designer Component Editor, and previously generated Platform Designer systems.

The Platform Designer IP Catalog includes the following IP component types:
- Basic Functions
- default groups
- DSP
- Generic Component
- Intel FPGA Interconnect
- Interface Protocols
- Low Power
- Memory Interfaces and Controllers
- Processors and Peripherals
- University Program

**Related Information**
Introduction to Intel FPGA IP Cores

### 1.2.1. Installing and Licensing IP Cores

The Intel Quartus Prime software includes the Intel FPGA IP Library. The library provides many useful IP core functions for production use without additional license. You can fully evaluate any licensed Intel FPGA IP core in simulation and in hardware until you are satisfied with its functionality and performance.
After you purchase a license for an IP core, you can request a license file from the licensing site and install it on your computer. When you request a license file, Intel emails you a `license.dat` file. If you do not have Internet access, contact your local Intel representative.

**1.2.2. Adding IP Cores to IP Catalog**

The IP Catalog automatically displays IP cores located in the project directory, in the default Intel Quartus Prime installation directory, and in the IP search path.

**Figure 1. Specifying IP Search Locations**

![Specifying IP Search Locations](image)

The IP Catalog displays Intel Quartus Prime IP components and Platform Designer systems, third-party IP components, and any custom IP components that you include in the path. Use the **IP Search Path** option (**Tools ➤ Options**) to include custom and third-party IP components in the IP Catalog.

The Intel Quartus Prime software searches the directories listed in the IP search path for the following IP core files:

- **Component Description File** (`_hw.tcl`)—defines a single IP core.
- **IP Index File** (`.ipx`)—each `.ipx` file indexes a collection of available IP cores. This file specifies the relative path of directories to search for IP cores. In general, `.ipx` files facilitate faster searches.
The Intel Quartus Prime software searches some directories recursively and other
directories only to a specific depth. When the search is recursive, the search stops at
any directory that contains a _hw.tcl or .ipx file.

In the following list of search locations, ** indicates a recursive descent.

### Table 2. IP Search Locations

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROJECT_DIR/*</td>
<td>Finds IP components and index files in the Intel Quartus Prime project directory.</td>
</tr>
<tr>
<td>PROJECT_DIR/ip/**/*</td>
<td>Finds IP components and index files in any subdirectory of the /ip subdirectory of the Intel Quartus Prime project directory.</td>
</tr>
</tbody>
</table>

If the Intel Quartus Prime software recognizes two IP cores with the same name, the
following search path precedence rules determine the resolution of files:

1. Project directory.
2. Project database directory.
3. Project IP search path specified in IP Search Locations, or with the SEARCH_PATH assignment for the current project revision.
4. Global IP search path specified in IP Search Locations, or with the SEARCH_PATH assignment in the quartus2.ini file.
5. Quartus software libraries directory, such as `<Quartus Installation>\libraries`.

#### Note:
If you add an IP component to the search path, update the IP Catalog by clicking Refresh IP Catalog in the drop-down list. In Platform Designer and Platform Designer, click File ➤ Refresh System to update the IP Catalog.

### 1.2.3. General Settings for IP

Use the following settings to control how the Intel Quartus Prime software manages IP cores in your project.

### Table 3. IP Core General Setting Locations

<table>
<thead>
<tr>
<th>Setting Location</th>
<th>Description</th>
</tr>
</thead>
</table>
| Tools ➤ Options ➤ IP Settings Or Tasks pane ➤ Settings ➤ IP Settings (Pro Edition Only) | • Specify the IP generation HDL preference. The parameter editor generates the HDL you specify for IP variations.  
• Increase the Maximum Platform Designer memory usage size if you experience slow processing for large systems, or for out of memory errors.  
• Use the IP Regeneration Policy setting to control when synthesis files regenerate for each IP variation. Typically, you Always regenerate synthesis files for IP cores after making changes to an IP variation. |
| Tools ➤ Options ➤ IP Catalog Search Locations Or Tasks pane ➤ Settings ➤ IP Catalog Search Locations (Pro Edition Only) | • Specify additional project and global IP search locations. The Intel Quartus Prime software searches for IP cores in the project directory, in the Intel Quartus Prime installation directory, and in the IP search path. |
1.2.4. Set up the IP Index File (.ipx) to Search for IP Components

An IP Index File (.ipx) contains a search path that Platform Designer uses to search for IP components. You can use the ip-make-ipx command to create an .ipx file for any directory tree, which can reduce the startup time for Platform Designer.

You can specify a search path in the user_components.ipx file in either in the Intel Quartus Prime software (Tools ➤ Options ➤ IP Catalog Search Locations). This method of discovering IP components allows you to add a locations dependent of the default search path. The user_components.ipx file directs Platform Designer to the location of an IP component or directory to search.

A <path> element in the .ipx file specifies a directory where multiple IP components may be found. A <component> entry specifies the path to a single component. A <path> element can use wildcards in its definition. An asterisk matches any file name. If you use an asterisk as a directory name, it matches any number of subdirectories.

**Example 1. Path Element in an .ipx File**

```xml
<library>
  <path path="...<user directory>" />
  <path path="...<user directory>" />
  ...
  <component ... file="...<user directory>" />
  ...
</library>
```

A <component> element in an .ipx file contains several attributes to define a component. If you provide the required details for each component in an .ipx file, the startup time for Platform Designer is less than if Platform Designer must discover the files in a directory. The example below shows two <component> elements. Note that the paths for file names are specified relative to the .ipx file.

**Example 2. Component Element in an .ipx File**

```xml
<library>
  <component
      name="A Platform Designer Component"
      displayName="Platform Designer FIR Filter Component"
      version="2.1"
      file="/components/qsys_filters/fir_hw.tcl"
    />
  <component
      name="rgb2cmyk_component"
      displayName="RGB2CMYK Converter(Color Conversion Category!)
      version="0.9"
      file="/components/qsys_converters/color/rgb2cmyk_hw.tcl"
    />
</library>
```

**Note:** You can verify that IP components are available with the ip-catalog command.

**Related Information**

Create an .ipx File with ip-make-ipx on page 92
1.2.5. Integrate Third-Party IP Components into the Platform Designer IP Catalog

You can use IP components created by Intel partners in your Platform Designer systems. These IP components have interfaces that are supported by Platform Designer, such as Avalon-MM or AXI. Additionally, some include timing and placement constraints, software drivers, simulation models, and reference designs.

To locate supported third-party IP components on Altera's web page, navigate to the Intellectual Property & Reference Designs page, type Platform Designer Certified in the Search box, select IP Core & Reference Designs, and then press Enter.

Refer to Intel's Intellectual Property & Reference Designs page for more information.

Related Information
Intellectual Property & Reference Designs

1.3. Create a Platform Designer System

Click Tools ➤ Platform Designer in the Intel Quartus Prime software to open Platform Designer. A .qsys file represents your Platform Designer system in your Intel Quartus Prime software project.

Related Information
• Creating Platform Designer Components on page 305
• Component Interface Tcl Reference on page 492

1.3.1. Create/Open Project in Platform Designer

The Intel Quartus Prime software tightly links with Platform Designer system creation. Platform Designer requires you to specify a Intel Quartus Prime project at time of system creation.

To create a new system, or open an existing system in Platform Designer:

1. To create a new Intel Quartus Prime project to associate with your Platform Designer system, click . To select an existing project, browse for the project. Alternatively, select an existing project from the drop-down list in the Quartus project field.
Note: Selecting None from the drop-down list in the Quartus project field opens the Platform Designer tool in view-only mode.\(^{(1)}\)

2. To create a new revision for the Intel Quartus Prime project, click \(\text{Create New Revision}\). To specify an existing revision for the project, select an existing revision from the drop-down list in the Revision field.

3. When creating a new Intel Quartus Prime project, specify the Device family and Device part to associate with your Platform Designer system by selecting the device name and device part number from the respective fields. If you are opening an existing Intel Quartus Prime project to associate with your Platform Designer system, click Retrieve Values to populate the fields with the device information of the Intel Quartus Prime project.

4. To create a new Platform Designer system, click \(\text{Create System}\). To open an existing .qsys file, browse for the file. Alternatively, select an existing file from the drop-down list.

Note: Similarly, you can open an existing IP file, or create a new IP variant by selecting the IP Variant tab in the Create New System dialog box. To create a new IP variant, you must specify a Component type for the .ip file.

**Figure 2. Platform Designer Create New System**

![Platform Designer Create New System](image)

Note: To change the Intel Quartus Prime project associated with your current Platform Designer system, click File ➤ Select Quartus Project.

### 1.3.1.1. Convert your Existing System to Platform Designer Format

When you open an existing system with incompatible components, Platform Designer prompts you to convert these components to the Platform Designer format. On conversion, the Platform Designer Conversion Results dialog box appears, listing all the converted system and IP source files.

\(^{(1)}\) View-only mode restricts the following functionality:

- Adding new IP components to the system or subsystem.
- Removing the instantiated IP components from the system or subsystem.
- Creating a new system, subsystem, or IP file.
- Executing system scripts.
Platform Designer stores the .ip files inside an ip folder, relative to the .qsys system file location. Platform Designer prefixes the system name to the .ip file name. Platform Designer automatically adds these converted files to the associated Intel Quartus Prime project. Ensure that you maintain these .ip files, along with your system files.

1.3.2. Modify the Target Device

The Platform Designer system inherits the device family from the associated Intel Quartus Prime project.

You can modify the device settings of your Platform Designer system from the Device Family tab. Changing the Device family or Device options from this tab automatically updates the associated Intel Quartus Prime project.

1.3.3. Modify the IP Search Path

Platform Designer allows you to view and modify the IP search locations specified for the Intel Quartus Prime project associated with your system. To specify the IP search path from Platform Designer:

1. Click Tools ➤ Options ➤ IP Search Path. The Intel Quartus Prime Global IP Search Path and Quartus Project IP Search Path panes display the IP search locations specified for your associated Intel Quartus Prime project.

2. Click Add or Remove to add/remove new search locations. The Intel Quartus Prime project automatically updates to reflect these modifications. In Platform Designer, click File ➤ Refresh System to propagate these changes.
1.3.4. Platform Designer System Design flow

The Platform Designer design flow involves creating, instantiating and generating, and simulating system output for IP components.

Figure 5. Platform Designer System Design Flow

Note: For information on how to define and generate single IP cores for use in your Intel Quartus Prime software projects, refer to Introduction to Intel FPGA IP Cores.
1.3.5. Add IP Components (IP Cores) to a Platform Designer System

The Platform Designer IP Catalog displays IP components (IP cores) available for your target device. Double-click any component in the IP Catalog to launch the parameter editor. The parameter editor allows you to create a custom IP component variation of the selected component. A Platform Designer system can contain a single instance of an IP component, or multiple, individually parameterized variations of multiple or the same IP components.

Platform Designer preserves each of the IP component’s parameters as a .ip file. A Platform Designer system instantiates a generic component in place of the actual IP core with a reference to the HDL entity name, module and interface assignments, compilation library, HDL ports, interfaces, and system-info parameters.

Follow these steps to locate, instantiate, and customize an IP component in your Platform Designer system:

1. Right-click any IP component name in the Platform Designer IP Catalog to display details about device support, installation location, versions, and links to documentation.

2. To locate a specific type of component, type some or all of the component’s name in the IP Catalog search box. For example, type memory to locate memory-mapped IP components, or axi to locate AXI IP. You can also filter the IP Catalog display with options on the right-click menu.

3. To launch the parameter editor, double-click any component. You can set the parameter values in the parameter editor and view the block diagram for the component. The Parameterization Messages tab at the bottom displays any errors in the parameterization of the IP component.

4. For IP components that have preset parameter values, select the preset file in the preset editor, and then click Apply. This option allows you to instantly apply preset parameter values for the IP component appropriate for a specific application.

5. To complete customization of the IP component, click Finish. The IP component appears in the System Contents and Component Instantiation tabs.

Note: Platform Designer creates a corresponding .ip file for the IP component on instantiation, and stores the file in the <ip> folder in your project directory.

The IP component appears in the System Contents tab.
1.3.6. Specify Implementation Type for IP Components

A Platform Designer system instantiates a generic component in place of the actual IP core with a reference to the HDL entity name, module and interface assignments, compilation library, HDL ports, interfaces, and system-info parameters.

The Component Instantiation tab allows you to configure the system representation of an IP core. To open the Component Instantiation tab, click View ➤ Component Instantiation.

Table 4. Component Instantiation GUI Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation Type</td>
<td>Allows you to decide how to define the implementation of your IP component.</td>
</tr>
<tr>
<td></td>
<td>Platform Designer has the following implementation types:</td>
</tr>
</tbody>
</table>

continued...
### Name | Description
--- | ---
**IP**—The default implementation type for any IP core. With **IP Implementation Type**, Platform Designer performs the following functions:  
— Runs background checks against the port widths between the IP component and the .ip file to ensure continuity.  
— Scans the .ip file for the error flag to understand if any component has parameterization errors.  
— Checks for system-info mismatches between the IP file and the IP component in the system and prompts you to resolve these through IP instantiation warnings in the **Instantiation Messages** tab.  
**HDL**—Allows you to quickly import RTL to your Platform Designer system. You can populate the signals and interfaces parameters of the generic component from an RTL file.  
**Blackbox**—By choosing this implementation type, you specify a component that represents the signal and interface boundary of an entity, without providing the component's implementation. You must provide the implementation of the component in a downstream compiler such as Intel Quartus Prime software or your RTL simulator.  
**HLS**—Select to add an existing high level synthesis (HSL) file, compile an HLS file, import a previously compiled HLS file, perform verification on an HLS project, or display the resulting compilation report.

**Compilation Info** | Allows you to specify the **HDL Entity name** and **HDL compilation library name** for the implementation. These are fixed values for the **IP Implementation Type**.

**Signals & Interfaces** | Allows you to define the port boundary of the component. Click `<<add interface>>` or `<<add signal>>` to add the interfaces and signals.

**System Information** | Allows you to specify the address map of the interfaces, input clock rate, and other necessary system information associated with the component.

**Block symbol** | Allows you to visualize the signals and interfaces added in the **Signals & Interfaces** tab.

**Implementation Templates** | Allows you to export implementation templates in the form of a pre-populated HDL entity, or a template Platform Designer system which contains the boundary information (signals and interfaces) as interface requirements.

**Export** | Allows you to export the signals and interfaces of an IP component as an IP-XACT file or a `_hw.tcl` file.

**Note:** Remember to click **Apply** in the **Component Instantiation** tab for any of your changes to take effect. Alternatively, click **Revert** to undo all the changes you have made to the component.

**Related Information**
Adding a Generic Component to the Platform Designer System on page 342

### 1.3.7. Connect IP Components in Your Platform Designer System

Use the **System Contents** tab to connect and configure components. Platform Designer supports connections between interfaces of compatible types and opposite directions. For example, you can connect a memory-mapped master interface to a slave interface, and an interrupt sender interface to an interrupt receiver interface. You can connect any interfaces exported from a Platform Designer system within a parent system.

**Note:** You cannot both export and connect interfaces internally within the same Platform Designer system.
Possible connections between interfaces appear as gray lines and open circles. To make a connection, click the open circle at the intersection of the interfaces. When you make a connection, Platform Designer draws the connection line in black and fills the connection circle. Clicking a filled-in circle removes the connection.

Platform Designer takes the high-level connectivity you specify, and instantiates a suitable HDL fabric to perform the needed adaptation and arbitration between components. Platform Designer includes this interconnect fabric in the generated RTL system output. The Connections tab (View ➤ Connections) shows a list of current and possible connections for selected instances or interfaces in the Hierarchy or System Contents tabs. You can add and remove connections by clicking the check box for each connection. Each column provides specific information about the connection. For example, the Clock Crossing, Data Width, and Burst columns provide interconnect information about added adapters that can result in slower $f_{\text{MAX}}$ or increased area utilization.

To prevent additional connectivity changes to your system, you can deselect Allow Connection Editing in the right-click menu. This option sets the Connections column to read-only and hides the possible connections.

Figure 7. Connections Column in the System Contents Tab

When you double-click an interface in the Export column to export it, all possible connections in the Connections column are displayed as a pin.

Figure 8. Connection Display for Exported Interfaces
Click the pin to restore the representation of the connections, and remove the interface from the Export column. You can also use the Connections tab to view and make connections for exported interfaces.

1.3.7.1. Create Connections Between Masters and Slaves

The Address Map tab specifies the address range that each memory-mapped master uses to connect to a slave in a Platform Designer system. Platform Designer shows the slaves on the left, the masters across the top, and the address span of the connection in each cell. If there is no connection between a master and a slave, the table cell is empty. In this case, use the Address Map tab to view the individual memory addresses for each connected master.

Platform Designer enables you to design a system where two masters access the same slave at different addresses. If you use this feature, Platform Designer labels the Base and End address columns in the System Contents tab as “mixed” rather than providing the address range.

Follow these steps to change or create a connection between master and slave IP components:

1. In Platform Designer, click the Address Map tab.
2. Locate the table cell that represents the connection between the master and slave component pair.
3. Either type in a base address, or update the current base address in the cell.

Note: The base address of a slave component must be a multiple of the address span of the component. This restriction is a requirement of the Platform Designer interconnect, which provides an efficient address decoding logic, which in turn allows Platform Designer to achieve the best possible fMAX.

1.3.8. Wire-Level Connectivity

Wire-level connectivity enables you to manipulate wire level connections in the system level view of Platform Designer in the Intel Quartus Prime Pro Edition for both GUI and scripting flows.

The use model for wire-level connectivity is exclusive to optional input ports. Select an input port of an IP component and enter a Verilog style syntax expression to drive it. Upon applying the expression, this port is moved out of its current interface and into a Wire-Level Endpoint interface. The new interface appends _wirelevel to the existing interface name. If you remove the wire-level expression, the port is removed from the wire-level interface and restored to the original interface.

You cannot connect ports contained within this new interface type to any other interfaces. Once a port has been moved to a Wire-Level Endpoint interface, all bits in the vector must be driven by wire-level expressions. You can apply multiple expressions to a single input port unless they collide or cause bus contention. Moving a port from its original interface might result in validation errors on the original interface. You must resolve validation errors occurring on the original interface for the interface to function correctly. Not all interfaces are resolvable to legal interfaces after certain ports are moved, so you must understand the impact of your changes.

A wire-level expression can consist of input ports, output ports, bi-directional ports, constant values, and logic terms using standard Verilog syntax. Platform Designer validates your wire-level expressions and provides messages for syntax, port
existence, and other systematic errors. Wire-level expressions can only consist of ports within the same level of hierarchy. If you require elements from a higher or lower hierarchy, you must export the appropriate elements to the same hierarchical context so that they are available for use in wire-level expressions at the same hierarchy level.

Wire-level connectivity can be achieved by a scripted flow or using the Platform Designer GUI. There are three commands for wire-level connectivity, `set_wirelevel_expression`, `get_wirelevel_expressions`, and `remove_wirelevel_expressions` which work in both the `qsys-script` utility or the `_hw.tcl` file.

Validation of wire-level expressions consists of the following:

- Validate the Verilog syntax.
- Warn if any sub-operator’s elements don’t match their bit size.
- Warn if resulting combined bit size is not the same as the driven input port.
- Validate that all module names and port names exist.
- Validate that all ports in a wire-level interface are input ports.
- Validate that all bits of each input port within a wire-level interface are driven by wire-level expressions.
- Validate that there is no bus-contention, meaning that no one wire is driven by more than one expression.
- In a composed `_hw.tcl` module, validate that all ports driven by wire-level expressions are not in any connection.
- In a composed `_hw.tcl` module, validate that all ports driven by wire-level expressions are not exported.

After you have defined wire-level expressions for your system and all errors have been resolved, you can go through the regular generation flow to generate Verilog files. When applied in the Platform Designer GUI, or with the `qsys-script` utility, the wire-level expression is inserted in the generated Verilog wrapper file for your system. When applied with composed `_hw.tcl` commands, the wire-level expression is inserted in the generated Verilog wrapper file for the specified IP component.

Related Information

- Wire-Level Connection Commands on page 267
- `set_wirelevel_expression` on page 268
- `get_wirelevel_expressions` on page 268
- `remove_wirelevel_expressions` on page 269

1.3.8.1. Wire-Level Expression Syntax

The expression syntax is based on Verilog. The following is a list of allowed operators and elements that can be used for wire-level expressions.
Table 5. Ports

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;instance_name&gt;.&lt;port_name&gt;</code></td>
<td>Whole port</td>
</tr>
<tr>
<td><code>&lt;instance_name&gt;.&lt;port_name&gt;[x]</code></td>
<td>Wire x of port</td>
</tr>
<tr>
<td><code>&lt;instance_name&gt;.&lt;port_name&gt;[y:x]</code></td>
<td>Wires x to y of port. Port ranges must be in decreasing order, for example <code>a[1:0]</code>.</td>
</tr>
<tr>
<td><code>&lt;constant base x values&gt;</code></td>
<td>For example: 1, 'b1, 4'hf, 4'o7, 32'd9</td>
</tr>
</tbody>
</table>

Table 6. Operators (Bitwise)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~</td>
<td>Negation</td>
</tr>
<tr>
<td>&amp;</td>
<td>AND</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>~&amp;</td>
<td>NAND</td>
</tr>
<tr>
<td>~</td>
<td></td>
</tr>
<tr>
<td>^</td>
<td>XOR</td>
</tr>
<tr>
<td>~^</td>
<td>XNOR</td>
</tr>
</tbody>
</table>

Table 7. Operators (Logical)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Conditional</td>
</tr>
<tr>
<td>!</td>
<td>Negation</td>
</tr>
<tr>
<td>&amp;&amp;</td>
<td>AND</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 8. Operators (Relational, Equality, and Shift)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Greater Than</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less Than</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater Than or Equal To</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less Than or Equal To</td>
</tr>
<tr>
<td>==</td>
<td>Equal To</td>
</tr>
<tr>
<td>!=</td>
<td>Not Equal To</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>Shift Left</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Shift Right</td>
</tr>
</tbody>
</table>
Table 9. Operators (Mathematical)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Addition</td>
</tr>
<tr>
<td>-</td>
<td>Subtraction</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication</td>
</tr>
<tr>
<td>/</td>
<td>Division</td>
</tr>
<tr>
<td>%</td>
<td>Modulus</td>
</tr>
</tbody>
</table>

Table 10. Operators (Other)

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{integer {x}}</td>
<td>Replication of x</td>
</tr>
<tr>
<td>{x, y, ...}</td>
<td>Concatenation</td>
</tr>
</tbody>
</table>

Example Expressions:

foo1.port1[5:0] = foo2.port1[5:0]
foo3.port1[8:4] = foo5.port1[4:0] & 5'b10101
foo6.port1 = 'b1
foo7.port1 = foo8.port1
foo9.port1[0] = ~foo10.port1[0]
foo10.port1[3:0] = foo11.port2[1:0] + 4'b1100
foo12.port1[3:0] = \{4(0)\}
foo13.port1[7:0] = \{foo14.port1[3:0], 4'b0011\}

1.3.8.2. Edit Wire-Level Expressions Dialog

You can add, edit, or remove wire-level expressions and connections in the Platform Designer GUI.

The **Edit Wire-Level Expression** dialog box is dependent on adding a wire-level expression to an optional input port. To specify a wire-level expression, right-click an input port in the **Hierarchy** list and select **Add Wire-Level Expression**.
Adding a wire-level expression to a port with the Add Wire-Level Expression command opens the Edit Wire-Level Expression dialog box. The specified port appears in the text box where you can type in a Verilog expression to assign a value to the port.

The Edit Wire-Level Expression dialog box also features an assistant to aid the selection of valid modules or ports. Click in the text field at the top of the Edit Wire-Level Expression dialog box and press the Down Arrow key to enable the assistant. The list provided by the assistant is context sensitive based on where the cursor is in the text box.
You can also create expressions graphically by dragging elements into the workspace from the operators or ports lists. You can then modify the elements of the expression in the workspace:

- To add a value to an expression, right-click on a node and select Insert Value.
- Double-click on a value to enter a numeric value or port name.
- Click on an operator node to change the operator type.
- You can reorder nodes or move nodes between operators by dragging them.

### 1.3.8.3. Wire-Level Endpoint Interfaces

Ports can be moved into or out of wire-level interfaces by right-clicking on the port in the Hierarchy tool and selecting Move Port to Wire-Level Interface or Remove Port from Wire-Level Interface.

The Wire-Level Endpoint interface appends _wirelevel to the existing interface name. You cannot connect ports contained within Wire-Level Endpoint interface to any other interfaces. Once a port has been moved to a Wire-Level Endpoint interface, you can view and edit it in the Component Instantiation tab.
1.3.8.4. Wire-Level Expressions Editor

You can manage wire-level expressions in the **Wire-Level Expression Editor**.

Selecting **View ➤ Wire-Level Expression Editor** creates a pane in Platform Designer displays a list of all wire-level expressions in the system. The **Wire-Level Expression Editor** allows you to add new wire-level expressions, edit, or remove existing wire-level expressions.
1.3.8.5. Scripting Flow for Wire-Level Expressions

Platform Designer includes new system scripting commands that you can use to apply wire-level expressions to your IP component input ports in either the qsys-script or _hw.tcl utilities. There are three Tcl commands for wire-level expressions.

You can use these commands to apply an expression to a port. You can also retrieve or remove expressions from a port, an instance, or the current system. You can use these commands with either the qsys-script utility or in a _hw.tcl file.

- Before using qsys-script, you must add new wire-level interfaces which moves the specified ports to a wire-level interface.
- When using _hw.tcl, you can apply a wire-level expression directly to the port.

Wire-Level Expression Scripting Commands

```
set_wirelevel_expression <instance_or_port_bitselection> <expression>
get_wirelevel_expressions <instance_or_port_bitselection>
remove_wirelevel_expressions <instance_or_port_bitselection>
```

These commands take a string that is composed of the left-handed and right-handed components of the expression. Platform Designer posts errors if there are any problems with syntax, existence, or system hierarchy.

Related Information

- Wire-Level Connection Commands on page 267
- set_wirelevel_expression on page 268
- get_wirelevel_expressions on page 268
1.3.9. Validate System Integrity

The **System Messages** tab displays all the errors and warnings associated with your current Platform Designer system. Double-click the warning or error messages to open the relevant **System Contents** or **Parameters** tabs to fix the issue. You can also click validate button in the **Hierarchy** tab, or the **Validate System Integrity** button at the bottom of the main Platform Designer panel to perform system integrity check for the entire system.

<table>
<thead>
<tr>
<th>System Messages Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Instantiation Warning</td>
<td>Indicates the mismatches between system information parameters or IP core parameterization errors. A system information parameters mismatch refers to the mismatch between an IP component's system parameter expectations and the component's saved system information parameters in the corresponding .ip file.</td>
</tr>
<tr>
<td>Component Instantiation Error</td>
<td>Indicates the mismatches between HDL entity name, compilation library, or ports which results in downstream compilation errors. The component instantiation errors always indicate the fundamental mismatches between generated system and interconnect fabric RTL.</td>
</tr>
<tr>
<td>System Connectivity Warning</td>
<td>Platform Designer system connectivity warnings.</td>
</tr>
<tr>
<td>System Connectivity Error</td>
<td>Platform Designer system connectivity errors.</td>
</tr>
</tbody>
</table>

1.3.9.1. Component Instantiation Warning Messages

Component Instantiation Warnings report the following inconsistencies:

- Interface types do not match
- Interface is missing
- Port has been moved to another interface
- Port role has changed
- Interface assignment is mismatched
- Interface assignment is missing

1.3.9.2. Component Instantiation Error Messages

Component Instantiation Errors report the following inconsistencies:

- Port is missing from the ip file
- Port is missing from instantiation
- Port direction has changed
- Port HDL type has changed
- Port width has changed
- Interface Parameter is mismatched
- Interface Parameter is missing
1.3.9.3. Validate System Integrity for Individual Components in the System

To validate the system integrity for your IP components:
1. Select the IP component in the **System Contents** tab.
2. Right-click and select **Validate Component Footprint** to check for any mismatches between the IP component and its .ip file representation.
3. If there are any errors, click **Reload Component Footprint** to reload the signals and interfaces for the component from the .ip file.

Note: To perform system integrity check for the entire system, right-click the **System Contents** tab and select **Validate System Integrity**. You can also click the validate button in the **Hierarchy** tab, or the **Validate System Integrity** button at the bottom of the main Platform Designer panel.

![Validating System Integrity](image)

**Figure 13.** Validating System Integrity

1.3.10. Propagate System Information to IP Components

When system information doesn’t match the requirements of an IP component, use the **System Info** tab to synchronize the IP component with mismatches. To open the **System Info** tab, click **View ➤ System Info**.

**Table 12. System Info GUI Information**

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Instantiation</td>
<td>This table shows the signals and interfaces for the selected IP component within the system. Mismatches are highlighted in blue. Missing elements are highlighted in green.</td>
</tr>
<tr>
<td>IP file</td>
<td>This table shows the signal and interface information for the selected IP component from its corresponding .ip file. Mismatches are highlighted in blue. Missing elements are highlighted in green.</td>
</tr>
<tr>
<td>Component Instantiation Value</td>
<td>This table shows the selected interface parameter value of the IP component within the system.</td>
</tr>
</tbody>
</table>

continued...
### IP File Value

This table shows the selected interface parameter value of the IP component from the corresponding .ip file.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP File Value</td>
<td>This button allows you to manually synchronize the mismatches in signals and interfaces, one at a time, between the IP file and the IP component.</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>This button allows you to synchronize all the system info mismatches for the IP component.</td>
</tr>
</tbody>
</table>

**Note:**

To update the system information for all the IP components in your current system simultaneously, click the update icon in the **Hierarchy** tab or the **Sync All System Info** button at the bottom of the main Platform Designer panel.

### 1.3.10.1. Update System Information

If the system information does not match the saved requirements of the corresponding .ip file for an IP component, the mismatches appear as Component Instantiation Warnings in the **System Messages** tab. In Platform Designer, you must manually synchronize these system info dependencies:

1. To open the **System Info** tab, select the signal or interface in the **System Contents** tab and click View ➤ System Info. You can also double-click the corresponding Component Instantiation Warning in the **System Messages** tab to open the system-info mismatch information in the **System Info** tab.

2. To update the .ip file with the current system information, select the mismatched parameter and click >>. Alternatively, you can synchronize all the mismatches for the component by clicking the **Sync All** button.

3. To update the system information for all the IP components in your current system, click **Sync All System Info** in the bottom right corner of the Platform Designer main frame.

**Note:** Clicking the update icon near the search field in the **Hierarchy** tab also synchronizes the system information for all the IP components in your system.
1.3.11. View Your Platform Designer System

Platform Designer allows you to change the display of your system to match your design development. Each tab on View menu allows you to view your design with a unique perspective. Multiple tabs open in your workspace allows you to focus on a selected element in your system under different perspectives.

The Platform Designer GUI supports global selection and edit. When you make a selection or apply an edit in the Hierarchy tab, Platform Designer updates all other open tabs to reflect your action. For example, when you select cpu_0 in the Hierarchy tab, Platform Designer updates the Parameters tab to show the parameters for cpu_0.

- By default, when you open Platform Designer, the IP Catalog, Hierarchy, and the Device Family tabs appear to the left of the main frame.
- The System Contents, Address Map, Interconnect Requirements, and Details tabs display in the main frame.
- Parameters, System Info, and Component Instantiation tabs appear to the right of the main frame.
- The System Messages tab displays in the lower portion of Platform Designer.
- The Parameterization Messages tab appears in the lower portion of the Parameter tab when you select an IP component, displaying parameter warnings and error messages, specific to that component.

Note: The Parameterization Messages tab also appears in the bottom pane of the parameter editor when you double-click an IP component from the IP Catalog.
You can dock tabs in the main frame as a group, or individually by clicking the tab control in the upper-right corner of the main frame. You can arrange your workspace by dragging and dropping, and then grouping tabs in an order appropriate to your design development, or close or dock tabs that you are not using. Tool tips on the upper-right corner of the tab describe possible workspace arrangements, for example, restoring or disconnecting a tab to or from your workspace. When you save your system, Platform Designer also saves the current workspace configuration. When you re-open a saved system, Platform Designer restores the last saved workspace.

The **Reset to System Layout** command on the **View** menu restores the workspace to its default configuration for Platform Designer system design. The **Reset to IP Layout** command restores the workspace to its default configuration for defining and generating single IP cores.

**Figure 15. Platform Designer GUI**

**1.3.11.1. Manage Platform Designer Window Views with Layouts**

Platform Designer Layout controls what tabs are open in your Platform Designer design window. When you create a Platform Designer window configuration that you want to keep, Platform Designer allows you to save that configuration as a custom layout. The Platform Designer GUI and features are well-suited for Platform Designer system design. You can also use Platform Designer to define and generate single IP cores for use in your Intel Quartus Prime software projects.

1. To configure your Platform Designer window with a layout suitable for Platform Designer system design, click **View ➤ Reset to System Layout**. The **System Contents**, **Address Map**, **Interconnect Requirements**, and **Messages** tabs open in the main pane, and the **IP Catalog** and **Hierarchy** tabs along the left pane.

2. To configure your Platform Designer window with a layout suitable for single IP core design, click **View ➤ Reset to IP Layout**.
The Parameters and Messages tabs open in the main pane, and the Details, Block Symbol and Presets tabs along the right pane.

3. To save your current Platform Designer window configuration as a custom layout, click View ➤ Custom Layouts ➤ Save. Platform Designer saves your custom layout in your project directory, and adds the layout to the custom layouts list, and the layouts.ini file. The layouts.ini file controls the order in which the layouts appear in the list.

4. To reset your Platform Designer window configuration to a previously saved configuration, click View ➤ Custom Layouts, and then select the custom layout in the list. The Platform Designer windows opens with your previously saved Platform Designer window configuration.

Figure 16. Save Your Platform Designer Window Views and Layouts

5. To manage your saved custom layouts, click View ➤ Custom Layouts. The Manage Custom Layouts dialog box opens and allows you to apply a variety of functions that facilitate custom layout management. For example, you can import or export a layout from or to a different directory.
Figure 17.  Manage Custom Layouts
The shortcut, Ctrl-3, for example, allows you to quickly change your Platform Designer window view with a quick keystroke.

1.3.11.2. Filter the Display of the System Contents Tab
You can use the Filters dialog box to filter the display of your system by interface type, instance name, or by using custom tags.

For example, in the System Contents tab, you can show only instances that include memory-mapped interfaces or instances connected to a particular Nios II processor. The filter tool also allows you to temporarily hide clock and reset interfaces to simplify the display.
1.3.11.3. Display Details About a Component or Parameter

The Details tab provides information for a selected component or parameter. Platform Designer updates the information in the Details tab as you select different components.

As you click through the parameters for a component in the parameter editor, Platform Designer displays the description of the parameter in the Details tab. To return to the complete description for the component, click the header in the Parameters tab.

1.3.11.4. Display a Graphical Representation of a Component

In the Block Symbol tab, Platform Designer displays a graphical representation of the element that you select in the Hierarchy or System Contents tabs. You can view the selected component's port interfaces and signals. The Show signals option allows you to turn on or off signal graphics.

The Block Symbol tab appears by default in the parameter editor when you add a component to your system. When the Block Symbol tab is open in your workspace, it reflects changes that you make in other tabs.
1.3.11.5. View a Schematic of Your Platform Designer System

The **Schematic** tab displays a schematic representation of your Platform Designer system. Tab controls allow you to zoom into a component or connection, or to obtain tooltip details for your selection. You can use the image handles in the right panel to resize the schematic image.

If your selection is a subsystem, use the Hierarchy tool to navigate to the parent subsystem, move up one level, or to drill into the currently open subsystem.

**Figure 19. Platform Designer Schematic Tab**

---

**Related Information**

Edit a Platform Designer Subsystem on page 51

1.3.11.6. View Connections in Your Platform Designer System

The **Connections** tab displays a lists of connections in your Platform Designer system. On the **Connections** tab (View ➤ Connections), you can choose to connect or unconnect a module in your system, and then view the results in the **System Contents** tab.
1.3.12. Navigate Your Platform Designer System

The Hierarchy tab is a full system hierarchical navigator that expands the Platform Designer system contents to show all elements in your system.

You can use the Hierarchy tab to browse, connect, parameterize IP, and drive changes in other open tabs. Expanding each interface in the Hierarchy tab allows you to view sub-components, associated elements, and signals for the interface. You can focus on a particular area of your system by coordinating selections in the Hierarchy tab with other open tabs in your workspace.

Navigating your system using the Hierarchy tab in conjunction with relevant tabs is useful during the debugging phase. Viewing your system with multiple tabs open allows you to focus your debugging efforts to a single element in your system.

The Hierarchy tab provides the following information and functionality:

- Connections between signals.
- Names of signals in exported interfaces.
- Right-click menu to connect, edit, add, remove, or duplicate elements in the hierarchy.
- Internal connections of Platform Designer subsystems that are included as IP components. In contrast, the System Contents tab displays only the exported interfaces of Platform Designer subsystems.
Expanding System Contents in the Hierarchy Tab

The Hierarchy tab displays a unique icon for each element in the system. Context sensitivity between tabs facilitates design development and debugging. For example, when you select an element in the Hierarchy tab, Platform Designer selects the same element in other open tabs. This allows you to interact with your system in more detail. In the example below, the ram_master selection appears selected in both the System Contents and Hierarchy tabs.

Related Information
Create and Manage Hierarchical Platform Designer Systems on page 48

1.3.13. Specify IP Component Parameters

The Parameters tab allows you to configure parameters that define an IP component’s functionality.

When you add a component to your system, or when you double-click a component in an open tab, the parameter editor opens. In the parameter editor, you can configure the parameters of the component to align with the requirements of your design. If you create your own IP components, use the Hardware Component Description File (hw.tcl) to specify configurable parameters.

Whenever you add an IP component to your system, Platform Designer stores the instantiated IP component in a separate .ip file. Any changes you make to the component's parameters from the Parameters tab, automatically updates the corresponding .ip file.
With the **Parameters** tab open, when you select an element in the **Hierarchy** tab, Platform Designer shows the same element in the **Parameters** tab. You can then make changes to the parameters that appear in the parameter editor, including changing the name for top-level instance that appears in the **System Contents** tab. Changes that you make in the **Parameters** tab affect your entire system and appear dynamically in other open tabs in your workspace.

In the parameter editor, the **Documentation** button provides information about a component's parameters, including the version.

When using `ip-deploy` or `qsys-script` commands, you must use the internal parameter names. To display the component's internal parameter names, right-click the banner in the **Parameters** tab and select **Show Parameter Display Names and Internal Names**. The default option is **Show Parameter Display Names**.

**Figure 22. Displaying the Parameter Display Names and Internal Names**

At the top of the parameter editor, Platform Designer shows the hierarchical path for the component and its elements. This feature is useful when you navigate deep within your system with the **Hierarchy** tab.

Below the hierarchical path, the parameter editor shows the HDL entity name and the IP file path for the selected IP component.

The **Parameters** tab also allows you to review the timing for an interface and displays the read and write waveforms at the bottom of the **Parameters** tab.

The **Parameterization Messages** appears at lower portion of the parameter editor, displaying parameter warnings and error messages, specific to the selected IP component.
1.3.13.1. Configure Your IP Component with a Pre-Defined Set of Parameters

The **Presets** tab allows you to apply a pre-defined set of parameters to your IP component to create a unique variation. The **Presets** tab opens the preset editor and allows you to create, modify, and save custom component parameter values as a preset file. Not all IP components have preset files.

When you add a new component to your system, if there are preset files available for the component, the preset editor opens in the parameter editor. The name of each preset file describes a particular protocol.

1. In your Platform Designer system, select an element in the **Hierarchy** tab.
2. Click **View ➤ Presets**.
3. Type text in the **Presets** search box to filter the list of preset files. For example, if you add the **DDR3 SDRAM Controller with UniPHY** component to your system, type `1g micron 256` in the search box, The **Presets** list displays only those preset files associated with `1g micron 256`.
4. Click **Apply** to assign the selected presets to the component. Presets whose parameter values match the current parameter settings appear in bold.
5. In the **Presets** tab, click **New** to create a custom preset file if the available presets do not meet the requirements of your design.
   
a. In the **New Preset** dialog box, specify the **Preset name** and **Preset description**.

b. Check or uncheck the parameters you want to include in the preset file.

c. Specify where you want to save the new preset file.
   If the file location that you specify is not already in the IP search path, Platform Designer adds the location of the new preset file to the IP search path.

d. Click **Save**.

6. In the **Presets** tab, click **Update** to update a custom preset.

   **Note:** Custom presets are preset files that you create by clicking **New** in the **Presets** tab.

7. In the **Presets** tab, click **Delete** to delete a custom preset.

**Figure 24. Specifying Presets**

---

1.3.14. Modify an Instantiated IP Component

Platform Designer allows you to manipulate the system representation of IP components. For example, you can modify the interfaces of an instantiated IP component to change its properties.

The example below shows how to instantiate a PLL in your system and then modify its conduit interface so that the conduit becomes a reset.

**1.3.14.1. Change a Conduit to a Reset**

1. In the IP Catalog search box, locate **Altera IOPLL** and double-click to add the component to your system.

2. Select the **PLL** component in the **System Contents** tab.

3. Open the **Component Instantiation** tab for the selected component.
4. In the **Signals & Interfaces** tab, select the **locked** conduit interface.

5. Change the **Type** from **Conduit** to **Reset Input**, and the **Synchronous edges** from **Deassert** to **None**.

6. Select the **locked** [1] signal below the **locked** interface.

7. Change the **Signal Type** from **export** to **reset_n**. Change the **Direction** from **output** to **input**.

8. Click **Apply**.

The conduit interface changes to reset for the instantiated PLL component.

**Figure 25. Changing Conduit to a Reset**

---

### 1.3.15. Save your System

To save your Platform Designer system, click **File ➤ Save**. To save a standalone .ip file that you open in the IP Parameter Editor Pro window, click **File ➤ Save**. To create a copy of the standalone .ip file, click **File ➤ Save As**.

**Note:**
- To save a copy of the Platform Designer system, refer to the **Archive your System** section.
- To save the system as a Platform Designer script, click **File ➤ Export System as qsys script (.tcl)**. You can restore this system by executing the .tcl script from the **System Scripting** tab.

**Related Information**

**Archive your System** on page 45

### 1.3.16. Archive your System

Platform Designer allows you to archive your system in a .zip format. To archive your system, click **File ➤ Archive System**.
In the Archive System dialog box, the Collect to common directory option is turned on by default. This option allows Platform Designer to collect all the .qsys files in the root directory of the archive, and all the .ip files in a single ip directory, while updating all the references to match. Disable this option to maintain the current directory structure for the archive.

To extract all the archived files in a given system to a specified folder, click File ➤ Restore Archive System. Select the source archive file, and the destination folder. Upon successful extraction, Platform Designer automatically launches the Open System dialog box, with the extracted .qsys file and the associated .qpf file, preloaded.

Note: You can also archive your system using command-line options. For more information, refer to Archive a System with qsys-archive section.

Related Information
Archive a Platform Designer System with qsys-archive on page 299

1.4. Synchronize IP File References

Whenever you load a system, Platform Designer ensures that the referenced IP files in your Platform Designer system matches the IP files list in the associated Intel Quartus Prime project.

The IP Synchronization Result dialog box displays the discrepancies list whenever IP synchronization mismatches occur in your Platform Designer system. To manually check for these mismatches, click File ➤ Synchronize IP File References.

Platform Designer identifies the following types of mismatches with the IP synchronization:

<table>
<thead>
<tr>
<th>Mismatch Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duplicate IP files</td>
<td>The list of same IP files references specified in both your Platform Designer system and the associated Intel Quartus Prime project. These IP files contain the same name, but are present in different locations. In such cases, the IP files referenced in the Intel Quartus Prime project takes precedence. Platform Designer replaces the IP file reference in the system with the one in the Intel Quartus Prime project. &lt;br&gt;Note: If the Intel Quartus Prime project contains more than one IP of the same file name, Platform Designer retains the first instance and removes all other occurrences of the IP file with the specific name.</td>
</tr>
<tr>
<td>Missing IP files</td>
<td>The list of missing IP file references specified in both your Platform Designer system and the corresponding Intel Quartus Prime project. In such cases, Platform Designer allows you to select a replacement IP file.</td>
</tr>
<tr>
<td>Missing Platform Designer IP files</td>
<td>The list of missing IP file references in your Platform Designer system whose associated Intel Quartus Prime project contains valid IP files of the same names. If Platform Designer locates a valid reference in the Intel Quartus Prime project, it replaces the missing reference.</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Mismatch Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing Quartus IP files</td>
<td>The list of IP file references in your Platform Designer system which are not listed in the associated Intel Quartus Prime project’s .qsf file. Platform Designer adds the missing IP file reference to the Intel Quartus Prime project. If the project’s .qsf file already contains reference to the missing IP file, but the file cannot be located in the specified path, Platform Designer removes the reference in the .qsf file, and adds the reference to the IP file in the Platform Designer system.</td>
</tr>
</tbody>
</table>

### 1.5. Upgrade Outdated IP Components in Platform Designer

When you open a Platform Designer system containing outdated IP components, you can retain and use the RTL of previously generated IP components within the Platform Designer system. If Platform Designer is unable to locate the IP core’s original version, you cannot re-parametrize the IP core without upgrading the IP core to the latest version. However, Platform Designer allows you to view the parametrization of the original core without upgrading.

To upgrade individual IP components in your Platform Designer system:

1. Click **View ➤ Parameters**
2. Select the outdated IP component in the Hierarchy or the System Contents tab.
3. Click the Parameters tab. This tab displays information on the current version, as well as the installed version of the selected IP component.
4. Click **Upgrade**. Platform Designer upgrades the IP component to the installed version, and deletes all the RTL files associated with the IP component.
To upgrade an IP component from the command-line, type the following:

```
qsys-generate --upgrade-ip-cores <ip_file>
```

To upgrade all the IP components in your Platform Designer system, open the associated project in the Intel Quartus Prime software, and click Project ➤ Upgrade IP Components.

**Related Information**

Introduction to the Platform Designer IP Catalog on page 11

1.6. Create and Manage Hierarchical Platform Designer Systems

Platform Designer supports hierarchical system design. You can add any Platform Designer system as a subsystem in another Platform Designer system. Platform Designer hierarchical system design allows you to create, explore and edit hierarchies dynamically within a single instance of the Platform Designer editor. Platform Designer generates the complete hierarchy during the top-level system's generation.

**Note:**

You can explore parameterizable Platform Designer systems and _hw.tcl files, but you cannot edit their elements.
Your Platform Designer systems appear in the IP Catalog under the System category under Project. You can reuse systems across multiple designs. In a team-based hierarchical design flow, you can divide large designs into subsystems and have team members develop subsystems simultaneously.

**Related Information**

Navigate Your Platform Designer System on page 40

### 1.6.1. Add a Subsystem to Your Platform Designer Design

You can create a child subsystem or nest subsystems at any level in the hierarchy. Platform Designer adds a subsystem to the system you are currently editing. This can be the top-level system, or a subsystem.

To create or nest subsystems in your Platform Designer design, use the following methods within the System Contents tab:

- Right-click command: **Add a new subsystem to the current system**.
- Left panel icon.
- **CTRL+SHIFT+N**.

**Figure 27.** Add a Subsystem to Your Platform Designer Design

### 1.6.2. Drill into a Platform Designer Subsystem to Explore its Contents

The ability to drill into a system provides visibility into its elements and connections. When you drill into an instance, you open the system it instantiates for editing.

You can drill into a subsystem with the following commands:
- Double-click a system in the **Hierarchy** tab.
- Right-click a system in the **System Contents** or **Schematic** tabs, and then select **Drill into subsystem**.
- CTRL+SHIFT+D in the **System Contents** tab.

**Note:** You can only drill into .qsys files, not parameterizable Platform Designer systems or _hw.tcl files.

The **Hierarchy** tab is rooted at the top-level and drives global selection. You can manage a hierarchical Platform Designer system that you build across multiple Platform Designer files, and view and edit their interconnected paths and address maps simultaneously. As an example, you can select a path to a subsystem in the **Hierarchy** tab, and then drill deeper into the subsystem in the **System Contents** or **Schematic** tabs.

Views that manage system-level editing, for example, the **System Contents** and **Schematic** tabs, contain the hierarchy widget, which allows you to efficiently navigate your subsystems. The hierarchy widget also displays the name of the current selection, and its path in the context of the system or subsystem.

The widget contains the following controls and information:

- **Top**—Navigates to the project-level .qsys file that contains the subsystem.
- **Up**—Navigates up one level from the current selection.
- **Drill Into**—Allows you to drill into an editable system.
- **System**—Displays the hierarchical location of the system you are currently editing.
- **Path**—Displays the relative path to the current selection.

**Note:** In the **System Contents** tab, you can use CTRL+SHIFT+U to navigate up one level, and CTRL+SHIFT+D to drill into a system.
1.6.3. Edit a Platform Designer Subsystem

You can double-click a Platform Designer subsystem in the Hierarchy tab to edit its contents in any tab. When you make a change, open tabs refresh their content to reflect your edit. You can change the level of a subsystem, or push it into another subsystem with commands in the System Contents tab.

**Note:** To edit a .qsys file, the file must be writeable and reside outside of the ACDS installation directory. You cannot edit systems that you create from composed _hw.tcl files, or systems that define instance parameters.

1. In the System Contents or Schematic tabs, use the hierarchy widget to navigate to the top-level system, up one level, or down one level (drill into a system). All tabs refresh and display the requested hierarchy level.

2. To edit a system, double-click the system in the Hierarchy tab. You can also drill into the system with the Hierarchy tool or right-click commands, which are available in the Hierarchy, Schematic, System Contents tabs. The system is open and available for edit in all Platform Designer views. A system currently open for edit appears as bold in the Hierarchy tab.

3. In the System Contents tab, you can rename any element, add, remove, or duplicate connections, and export interfaces, as appropriate. Changes to a subsystem affect all instances. Platform Designer identifies unsaved changes to a subsystem with an asterisk next to the subsystem in the Hierarchy tab.
1.6.4. Change the Hierarchy Level of a Platform Designer Component

You can push selected components down into their own subsystem, which can simplify your top-level system view. Similarly, you can pull a component up out of a subsystem to perhaps share it between two unique subsystems. Hierarchical-level management facilitates system optimization and can reduce complex connectivity in your subsystems. When you make a change, open tabs refresh their content to reflect your edit.

1. In the **System Contents** tab, to group multiple components that perhaps share a system-level component, select the components, right-click, and then select **Push down into new subsystem**.
   Platform Designer pushes the components into their own subsystem and re-establishes the exported signals and connectivity in the new location.

2. In the **System Contents** tab, to pull a component up out of a subsystem, select the component, and then click **Pull up**.
   Platform Designer pulls the component up out of the subsystem and re-establishes the exported signals and connectivity in the new location.

1.6.5. Save New Platform Designer Subsystem

When you save a subsystem to your Platform Designer design, Platform Designer confirms the new subsystem in the **Confirm New System Filenames** dialog box. The **Confirm New System Filenames** dialog box appears when you save your Platform Designer design. Platform Designer uses the name that you give a subsystem as `.qsys` filename, and saves the subsystem in the project’s ip directory.

1. Click **File ➤ Save** to save your Platform Designer design.

2. In the **Confirm New System Filenames** dialog box, click **OK** to accept the subsystem file names.
   
   *Note:* If you have not yet saved your top-level system, or multiple subsystems, you can type a name, and then press **Enter**, to move to the next un-named system.

3. In the **Confirm New System Filenames** dialog box, to edit the name of a subsystem, click the subsystem, and then type the new name.

4. To cancel the save process, click **Cancel** in the **Confirm New System Filenames** dialog box.

1.7. Specify Signal and Interface Boundary Requirements

The **Interface Requirements** tab allows you to specify the expected signal and interface boundary requirements that your Platform Designer system must satisfy. Use this tab to view and resolve any interface requirement mismatches in your current system. You can also edit the names of the exported signals and interfaces in your system from the **Interface Requirements** tab.

To open the **Interface Requirements** tab, click **View ➤ Interface Requirements**.
Table 14. Interface Requirements GUI Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current System</strong></td>
<td>This table displays all the exported interfaces in your current Platform Designer system. Add or remove the interfaces in the <strong>Current System</strong> table by adding or removing instances to the system in the <strong>System Contents</strong> tab.</td>
</tr>
<tr>
<td><strong>Interface Requirements</strong></td>
<td>This table shows all the interface requirements set for the current Platform Designer system.</td>
</tr>
</tbody>
</table>
| **Parameter Differences**     | This table lists the **Parameter Name**, **Current System Value**, and **Interface Requirement Value** for the selected mismatched interface.  
   Note: The **Interface Requirements** tab highlights in blue the signals and interfaces that are the same, but have different parameter values.  
   Selecting a blue item populates the **Parameter Differences** table.                                                                 |
| **Import Interface Requirements** | This button allows you to populate the **Interface Requirements** table from an IP-XACT file representing a generic component or an entire Platform Designer system.                            |
| **Parameters**                | This table lists the signal and interface parameters for the selected interface. You can view the table as **Current Parameters** when you select an interface or signal from the **Current System** table, and as **Required Parameters** when you select the signal or interface from **Interface Requirements** table. You can modify the name of your exported signal or interface from this table. For more information about how to edit the name of an exported signal or interface, refer to *Edit the Name of Exported Interfaces and Signals*.

Related Information

*Edit the Name of Exported Interfaces and Signals* on page 54

1.7.1. Match the Exported Interface with Interface Requirements

If an exported interface does not match the interface requirements of the system, Platform Designer generates component instantiation errors. You must match all the exported interfaces with the interface requirements of the system:

1. To open the **Interface Requirements** tab, click **View ➤ Interface Requirements**.
2. To load the interface requirements from a Platform Designer system, click **Import Interface Requirements** in the **Interface Requirements** table. A dialog box appears from which you can choose the .ipxact representation of the Platform Designer system.
3. To add new interface requirements, click `<add interface>` or `<add signal>` in the **Interface Requirements** table.
4. To correct the mismatches, select the missing or mismatched interface or signal in the **Current System** table and click `>>`.  
   Note: Platform Designer highlights the mismatches between the system and interface requirements in blue, and highlights the missing interfaces and signals in green.
1.7.2. Edit the Name of Exported Interfaces and Signals

To rename the exported signal or interface:

- Double-click the signal or interface in **Current System** table.
- Select the signal or interface in the **Current System** table and press F2.
- Select the signal or interface in the **Current System** table and rename from the **Current Parameters** pane at the bottom of the tab. The **Current Parameters** pane displays all the parameters of the selected interface or signal.

*Note:* All other parameters in the **Current Parameters** except **Name** are read-only for the current system.

**Related Information**

- Specify Signal and Interface Boundary Requirements on page 52
- Creating System Template for a Generic Component on page 353
1.8. Run System Scripts

The **System Scripting** tab allows you to execute Tcl scripts on your Platform Designer system. To open the **System Scripting** tab, click View ➤ System Scripting.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform Designer Built-in Scripts</td>
<td>Scripts that the Platform Designer tool provides. You cannot edit these scripts.</td>
</tr>
<tr>
<td>User Scripts</td>
<td>You can add your own scripts to this entry. Platform Designer saves these scripts to your user preference file, available in your home directory. The scripts that you add to this entry are available every time you open Platform Designer. Click &lt;&lt;add script&gt;&gt; to add a new script file to this entry. Double-click the Description field to add a description. Right-click the added script and click Rename to set a display name for the script.</td>
</tr>
<tr>
<td>Project Scripts</td>
<td>You can add your own scripts to this entry. Platform Designer saves these scripts to your current system. The scripts that you add to this entry are available only when you open this specific Platform Designer system. Click &lt;&lt;add script&gt;&gt; to add a new script file to this entry. Double-click the Description field to add a description or additional commands to the script. Right-click the added script and click Rename to set a display name for the script.</td>
</tr>
<tr>
<td>Edit File</td>
<td>Selecting the script in the File field displays the script in the pane below. Click Edit File to edit the script.</td>
</tr>
<tr>
<td>Revert File</td>
<td>Discards all your changes to the edited file.</td>
</tr>
<tr>
<td>Save File</td>
<td>Saves your changes to the edited file.</td>
</tr>
<tr>
<td>Run Script</td>
<td>Executes the selected script.</td>
</tr>
<tr>
<td>System Scripting Messages</td>
<td>Displays the warning and error messages when running the script.</td>
</tr>
</tbody>
</table>
1.9. View and Filter Clock and Reset Domains in Your Platform Designer System

The Platform Designer clock and reset domains tabs allow you to see clock domains and reset domains in your Platform Designer system. Platform Designer determines clock and reset domains by the associated clocks and resets, which are displayed in tooltips for each interface in your system. You can filter your system to display particular components or interfaces within a selected clock or reset domain. The clock and reset domain tabs also provide quick access to performance bottlenecks by indicating connection points where Platform Designer automatically inserts clock crossing adapters and reset synchronizers during system generation. With these tools, you can more easily create optimal connections between interfaces.

Click View ➤ Clock Domains, or View ➤ Reset Domains to open the respective tabs in your workspace. The domain tools display as a tree with the current system at the root. You can select each clock or reset domain in the list to view associated interfaces.

When you select an element in the Clock Domains tab, the corresponding selection appears in the System Contents tab. You can select one or more single or multiple interfaces and modules. Mouse over tooltips in the System Contents tab to provide
detailed information for all elements and connections. Colors that appear for the
clocks and resets in the domain tools correspond to the colors in the System
Contents and Schematic tabs.

Clock and reset control tools at the bottom on the System Contents tab allow you to
choose between highlighting clock or reset domains. You can further filter your view
with options in the Filters dialog box, which is accessible by clicking the filter icon at
the bottom of the System Contents tab. In the Filters dialog box, you can choose to
view a single interface, or to hide clock, reset, or interrupt interfaces.

Clock and reset domain tools respond to global selection and edits, and help to
provide answers to the following system design questions:

- How many clock and reset domains do you have in your Platform Designer
  system?
- What interfaces and modules does each clock or reset domain contain?
- Where do clock or reset crossings occur?
- At what connection points does Platform Designer automatically insert clock or
  reset adapters?
- Where do you have to manually insert a clock or reset adapter?

**Figure 32. Platform Designer Clock and Reset Domains**

1.9.1. View Clock Domains in Your Platform Designer System

With the Clock Domains tab, you can filter the System Contents tab to display a
single clock domain, or multiple clock domains. You can further filter your view with
selections in the Filters dialog box. When you select an element in the Clock
Domains tab, the corresponding selection appears highlighted in the System
Contents tab.

1. To view clock domain interfaces and their connections in your Platform Designer
  system, click View ➤ Clock Domains to open the Clock Domains tab.
2. To enable and disable highlighting of the clock domains in the System Contents
   tab, click the clock control tool at the bottom of the System Contents tab.
3. To view a single clock domain, or multiple clock domains and their modules and connections, click the clock name or names in the **Clock Domains** tab. The modules for the selected clock domain or domains and their connections appear highlighted in the **System Contents** tab. Detailed information for the current selection appears in the clock domain details pane. Red dots in the **Connections** column indicate auto insertions by Platform Designer during system generation, for example, a reset synchronizer or clock crossing adapter.

4. To view interfaces that cross clock domains, expand the **Clock Domain Crossings** icon in the **Clock Domains** tab, and select each element to view its details in the **System Contents** tab.

Platform Designer lists the interfaces that cross clock domain under **Clock Domain Crossings**. As you click through the elements, detailed information appears in the clock domain details pane. Platform Designer also highlights the selection in the **System Contents** tab.

If a connection crosses a clock domain, the connection circle appears as a red dot in the **System Contents** tab. Mouse over tooltips at the red dot connections provide details about the connection, as well as what adapter type Platform Designer automatically inserts during system generation.

### 1.9.2. View Reset Domains in Your Platform Designer System

With the **Reset Domains** tab, you can filter the **System Contents** tab to display a single reset domain, or multiple reset domains. When you select an element in the **Reset Domains** tab, the corresponding selection appears in the **System Contents** tab.

1. To view reset domain interfaces and their connections in your Platform Designer system, click **View ➤ Reset Domains** to open the **Reset Domains** tab.

2. To show reset domains in the **System Contents** tab, click the reset control tool at the bottom of the **System Contents** tab.
Figure 35.  Reset Control Tool

3. To view a single reset domain, or multiple reset domains and their modules and connections, click the reset names in the Reset Domain tab. Platform Designer displays your selection according to the following rules:

- When you select multiple reset domains, the System Contents tab shows interfaces and modules in both reset domains.
- When you select a single reset domain, the other reset domains are grayed out, unless the two domains have interfaces in common.
- Reset interfaces appear black when connected to multiple reset domains.
- Reset interfaces appear gray when they are not connected to all of the selected reset domains.
- If an interface is contained in multiple reset domains, the interface is grayed out.

Detailed information for your selection appears in the reset domain details pane.

Note: Red dots in the Connections column between reset sinks and sources indicate auto insertions by Platform Designer during system generation, for example, a reset synchronizer. Platform Designer decides when to display a red dot with the following protocol, and ends the decision process at first match.

- Multiple resets fan into a common sink.
- Reset inputs are associated with different clock domains.
- Reset inputs have different synchronicity.

1.9.3. Filter Platform Designer Clock and Reset Domains in the System Contents Tab

You can filter the display of your Platform Designer clock and reset domains in the System Contents tab.

1. To filter the display in the System Contents tab to view only a particular interface and its connections, or to choose to hide clock, reset, or interrupt interfaces, click the Filters icon in the clock and reset control tool to open the Filters dialog box.

The selected interfaces appear in the System Contents tab.
2. To clear all clock and reset filters in the System Contents tab and show all interfaces, click the Filters icon with the red "x" in the clock and reset control tool.

1.9.4. View Avalon Memory Mapped Domains in Your Platform Designer System

The Avalon Memory Mapped Domains tab (View ➤ Avalon Memory Mapped Domains) displays a list of all the Avalon domains in the system.

With the Avalon Memory Mapped Domains tab, you can filter the System Contents tab to display a single Avalon domain, or multiple domains. You can further filter your view with selections in the Filters dialog box. When you select a domain in the Avalon Memory Mapped Domains tab, the corresponding selection is highlighted in the System Contents tab.

To rename an Avalon memory mapped domain, double-click the domain name. Detailed information for the current selection appears in the Avalon domain details pane. Also, you can choose to view only the selected domain's interfaces in the System Contents tab.
Figure 38.  **Avalon Memory Mapped Domains Tab**

Shows only the Interfaces in the Selected Avalon Memory Mapped Domain in the System Contents Tab

Double-Click to Rename Domain Name

Displays Information about the Current Domain Selection

To enable and disable the highlighting of the Avalon domains in the System Contents tab, click the domain control tool at the bottom of the System Contents tab.

Figure 39.  **Avalon Memory Mapped Domains Control Tool**
1.10. Specify Platform Designer Interconnect Requirements

The **Interconnect Requirements** tab allows you to apply system-wide, $\texttt{system}$, and interface interconnect requirements for IP components in your system. Options in the **Setting** column vary depending on what you select in the **Identifier** column. Click the drop-down menu to select the settings, and to assign the corresponding values to the settings.
### Table 16. System-Wide Interconnect Requirements

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit interconnect pipeline stages to</td>
<td>Specifies the maximum number of pipeline stages that Platform Designer can insert in each command and response path to increase the $f_{\text{MAX}}$ at the expense of additional latency. You can specify between 0â€“4 pipeline stages, where 0 means that the interconnect has a combinational datapath. Choosing 3 or 4 pipeline stages may significantly increase the logic utilization of the system. This setting is specific for each Platform Designer system or subsystem, meaning that each subsystem can have a different setting. Additional latency is added once on the command path, and once on the response path. You can manually adjust this setting in the <strong>Memory-Mapped Interconnect</strong> tab. Access this tab by clicking <strong>System ➤ Show System With Platform Designer Interconnect</strong>.</td>
</tr>
<tr>
<td>Clock crossing adapter type</td>
<td>Specifies the default implementation for automatically inserted clock crossing adapters:</td>
</tr>
<tr>
<td>Handshake</td>
<td>This adapter uses a simple handshaking protocol to propagate transfer control signals and responses across the clock boundary. This methodology uses fewer hardware resources because each transfer is safely propagated to the target domain before the next transfer can begin. The <strong>Handshake</strong> adapter is appropriate for systems with low throughput requirements.</td>
</tr>
<tr>
<td>FIFO</td>
<td>This adapter uses dual-clock FIFOs for synchronization. The latency of the FIFO-based adapter is a couple of clock cycles more than the handshaking clock crossing component. However, the FIFO-based adapter can sustain higher throughput because it supports multiple transactions at any given time. FIFO-based clock crossing adapters require more resources. The <strong>FIFO</strong> adapter is appropriate for memory-mapped transfers requiring high throughput across clock domains.</td>
</tr>
<tr>
<td>Auto</td>
<td>If you select <strong>Auto</strong>, Platform Designer specifies the <strong>FIFO</strong> adapter for bursting links, and the <strong>Handshake</strong> adapter for all other links.</td>
</tr>
<tr>
<td>Automate default slave insertion</td>
<td>Directs Platform Designer to automatically insert a default slave for undefined memory region accesses during system generation.</td>
</tr>
<tr>
<td>Enable instrumentation</td>
<td>When you set this option to <strong>TRUE</strong>, Platform Designer enables debug instrumentation in the Platform Designer interconnect, which then monitors interconnect performance in the system console.</td>
</tr>
<tr>
<td>Burst Adapter Implementation</td>
<td>Allows you to choose the converter type that Platform Designer applies to each burst.</td>
</tr>
<tr>
<td>Generic converter (slower, lower area)</td>
<td>Default. Controls all burst conversions with a single converter that is able to adapt incoming burst types. This results in an adapter that has lower $f_{\text{MAX}}$, but smaller area.</td>
</tr>
<tr>
<td>Per-burst-type converter (faster, higher area)</td>
<td>Controls incoming bursts with a particular converter, depending on the burst type. This results in an adapter that has higher $f_{\text{MAX}}$, but higher area. This setting is useful when you have AXI masters or slaves and you want a higher $f_{\text{MAX}}$.</td>
</tr>
<tr>
<td>Enable ECC protection</td>
<td>Specifies the default implementation for ECC protection for memory elements.</td>
</tr>
<tr>
<td>FALSE</td>
<td>Default. Disables ECC protection for memory elements in the Platform Designer interconnect.</td>
</tr>
<tr>
<td>TRUE</td>
<td>Enables ECC protection for memory elements. Platform Designer interconnect sends uncorrectable errors arising from memory as <code>DECODEERROR</code> (DECERR) on the Avalon response bus.</td>
</tr>
</tbody>
</table>

continued...
Option | Description
--- | ---
For more information about Error Correction Coding (ECC), refer to *Error Correction Coding in Platform Designer Interconnect.*

Interconnect type

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>suitable for all devices</td>
</tr>
<tr>
<td>(Alpha release)</td>
<td></td>
</tr>
<tr>
<td>Hyperflex-optimized</td>
<td>suitable for latency-tolerant Intel Stratix® 10 applications. This option has higher potential ( f_{\text{max}} ) and bandwidth, at the expense of increased latency</td>
</tr>
</tbody>
</table>

Table 17. **Specifying Interface Interconnect Requirements**

You can apply the following interconnect requirements when you select a component interface as the Identifier in the Interconnect Requirements tab, in the All Requirements table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>• Non-secure</td>
<td>After you establish connections between the masters and slaves, allows you to set the security options, as needed, for each master and slave in your system. Note: You can also set these values in the Security column in the System Contents tab.</td>
</tr>
<tr>
<td></td>
<td>• Secure</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Secure ranges</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TrustZone*-aware</td>
<td></td>
</tr>
<tr>
<td>Secure address ranges</td>
<td>Accepts valid address range.</td>
<td>Allows you to type in any valid address range.</td>
</tr>
</tbody>
</table>

**Related Information**

- *Error Correction Coding (ECC) in Platform Designer Interconnect* on page 417
- *Error Correction Coding (ECC) in Platform Designer Interconnect* on page 417

# 1.11. Manage Platform Designer System Security

Arm TrustZone is the security extension of the Arm-based architecture. It includes secure and non-secure transactions designations, and a protocol for processing between the designations. TrustZone security support is a part of the Platform Designer interconnect.

The AXI *AxPROT* protection signal specifies a secure or non-secure transaction. When an AXI master sends a command, the *AxPROT* signal specifies whether the command is secure or non-secure. When an AXI slave receives a command, the *AxPROT* signal determines whether the command is secure or non-secure. Determining the security of a transaction while sending or receiving a transaction is a run-time protocol.

The Avalon specification does not include a protection signal as part of its specification. When an Avalon master sends a command, it has no embedded security and Platform Designer recognizes the command as non-secure. When an Avalon slave receives a command, it also has no embedded security, and the slave always accepts the command and responds.

AXI masters and slaves can be TrustZone-aware. All other master and slave interfaces, such as Avalon-MM interfaces, are non-TrustZone-aware. You can set compile-time security support for all components (except AXI masters, including AMBA 3 AXI, AMBA 3 AXI, and AMBA 3 AXI-Lite) in the Security column in the System Contents tab, or in the Interconnect Requirements tab under the Identifier column for the master...
or slave interface. To begin creating a secure system, you must first add masters and slaves to your system, and the connections between them. After you establish connections between the masters and slaves, you can then set the security options, as needed.

An example of when you may need to specify compile-time security support is when an Avalon master needs to communicate with a secure AXI slave, and you can specify whether the connection point is secure or non-secure. You can specify a compile-time secure address ranges for a memory slave if an interface-level security setting is not sufficient.

Related Information
- Platform Designer Interconnect on page 357
- Platform Designer System Design Components on page 620

1.11.1. Configure Platform Designer Security Settings Between Interfaces

The AXI AxPROT signal specifies a transaction as secure or non-secure at runtime when a master sends a transaction. Platform Designer identifies AXI master interfaces as TrustZone-aware. You can configure AXI slaves as TrustZone-aware, secure, non-secure, or secure ranges.

Table 18. Compile-Time Security Options

<table>
<thead>
<tr>
<th>Compile-Time Security Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-secure</td>
<td>Master sends only non-secure transactions, and the slave receives any</td>
</tr>
<tr>
<td></td>
<td>transaction, secure or non-secure.</td>
</tr>
<tr>
<td>Secure</td>
<td>Master sends only secure transactions, and the slave receives only secure</td>
</tr>
<tr>
<td></td>
<td>transactions.</td>
</tr>
<tr>
<td>Secure ranges</td>
<td>Applies to only the slave interface. The specified address ranges within the</td>
</tr>
<tr>
<td></td>
<td>slave’s address span are secure, all other address ranges are not. The</td>
</tr>
<tr>
<td></td>
<td>format is a comma-separated list of inclusive-low and inclusive-high</td>
</tr>
<tr>
<td></td>
<td>addresses, for example, 0x0:0xffff, 0x2000:0x20ff.</td>
</tr>
</tbody>
</table>

After setting compile-time security options for non-TrustZone-aware master and slave interfaces, you must identify those masters that require a default slave before generation. To designate a slave interface as the default slave, turn on Default Slave in the System Contents tab. A master can have only one default slave.

Note: The Security and Default Slave columns in the System Contents tab are hidden by default. Right-click the System Contents header to select which columns you want to display.
The following are descriptions of security support for master and slave interfaces. These descriptions can guide you in your design decisions when you want to create secure systems that have mixed secure and non-TrustZone-aware components:

- All AXI, AMBA 3 AXI, and AMBA 3 AXI-Lite masters are TrustZone-aware.
- You can set AXI, AMBA 3 AXI, and AMBA 3 AXI-Lite slaves as TrustZone-aware, secure, non-secure, or secure range ranges.
- You can set non-AXI master interfaces as secure or non-secure.
- You can set non-AXI slave interfaces as secure, non-secure, or secure address ranges.

### 1.11.2. Specify a Default Slave in a Platform Designer System

If a master issues "per-access" or "not allowed" transactions, your design must contain a default slave. Per-access refers to the ability of a TrustZone-aware master to allow or disallow access or transactions. A transaction that violates security is rerouted to the default slave and subsequently responds to the master with an error. You can designate any slave as the default slave.

You can share a default slave between multiple masters. You should have one default slave for each interconnect domain. An interconnect domain is a group of connected memory-mapped masters and slaves that share the same interconnect. The `altera_error_response_slave` component includes the required TrustZone features.

You can achieve an optimized secure system by partitioning your design and carefully designating secure or non-secure address maps to maintain reliable data. Avoid a design where, under the same hierarchy, a non-secure master initiates transactions to a secure slave resulting in unsuccessful transfers.

#### Table 19. Secure and Non-Secure Access Between Master, Slave, and Memory Components

<table>
<thead>
<tr>
<th>Transaction Type</th>
<th>TrustZone-aware Master</th>
<th>Non-TrustZone-aware Master Secure</th>
<th>Non-TrustZone-aware Master Non-Secure</th>
</tr>
</thead>
<tbody>
<tr>
<td>TrustZone-aware slave/memory</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Non-TrustZone-aware slave (secure)</td>
<td>Per-access</td>
<td>OK</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Non-TrustZone-aware slave (non-secure)</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Non-TrustZone-aware memory (secure region)</td>
<td>Per-access</td>
<td>OK</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Non-TrustZone-aware memory (non-secure region)</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

#### Related Information

- [Error Response Slave](#) on page 643
- [Designating a Default Slave in the System Contents Tab](#) on page 648
1.11.3. Access Undefined Memory Regions

When a transaction from a master targets a memory region that is not specified in the slave memory map, it is known as an access to an undefined memory region. To ensure predictable response behavior when this occurs, you must add a default slave to your design. Platform Designer then routes undefined memory region accesses to the default slave, which terminates the transaction with an error response.

You can designate any memory-mapped slave as a default slave. Intel recommends that you have only one default slave for each interconnect domain in your system. Accessing undefined memory regions can occur in the following cases:

- When there are gaps within the accessible memory map region that are within the addressable range of slaves, but are not mapped.
- Accesses by a master to a region that does not belong to any slaves that is mapped to the master.
- When a non-secured transaction is accessing a secured slave. This applies to only slaves that are secured at compilation time.
- When a read-only slave is accessed with a write command, or a write-only slave is accessed with a read command.

To designate a slave as the default slave, for the selected component, turn on Default Slave in the Systems Content tab.

Note: If you do not specify the default slave, Platform Designer automatically assigns the slave at the lowest address within the memory map for the master that issues the request as the default slave.

1.12. Integrating a Platform Designer System with a Intel Quartus Prime Project

The Intel Quartus Prime software tightly links with Platform Designer system creation. Platform Designer requires you to specify a Intel Quartus Prime project at time of system creation. The Intel Quartus Prime software automatically adds all .qsys and all .ip files for the associated Platform Designer system to your Intel Quartus Prime project. When you open your Intel Quartus Prime project, the project automatically lists all the files related to the Platform Designer system.

Figure 41. Platform Designer System Files in Intel Quartus Prime Project
### 1.13. Manage IP Settings in the Intel Quartus Prime Software

To specify the following IP Settings in the Intel Quartus Prime software, click **Tools ➤ Option ➤ IP Settings**:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Platform Designer memory usage</td>
<td>Allows you to increase memory usage for Platform Designer if you experience slow processing for large systems, or if Platform Designer reports an <em>Out of Memory</em> error.</td>
</tr>
<tr>
<td>IP generation HDL preference</td>
<td>The Intel Quartus Prime software uses this setting when the <em>.qsys</em> file appears in the <em>Files</em> list for the current project in the <em>Settings</em> dialog box and you run Analysis &amp; Synthesis. Platform Designer uses this setting when you generate HDL files.</td>
</tr>
<tr>
<td>IP Catalog Search Locations</td>
<td>The Intel Quartus Prime software uses the settings that you specify for global and project search paths under <em>IP Search Locations</em>, to populate the Intel Quartus Prime software IP Catalog. Platform Designer uses the settings that you specify for global search paths under <em>IP Search Locations</em> to populate the Platform Designer IP Catalog when you open Platform Designer from within the Intel Quartus Prime software (<em>Tools ➤ Options</em>). Platform Designer uses the project search path settings to populate the Platform Designer IP Catalog when you open Platform Designer from the command-line.</td>
</tr>
</tbody>
</table>

**Note:** You can also access **IP Settings** by clicking **Assignments ➤ Settings ➤ IP Settings**. This access is available only when you have a Intel Quartus Prime project open. This allows you access to **IP Settings** when you want to create IP cores independent of a Intel Quartus Prime project. Settings that you apply or create in either location are shared.

#### 1.13.1. Opening Platform Designer with Additional Memory

If your Platform Designer system requires more than the 512 megabytes of default memory, you can increase the amount of memory either in the Intel Quartus Prime software *Options* dialog box, or at the command-line.

- When you open Platform Designer from within the Intel Quartus Prime software, you can increase memory for your Platform Designer system, by clicking **Tools ➤ Options ➤ IP Settings**, and then selecting the appropriate amount of memory with the **Maximum Platform Designer memory usage** option.
- When you open Platform Designer from the command-line, you can add an option to increase the memory. For example, the following `qsys-edit` command allows you to open Platform Designer with 1 gigabytes of memory.

```
qsys-edit --jvm-max-heap-size=1g
```

### 1.14. Generate a Platform Designer System

In Platform Designer, you can choose options for generation of synthesis, simulation and testbench files for your Platform Designer system.
Platform Designer system generation creates the interconnect between IP components and generates synthesis and simulation HDL files. You can generate a testbench system that adds Bus Functional Models (BFMs) that interact with your system in a simulator.

When you make changes to a system, Platform Designer gives you the option to exit without generating. If you choose to generate your system before you exit, the Generation dialog box opens and allows you to select generation options.

The Generate HDL button in the lower-right of the Platform Designer window allows you to quickly generate synthesis and simulation files for your system.

*Note:* If you cannot find the memory interface generated by Platform Designer when you use EMIF (External Memory Interface Debug Toolkit), verify that the .sopcinfo file appears in your Platform Designer project folder.

**Figure 42. Generating IP-XACT file for the system**

![Generating IP-XACT file](image)

**Related Information**
- Avalon Verification IP Suite User Guide
- Mentor Verification IP (VIP) Altera Edition (AE)
- External Memory Interface Debug Toolkit

**1.14.1. Set the Generation ID**

The Generation ID parameter is a unique integer value that is set to a timestamp during Platform Designer system generation. System tools, such as Nios® II or HPS (Hard Processor System) use the Generation ID to ensure software-build compatibility with your Platform Designer system.

To set the Generation ID parameter, select the top-level system in the Hierarchy tab, and then locating the parameter in the open Parameters tab.
1.14.2. Generate Files for Synthesis and Simulation

Platform Designer generates files for synthesis in Intel Quartus Prime software and simulation in a third-party simulator.

In Platform Designer, you can generate simulation HDL files (Generate ➤ Generate HDL), which can include simulation-only features targeted towards your simulator. You can generate simulation files as Verilog or VHDL.

**Note:** For a list of Intel-supported simulators, refer to *Simulating Intel Designs*.

Platform Designer supports standard and legacy device generation. Standard device generation refers to generating files for the Intel Arria® 10 and later device families. Legacy device generation refers to generating files for device families prior to the release of the Intel Arria 10 device family, including MAX 10 devices.

The **Output Directory** option applies to both synthesis and simulation generation. By default, the path of the generation output directory is fixed relative to the .qsys file. You can change the default directory in the **Generation** dialog box for legacy devices. For standard devices, the generation directory is fixed to the Platform Designer project directory.

**Note:** If you need to change top-level I/O pin or instance names, create a top-level HDL file that instantiates the Platform Designer system. The Platform Designer-generated output is then instantiated in your design without changes to the Platform Designer-generated output files.

The following options in the **Generation** dialog box (Generate ➤ Generate HDL) allow you to generate synthesis and simulation files:

<table>
<thead>
<tr>
<th>Table 21. Generation Dialog Box Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>Create HDL design files for synthesis</td>
</tr>
<tr>
<td>Create timing and resource estimates for third-party EDA synthesis tools</td>
</tr>
<tr>
<td>Create Block Symbol File (.bsf)</td>
</tr>
<tr>
<td>IP-XACT</td>
</tr>
<tr>
<td>Create simulation model</td>
</tr>
<tr>
<td>Clear output directories for selected generation targets</td>
</tr>
</tbody>
</table>

**Note:** ModelSim* - Intel FPGA Edition now supports native mixed-language (VHDL/Verilog/SystemVerilog) simulation. Therefore, Intel simulation libraries may not be compatible with single language simulators. If you have a VHDL-only license, some versions of Mentor simulators may not be able to simulate IP written in Verilog. As a workaround, you can use ModelSim - Intel FPGA Edition, or purchase a mixed language simulation license from Mentor.
1.14.2.1. Files Generated for Intel FPGA IP Cores and Platform Designer Systems

The Intel Quartus Prime Pro Edition software generates the following output file structure for IP cores and Platform Designer systems. The Intel Quartus Prime Pro Edition Platform Designer software automatically adds the generated .ip and .qsys files to your Intel Quartus Prime project.

**Figure 43. Files generated for IP cores and Platform Designer Systems**

- `<Project Directory>`
  - `<your_system>.qsys` - System File
  - `<your_subsystem>.qsys` - Subsystem File
- `<your_system_directory>`
  - `<your_ip>.bsf` - Block symbol schematic file
  - `<your_ip>.cmp` - VHDL component declaration
  - `<your_ip>.debuginfo` - Post-generation debug data
  - `<your_ip>.html` - Memory map data
  - `<your_ip>.ppf` - XML I/O pin information file
  - `<your_ip>.qip` - Lists files for IP core synthesis
  - `<your_ip>.sip` - NativeLink simulation integration file
  - `<your_ip>_inst.v or .vhd` - Lists file for IP core synthesis
- `<your_ip>_generation.rpt` - IP generation report
- `<your_system>.qsys` - System File
- `<your_subsystem>.qsys` - Subsystem File
- `<your_system_directory>`
  - `<your_ip>.ipxact` - IP XACT File
  - `<your_ip>.qgsimc` - Simulation caching file
  - `<your_ip>.qgsynthc` - Synthesis caching file
- `<sim> - IP simulation files`
  - `<your_ip>.v or .vhd` - Top-level simulation file
  - `<simulator vendor>` - Simulator setup scripts
  - `<common> - IP simulation script files`
    - `<simulator vendor>_<files.tcl`
- `<synth> - IP synthesis files`
  - `<your_ip>.v or .vhd` - Top-level IP synthesis file
- `<ip> - IP files`
  - `<your_system>` - Your system directory
  - `<your_system>.ip` - Parameter file for system IP component
  - `<your_subsystem>` - Your Subsystem directory
  - `<your_subsystem>.ip` - Parameter file for subsystem IP component
### Table 22. IP Core and Platform Designer Simulation Files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;my_system&gt;.qsys</code></td>
<td>The Platform Designer system.</td>
</tr>
<tr>
<td><code>&lt;my_subsystem&gt;.qsys</code></td>
<td>The Platform Designer subsystem.</td>
</tr>
<tr>
<td><code>ip/</code></td>
<td>Contains the parameter files for the IP components in the system and subsystems.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.cmp</code></td>
<td>The VHDL Component Declaration (.cmp) file is a text file that contains local generic and port definitions that you can use in VHDL design files.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;_generation.rpt</code></td>
<td>IP or Platform Designer generation log file. A summary of the messages during IP generation.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.qgsimc</code></td>
<td>Simulation caching file that compares the .qsys and .ip files with the current parameterization of the Platform Designer system and IP core. This comparison determines if Platform Designer can skip regeneration of the HDL.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.qgsynth</code></td>
<td>Synthesis caching file that compares the .qsys and .ip files with the current parameterization of the Platform Designer system and IP core. This comparison determines if Platform Designer can skip regeneration of the HDL.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.qip</code></td>
<td>Contains all the required information about the IP component to integrate and compile the IP component in the Intel Quartus Prime software.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.csv</code></td>
<td>Contains information about the upgrade status of the IP component.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.bsf</code></td>
<td>A Block Symbol File (.bsf) representation of the IP variation for use in Block Diagram Files (.bdf).</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.spd</code></td>
<td>Required input file for ip-make-simscript to generate simulation scripts for supported simulators. The .spd file contains a list of files generated for simulation, along with information about memories that you can initialize.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.ppf</code></td>
<td>The Pin Planner File (.ppf) stores the port and node assignments for IP components created for use with the Pin Planner.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;_bb.v</code></td>
<td>Use the Verilog black box (_bb.v) file as an empty module declaration for use as a black box.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.sip</code></td>
<td>Contains information required for NativeLink simulation of IP components. Add the .sip file to your Intel Quartus Prime Standard Edition project to enable NativeLink for supported devices. The Intel Quartus Prime Pro Edition software does not support NativeLink simulation.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;_inst.v</code> or <code>_inst.vhd</code></td>
<td>HDL example instantiation template. Copy and paste the contents of this file into your HDL file to instantiate the IP variation.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.regmap</code></td>
<td>If the IP contains register information, the Intel Quartus Prime software generates the .regmap file. The .regmap file describes the register map information of master and slave interfaces. This file complements the .sopcinfo file by providing more detailed register information about the system. This file enables register display views and user customizable statistics in System Console.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.svd</code></td>
<td>Allows HPS System Debug tools to view the register maps of peripherals connected to HPS within a Platform Designer system. During synthesis, the Intel Quartus Prime software stores the .svd files for slave interface visible to the System Console masters in the .sof file in the debug session. System Console reads this section, which Platform Designer can query for register map information. For system slaves, Platform Designer can access the registers by name.</td>
</tr>
<tr>
<td><code>&lt;my_ip&gt;.v</code> <code>&lt;my_ip&gt;.vhd</code></td>
<td>HDL files that instantiate each submodule or child IP core for synthesis or simulation.</td>
</tr>
<tr>
<td><code>mentor/</code></td>
<td>Contains a ModelSim script msim_setup.tcl to set up and run a simulation.</td>
</tr>
</tbody>
</table>

*continued...*
### File Name Description

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aldec/</td>
<td>Contains a Riviera-PRO script rivierapro_setup.tcl to setup and run a simulation.</td>
</tr>
<tr>
<td>/synopsys/vcs</td>
<td>Contains a shell script vcs_setup.sh to set up and run a VCS® simulation.</td>
</tr>
<tr>
<td>/synopsys/vcsmx</td>
<td>Contains a shell script vcsmx_setup.sh and synopsys_sim.setup file to set up and run a VCS MX® simulation.</td>
</tr>
<tr>
<td>/cadence</td>
<td>Contains a shell script ncsim_setup.sh and other setup files to set up and run an NCSIM simulation.</td>
</tr>
<tr>
<td>/xcelium</td>
<td>Contains a shell script xcelium_setup.sh and other setup files to set up and run a Xcelium simulation.</td>
</tr>
<tr>
<td>/common</td>
<td>Contains a set of Tcl files, &lt;simulator&gt;_files.tcl, which provide all design related simulation information required by a corresponding simulation script. The Tcl file contains designs from current system-level hierarchy, and references to sub-systems and IP components.</td>
</tr>
<tr>
<td>/submodules</td>
<td>Contains HDL files for the IP core submodule.</td>
</tr>
<tr>
<td>&lt;IP submodule&gt;/</td>
<td>For each generated IP submodule directory, Platform Designer generates /synth and /sim sub-directories.</td>
</tr>
</tbody>
</table>

### 1.14.3. Generate Files for a Testbench Platform Designer System

Platform Designer testbench is a new system that instantiates the current Platform Designer system by adding BFMs to drive the top-level interfaces. BFMs interact with the system in the simulator. You can use options in the **Generation** dialog box (**Generate ➤ Generate Testbench System**) to generate a testbench Platform Designer system.

You can generate a standard or simple testbench system with BFM or Mentor Verification IP (for AMBA 3 AXI or AMBA 3 AXI) IP components that drive the external interfaces of your system. Platform Designer generates a Verilog HDL or VHDL simulation model for the testbench system to use in your simulation tool. You should first generate a testbench system, and then modify the testbench system in Platform Designer before generating its simulation model. In most cases, you should select only one of the simulation model options.

By default, the path of the generation output directory is fixed relative to the `.qsys` file. You can change the default directory in the **Generation** dialog box for legacy devices. For standard devices, the generation directory is fixed to the Platform Designer project directory.
The following options are available for generating a Platform Designer testbench system:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create testbench Platform Designer system | • **Standard, BFMs for standard Platform Designer Interconnect**  
  — Creates a testbench Platform Designer system with BFM IP components attached to exported Avalon and AMBA 3 AXI or AMBA 3 AXI interfaces. Includes any simulation partner modules specified by IP components in the system. The testbench generator supports AXI interfaces and can connect AMBA 3 AXI or AMBA 3 AXI interfaces to Mentor Graphics AMBA 3 AXI or AMBA 3 AXI master/slave BFMs. However, BFMs support address widths only up to 32-bits.  
  • **Simple, BFMs for clocks and resets**  
  — Creates a testbench Platform Designer system with BFM IP components driving only clock and reset interfaces. Includes any simulation partner modules specified by IP components in the system. |
| Create testbench simulation model      | Creates Verilog HDL or VHDL simulation model files and simulation scripts for the testbench Platform Designer system currently open in your workspace. Use this option if you do not need to modify the Platform Designer-generated testbench before running the simulation. |

**Note:** ModelSim - Intel FPGA Edition now supports native mixed-language (VHDL/Verilog/SystemVerilog) simulation. Therefore, Intel simulation libraries may not be compatible with single language simulators. If you have a VHDL-only license, some versions of Mentor simulators may not be able to simulate IP written in Verilog. As a workaround, you can use ModelSim - Intel FPGA Edition, or purchase a mixed language simulation license from Mentor.

### 1.14.3.1. Files Generated for Platform Designer Testbench

**Table 23. Platform Designer-Generated Testbench Files**

<table>
<thead>
<tr>
<th>File Name or Directory Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;system&gt;_tb.qsys</td>
<td>The Platform Designer testbench system.</td>
</tr>
<tr>
<td>&lt;system&gt;_tb.v or &lt;system&gt;_tb.vhd</td>
<td>The top-level testbench file that connects BFMs to the top-level interfaces of &lt;system&gt;_tb.qsys.</td>
</tr>
</tbody>
</table>
| <system>_tb.spd             | Required input file for ip-make-simscript to generate simulation scripts for supported simulators.  
  The .spd file contains a list of files generated for simulation and information about memory that you can initialize. |
| <system>.html and <system>_tb.html | A system report that contains connection information, a memory map showing the address of each slave with respect to each master to which it is connected, and parameter assignments. |
| <system>_generation.rpt     | Platform Designer generation log file. A summary of the messages that Platform Designer issues during testbench system generation.               |
| <system>.ipx                | The IP Index File (.ipx) lists the available IP components, or a reference to other directories to search for IP components.                 |
| <system>.svd                | Allows HPS System Debug tools to view the register maps of peripherals connected to HPS within a Platform Designer system.  
  Similarly, during synthesis the .svd files for slave interfaces visible to System Console masters are stored in the .sof file in the debug section. System Console reads this section, which Platform Designer can query for register map information. For system slaves, Platform Designer can access the registers by name. |
<p>| mentor/                    | Contains a ModelSim script msim_setup.tcl to set up and run a simulation.                                                                       |</p>
<table>
<thead>
<tr>
<th>File Name or Directory Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aldec/</td>
<td>Contains a Riviera-PRO script <code>rivierapro_setup.tcl</code> to setup and run a simulation.</td>
</tr>
<tr>
<td>/synopsys/vcs</td>
<td>Contains a shell script <code>vcs_setup.sh</code> to set up and run a VCS simulation.</td>
</tr>
<tr>
<td>/synopsys/vcsmx</td>
<td>Contains a shell script <code>vcsmx_setup.sh</code> and <code>synopsys_sim.setup</code> file to set up and run a VCS MX® simulation.</td>
</tr>
<tr>
<td>/cadence</td>
<td>Contains a shell script <code>ncsim_setup.sh</code> and other setup files to set up and run an NCSIM simulation.</td>
</tr>
<tr>
<td>/xcelium</td>
<td>Contains a shell script <code>xcelium_setup.sh</code> and other setup files to set up and run a Xcelium simulation.</td>
</tr>
<tr>
<td>/common</td>
<td>Contains a set of Tcl files, <code>&lt;simulator&gt;_files.tcl</code>, which provide all design related simulation information required by a corresponding simulation script. The Tcl file contains designs from current system-level hierarchy, and references to sub-systems and IP components.</td>
</tr>
<tr>
<td>/submodules</td>
<td>Contains HDL files for the submodule of the Platform Designer testbench system.</td>
</tr>
<tr>
<td><code>&lt;child IP cores&gt;/</code></td>
<td>For each generated child IP core directory, Platform Designer testbench generates /synth and /sim subdirectories.</td>
</tr>
</tbody>
</table>

### 1.14.3.2. Platform Designer Testbench Simulation Output Directories

The `/sim` and `/simulation` directories contain the Platform Designer-generated output files to simulate your Platform Designer testbench system.
1.14.3.3. Generate and Modify a Platform Designer Testbench System

You can use the following steps to create a Platform Designer testbench system of your Platform Designer system.
1. Create a Platform Designer system.
2. Generate a testbench system in the Platform Designer **Generation** dialog box (Generate ➤ Generate Testbench System).
3. Open the testbench system in Platform Designer. Make changes to the BFMs, as needed, such as changing the instance names and **VHDL ID** value. For example, you can modify the **VHDL ID** value in the **Altera Avalon Interrupt Source** IP component.
4. If you modify a BFM, regenerate the simulation model for the testbench system.
5. Create a custom test program for the BFMs.
6. Compile and load the Platform Designer system and testbench into your simulator, and then run the simulation.

### 1.14.4. Platform Designer Simulation Scripts

Platform Designer generates simulation scripts to set up the simulation environment for Mentor Graphics ModelSim®, Questasim®, Synopsys VCS and VCS MX, Cadence Incisive Enterprise Simulator® (NCSIM) and Xcelium™ Parallel Simulator and the Aldec Riviera-PRO® Simulator.

Platform Designer generates simulation scripts for all .ip and .qsys files of a system and places the files in the simulation script output folder (<top-level system name>/sim/<simulator name>).

Platform Designer always generates the simulation scripts from the currently loaded system down. You can open a subsystem and choose to generate a simulation script just for that subsystem.

You can use scripts to compile the required device libraries and system design files in the correct order and elaborate or load the top-level system for simulation.

### Table 24. Simulation Script Variables

The simulation scripts provide variables that allow flexibility in your simulation environment.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOP_LEVEL_NAME</td>
<td>If the testbench Platform Designer system is not the top-level instance in your simulation environment because you instantiate the Platform Designer testbench within your own top-level simulation file, set the <strong>TOP_LEVEL_NAME</strong> variable to the top-level hierarchy name.</td>
</tr>
<tr>
<td>QSYS_SIMDIR</td>
<td>If the simulation files generated by Platform Designer are not in the simulation working directory, use the <strong>QSYS_SIMDIR</strong> variable to specify the directory location of the Platform Designer simulation files.</td>
</tr>
<tr>
<td>QUARTUS_INSTALL_DIR</td>
<td>Points to the Quartus installation directory that contains the device family library.</td>
</tr>
</tbody>
</table>

### Example 3. Top-Level Simulation HDL File for a Testbench System

The example below shows the **pattern_generator_tb** generated for a Platform Designer system called **pattern_generator**. The **top.sv** file defines the top-level module that instantiates the **pattern_generator_tb** simulation model, as well as a custom SystemVerilog test program with BFM transactions, called **test_program**.

```verilog
module top();
pattern_generator_tb tb();
test_program pgm();
endmodule
```
Note: The VHDL version of the Altera Tristate Conduit BFM is not supported in Synopsys VCS, NCSim, and Riviera-PRO in the Intel Quartus Prime software version 14.0. These simulators do not support the VHDL protected type, which is used to implement the BFM. For a workaround, use a simulator that supports the VHDL protected type.

Note: ModelSim - Intel FPGA Edition now supports native mixed-language (VHDL/Verilog/SystemVerilog) simulation. Therefore, Intel simulation libraries may not be compatible with single language simulators. If you have a VHDL-only license, some versions of Mentor simulators may not be able to simulate IP written in Verilog. As a workaround, you can use ModelSim - Intel FPGA Edition, or purchase a mixed language simulation license from Mentor.

Related Information
Incorporating IP Simulation Scripts in Top-Level Scripts


You can run the Generate Simulator Setup Script for IP command to generate a combined simulator setup script.

Note: This feature is available in the Intel Quartus Prime Pro Edition software for all devices. This feature is available in the Intel Quartus Prime Standard Edition software for only Intel Arria 10 devices.

Source this combined script from a top-level simulation script. Click Tools ➤ Generate Simulator Setup Script for IP (or use of the ip-setup-simulation utility at the command-line) to generate or update the combined scripts, after any of the following occur:
- IP core initial generation or regeneration with new parameters
- Intel Quartus Prime software version upgrade
- IP core version upgrade

To generate a combined simulator setup script for all project IP cores for each simulator:

1. Generate, regenerate, or upgrade one or more IP core. Refer to Generating IP Cores or Upgrading IP Cores.

2. Click Tools ➤ Generate Simulator Setup Script for IP (or run the ip-setup-simulation utility). Specify the Output Directory and library compilation options. Click OK to generate the file. By default, the files generate into the /<project directory>/<simulator>/ directory using relative paths.

3. To incorporate the generated simulator setup script into your top-level simulation script, refer to the template section in the generated simulator setup script as a guide to creating a top-level script:
   a. Copy the specified template sections from the simulator-specific generated scripts and paste them into a new top-level file.
   b. Remove the comments at the beginning of each line from the copied template sections.
   c. Specify the customizations you require to match your design simulation requirements, for example:
• Specify the \texttt{TOP\_LEVEL\_NAME} variable to the design’s simulation top-level file. The top-level entity of your simulation is often a testbench that instantiates your design. Then, your design instantiates IP cores or Platform Designer systems. Set the value of \texttt{TOP\_LEVEL\_NAME} to the top-level entity.

• If necessary, set the \texttt{QSYS\_SIMDIR} variable to point to the location of the generated IP simulation files.

• Compile the top-level HDL file (for example, a test program) and all other files in the design.

• Specify any other changes, such as using the \texttt{grep} command-line utility to search a transcript file for error signatures, or e-mail a report.

4. Re-run \texttt{Tools} \textgreater{} \texttt{Generate Simulator Setup Script for IP} (or \texttt{ip\_setup\_simulation}) after regeneration of an IP variation.

<table>
<thead>
<tr>
<th>Table 25. Simulation Script Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utility</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>\texttt{ip_setup_simulation} generates a combined, version-independent simulation script for all Intel FPGA IP cores in your project. The command also automates regeneration of the script after upgrading software or IP versions. Use the \texttt{compile-to-work} option to compile all simulation files into a single work library if your simulation environment requires. Use the \texttt{--use-relative-paths} option to use relative paths whenever possible.</td>
</tr>
<tr>
<td>\texttt{ip_make_simscript} generates a combined simulation script for all IP cores and subsystems that you specify on the command line.</td>
</tr>
<tr>
<td>\texttt{ip_make_simscript} generates a combined simulation script for all IP cores that you specify on the command line. Specify one or more \texttt{.spd} files and an output directory in the command. Running the script compiles IP simulation models into various simulation libraries.</td>
</tr>
</tbody>
</table>

The following sections provide step-by-step instructions for sourcing each simulator setup script in your top-level simulation script.

### 1.14.5. Simulating Software Running on a Nios II Processor

To simulate the software in a system driven by a Nios II processor, generate the simulation model for the Platform Designer testbench system with the following steps:

1. In the \texttt{Generation} dialog box (\texttt{Generate} \textgreater{} \texttt{Generate Testbench System}), select \texttt{Simple}, \texttt{BFMs for clocks and resets}.

2. For the \texttt{Create testbench simulation model} option select \texttt{Verilog} or \texttt{VHDL}.

3. Click \texttt{Generate}.

4. Open the \texttt{Nios II Software Build Tools for Eclipse}.

5. Set up an application project and board support package (BSP) for the \texttt{<system>.sopcinfo} file.
6. To simulate, right-click the application project in Eclipse, and then click **Run as ➤ Nios II ModelSim**.
   Sets up the ModelSim simulation environment, and compiles and loads the Nios II software simulation.

7. To run the simulation in ModelSim, type `run -all` in the ModelSim transcript window.

8. Set the ModelSim settings and select the Platform Designer Testbench Simulation Package Descriptor (.spd) file, `<system>_tb.spd`. The .spd file is generated with the testbench simulation model for Nios II designs and specifies the files required for Nios II simulation.

**Related Information**

- **Getting Started with the Graphical User Interface**
  In *Nios II Gen2 Software Developer’s Handbook*

- **Getting Started from the Command Line**
  In *Nios II Gen2 Software Developer’s Handbook*

### 1.14.6. Add Assertion Monitors for Simulation

You can add monitors to Avalon-MM, AXI, and Avalon-ST interfaces in your system to verify protocol and test coverage with a simulator that supports SystemVerilog assertions.

**Note:** ModelSim - Intel FPGA Edition does not support SystemVerilog assertions. If you want to use assertion monitors, you must use a supported third-party simulators such as Mentor Questasim, Synopsys VCS, or Cadence Incisive. For more information, refer to *Introduction to Intel FPGA IP Cores*.

**Figure 45. Inserting an Avalon-MM Monitor Between an Avalon-MM Master and Slave Interface**

This example demonstrates the use of a monitor with an Avalon-MM monitor between the `pcie_compiler_bar1_0_Prefetchable Avalon-MM master interface, and the dma_0 control_port_slave Avalon-MM slave interface.**

Similarly, you can insert an Avalon-ST monitor between Avalon-ST source and sink interfaces.
1.14.7. CMSIS Support for the HPS IP Component

Platform Designer systems that contain an HPS IP component generate a System View Description (.svd) file that lists peripherals connected to the ARM processor.

The .svd (or CMSIS-SVD) file format is an XML schema specified as part of the Cortex Microcontroller Software Interface Standard (CMSIS) provided by ARM. The .svd file allows HPS system debug tools (such as the DS-5 Debugger) to view the register maps of peripherals connected to HPS in a Platform Designer system.

1.14.8. Generate Header Files

You can use the sopc-create-header-files command from the Nios II command shell to create header files for any master component in your Platform Designer system. The Nios II tool chain uses this command to create the processor's system.h file. You can also use this command to generate system level information for a hard processing system (HPS) in Intel's SoC devices or other external processors. The header file includes address map information for each slave, relative to each master that accesses the slave. Different masters may have different address maps to access a particular slave component. By default, the header files are in C format and have a .h suffix. You can select other formats with appropriate command-line options.

Table 26. sopc-create-header-files Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;sopc&gt;</td>
<td>Path to Platform Designer .sopcinfo file, or the file directory. If you omit this option, the path defaults to the current directory. If you specify a directory path, you must make sure that there is a .sopcinfo file in the directory.</td>
</tr>
<tr>
<td>--separate-masters</td>
<td>Does not combine a module's masters that are in the same address space.</td>
</tr>
<tr>
<td>--output-dir[=&lt;dirname&gt;]</td>
<td>Allows you to specify multiple header files in dirname. The default output directory is '.'.</td>
</tr>
<tr>
<td>--single[=&lt;filename&gt;]</td>
<td>Allows you to create a single header file, filename.</td>
</tr>
<tr>
<td>--single-pref[=&lt;prefix&gt;]</td>
<td>Prefixes macros from a selected single master.</td>
</tr>
<tr>
<td>--module[=&lt;moduleName&gt;]</td>
<td>Specifies the module name when creating a single header file.</td>
</tr>
<tr>
<td>--master[=&lt;masterName&gt;]</td>
<td>Specifies the master name when creating a single header file.</td>
</tr>
<tr>
<td>--format[=&lt;type&gt;]</td>
<td>Specifies the header file format. Default file format is .h.</td>
</tr>
<tr>
<td>--silent</td>
<td>Does not display normal messages.</td>
</tr>
<tr>
<td>--help</td>
<td>Displays help for sopc-create-header-files.</td>
</tr>
</tbody>
</table>
By default, the `sopc-create-header-files` command creates multiple header files. There is one header file for the entire system, and one header file for each master group in each module. A master group is a set of masters in a module in the same address space. In general, a module may have multiple master groups. Addresses and available devices are a function of the master group.

Alternatively, you can use the `--single` option to create one header file for one master group. If there is one CPU module in the Platform Designer system with one master group, the command generates a header file for that CPU’s master group. If there are no CPU modules, but there is one module with one master group, the command generates the header file for that module’s master group.

You can use the `--module` and `--master` options to override these defaults. If your module has multiple master groups, use the `--master` option to specify the name of a master in the desired master group.

**Table 27. Supported Header File Formats**

<table>
<thead>
<tr>
<th>Type</th>
<th>Suffix</th>
<th>Uses</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>h</td>
<td>.h</td>
<td>C/C++ header files</td>
<td>#define FOO 12</td>
</tr>
<tr>
<td>m4</td>
<td>.m4</td>
<td>Macro files for m4</td>
<td>m4_define(&quot;FOO&quot;, 12)</td>
</tr>
<tr>
<td>sh</td>
<td>.sh</td>
<td>Shell scripts</td>
<td>FOO=12</td>
</tr>
<tr>
<td>mk</td>
<td>.mk</td>
<td>Makefiles</td>
<td>FOO := 12</td>
</tr>
<tr>
<td>pm</td>
<td>.pm</td>
<td>Perl scripts</td>
<td>$macros(FOO) = 12;</td>
</tr>
</tbody>
</table>

**Note:** You can use the `sopc-create-header-files` command when you want to generate C macro files for DMAs that have access to memory that the Nios II does not have access to.

### 1.14.9. Incrementally Generate the System

You can modify the parameters of an IP component and regenerate the RTL for just that particular IP component.

The example below demonstrates the incremental generation flow of a Platform Designer System:

1. In Platform Designer, click **File ➤ New System**. The **Create New System** dialog box appears, from which you create your new Platform Designer system and associate your system with a specific Intel Quartus Prime project.
2. In the IP Catalog search box, locate the **On-Chip Memory (RAM or ROM)** and double-click to add the component to your system.
3. Similarly, locate the **Reset Bridge** and **Clock Bridge** components and double-click to add the components to your system.
4. Make the necessary system connections between the IP components added to the system.

   **Note:** For more information about connecting IP components, refer to **Connecting IP Components**.
5. To save and close the system without generating, click **File ➤ Save**.

6. In the Intel Quartus Prime software, click **File ➤ Open Project**.

7. Select the Intel Quartus Prime project associated with your saved Platform Designer system. The Intel Quartus Prime software opens the project and the associated Platform Designer system.

8. To start the compilation of the Intel Quartus Prime project, click **Processing ➤ Start Compilation**.

9. To open the Status window, click **View ➤ Status**. From this window, track the time for Full Compilation, as well as IP components Generation.

10. Once the compilation finishes, in Platform Designer, click **File ➤ Open**.

11. Select the `.ip` file for any one of the IP components in your saved system.

12. Modify some parameter in this `.ip` file.

   **Note:** Make sure your modifications do not affect the parent system, requiring a system update by running **Validate System Integrity** from within the Platform Designer system after loading the parent system, or by running `qsys-validate` from the command-line.

13. To save the IP file, click **File ➤ Save**.

14. To restart the compilation of the same Intel Quartus Prime project with modified Platform Designer system, click **Processing ➤ Start Compilation** in the Intel Quartus Prime software. Platform Designer generates the RTL only for the modified IP component, skipping the generation of the other components in the system.

**Figure 46. Incremental Generation of Platform Designer System**

<table>
<thead>
<tr>
<th>Status</th>
<th>Module</th>
<th>Progress</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Generation Tool</td>
<td>100%</td>
<td>00:00:45</td>
<td></td>
</tr>
<tr>
<td>Analyzer &amp; Synthesis</td>
<td>100%</td>
<td>00:09:11</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>100%</td>
<td>00:03:19</td>
<td></td>
</tr>
<tr>
<td>Assembler</td>
<td>100%</td>
<td>00:00:39</td>
<td></td>
</tr>
<tr>
<td>TimeQuest Timing Analyzer</td>
<td>100%</td>
<td>00:00:35</td>
<td></td>
</tr>
</tbody>
</table>

**Related Information**

Connect IP Components in Your Platform Designer System on page 21

### 1.15. Explore and Manage Platform Designer Interconnect

The System with Platform Designer Interconnect window allows you to see the contents of the Platform Designer interconnect before you generate your system. In this display of your system, you can review a graphical representation of the generated interconnect. Platform Designer converts connections between interfaces to interconnect logic during system generation.
You access the System with Platform Designer Interconnect window by clicking Show System With Platform Designer Interconnect command on the System menu.

The System with Platform Designer Interconnect window has the following tabs:

- **System Contents**—Displays the original instances in your system, as well as the inserted interconnect instances. Connections between interfaces are replaced by connections to interconnect where applicable.
- **Hierarchy**—Displays a system hierarchical navigator, expanding the system contents to show modules, interfaces, signals, contents of subsystems, and connections.
- **Parameters**—Displays the parameters for the selected element in the Hierarchy tab.
- **Memory-Mapped Interconnect**—Allows you to select a memory-mapped interconnect module and view its internal command and response networks. You can also insert pipeline stages to achieve timing closure.

The **System Contents**, **Hierarchy**, and **Parameters** tabs are read-only. Edits that you apply on the **Memory-Mapped Interconnect** tab are automatically reflected on the **Interconnect Requirements** tab.

The **Memory-Mapped Interconnect** tab in the System with Platform Designer Interconnect window displays a graphical representation of command and response datapaths in your system. Datapaths allow you precise control over pipelining in the interconnect. Platform Designer displays separate figures for the command and response datapaths. You can access the datapaths by clicking their respective tabs in the **Memory-Mapped Interconnect** tab.

Each node element in a figure represents either a master or slave that communicates over the interconnect, or an interconnect sub-module. Each edge is an abstraction of connectivity between elements, and its direction represents the flow of the commands or responses.

Click Highlight Mode (Path, Successors, Predecessors) to identify edges and datapaths between modules. Turn on Show Pipelinable Locations to add greyed-out registers on edges where pipelining is allowed in the interconnect.

**Note:** You must select more than one module to highlight a path.

### 1.15.1. Manually Control Pipelining in the Platform Designer Interconnect

The **Memory-Mapped Interconnect** tab allows you to manipulate pipeline connections in the Platform Designer interconnect. Access the **Memory-Mapped Interconnect** tab by clicking System ➤ Show System With Platform Designer Interconnect

**Note:** To increase interconnect frequency, you should first try increasing the value of the Limit interconnect pipeline stages to option on the Interconnect Requirements tab. You should only consider manually pipelining the interconnect if changes to this option do not improve frequency, and you have tried all other options to achieve timing closure, including the use of a bridge. Manually pipelining the interconnect should only be applied to complete systems.
1. In the **Interconnect Requirements** tab, first try increasing the value of the **Limit interconnect pipeline stages to** option until it no longer gives significant improvements in frequency, or until it causes unacceptable effects on other parts of the system.

2. In the Intel Quartus Prime software, compile your design and run timing analysis.

3. Using the timing report, identify the critical path through the interconnect and determine the approximate mid-point. The following is an example of a timing report:

   ```plaintext
   2.800 0.000 cpu_instruction_master|out_shifter[63]|q
   3.004 0.204 mm_domain_0|addr_router_001|Equal15-0|datab
   3.246 0.242 mm_domain_0|addr_router_001|Equal15-0|combout
   3.346 0.100 mm_domain_0|addr_router_001|Equal15-1|databa
   3.685 0.339 mm_domain_0|addr_router_001|Equal15-1|combout
   4.153 0.468 mm_domain_0|addr_router_001|src_channel[5]-0|datab
   4.373 0.220 mm_domain_0|addr_router_001|src_channel[5]-0|combout
   ```

4. In Platform Designer, click **System ➤ Show System With Platform Designer Interconnect**.

5. In the **Memory-Mapped Interconnect** tab, select the interconnect module that contains the critical path. You can determine the name of the module from the hierarchical node names in the timing report.

6. Click **Show Pipelinable Locations**. Platform Designer display all possible pipeline locations in the interconnect. Right-click the possible pipeline location to insert or remove a pipeline stage.

7. Locate the possible pipeline location that is closest to the mid-point of the critical path. The names of the blocks in the memory-mapped interconnect tab correspond to the module instance names in the timing report.

8. Right-click the location where you want to insert a pipeline, and then click **Insert Pipeline**.

9. Regenerate the Platform Designer system, recompile the design, and then rerun timing analysis. If necessary, repeat the manual pipelining process again until timing requirements are met.

**Manual pipelining has the following limitations:**

- If you make changes to your original system's connectivity after manually pipelining an interconnect, your inserted pipelines may become invalid. Platform Designer displays warning messages when you generate your system if invalid pipeline stages are detected. You can remove invalid pipeline stages with the **Remove Stale Pipelines** option in the **Memory-Mapped Interconnect** tab. Intel recommends that you do not make changes to the system's connectivity after manual pipeline insertion.

- Review manually-inserted pipelines when upgrading to newer versions of Platform Designer. Manually-inserted pipelines in one version of Platform Designer may not be valid in a future version.

**Related Information**

**Specify Platform Designer Interconnect Requirements** on page 62
1.16. Implement Performance Monitoring

Use the Platform Designer Instrumentation tab (View ➤ Instrumentation) in to set up real-time performance monitoring using throughput metrics such as read and write transfers. The Add debug instrumentation to the Platform Designer Interconnect option allows you to interact with the Bus Analyzer Toolkit, which you can access on the Tools menu in the Intel Quartus Prime software.

Platform Designer supports performance monitoring for only Avalon-MM interfaces. In your Platform Designer system, you can monitor the performance of no less than three, and no greater than 15 components at one time. The performance monitoring feature works with Intel Quartus Prime software devices 13.1 and newer.

**Note:** For more information about the Bus Analyzer Toolkit and the Platform Designer Instrumentation tab, refer to the Bus Analyzer Toolkit page.

**Related Information**
- Bus Analyzer Toolkit

1.17. Platform Designer 64-Bit Addressing Support

Platform Designer interconnect supports up to 64-bit addressing for all Platform Designer interfaces and IP components, with a range of: 0x0000 0000 0000 0000 to 0xFFFF FFFF FFFF FFFF, inclusive.

Address parameters appear in the Base and End columns in the System Contents tab, on the Address Map tab, in the parameter editor, and in validation messages. Platform Designer displays as many digits as needed in order to display the top-most set bit, for example, 12 hex digits for a 48-bit address.

A Platform Designer system can have multiple 64-bit masters, with each master having its own address space. You can share slaves between masters and masters can map slaves to different addresses. For example, one master can interact with slave 0 at base address 0000_0000_0000, and another master can see the same slave at base address c000_000_000.

Intel Quartus Prime debugging tools provide access to the state of an addressable system via the Avalon-MM interconnect. These are also 64-bit compatible, and process within a 64-bit address space, including a JTAG to Avalon master bridge.

**Related Information**
- Address Span Extender on page 638

1.17.1. Support for Avalon-MM Non-Power of Two Data Widths

Platform Designer requires that you connect all multi-point Avalon-MM connections to interfaces with data widths that are equal to powers of two.

Platform Designer issues a validation error if an Avalon-MM master or slave interface on a multi-point connection is parameterized with a non-power of two data width.

**Note:** Avalon-MM point-to-point connections between an Avalon-MM master and an Avalon-MM slave are an exception and may set their data widths to a non-power of two.
1.18. Platform Designer System Example Designs

Click the **Example Design** button in the parameter editor to generate an example design.

If there are multiple example designs for an IP component, then there is a button for each example in the parameter editor. When you click the **Example Design** button, the **Select Example Design Directory** dialog box appears, where you can select the directory to save the example design.

The **Example Design** button does not appear in the parameter editor if there is no example. For some IP components, you can click **Generate ➤ Generate Example Design** to access an example design.

The following Platform Designer system example designs demonstrate various design features and flows that you can replicate in your Platform Designer system.

**Related Information**
- Nios II Platform Designer Example Design
- PCI Express Avalon-ST Platform Designer Example Design
- Triple Speed Ethernet Platform Designer Example Design

1.19. Platform Designer Command-Line Utilities

You can perform many of the functions available in the Platform Designer GUI at the command-line, with Platform Designer command-line utilities.

You run Platform Designer command-line executables from the Intel Quartus Prime installation directory:

```plaintext
<Intel Quartus Prime installation directory>/quartus\sopc_builder\bin
```

For command-line help listing of all the options for any executable, type the following command:

```plaintext
<Intel Quartus Prime installation directory>/quartus\sopc_builder\bin\<executable name> --help
```

**Note:** You must add `$QUARTUS_ROOTDIR/sopc_builder/bin/` to the **PATH** variable to access command-line utilities. Once you add this **PATH** variable, you can launch the utility from any directory location.

1.19.1. Run the Platform Designer Editor with qsys-edit

You can use the **qsys-edit** utility to run the Platform Designer editor from command-line. Platform Designer requires that you open a project and create or select an IP Variant.
You can use the following options with the `qsys-edit` utility:

**Table 28. qsys-edit Command-Line Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>1st arg file</code></td>
<td>Optional</td>
<td>Specifies the name of the .qsys system or .qvar variation file to edit.</td>
</tr>
<tr>
<td><code>--search-path[=&lt;value&gt;]</code></td>
<td>Optional</td>
<td>If you omit this command, Platform Designer uses a standard default path. If you provide a search path, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use &quot;$&quot;, for example: /extra/dir,$.</td>
</tr>
<tr>
<td><code>--quartus-project[=&lt;value&gt;]</code></td>
<td>Required</td>
<td>This option is mandatory if you are associating your Platform Designer system with an existing Intel Quartus Prime project. Specifies the name of the Intel Quartus Prime project file. If you do not provide the revision via <code>--rev</code>, Platform Designer uses the default revision as the Intel Quartus Prime project name.</td>
</tr>
<tr>
<td><code>--new-quartus-project[=&lt;value&gt;]</code></td>
<td>Required</td>
<td>This option is mandatory if you are associating your Platform Designer system with a new Intel Quartus Prime project. Specifies the name and path of the new Intel Quartus Prime project. Creates a new Intel Quartus Prime project at the specified path. You can also provide the revision name.</td>
</tr>
<tr>
<td><code>--rev[=&lt;value&gt;]</code></td>
<td>Optional</td>
<td>Specifies the name of the Intel Quartus Prime project revision.</td>
</tr>
<tr>
<td><code>--family[=&lt;value&gt;]</code></td>
<td>Optional</td>
<td>Sets the device family.</td>
</tr>
<tr>
<td><code>--part[=&lt;value&gt;]</code></td>
<td>Optional</td>
<td>Sets the device part number. If set, this option overrides the <code>--family</code> option.</td>
</tr>
<tr>
<td><code>--new-component-type[=&lt;value&gt;]</code></td>
<td>Optional</td>
<td>Specifies the instance type for parameterization in a variation.</td>
</tr>
<tr>
<td><code>--require-generation</code></td>
<td>Optional</td>
<td>Marks the loading system as requiring generation.</td>
</tr>
<tr>
<td><code>--debug</code></td>
<td>Optional</td>
<td>Enables debugging features and output.</td>
</tr>
<tr>
<td><code>--jvm-max-heap-size=&lt;value&gt;</code></td>
<td>Optional</td>
<td>The maximum memory size that Platform Designer uses when running <code>qsys-edit</code>. You specify this value as <code>&lt;size&gt;&lt;unit&gt;</code>, where unit is m (or M) for multiples of megabytes, or g (or G) for multiples of gigabytes. The default value is 512m.</td>
</tr>
<tr>
<td><code>--help</code></td>
<td>Optional</td>
<td>Displays help for <code>qsys-edit</code>.</td>
</tr>
</tbody>
</table>

**Important:** The options `--quartus-project` and `--new-quartus-project` are mutually exclusive. If you use `--quartus-project` you cannot use `--new-quartus-project` and vice versa.

**Extended Features with the `--debug` Options**

The `--debug` option provides powerful tools for debugging. When you launch Platform Designer with the `--debug` option enabled, you can:
• View debug messages when opening a system or generating HDL for that system.
• Add the `--verbose` argument when generating IP or a system using command-line utilities.
• Access internal library components in the IP Catalog, for example, modules used to create interconnect fabric.
• Access to debug tools and files from the Internal menu.

**Figure 47. Internal Menu Options**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show hw.tcl Debugger</td>
<td>Displays a Tcl debugger.</td>
</tr>
<tr>
<td>Show System File</td>
<td>Displays the current system XML in a text dialog box.</td>
</tr>
<tr>
<td>Show SOPCINFO File</td>
<td>Shows the SOPCINFO report XML in a text dialog box.</td>
</tr>
<tr>
<td>Show UI Properties</td>
<td>Displays the UI properties in a text dialog box.</td>
</tr>
<tr>
<td>Show Command Line Arguments</td>
<td>Displays all command-line arguments and environment variables in a text dialog box.</td>
</tr>
<tr>
<td>Show System Changes</td>
<td>Displays dynamic system changes in a text dialog box.</td>
</tr>
<tr>
<td>Make Model Read-only</td>
<td>Makes the system you are working in read-only.</td>
</tr>
<tr>
<td>Take Screenshots</td>
<td>Creates a <code>.png</code> file in the <code>&lt;project_directory&gt;</code> by default. You can navigate and save to a directory of your choice.</td>
</tr>
<tr>
<td>Show Plug-In Catalog</td>
<td>Displays library details such as type, version, tags, etc. for all IPs in the IP Catalog.</td>
</tr>
<tr>
<td>Show Adapter Reports</td>
<td>Displays adapter reports for any adapters added when transforming the system.</td>
</tr>
</tbody>
</table>

**Table 29. Debug Options on the Internal Menu**

• You can view detailed debugging messages in the **Component Editor** while building a custom IP component.
• You can view the generated Tcl script while editing in the **Component Editor** with the Advanced ➤ Show Tcl for Component command.
• You can launch the System Console with debug logging.
1.19.2. Scripting IP Core Generation

Use the `qsys-script` and `qsys-generate` utilities to define and generate an IP core variation outside of the Intel Quartus Prime GUI.

To parameterize and generate an IP core at command-line, follow these steps:

1. Run `qsys-script` to start a Tcl script that instantiates the IP and sets desired parameters:
   
   ```
   qsys-script --script=<script_file>.tcl
   ```

2. Run `qsys-generate` to generate the IP core variation:
   
   ```
   qsys-generate <IP variation file>.qsys
   ```

Table 30. `qsys-generate` Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;1st arg file&gt;</code></td>
<td>Required</td>
<td>Specifies the name of the <code>.qsys</code> system file to generate.</td>
</tr>
<tr>
<td>`--synthesis=&lt;VERILOG</td>
<td>VHDL&gt;`</td>
<td>Optional</td>
</tr>
<tr>
<td><code>--block-symbol-file</code></td>
<td>Optional</td>
<td>Creates a Block Symbol File (.bsf) for the Platform Designer system.</td>
</tr>
<tr>
<td><code>--greybox</code></td>
<td>Optional</td>
<td>If you are synthesizing your design with a third-party EDA synthesis tool, generate a netlist for the synthesis tool to estimate timing and resource usage for this design.</td>
</tr>
<tr>
<td><code>--ipxact</code></td>
<td>Optional</td>
<td>If you set this option to true, Platform Designer renders the post-generation system as an IPXACT-compatible component description.</td>
</tr>
<tr>
<td>`--simulation=&lt;VERILOG</td>
<td>VHDL&gt;`</td>
<td>Optional</td>
</tr>
<tr>
<td>`--testbench=&lt;SIMPLE</td>
<td>STANDARD&gt;`</td>
<td>Optional</td>
</tr>
<tr>
<td>`--testbench-simulation=&lt;VERILOG</td>
<td>VHDL&gt;`</td>
<td>Optional</td>
</tr>
<tr>
<td><code>--example-design=&lt;value&gt;</code></td>
<td>Optional</td>
<td>Creates example design files. For example, <code>--example-design=all</code> generates example designs for all instances. Alternatively, choose specific filesets based on instance name and fileset name. For example, <code>--example-design=instance0.example_design1,instance1.example_design2</code>. Specify an output directory for the example design files creation.</td>
</tr>
</tbody>
</table>

continued...
### Option | Usage | Description
--- | --- | ---
--search-path=<value> | Optional | If you omit this command, Platform Designer uses a standard default path. If you provide this command, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use "$", for example, "/extra/dir,8".

--family=<value> | Optional | Sets the device family name.

--part=<value> | Optional | Sets the device part number. If set, this option overrides the --family option.

--upgrade-variation-file | Optional | If you set this option to true, the file argument for this command accepts a .v file, which contains an IP variant. This file parameterizes a corresponding instance in a Platform Designer system of the same name.

--upgrade-ip-cores | Optional | Enables upgrading all the IP cores that support upgrade in the Platform Designer system.

--clear-output-directory | Optional | Clears the output directory corresponding to the selected target, that is, simulation or synthesis.

--jvm-max-heap-size=<value> | Optional | The maximum memory size that Platform Designer uses when running qsys-generate. You specify the value as <size><unit>, where unit is m (or M) for multiples of megabytes or g (or G) for multiples of gigabytes. The default value is 512m.

--help | Optional | Displays help for --qsys-generate.

### Related Information

Generate a Platform Designer System with qsys-script on page 94

### 1.19.3. Display Available IP Components with ip-catalog

The ip-catalog command displays a list of available IP components relative to the current Intel Quartus Prime project directory, as either text or XML.

You can use the following options with the ip-catalog utility:

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--project-dir= &lt;directory&gt;</td>
<td>Optional</td>
<td>Finds IP components relative to the Intel Quartus Prime project directory. By default, Platform Designer uses '.' as the current directory. To exclude a project directory, leave the value empty.</td>
</tr>
<tr>
<td>--type</td>
<td>Optional</td>
<td>Provides a pattern to filter the type of available plug-ins. By default, Platform Designer shows only IP components. To look for a partial type string, surround with *, for instance, <em>connection</em>.</td>
</tr>
<tr>
<td>--name=&lt;value&gt;</td>
<td>Optional</td>
<td>Provides a pattern to filter the names of the IP components found. To show all IP components, use a * or '. By default, Platform Designer shows all IP components. The argument is not case sensitive. To look for a partial name, surround with *, for instance, <em>uart</em></td>
</tr>
<tr>
<td>--verbose</td>
<td>Optional</td>
<td>Reports the progress of the command.</td>
</tr>
<tr>
<td>--xml</td>
<td>Optional</td>
<td>Generates the output in XML format, in place of colon-delimited format.</td>
</tr>
</tbody>
</table>
1. Creating a System with Platform Designer
UG-20130 | 2018.06.15

Option

Usage

Description

--search-path=<value>

Optional

If you omit this command, Platform Designer uses a standard
default path. If you provide this command, Platform Designer
searches a comma-separated list of paths. To include the
standard path in your replacement, use "$", for example, "/
extra/dir,$".

<1st arg value>

Optional

Specifies the directory or name fragment.

--jvm-max-heap-size=<value>

Optional

The maximum memory size that Platform Designer uses for
when running ip-catalog. You specify the value as <size
><unit>, where unit is m (or M) for multiples of megabytes
or g (or G) for multiples of gigabytes. The default value is
512m.

--help

Optional

Displays help for the ip-catalog command.

1.19.4. Create an .ipx File with ip-make-ipx
The ip-make-ipx command creates an .ipx index file. This file provides a convenient
way to include a collection of IP components from an arbitrary directory. You can edit
the .ipx file to disable visibility of one or more IP components in the IP Catalog.
You can use the following options with the ip-make-ipx utility:
Table 32.

ip-make-ipx Command-Line Options
Option

Usage

Description

--source-directory=<directory>

Optional

Specifies the directory containing your IP components. The
default directory is ‘.’. You can provide a comma-separated
list of directories.

--output=<file>

Optional

Specifies the name of the index file to generate. The default
name is /component.ipx. Set as --output=<""> to print
the output to the console.

--relative-vars=<value>

Optional

Causes the output file to include references relative to the
specified variable or variables wherever possible. You can
specify multiple variables as a comma-separated list.

--thorough-descent

Optional

If you set this option, Platform Designer searches all the
component files, without skipping the sub-directories.

--message-before=<value>

Optional

Prints a log message at the start of reading an index file.

--message-after=<value>

Optional

Prints a log message at the end of reading an index file.

--jvm-max-heap-size=<value>

Optional

The maximum memory size Platform Designer uses when
running ipr-make-ipx. You specify this value as
<size><unit>, where unit is m (or M) for multiples of
megabytes, or g (or G) for multiples of gigabytes. The
default value is 512m.

--help

Optional

Displays help for the ip-make-ipx command.

Related Information
Set up the IP Index File (.ipx) to Search for IP Components on page 14

Platform Designer User Guide Intel® Quartus® Prime Pro Edition
92


1.19.5. Generate Simulation Scripts

You can use the `ip-make-simscript` utility to generate simulation scripts for one or more simulators, given one or more Simulation Package Descriptor (SPD) files, `.qsys` files, and `.ip` files.

In Platform Designer, `ip-make-simscript` generates simulation scripts in a hierarchical structure instead of a flat view of the entire system. The `ip-make-simscript` utility uses SPD and system files according to the options you select:

- When targeting only SPD files (`ip-make-simscript --spd=<file>.spd`) the utility combines the contents of all input SPD files, and generates a common directory which contains a set of `<simulator>_files.tcl` files under the specified output directory.
- When targeting only system files (`ip-make-simscript --system-file=<file>`) such as `.qsys` and `.ip` files, the utility searches for instances of `<simulator>_files.tcl` files for each input system, and generates a combined simulation script which contains a list of references of `<simulator>_files.tcl`.
- When the utility uses both `--spd` and `--system-file` options, `ip-make-simscript` combines all input SPD files and generates a common/ `<simulator>_files.tcl` in the specified output directory. The generated simulation script refers to the generated common/ `<simulator>_files.tcl` first, followed by a list of Tcl files from each input system.

**Table 33. ip-make-simscript Command-Line Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
</table>
| `--spd=<file>`     | Optional/Repeatable        | The SPD files describe the list of HDL files for simulation, and memory models hierarchy. This argument can either be a single path to an SPD file or a comma-separated list of paths of SPD files. For instance, `--spd=ipcore_1.spd,ipcore_2.spd` The generated list is processed in the order of the input SPD files.  
  *Note:* When this argument is used in combination with `--system-file`, the SPD files are parsed before the system files. |
| `--system-file=<file>` | Optional/Repeatable        | Specifies the system files (.qsys or .ip files) used to generate the simulation scripts. This argument can contain either a single path to a Platform Designer system file or a comma-separated list of paths to Platform Designer system files. The simulation script is generated in the order the system files are listed.  
  *Note:* When this argument is used in combination with `--spd`, the SPD files are parsed before the system files. |
| `--output-directory=<directory>` | Optional | Specifies the directory path for the location of output files. If you do not specify a directory, the output directory defaults to the directory from which `--ip-make-simscript` runs. |
| `--compile-to-work` | Optional                  | Compiles all design files to the default library - work.                                                                                                                                               |
| `--use-relative-paths` | Optional                  | Uses relative paths whenever possible.                                                                                                                                                                  |

*continued...*
<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--cache-file[=&lt;file&gt;]</td>
<td>Optional</td>
<td>Generates cache file for managed flow.</td>
</tr>
<tr>
<td>--quiet</td>
<td>Optional</td>
<td>Quiet reporting mode. Does not report generated files.</td>
</tr>
<tr>
<td>--jvm-max-heap-size=&lt;value&gt;</td>
<td>Optional</td>
<td>The maximum memory size Platform Designer uses when running ip-make-simscript. You specify this value as &lt;size&gt;&lt;\unit&gt;, where unit is m (or M) for multiples of megabytes, or g (or G) for multiples of gigabytes. The default value is 512m.</td>
</tr>
<tr>
<td>--search-path=&lt;value&gt;</td>
<td>Optional</td>
<td>A comma-separated list of paths to be searched. If omitted, a default path including the current working directory is used. To include the standard path in your replacement, append the $ symbol, for example:”/extra/dir,$&quot;</td>
</tr>
<tr>
<td>--device-family=&lt;value&gt;</td>
<td>Optional</td>
<td>Overrides the existing device family when used.</td>
</tr>
<tr>
<td>--top-name=&lt;value&gt;</td>
<td>Optional</td>
<td>Specify a top-level entity name used in generated simulation scripts.</td>
</tr>
<tr>
<td>--help</td>
<td>Optional</td>
<td>Displays help for --ip-make-simscript.</td>
</tr>
</tbody>
</table>

1.19.6. Generate a Platform Designer System with qsys-script

You can use the qsys-script utility to create and manipulate a Platform Designer system with Tcl scripting commands. If you specify a system, Platform Designer loads that system before executing any of the scripting commands.

**Note:** You must provide a package version for the qsys-script. If you do not specify the --package-version=\<value\> command, you must then provide a Tcl script and request the system scripting API directly with the package require -exact qsys<version> command.

**Example 4. Platform Designer Command-Line Scripting**

qsys-script --script=my_script.tcl \ 
--system-file=fancy.qsys

my_script.tcl contains:

```tcl
package require -exact qsys 16.0
# get all instance names in the system and print one by one
set instances [ get_instances ]
foreach instance $instances {
    send_message Info "$instance"
}
```
You can use the following options with the qsys-script utility:

Table 34. qsys-script Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>--system-file=&lt;file&gt;</td>
<td>Optional</td>
<td>Specifies the path to a .qsys file. Platform Designer loads the system before running scripting commands.</td>
</tr>
<tr>
<td>--script=&lt;file&gt;</td>
<td>Optional</td>
<td>A file that contains Tcl scripting commands that you can use to create or manipulate a Platform Designer system. If you specify both --cmd and --script, Platform Designer runs the --cmd commands before the script specified by --script.</td>
</tr>
<tr>
<td>--cmd=&lt;value&gt;</td>
<td>Optional</td>
<td>A string that contains Tcl scripting commands that you can use to create or manipulate a Platform Designer system. If you specify both --cmd and --script, Platform Designer runs the --cmd commands before the script specified by --script.</td>
</tr>
<tr>
<td>--package-version=&lt;value&gt;</td>
<td>Optional</td>
<td>Specifies which Tcl API scripting version to use and determines the functionality and behavior of the Tcl commands. The Intel Quartus Prime software supports Tcl API scripting commands. The minimum supported version is 12.0. If you do not specify the version on the command-line, your script must request the scripting API directly with the package require -exact qsys &lt;version&gt; command.</td>
</tr>
<tr>
<td>--search-path=&lt;value&gt;</td>
<td>Optional</td>
<td>If you omit this command, a Platform Designer uses a standard default path. If you provide this command, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use &quot;$&quot;, for example, /&lt;directory path&gt;/dir, $. Separate multiple directory references with a comma.</td>
</tr>
<tr>
<td>--quartus-project=&lt;value&gt;</td>
<td>Optional</td>
<td>Specifies the path to a .qpf Intel Quartus Prime project file. Utilizes the specified Intel Quartus Prime project to add the file saved using save_system command. If you omit this command, Platform Designer uses the default revision as the project name.</td>
</tr>
<tr>
<td>--new-quartus-project=&lt;value&gt;</td>
<td>Optional</td>
<td>Specifies the name of the new Intel Quartus Prime project. Creates a new Intel Quartus Prime project at the specified path and adds the file saved using save_system command to the project. If you omit this command, Platform Designer uses the Intel Quartus Prime project revision as the new Intel Quartus Prime project name.</td>
</tr>
<tr>
<td>--rev=&lt;value&gt;</td>
<td>Optional</td>
<td>Allows you to specify the name of the Intel Quartus Prime project revision.</td>
</tr>
<tr>
<td>--jvm-max-heap-size=&lt;value&gt;</td>
<td>Optional</td>
<td>The maximum memory size that the qsys-script tool uses. You specify this value as &lt;size&gt;&lt;unit&gt;, where unit is m (or M) for multiples of megabytes, or g (or G) for multiples of gigabytes.</td>
</tr>
<tr>
<td>--help</td>
<td>Optional</td>
<td>Displays help for the qsys-script utility.</td>
</tr>
</tbody>
</table>

Related Information
Altera Wiki Platform Designer Scripts

1.19.7. Platform Designer Scripting Command Reference

Platform Designer system scripting provides Tcl commands to manipulate your system. The qsys-script provides a command-line alternative to the Platform Designer tool. Use the qsys-script commands to create and modify your system, as well as to create reports about the system.
To use the current version of the Tcl commands, include the following line at the top of your script:

```
package require -exact qsys <version>
```

For example, for the current release of the Intel Quartus Prime software, include:

```
package require -exact qsys 18.0
```

The Platform Designer scripting commands fall under the following categories:

- **System** on page 97
- **Subsystems** on page 110
- **Instances** on page 119
- **Instantiations** on page 152
- **Components** on page 191
- **Connections** on page 217
- **Top-level Exports** on page 229
- **Validation** on page 243
- **Miscellaneous** on page 254
- **Wire-Level Connection Commands** on page 267
1.19.7.1. System

This section lists the commands that allow you to manipulate your Platform Designer system.

create_system on page 98
export_hw_tcl on page 99
get_device_families on page 100
get_devices on page 101
get_module_properties on page 102
get_module_property on page 103
get_project_properties on page 104
get_project_property on page 105
load_system on page 106
save_system on page 107
set_module_property on page 108
set_project_property on page 109
1.19.7.1.1. create_system

Description
Replaces the current system with a new system of the specified name.

Usage
create_system [name]

Returns
No return value.

Arguments

name (optional)  The new system name.

Example
create_system my_new_system_name

Related Information
- load_system on page 106
- save_system on page 107
1.19.7.1.2. export_hw_tcl

**Description**
Allows you to save the currently open system as an `_hw.tcl` file in the project directory. The saved systems appears under the **System** category in the IP Category.

**Usage**
`export_hw_tcl`

**Returns**
No return value.

**Arguments**
No arguments

**Example**
```
export_hw_tcl
```

**Related Information**
- `load_system` on page 106
- `save_system` on page 107
1.19.7.1.3. get_device_families

**Description**
Returns the list of installed device families.

**Usage**
get_device_families

**Returns**

*String[]*  The list of device families.

**Arguments**
No arguments

**Example**

```java
get_device_families
```

**Related Information**
get_devices on page 101
1.19.7.1.4. get_devices

**Description**
Returns the list of installed devices for the specified family.

**Usage**
get_devices `<family>`

**Returns**
String[]  The list of devices.

**Arguments**

family  Specifies the family name to get the devices for.

**Example**

```
get_devices exampleFamily
```

**Related Information**

get_device_families on page 100
1.19.7.1.5. get_module_properties

**Description**
Returns the properties that you can manage for a top-level module of the Platform Designer system.

**Usage**
get_module_properties

**Returns**
The list of property names.

**Arguments**
No arguments.

**Example**

```
get_module_properties
```

**Related Information**
- `get_module_property` on page 103
- `set_module_property` on page 108
1.19.7.1.6. get_module_property

**Description**
Returns the value of a top-level system property.

**Usage**
get_module_property <property>

**Returns**
The property value.

**Arguments**

*property*  The property name to query. Refer to *Module Properties*.

**Example**

```
get_module_property NAME
```

**Related Information**
- get_module_properties on page 102
- set_module_property on page 108
1.19.7.1.7. get_project_properties

**Description**
Returns the list of properties that you can query for properties pertaining to the Intel Quartus Prime project.

**Usage**
get_project_properties

**Returns**
The list of project properties.

**Arguments**
No arguments

**Example**

```
get_project_properties
```

**Related Information**
- `get_project_property` on page 105
- `set_project_property` on page 109
1. Creating a System with Platform Designer

1.19.7.1.8. get_project_property

**Description**
Returns the value of a Intel Quartus Prime project property.

**Usage**
get_project_property <property>

**Returns**
The property value.

**Arguments**

*property* The project property name. Refer to *Project properties*.

**Example**

```
get_project_property DEVICE_FAMILY
```

**Related Information**
- get_module_properties on page 102
- get_module_property on page 103
- set_module_property on page 108
- Project Properties on page 285
1.19.7.1.9. load_system

Description
Loads the Platform Designer system from a file, and uses the system as the current system for scripting commands.

Usage
load_system <file>

Returns
No return value.

Arguments

file  The path to the .qsys file.

Example

load_system example.qsys

Related Information
- create_system on page 98
- save_system on page 107
1.19.7.1.10. save_system

Description
Saves the current system to the specified file. If you do not specify the file, Platform Designer saves the system to the same file opened with the load_system command.

Usage
save_system <file>

Returns
No return value.

Arguments

file  If available, the path of the .qsys file to save.

Example

<table>
<thead>
<tr>
<th>command</th>
</tr>
</thead>
<tbody>
<tr>
<td>save_system</td>
</tr>
<tr>
<td>save_system file.qsys</td>
</tr>
</tbody>
</table>

Related Information
- load_system on page 106
- create_system on page 98
1.19.7.1.11. set\_module\_property

**Description**
Specifes the Tcl procedure to evaluate changes in Platform Designer system instance parameters.

**Usage**
set\_module\_property <\textit{property}> <\textit{value}>

**Returns**
No return value.

**Arguments**

\textit{property}  The property name. Refer to \textit{Module Properties}.

\textit{value}  The new value of the property.

**Example**

```tcl
set\_module\_property COMPOSITION\_CALLBACK "my\_composition\_callback"
```

**Related Information**
- \textit{get\_module\_properties} on page 102
- \textit{get\_module\_property} on page 103
- \textit{Module Properties} on page 279
1.19.7.1.12. set_project_property

**Description**

Sets the project property value, such as the device family.

**Usage**

```
set_project_property <property> <value>
```

**Returns**

No return value.

**Arguments**

- `property` The property name. Refer to *Project Properties*.
- `value` The new property value.

**Example**

```
set_project_property DEVICE_FAMILY "Cyclone IV GX"
```

**Related Information**

- [get_project_properties](#) on page 104
- [get_project_property](#) on page 105
- [Project Properties](#) on page 285
1.19.7.2. Subsystems

This section lists the commands that allow you to obtain the connection and parameter information of instances in your Platform Designer subsystem.

- `get_composed_connections` on page 111
- `get_composed_connection_parameter_value` on page 112
- `get_composed_connection_parameters` on page 113
- `get_composed_instance_assignment` on page 114
- `get_composed_instance_assignments` on page 115
- `get_composed_instance_parameter_value` on page 116
- `get_composed_instance_parameters` on page 117
- `get_composed_instances` on page 118
1.19.7.2.1. get_composed_connections

Description
Returns the list of all connections in the subsystem for an instance that contains the subsystem of the Platform Designer system.

Usage
get_composed_connections <instance>

Returns
The list of connection names in the subsystem.

Arguments
instance The child instance containing the subsystem.

Example
get_composed_connections subsystem_0

Related Information
- get_composed_connection_parameter_value on page 112
- get_composed_connection_parameters on page 113
1.19.7.2.2. get_composed_connection_parameter_value

Description

Returns the parameter value of a connection in a child instance containing the subsystem.

Usage

get_composed_connection_parameter_value <instance> <child_connection> <parameter>

Returns

The parameter value.

Arguments

instance The child instance that contains the subsystem.

child_connection The connection name in the subsystem.

parameter The parameter name to query for the connection.

Example

get_composed_connection_parameter_value subsystem_0 cpu.data_master/memory.s0 baseAddress

Related Information

- get_composed_connection_parameters on page 113
- get_composed_connections on page 111
1.19.7.2.3. get_composed_connection_parameters

**Description**
Returns the list of parameters of a connection in the subsystem, for an instance that contains the subsystem.

**Usage**
get_composed_connection_parameters <instance> <child_connection>

**Returns**
The list of parameter names.

**Arguments**

*instance*  The child instance containing the subsystem.

*child_connection*  The name of the connection in the subsystem.

**Example**

```
get_composed_connection_parameters subsystem_0 cpu.data_master/memory.s0
```

**Related Information**
- get_composed_connection_parameter_value on page 112
- get_composed_connections on page 111
1.19.7.2.4. get_composed_instance_assignment

Description
Returns the assignment value of the child instance in the subsystem.

Usage
get_composed_instance_assignment <instance> <child_instance> <assignment>

Returns
The assignment value.

Arguments

instance The subsystem containing the child instance.

child_instance The child instance name in the subsystem.

assignment The assignment key.

Example

get_composed_instance_assignment subsystem_0 video_0 "embeddedsw.CMacro.colorSpace"

Related Information
- get_composed_instance_assignments on page 115
- get_composed_instances on page 118
1.19.7.2.5. get_composed_instance_assignments

**Description**
Returns the list of assignments of the child instance in the subsystem.

**Usage**
get_composed_instance_assignments <instance> <child_instance>

**Returns**
The list of assignment names.

**Arguments**

*instance* The subsystem containing the child instance.

*child_instance* The child instance name in the subsystem.

**Example**
```
get_composed_instance_assignments subsystem_0 cpu
```

**Related Information**
- get_composed_instance_assignment on page 114
- get_composed_instances on page 118
1.19.7.2.6. `get_composed_instance_parameter_value`

**Description**
Returns the parameter value of the child instance in the subsystem.

**Usage**
`get_composed_instance_parameter_value <instance> <child_instance> <parameter>`

**Returns**
The parameter value of the instance in the subsystem.

**Arguments**

- **instance**  The subsystem containing the child instance.
- **child_instance**  The child instance name in the subsystem.
- **parameter**  The parameter name to query on the child instance in the subsystem.

**Example**
```
get_composed_instance_parameter_value subsystem_0 cpu DATA_WIDTH
```

**Related Information**
- `get_composed_instance_parameters` on page 117
- `get_composed_instances` on page 118
1.19.7.2.7. get_composed_instance_parameters

Description
Returns the list of parameters of the child instance in the subsystem.

Usage
get_composed_instance_parameters <instance> <child_instance>

Returns
The list of parameter names.

Arguments

instance The subsystem containing the child instance.

child_instance The child instance name in the subsystem.

Example

get_composed_instance_parameters subsystem_0 cpu

Related Information

- get_composed_instance_parameter_value on page 116
- get_composed_instances on page 118
1.19.7.2.8. get_composed_instances

**Description**
Returns the list of child instances in the subsystem.

**Usage**
get_composed_instances <instance>

**Returns**
The list of instance names in the subsystem.

**Arguments**

*instance*  The subsystem containing the child instance.

**Example**

```plaintext
get_composed_instances subsystem_0
```

**Related Information**
- [get_composed_instance_assignment](#) on page 114
- [get_composed_instance_assignments](#) on page 115
- [get_composed_instance_parameter_value](#) on page 116
- [get_composed_instance_parameters](#) on page 117
1.19.7.3. Instances

This section lists the commands that allow you to manipulate the instances of IP components in your Platform Designer system.

- add_instance on page 120
- apply_instance_preset on page 121
- create_ip on page 122
- add_component on page 123
- duplicate_instance on page 124
- enable_instance_parameter_update_callback on page 125
- get_instance_assignment on page 126
- get_instance_assignments on page 127
- get_instance_documentation_links on page 128
- get_instance_interface_assignment on page 129
- get_instance_interface_assignments on page 130
- get_instance_interface_parameter_property on page 131
- get_instance_interface_parameter_value on page 132
- get_instance_interface_parameters on page 133
- get_instance_interface_port_property on page 134
- get_instance_interface_ports on page 135
- get_instance_interface_properties on page 136
- get_instance_interface_property on page 137
- get_instance_interfaces on page 138
- get_instance_parameter_property on page 139
- get_instance_parameter_value on page 140
- get_instance_parameter_values on page 141
- get_instance_parameters on page 142
- get_instance_port_property on page 143
- get_instance_properties on page 144
- get_instance_property on page 145
- get_instances on page 146
- is_instance_parameter_update_callback_enabled on page 147
- remove_instance on page 148
- set_instance_parameter_value on page 149
- set_instance_parameter_values on page 150
- set_instance_property on page 151
1.19.7.3.1. add_instance

**Description**
Adds an instance of a component, referred to as a *child* or *child instance*, to the system.

**Usage**
```
add_instance <name> <type> [<version>]
```

**Returns**
No return value.

**Arguments**

- **name**  Specifies a unique local name that you can use to manipulate the instance. Platform Designer uses this name in the generated HDL to identify the instance.

- **type**  Refers to a kind of instance available in the IP Catalog, for example `altera_avalon_uart`.

- **version (optional)**  The required version of the specified instance type. If you do not specify any instance, Platform Designer uses the latest version.

**Example**
```
add_instance uart_0 altera_avalon_uart 16.1
```

**Related Information**

- [get_instance_property](#) on page 145
- [get_instances](#) on page 146
- [remove_instance](#) on page 148
- [set_instance_parameter_value](#) on page 149
- [get_instance_parameter_value](#) on page 140
1.19.7.3.2. apply_instance_preset

Description
Applies the settings in a preset to the specified instance.

Usage
apply_instance_preset <preset_name>

Returns
No return value.

Arguments

preset_name  The preset name.

Example

apply_preset "Custom Debug Settings"

Related Information
set_instance_parameter_value on page 149
1.19.7.3.3. create_ip

Description
Creates a new IP Variation system with the given instance.

Usage
create_ip <type> [ <instance_name> <version> ]

Returns
No return value.

Arguments

* type Kind of instance available in the IP catalog, for example, altera_avalon_uart.

* instance_name (optional) A unique local name that you can use to manipulate the instance. If not specified, Platform Designer uses a default name.

* version (optional) The required version of the specified instance type. If not specified, Platform Designer uses the latest version.

Example
create_ip altera_avalon_uart altera_avalon_uart_inst 17.0

Related Information
- add_component on page 123
- load_system on page 106
- save_system on page 107
- set_instance_parameter_value on page 149
1.19.7.3.4. add_component

**Description**
Adds a new IP Variation component to the system.

**Usage**
add_component <instance_name> <file_name> [component_type:<component_instance_name> <component_version>]

**Returns**
No return value.

**Arguments**

*instance_name*  A unique local name that you can use to manipulate the instance.

*file_name*  The IP variation file name. If a path is not specified, Platform Designer saves the file in the ./ip/system/ sub-folder of your system.

*component_type*  (optional)  The kind of instance available in the IP catalog, for example altera_avalon_uart.

*component_instance_name*  (optional)  The instance name of the component in the IP variation file. If not specified, Platform Designer uses a default name.

*component_version*  (optional)  The required version of the specified instance type. If not specified, Platform Designer uses the latest version.

**Example**
add_component myuart_0 myuart.ip altera_avalon_uart altera_avalon_uart_inst 17.0

**Related Information**
- [load_component](#) on page 212
- [load_instantiation](#) on page 179
- [save_system](#) on page 107
1.19.7.3.5. duplicate_instance

**Description**
Creates a duplicate instance of the specified instance.

**Usage**
duplicate_instance <instance> [ <name> ]

**Returns**

*String* The new instance name.

**Arguments**

*instance* Specifies the instance name to duplicate.

*name (optional)* Specifies the name of the duplicate instance.

**Example**
```
duplicate_instance cpu cpu_0
```

**Related Information**
- add_instance on page 120
- remove_instance on page 148
1.19.7.3.6. enable_instance_parameter_update_callback

**Description**
Enables the update callback for instance parameters.

**Usage**
enable_instance_parameter_update_callback [<value>]

**Returns**
No return value.

**Arguments**

*value (optional)* Specifies whether to enable/disable the instance parameters callback. Default option is "1".

**Example**

```plaintext
enabled_instance_parameter_update_callback
```

**Related Information**
- is_instance_parameter_update_callback_enabled on page 147
- set_instance_parameter_value on page 149
1.19.7.3.7. get_instance_assignment

Description
Returns the assignment value of a child instance. Platform Designer uses assignments to transfer information about hardware to embedded software tools and applications.

Usage
get_instance_assignment <instance> <assignment>

Returns
String   The value of the specified assignment.

Arguments

instance   The instance name.

assignment   The assignment key to query.

Example
get_instance_assignment video_0 embeddedsw.CMacro.colorSpace

Related Information
get_instance_assignments on page 127
1.19.7.3.8. get_instance_assignments

**Description**
Returns the list of assignment keys for any defined assignments for the instance.

**Usage**
get_instance_assignments <instance>

**Returns**

`String[]` The list of assignment keys.

**Arguments**

`instance` The instance name.

**Example**

```
get_instance_assignments sdram
```

**Related Information**

`get_instance_assignment` on page 126
1.19.7.3.9. get_instance_documentation_links

**Description**
Returns the list of all documentation links provided by an instance.

**Usage**
get_instance_documentation_links <instance>

**Returns**
String[] The list of documentation links.

**Arguments**

*instance*  The instance name.

**Example**
get_instance_documentation_links cpu_0

**Notes**
The list of documentation links includes titles and URLs for the links. For instance, a component with a single data sheet link may return:

{Data Sheet} {http://url/to/data/sheet}
1.19.7.3.10. get_instance_interface_assignment

**Description**
Returns the assignment value for an interface of a child instance. Platform Designer uses assignments to transfer information about hardware to embedded software tools and applications.

**Usage**
get_instance_interface_assignment <instance> <interface> <assignment>

**Returns**
String  The value of the specified assignment.

**Arguments**

*instance*  The child instance name.

*interface*  The interface name.

*assignment*  The assignment key to query.

**Example**

get_instance_interface_assignment sdram s1 embeddedsw.configuration.isFlash

**Related Information**
get_instance_interface_assignments on page 130
1.19.7.3.11. get_instance_interface_assignments

Description
Returns the list of assignment keys for any assignments defined for an interface of a child instance.

Usage
get_instance_interface_assignments <instance> <interface>

Returns
String[] The list of assignment keys.

Arguments

instance The child instance name.

interface The interface name.

Example

get_instance_interface_assignments sdram s1

Related Information
get_instance_interface_assignment on page 129
1.19.7.3.12. get_instance_interface_parameter_property

**Description**
Returns the property value for a parameter in an interface of an instance. Parameter properties are metadata about how Platform Designer uses the parameter.

**Usage**
get_instance_interface_parameter_property <instance> <interface> <parameter> <property>

**Returns**
various The parameter property value.

**Arguments**

*instance*  The child instance name.

*interface*  The interface name.

*parameter*  The parameter name for the interface.

*property*  The property name for the parameter. Refer to Parameter Properties.

**Example**
get_instance_interface_parameter_property uart_0 s0 setupTime ENABLED

**Related Information**
- get_instance_interface_parameters on page 133
- get_instance_interfaces on page 138
- get_parameter_properties on page 260
- Parameter Properties on page 280
1.19.7.3.13. get_instance_interface_parameter_value

Description
Returns the parameter value of an interface in an instance.

Usage
get_instance_interface_parameter_value <instance> <interface> <parameter>

Returns
various  The parameter value.

Arguments
instance  The child instance name.

interface  The interface name.

parameter  The parameter name for the interface.

Example
get_instance_interface_parameter_value uart_0 s0 setupTime

Related Information
• get_instance_interface_parameters on page 133
• get_instance_interfaces on page 138
1.19.7.3.14. get_instance_interface_parameters

**Description**
Returns the list of parameters for an interface in an instance.

**Usage**
get_instance_interface_parameters `<instance>` `<interface>`

**Returns**

`String[]`  The list of parameter names for parameters in the interface.

**Arguments**

`instance`  The child instance name.

`interface`  The interface name.

**Example**

```plaintext
get_instance_interface_parameters uart_0 s0
```

**Related Information**

- `get_instance_interface_parameter_value` on page 132
- `get_instance_interfaces` on page 138
1.19.7.3.15. get_instance_interface_port_property

**Description**

Returns the property value of a port in the interface of a child instance.

**Usage**

```
get_instance_interface_port_property <instance> <interface> <port> <property>
```

**Returns**

`various` The port property value.

**Arguments**

- `instance` The child instance name.
- `interface` The interface name.
- `port` The port name.
- `property` The property name of the port. Refer to *Port Properties*.

**Example**

```
get_instance_interface_port_property uart_0 exports tx WIDTH
```

**Related Information**

- `get_instance_interface_ports` on page 135
- `get_port_properties` on page 238
- *Port Properties* on page 284
1.19.7.3.16. get_instance_interface_ports

Description
Returns the list of ports in an interface of an instance.

Usage
go_instance_interface_ports <instance> <interface>

Returns
String[] The list of port names in the interface.

Arguments

instance The instance name.

interface The interface name.

Example

giip uart_0 s0

Related Information
• get_instance_interface_port_property on page 134
• get_instance_interfaces on page 138
1.19.7.3.17. get_instance_interface_properties

**Description**
Returns the list of properties that you can query for an interface in an instance.

**Usage**
get_instance_interface_properties

**Returns**

`String[]` The list of property names.

**Arguments**
No arguments.

**Example**

```
get_instance_interface_properties
```

**Related Information**
- `get_instance_interface_property` on page 137
- `get_instance_interfaces` on page 138
1.19.7.3.18. get_instance_interface_property

**Description**
Returns the property value for an interface in a child instance.

**Usage**
get_instance_interface_property <instance> <interface> <property>

**Returns**
String  The property value.

**Arguments**
- **instance**  The child instance name.
- **interface**  The interface name.
- **property**  The property name. Refer to *Element Properties*.

**Example**
get_instance_interface_property uart_0 s0 DESCRIPTION

**Related Information**
- get_instance_interface_properties on page 136
- get_instance_interfaces on page 138
- Element Properties on page 275
1.19.7.3.19. get_instance_interfaces

**Description**
Returns the list of interfaces in an instance.

**Usage**
get_instance_interfaces `<instance>`

**Returns**

`String[]` The list of interface names.

**Arguments**

`instance` The instance name.

**Example**
```
get_instance_interfaces uart_0
```

**Related Information**
- `get_instance_interface_ports` on page 135
- `get_instance_interface_properties` on page 136
- `get_instance_interface_property` on page 137
1.19.7.3.20. get_instance_parameter_property

Description
Returns the property value of a parameter in an instance. Parameter properties are metadata about how Platform Designer uses the parameter.

Usage
get_instance_parameter_property <instance> <parameter> <property>

Returns

*various* The parameter property value.

Arguments

*instance* The instance name.

*parameter* The parameter name.

*property* The property name of the parameter. Refer to Parameter Properties.

Example

```
get_instance_parameter_property uart_0 baudRate ENABLED
```

Related Information

- get_instance_parameters on page 142
- get_parameter_properties on page 260
- Parameter Properties on page 280
1.19.7.3.21. get_instance_parameter_value

**Description**
Returns the parameter value in a child instance.

**Usage**
get_instance_parameter_value <instance> <parameter>

**Returns**

`various` The parameter value.

**Arguments**

`instance` The instance name.

`parameter` The parameter name.

**Example**

```
get_instance_parameter_value pixel_converter input_DPI
```

**Related Information**
- get_instance_parameters on page 142
- set_instance_parameter_value on page 149
1.19.7.3.22. get_instance_parameter_values

Description
Returns a list of the parameters' values in a child instance.

Usage
get_instance_parameter_values <instance> <parameters>

Returns
String[] A list of the parameters' value.

Arguments

instance The child instance name.

parameter A list of parameter names in the instance.

Example
get_instance_parameter_value uart_0 [list param1 param2]

Related Information
- get_instance_parameters on page 142
- set_instance_parameter_value on page 149
- set_instance_parameter_values on page 150
1.19.7.3.23. **get_instance_parameters**

**Description**
Returns the names of all parameters for a child instance that the parent can manipulate. This command omits derived parameters and parameters that have the `SYSTEM_INFO` parameter property set.

**Usage**
`get_instance_parameters <instance>`

**Returns**

`instance`  The list of parameters in the instance.

**Arguments**

`instance`  The instance name.

**Example**
```plaintext
get_instance_parameters uart_0
```

**Related Information**

- `get_instance_parameter_property` on page 139
- `get_instance_parameter_value` on page 140
- `set_instance_parameter_value` on page 149
1.19.7.3.24. get_instance_port_property

**Description**
Returns the property value of a port contained by an interface in a child instance.

**Usage**
get_instance_port_property <instance> <port> <property>

**Returns**

`various`  The property value for the port.

**Arguments**

`instance`  The child instance name.

`port`  The port name.

`property`  The property name. Refer to Port Properties.

**Example**

get_instance_port_property uart_0 tx WIDTH

**Related Information**
- get_instance_interface_ports on page 135
- get_port_properties on page 238
- Port Properties on page 284
1.19.7.3.25. get_instance_properties

**Description**
Returns the list of properties for a child instance.

**Usage**
get_instance_properties

**Returns**

*String[]* The list of property names for the child instance.

**Arguments**
No arguments.

**Example**

```
get_instance_properties
```

**Related Information**

get_instance_property on page 145
1.19.7.3.26. get_instance_property

Description
Returns the property value for a child instance.

Usage
get_instance_property <instance> <property>

Returns
String  The property value.

Arguments
instance  The child instance name.

property  The property name. Refer to Element Properties.

Example
get_instance_property uart_0 ENABLED

Related Information
• get_instance_properties on page 144
• Element Properties on page 275
1.19.7.3.27. get_instances

Description
Returns the list of the instance names for all the instances in the system.

Usage
get_instances

Returns

String[] The list of child instance names.

Arguments
No arguments.

Example

get_instances

Related Information
- add_instance on page 120
- remove_instance on page 148
1.19.7.3.28. is_instance_parameter_update_callback_enabled

Description
Returns true if you enable the update callback for instance parameters.

Usage
is_instance_parameter_update_callback_enabled

Returns

boolean 1 if you enable the callback; 0 if you disable the callback.

Arguments
No arguments

Example

is_instance_parameter_update_callback_enabled

Related Information
enable_instance_parameter_update_callback on page 125
1.19.7.3.29. remove_instance

Description
Removes an instance from the system.

Usage
remove_instance <instance>

Returns
No return value.

Arguments

instance  The child instance name to remove.

Example

<p>| |</p>
<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>remove_instance cpu</td>
</tr>
</tbody>
</table>

Related Information

- add_instance on page 120
- get_instances on page 146
1.19.7.3.30. set_instance_parameter_value

Description
Sets the parameter value for a child instance. You cannot set derived parameters and SYSTEM_INFO parameters for the child instance with this command.

Usage
set_instance_parameter_value <instance> <parameter> <value>

Returns
No return value.

Arguments

instance The child instance name.

parameter The parameter name.

value The parameter value.

Example

```
set_instance_parameter_value uart_0 baudRate 9600
```

Related Information

- get_instance_parameter_value on page 140
- get_instance_parameter_property on page 139
1.19.7.3.31. set_instance_parameter_values

Description
Sets a list of parameter values for a child instance. You cannot set derived parameters and SYSTEM_INFO parameters for the child instance with this command.

Usage
set_instance_parameter_value <instance> <parameter_value_pairs>

Returns
No return value.

Arguments

instance  The child instance name.

parameter_value_pairs  The pairs of parameter name and value to set.

Example

set_instance_parameter_value uart_0 [list baudRate 9600 parity odd]

Related Information
- get_instance_parameter_value on page 140
- get_instance_parameter_values on page 141
- get_instance_parameters on page 142
1.19.7.3.32. set_instance_property

Description
Sets the property value of a child instance. Most instance properties are read-only and can only be set by the instance itself. The primary use for this command is to update the ENABLED parameter, which includes or excludes a child instance when generating Platform Designer interconnect.

Usage
set_instance_property <instance> <property> <value>

Returns
No return value.

Arguments
instance The child instance name.
property The property name. Refer to Instance Properties.
value The property value.

Example
set_instance_property cpu ENABLED false

Related Information
- get_instance_parameters on page 142
- get_instance_property on page 145
- Instance Properties on page 276
1.19.7.4. Instantiations

This section lists the commands that allow you to manipulate the loaded instantiations in your Platform Designer system.

- add_instantiation_hdl_file on page 154
- add_instantiation_interface on page 155
- add_instantiation_interface_port on page 156
- copy_instance_interface_to_instantiation on page 157
- get_instantiation_assignment_value on page 158
- get_instantiation_assignments on page 159
- get_instantiation_hdl_file_properties on page 160
- get_instantiation_hdl_file_property on page 161
- get_instantiation_hdl_files on page 162
- get_instantiation_interface_assignment_value on page 163
- get_instantiation_interface_assignments on page 164
- get_instantiation_interface_parameter_value on page 165
- get_instantiation_interface_parameters on page 166
- get_instantiation_interface_port_properties on page 167
- get_instantiation_interface_port_property on page 168
- get_instantiation_interface_ports on page 169
- get_instantiation_interface_property on page 170
- get_instantiation_interface_properties on page 171
- get_instantiation_interface_sysinfo_parameter_value on page 172
- get_instantiation_interface_sysinfoParameters on page 173
- get_instantiation_interfaces on page 174
- get_instantiation_properties on page 175
- get_instantiation_property on page 176
- get_loaded_instantiation on page 177
- import_instantiation_interfaces on page 178
- load_instantiation on page 179
- remove_instantiation_hdl_file on page 180
- remove_instantiation_interface on page 181
- remove_instantiation_interface_port on page 182
- save_instantiation on page 183
- set_instantiation_assignment_value on page 184
- set_instantiation_hdl_file_property on page 185
- set_instantiation_interface_assignment_value on page 186
- set_instantiation_interface_parameter_value on page 187
1.19.7.4.1. add_instantiation_hdl_file

**Description**
Adds an HDL file to the loaded instantiation.

**Usage**
add_instantiation_hdl_file <file> [<kind>]

**Returns**
No return value.

**Arguments**

*file*  Specifies the HDL file name.

*kind (optional)*  Indicates the file set kind to add the file to. If you do not specify this option, the command adds the file to all the file sets. Refer to File Set Kind.

**Example**

```
add_instantiation_hdl_file my_nios2_gen2.vhdl quartus_synth
```

**Related Information**

- load_instantiation on page 179
- save_instantiation on page 183
- File Set Kind on page 291
1.19.7.4.2. add_instantiation_interface

**Description**

Adds an interface to the loaded instantiation.

**Usage**

add_instantiation_interface `<interface>` `<type>` `<direction>`

**Returns**

No return value.

**Arguments**

- **interface**  Specifies the interface name.
- **type**  Specifies the interface type.
- **direction**  Specifies the interface direction. Refer to *Interface Direction*.

**Example**

add_instantiation_interface clk_0 clock OUTPUT

**Related Information**

- load_instantiation on page 179
- save_instantiation on page 183
- Interface Direction on page 290
1.19.7.4.3. add_instantiation_interface_port

**Description**
Adds a port to a loaded instantiation's interface.

**Usage**
```
add_instantiation_interface_port <interface> <port> <role> <width> <vhdl_type><direction>
```

**Returns**
No return value.

**Arguments**
- **interface**  Specifies the interface name.
- **port**  Specifies the port name.
- **role**  Specifies the port role.
- **width**  Specifies the port width.
- **vhdl_type**  Specifies the VHDL type of the port. Refer to **VHDL Type**.
- **direction**  Specifies the port direction. Refer to **Direction Properties**.

**Example**
```
add_instantiation_interface_port avs_s0 avs_s0_address address 8 {standard logic vector} input
```

**Related Information**
- **load_instantiation** on page 179
- **save_instantiation** on page 183
- **VHDL Type** on page 298
- **Direction Properties** on page 274
1.19.7.4.4. copy_instance_interface_to_instantiation

**Description**
Add an interface to a loaded instantiation by copying the specified interface of another instance.

**Usage**
copy_instance_interface_to_instantiation <instance> <interface> <type>

**Returns**
String  The name of the newly added interface.

**Arguments**

*instance*  Specifies the name of the instance to copy the interface from.

*interface*  Specifies the name of the interface to copy.

*type*  Specifies the type of copy to make. Refer to *Instantiation Interface Duplicate Type*.

**Example**
copy_instance_interface_to_instantiation cpu_0 data_master CLONE

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
- Instantiation Interface Duplicate Type on page 294
1.19.7.4.5. `get_instantiation_assignment_value`

**Description**

Gets the assignment value on the loaded instantiation.

**Usage**

`get_instantiation_assignment_value <name>`

**Returns**

*String*  
The assignment value.

**Arguments**

*name*  
Specifies the name of the assignment to get the value of.

**Example**

```
get_instantiation_assignment_value embeddedsw.configuration.exceptionOffset
```

**Related Information**

- `load_instantiation` on page 179
- `save_instantiation` on page 183
1.19.7.4.6. get_instantiation_assignments

Description
Gets the assignment names in the loaded instantiation.

Usage
get_instantiation_assignments

Returns

String[] The list of assignment names.

Arguments
No arguments

Example

get_instantiation_assignments

Related Information

- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.7. get_instantiation_hdl_file_properties

Description
Returns the list of properties in an HDL file associated with an instantiation.

Usage
get_instantiation_hdl_file_properties

Returns
String[] The list of property names.

Arguments
No arguments

Example
get_instantiation_hdl_file_properties

Related Information
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.8. get_instantiation_hdl_file_property

**Description**
Returns the property value of an HDL file associated with the loaded instantiation.

**Usage**
get_instantiation_hdl_file_property <file> <property>

**Returns**

*various* The property value.

**Arguments**

*file* Specifies the HDL file name.

*property* Specifies the property name. Refer to *Instantiation Hdl File Properties*.

**Example**
```
get_instantiation_hdl_file_property my_nios2_gen2.vhdl OUTPUT_PATH
```

**Related Information**
- *load_instantiation* on page 179
- *save_instantiation* on page 183
- *Instantiation Hdl File Properties* on page 293
## 1.19.7.4.9. `get_instantiation_hdl_files`

**Description**

Returns the list of HDL files of the loaded instantiation.

**Usage**

```plaintext
get_instantiation_hdl_files [<kind>]
```

**Returns**

`String[]` The list of HDL file names.

**Arguments**

`kind (optional)` Specifies the file set kind to get the files of. If you do not specify this option, the command gets the `QUARTUS_SYNTH` files. Refer to *File Set Kind*.

**Example**

```plaintext
get_instantiation_hdl_files quartus_synth
```

**Related Information**

- `load_instantiation` on page 179
- `save_instantiation` on page 183
- *File Set Kind* on page 291
1.19.7.4.10. get_instantiation_interface_assignment_value

**Description**
Gets the assignment value of the loaded instantiation's interface.

**Usage**
get_instantiation_interface_assignment_value <interface> <name>

**Returns**
String  The assignment value

**Arguments**

*interface*  Specifies the interface name.

*nname*  Specifies the assignment name to get the value of.

**Example**

get_instantiation_interface_assignment_value avs_s0 embeddedsw.configuration.exceptionOffset

**Related Information**

- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.11. `get_instantiation_interface_assignments`

**Description**
Gets the assignment names of the loaded instantiation's interface.

**Usage**
```
get_instantiation_interface_assignments <interface>
```

**Returns**
`String[]` The list of assignment names.

**Arguments**

- `interface` Specifies the interface name.

**Example**
```
get_instantiation_interface_assignments avs_s0
```

**Related Information**
- `load_instantiation` on page 179
- `save_instantiation` on page 183
1.19.7.4.12. get_instantiation_interface_parameter_value

**Description**
Returns the parameter value of a loaded instantiation's interface.

**Usage**
get_instantiation_interface_parameter_value <interface> <parameter>

**Returns**
String  The parameter value.

**Arguments**

*interface*  Specifies the interface name.

*parameter*  Specifies the parameter name.

**Example**
get_instantiation_interface_parameter_value avs_s0 associatedClock

**Related Information**
- get_instantiation_interface_parameters on page 166
- set_instantiation_interface_parameter_value on page 187
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.13. get_instantiation_interface_parameters

**Description**
Returns the list of parameters of an instantiation's interface.

**Usage**
get_instantiation_interface_parameters <interface>

**Returns**

String[] The list of parameter names.

**Arguments**

interface Specifies the interface name.

**Example**

get_instantiation_interface_parameters avs_s0

**Related Information**

- load_instantiation on page 179
- save_instantiation on page 183
- get_instantiation_interface_parameter_value on page 165
- set_instantiation_interface_parameter_value on page 187
1.19.7.4.14. get_instantiation_interface_port_properties

**Description**
Returns the list of port properties of an instantiation's interface.

**Usage**
get_instantiation_interface_port_properties

**Returns**
String[] The list of port properties.

**Arguments**
No arguments

**Example**
get_instantiation_interface_port_properties

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.15. get_instantiation_interface_port_property

Description
Returns the port property value of a loaded instantiation's interface.

Usage
get_instantiation_interface_port_property <interface> <port> <property>

Returns
various The property value.

Arguments
interface Specifies the interface name.

port Specifies the port name.

property Specifies the property name. Refer to Port Properties.

Example
get_instantiation_interface_port_property avs_s0 avs_s0_address WIDTH

Related Information
- load_instantiation on page 179
- save_instantiation on page 183
- Port Properties on page 297
1.19.7.4.16. get_instantiation_interface_ports

Description
Returns the list of ports of the loaded instantiation’s interface.

Usage
get_instantiation_interface_ports <interface>

Returns
String[]  The list of port names.

Arguments

interface  Specifies the interface name.

Example
get_instantiation_interface_ports avs_s0

Related Information
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.17. get\_instantiation\_interface\_property

**Description**
Returns the value of a single interface property from the specified instantiation interface.

**Usage**
get\_instantiation\_interface\_property <\textit{interface}> <\textit{property}>

**Returns**

\textit{various} The property value.

**Arguments**

\textit{interface} The interface name on the currently loaded interface.

\textit{property} The property name. Refer to \textit{Instantiation Interface Properties}.

**Example**

get\_instantiation\_interface\_property in\_clk TYPE

**Related Information**
- get\_instantiation\_interface\_properties on page 171
- load\_instantiation on page 179
- Instantiation Interface Properties on page 295
1.19.7.4.18. get_instantiation_interface_properties

**Description**
Returns the names of all the available instantiation interface properties, common to all interface types.

**Usage**
get_instantiation_interface_properties

**Returns**
String[] A list of instantiation interface properties.

**Arguments**
No arguments.

**Example**

```
get_instantiation_interface_properties
```

**Related Information**
get_instantiation_interface_property on page 170
1.19.7.4.19. **get_instantiation_interface_sysinfo_parameter_value**

**Description**
Gets the system info parameter value for a loaded instantiation’s interface.

**Usage**
ge`t_instantiation_interface_sysinfo_parameter_value <interface> <parameter>

**Returns**

*various*  The system info property value.

**Arguments**

*interface*  Specifies the interface name.

*parameter*  Specifies the system info parameter name. Refer to *System Info Type*.

**Example**

```
get_instantiation_interface_sysinfo_parameter_value debug_mem_slave max_slave_data_width
```

**Related Information**

- [get_instantiation_interface_sysinfo_parameters](#) on page 173
- [set_instantiation_interface_sysinfo_parameter_value](#) on page 189
- [System Info Type Properties](#) on page 286
1.19.7.4.20. get_instantiation_interface_sysinfo_parameters

Description
Returns the list of system info parameters for the loaded instantiation's interface.

Usage
get_instantiation_interface_sysinfo_parameters <interface> [ <type> ]

Returns
String[] The list of system info parameter names.

Arguments

interface Specifies the interface name.

type (optional) Specifies the parameters type to return. If you do not specify this option, the command returns all the parameters. Refer to Access Type.

Example
get_instantiation_interface_sysinfo_parameters debug_mem_slave

Related Information
- get_instantiation_interface_sysinfo_parameter_value on page 172
- set_instantiation_interface_sysinfo_parameter_value on page 189
- Access Type on page 292
1.19.7.4.21. get_instantiation_interfaces

**Description**
Returns the list of interfaces for the loaded instantiation.

**Usage**
get_instantiation_interfaces

**Returns**
String[] The list of interface names.

**Arguments**
No arguments.

**Example**
get_instantiation_interfaces

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.22. get_instantiation_properties

**Description**
Returns the list of properties for the loaded instantiation.

**Usage**
get_instantiation_properties

**Returns**

*String[]* The list of property names.

**Arguments**
No arguments.

**Example**
```
get_instantiation_properties
```

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.23. get_instantiation_property

Description
Returns the value of the specified property for the loaded instantiation.

Usage
get_instantiation_property <property>

Returns
various The value of an instantiation property.

Arguments

property Specifies the property name to get the value of. Refer to Instantiation Properties.

Example

get_instantiation_property HDL_ENTITY_NAME

Related Information
- load_instantiation on page 179
- save_instantiation on page 183
- Instantiation Properties on page 296
1.19.7.4.24. get_loaded_instantiation

**Description**
Returns the instance name of the loaded instantiation.

**Usage**
geet_loaded_instantiation

**Returns**

*String*  The instance name.

**Arguments**
No arguments

**Example**

get_loaded_instantiation

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.25. import_instantiation_interfaces

Description
Sets the interfaces of a loaded instantiation, by importing the interfaces from the specified file.

Usage
import_instantiation_interfaces <file>

Returns
No return value

Arguments

file Specifies the The IP or IP-XACT file to import the interfaces from.

Example

import_instantiation_interfaces ip/my_system/my_system_nios2_gen2_0.ip

Related Information
• load_instantiation on page 179
• save_instantiation on page 183
1.19.7.4.26. load_instantiation

Description
Loads the instantiation of an instance, so that you can modify the instantiation if necessary.

Usage
load_instantiation <instance>

Returns

boolean 1 if successful; 0 if unsuccessful.

Arguments

instance Specifies the instance name.

Example

load_instantiation cpu

Related Information

save_instantiation on page 183
1.19.7.4.27. remove_instantiation_hdl_file

Description
Removes an HDL file from the loaded instantiation.

Usage
remove_instantiation_hdl_file <file> [<kind>]

Returns
No return value.

Arguments

file  Specifies the HDL file name.

kind (optional)  Specifies the kind of file set to remove the file from. If you do not specify this option, the command removes the file from all the file sets. Refer to File Set Kind.

Example

```
remove_instantiation_hdl_file my_nios2_gen2.vhdl quartus_synth
```

Related Information

- load_instantiation on page 179
- save_instantiation on page 183
- File Set Kind on page 291
1.19.7.4.28. remove_instantiation_interface

Description
Removes an interface from a loaded instantiation.

Usage
remove_instantiation_interface <interface>

Returns
No return value

Arguments

interface  Specifies the interface name.

Example

```
remove_instantiation_interface avs_s0
```

Related Information
- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.4.29. **remove_instantiation_interface_port**

**Description**
Removes a port from a loaded instantiation's interface.

**Usage**
`remove_instantiation_interface_port <interface> <port>`

**Returns**
No return value

**Arguments**

`interface` Specifies the interface name.

`port` Specifies the port name.

**Example**

```
remove_instantiation_interface_port avs_s0 avs_s0_address
```

**Related Information**
- `load_instantiation` on page 179
- `save_instantiation` on page 183
1.19.7.4.30. save_instantiation

**Description**
Saves the loaded instantiation.

**Usage**
save_instantiation

**Returns**
No return value

**Arguments**
No arguments

**Example**

```plaintext
save_instantiation
```

**Related Information**
load_instantiation on page 179
1.19.7.4.31. set_instantiation_assignment_value

**Description**
Sets the assignment value for the loaded instantiation.

**Usage**
set_instantiation_assignment_value <name> [value]

**Returns**
No return value

**Arguments**

*instance*  Specifies the assignment name to set value for.

*value (optional)*  Specifies the assignment value. If you do not specify this option, the command removes the assignment.

**Example**

```
set_instantiation_assignment_value embeddedsw.configuration.exceptionOffset 32
```

**Related Information**

[get_instantiation_assignment_value](#) on page 158
1.19.7.4.32. set_instantiation_hdl_file_property

**Description**
Sets the property value for an HDL file associated with a loaded instantiation.

**Usage**
set_instantiation_hdl_file_property <file> <property> <value>

**Returns**
No return value

**Arguments**

file  Specifies the HDL file name.

property Specifies the property name. Refer to *Instantiation Hdl File Properties*.

value  Specifies the property value.

**Example**

```plaintext
set_instantiation_hdl_file_property my_nios2_gen2.vhdl OUTPUT_PATH
my_nios2_gen2.vhdl
```

**Related Information**

- [load_instantiation on page 179](#)
- [save_instantiation on page 183](#)
- [Instantiation Hdl File Properties on page 293](#)
1.19.7.4.33. set_instantiation_interface_assignment_value

**Description**
Sets the assignment value for the loaded instantiation's interface.

**Usage**

```plaintext
set_instantiation_interface_assignment_value <interface> <name> [value]
```

**Returns**
No return value

**Arguments**

- **interface**  Specifies the interface name.
- **name**  Specifies the assignment name to set the value of.
- **value (optional)**  Specifies the new assignment value. If you do not specify this value, the command removes the assignment.

**Example**

```plaintext
set_instantiation_interface_assignment_value embeddedsw.configuration.exceptionOffset 32
```

**Related Information**

`get_instantiation_assignment_value` on page 158
1.19.7.4.34. set_instantiation_interface_parameter_value

**Description**
Sets the parameter value for the loaded instantiation’s interface.

**Usage**

```plaintext
set_instantiation_interface_parameter_value <interface> <parameter> <value>
```

**Returns**
No return value

**Arguments**

- `instance` Specifies the interface name.
- `parameter` Specifies the parameter name.
- `value` Specifies the parameter value.

**Example**

```plaintext
set_instantiation_interface_parameter avs_s0 associatedClock clk
```

**Related Information**
- `load_instantiation` on page 179
- `save_instantiation` on page 183
- `get_instantiation_interface_parameter_value` on page 165
- `get_instantiation_interface_parameters` on page 166
1.19.7.4.35. set_instantiation_interface_port_property

**Description**
Sets the port property value on a loaded instantiation's interface.

**Usage**
```
set_instantiation_interface_port_property <interface> <port> <property> <value>
```

**Returns**
No return value

**Arguments**

- `interface` Specifies the interface name.
- `port` Specifies the port name.
- `property` Specifies the property name. Refer to *Port Properties*.
- `value` Specifies the property value.

**Example**
```
set_instantiation_interface_port_property avs_s0 avs_s0_address WIDTH 1
```

**Related Information**
- `load_instantiation` on page 179
- `save_instantiation` on page 183
- *Port Properties* on page 297
### 1.19.7.4.36. `set_instantiation_interface_sysinfo_parameter_value`

**Description**
Sets the system info parameter value for the loaded instantiation's interface.

**Usage**
```
set_instantiation_interface_sysinfo_parameter_value <interface> <parameter> <value>
```

**Returns**
No return value

**Arguments**
- `interface` Specifies the interface name.
- `parameter` Specifies the system info parameter name. Refer to `System Info Type`.
- `value` Specifies the system info parameter value.

**Example**
```
set_instantiation_interface_sysinfo_parameter_value debug_mem_slave max_slave_data_width 64
```

**Related Information**
- `get_instantiation_interface_sysinfo_parameter_value` on page 172
- `get_instantiation_interface_sysinfo_parameters` on page 173
- `System Info Type Properties` on page 286
1.19.7.4.37. set_instantiation_property

Description
Sets the property value for the loaded instantiation.

Usage
set_instantiation_property <property> <value>

Returns
No return value

Arguments

property  Specifies the property name. Refer to Instantiation Properties.

value    Specifies the value to set.

Example

| set_instantiation_property HDL_ENTITY_NAME my_system_nios2_gen2_0 |

Related Information

- load_instantiation on page 179
- save_instantiation on page 183
- Instantiation Properties on page 296
1.19.7.5. Components

This section lists the commands that allow you to manipulate the loaded IP components in your Platform Designer system.

apply_component_preset on page 192
get_component_assignment on page 193
get_component_assignments on page 194
get_component_documentation_links on page 195
get_component_interface_assignment on page 196
get_component_interface_assignments on page 197
get_component_interface_parameter_property on page 198
get_component_interface_parameter_value on page 199
get_component_interface_parameters on page 200
get_component_interface_port_property on page 201
get_component_interface_ports on page 202
get_component_interface_property on page 203
get_component_interfaces on page 204
get_component_parameter_property on page 205
get_component_parameter_value on page 206
get_component_parameters on page 207
get_component_project_properties on page 208
get_component_project_property on page 209
get_component_property on page 210
get_loaded_component on page 211
load_component on page 212
reload_component_footprint on page 213
save_component on page 214
set_component_parameter_value on page 215
set_component_project_property on page 216
1.19.7.5.1. apply_component_preset

**Description**
Applies the settings in a preset to the loaded component.

**Usage**
apply_component_preset <preset_name>

**Returns**
No return value

**Arguments**

*preset_name*  Specifies the preset name.

**Example**
apply_component_preset "Custom Debug Settings"

**Related Information**
- load_component on page 212
- set_component_parameter_value on page 215
1.19.7.5.2. get_component_assignment

Description
Returns the assignment value for the loaded component.

Usage
get_component_assignment <assignment>

Returns
String The specified assignment value.

Arguments

assignment Specifies the assignment key value to query.

Example
get_component_assignment embeddedsw.CMacro.colorSpace

Related Information
- load_component on page 212
- get_component_assignments on page 194
1.19.7.5.3. get_component_assignments

Description
Returns the list of assignment keys for the loaded component.

Usage
get_component_assignments

Returns

String[] The list of assignment keys.

Arguments
No arguments

Example

```
get_component_assignments
```

Related Information
- `get_instance_assignment` on page 126
- `load_component` on page 212
1.19.7.5.4. get_component_documentation_links

Description
Returns the list of all documentation links that the loaded component provides.

Usage
get_component_documentation_links

Returns
String[] The list of documentation links.

Arguments
No arguments

Example
get_component_documentation_links

Related Information
load_component on page 212
1.19.7.5.5. get_component_interface_assignment

Description
Returns the assignment value of an interface of the loaded component.

Usage
get_component_interface_assignment <interface> <assignment>

Returns
String  The specified assignment value.

Arguments
interface  Specifies the interface name.

assignment  Specifies the assignment key to the query.

Example
get_component_interface_assignment s1 embeddedsw.configuration.isFlash

Related Information
- get_component_interface_assignments on page 197
- load_component on page 212
1.19.7.5.6. get_component_interface_assignments

**Description**

Returns the list of assignment keys for any assignments that you define for an interface on the loaded component.

**Usage**

```
get_component_interface_assignments <interface>
```

**Returns**

`String[]`  The list of assignment keys.

**Arguments**

`interface`  Specifies the interface name.

**Example**

```
get_component_interface_assignments s1
```

**Related Information**

- `get_component_interface_assignment` on page 196
- `load_component` on page 212
1.19.7.5.7. get_component_interface_parameter_property

Description
Returns the property value of a parameter in a loaded component's interface. Parameter properties are metadata about how the Intel Quartus Prime uses the parameters.

Usage
get_component_interface_parameter_property <interface> <parameter> <property>

Returns

various The parameter property value.

Arguments

interface Specifies the interface name.

parameter Specifies the parameter name.

property Specifies the parameter property. Refer to Parameter Properties.

Example

get_component_interface_parameter_property s0 setupTime ENABLED

Related Information

- get_component_interface_parameters on page 200
- get_component_interfaces on page 204
- load_component on page 212
- Parameter Properties on page 280
- get_parameter_properties on page 260
1.19.7.5.8. get_component_interface_parameter_value

**Description**
Returns the parameter value of an interface of the loaded component.

**Usage**
```
get_component_interface_parameter_value <interface> <parameter>
```

**Returns**
```
various  The parameter value.
```

**Arguments**
- `interface` Specifies the interface name.
- `parameter` Specifies the parameter name.

**Example**
```
get_component_interface_parameter_value s0 setupTime
```

**Related Information**
- `get_component_interface_parameters` on page 200
- `get_component_interfaces` on page 204
- `load_component` on page 212
1.19.7.5.9. `get_component_interface_parameters`

**Description**
Returns the list of parameters for an interface of the loaded component.

**Usage**
```
get_component_interface_parameters <interface>
```

**Returns**

`String[]` The list of parameter names.

**Arguments**

`interface` Specifies the interface name.

**Example**
```
get_component_interface_parameters s0
```

**Related Information**
- `get_component_interface_parameter_value` on page 199
- `get_component_interfaces` on page 204
- `load_component` on page 212
1.19.7.5.10. get_component_interface_port_property

**Description**
Returns the property value of a port in the interface of the loaded component.

**Usage**
get_component_interface_port_property <interface> <port> <property>

**Returns**

various  The port property value

**Arguments**

interface  Specifies the interface name.

port  Specifies the port name of the interface.

property  Specifies the property name of the port. Refer to Port Properties.

**Example**

```plaintext
get_component_interface_port_property exports tx WIDTH
```

**Related Information**

- get_component_interface_ports on page 202
- load_component on page 212
- Port Properties on page 297
- get_port_properties on page 238
1.19.7.5.11. get_component_interface_ports

**Description**
Returns the list of interface ports of the loaded component.

**Usage**
get_component_interface_ports <interface>

**Returns**

String[]  The list of port names

**Arguments**

interface  Specifies the interface name.

**Example**

```
get_component_interface_ports s0
```

**Related Information**
- get_component_interface_port_property on page 201
- get_component_interfaces on page 204
- load_component on page 212
1.19.7.5.12. get_component_interface_property

Description
Returns the value of a single property from the specified interface for the loaded component.

Usage
get_component_interface_property <interface> <property>

Returns
String  The property value.

Arguments

interface  Specifies the interface name.

property  Specifies the property name. Refer to Element Properties.

Example
get_interface_property clk_in DISPLAY_NAME

Related Information
- load_component on page 212
- Element Properties on page 275
- get_interface_properties on page 235
1.19.7.5.13. get_component_interfaces

**Description**
Returns the list of interfaces in the loaded component.

**Usage**
get_component_interfaces

**Returns**

*String[]* The list of interface names.

**Arguments**
No arguments

**Example**
```java
get_component_interfaces
```

**Related Information**
- *get_component_interface_ports* on page 202
- *get_component_interface_property* on page 203
- *load_component* on page 212
1.19.7.5.14. get_component_parameter_property

**Description**
Returns the property value of a parameter in the loaded component.

**Usage**
get_component_parameter_property <parameter> <property>

**Returns**
Various  The parameter property value.

**Arguments**

*parameter*  Specifies the parameter name in the component.

*property*  Specifies the property name of the parameter. Refer to Parameter Properties.

**Example**
get_component_parameter_property baudRate ENABLED

**Related Information**
-  [get_component_parameters](#) on page 207
-  [get_parameter_properties](#) on page 260
-  [load_component](#) on page 212
-  Parameter Properties on page 280
1.19.7.5.15. get_component_parameter_value

**Description**
Returns the parameter value in the loaded component.

**Usage**
get_component_parameter_value \(<\text{parameter}>\)

**Returns**

```
various  The parameter value
```

**Arguments**

*parameter*  Specifies the parameter name in the component.

**Example**

```
get_component_parameter_value baudRate
```

**Related Information**

- [get_component_parameters on page 207](#)
- [load_component on page 212](#)
- [set_component_parameter_value on page 215](#)
1.19.7.5.16. get_component_parameters

Description
Returns the list of parameters in the loaded component.

Usage
get_component_parameters

Returns

String[] The list of parameters in the component.

Arguments
No arguments

Example

get_instance_parameters

Related Information
- get_component_parameter_property on page 205
- get_component_parameter_value on page 206
- load_component on page 212
- set_component_parameter_value on page 215
1.19.7.5.17. get_component_project_properties

**Description**

Returns the list of properties that you query about the loaded component's Intel Quartus Prime project.

**Usage**

get_component_project_properties

**Returns**

*String[]*  The list of project properties.

**Arguments**

No arguments

**Example**

```java
get_component_project_properties
```

**Related Information**

- *get_component_project_property* on page 209
- *load_component* on page 212
- *set_component_project_property* on page 216
1.19.7.5.18. get_component_project_property

Description
Returns the project property value of the loaded component. Only select project
properties are available.

Usage
get_component_project_property <property>

Returns
String  The property value.

Arguments

property  Specifies the project property name. Refer to Project Properties.

Example

get_component_project_property HIDE_FROM_IP_CATALOG

Related Information
•  get_component_project_properties on page 208
•  load_component on page 212
•  set_component_project_property on page 216
•  Project Properties on page 285
1.19.7.5.19. get_component_property

Description
Returns the property value of the loaded component.

Usage
get_component_property <property>

Returns
String  The property value.

Arguments

property  The property name on the loaded component. Refer to Element Properties.

Example

get_component_property CLASS_NAME

Related Information

• load_component on page 212
• get_instance_properties on page 144
• Element Properties on page 275
1.19.7.5.20. get_loaded_component

**Description**
Returns the instance name associated with the loaded component.

**Usage**
get_loaded_component

**Returns**

*String*  The instance name.

**Arguments**
No arguments

**Example**

```
get_loaded_component
```

**Related Information**
- load_component on page 212
- save_component on page 214
### Description

Loads the actual component inside of a generic component, so that you can modify the component parameters.

### Usage

```
load_component <instance>
```

### Returns

`boolean` 1 if successful; 0 if unsuccessful.

### Arguments

- **instance** Specifies the instance name.

### Example

```
load_component cpu
```

### Related Information

- [get_loaded_component](#) on page 211
- [save_component](#) on page 214
1.19.7.5.22. reload_component_footprint

**Description**
Validates the footprint of a specified child instance, and updates the footprint of the instance in case of issues.

**Usage**
reload_component_footprint [\(<\text{instance}>\)]

**Returns**
String[] A list of validation messages.

**Arguments**

- **instance (optional)**
  Specifies the child instance name to validate. If you do not specify this option, the command validates all the generic components in the system.

**Example**

```
reload_component_footprint cpu_0
```

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
- validate_component_footprint on page 252
1.19.7.5.23. save_component

Description
Saves the loaded component.

Usage
save_component

Returns
No return value

Arguments
No arguments

Example
save_component

Related Information
- get_loaded_component on page 211
- load_component on page 212
1.19.7.5.24. set_component_parameter_value

**Description**
Sets the parameter value for the loaded component.

**Usage**
```
set_component_parameter_value <parameter> <value>
```

**Returns**
No return value

**Arguments**

*parameter*  Specifies the parameter name.

*parameter*  Specifies the new parameter value.

**Example**
```
set_component_parameter_value baudRate 9600
```

**Related Information**
- `get_component_parameter_value` on page 206
- `get_component_parameters` on page 207
- `load_component` on page 212
1.19.7.5.25. set_component_project_property

Description
Sets the project property value of the loaded component, such as hiding from the IP catalog.

Usage
set_component_project_property <property> <value>

Returns
No return value

Arguments

property  Specifies the property name. Refer to Project Properties.

value  Specifies the new property value.

Example

set_component_project_property HIDE_FROM_IP_CATALOG false

Related Information

- get_component_project_properties on page 208
- get_component_project_property on page 209
- load_component on page 212
- Project Properties on page 285
1.19.7.6. Connections

This section lists the commands that allow you to manipulate the interface connections in your Platform Designer system.

add_connection on page 218
auto_connect on page 219
get_connection_parameter_property on page 220
get_connection_parameter_value on page 221
get_connection_parameters on page 222
get_connection_properties on page 223
get_connection_property on page 224
get_connections on page 225
remove_connection on page 226
remove_dangling_connections on page 227
set_connection_parameter_value on page 228
1.19.7.6.1. add_connection

Description
Connects the named interfaces using an appropriate connection type. Both interface names consist of an instance name, followed by the interface name that the module provides.

Usage
add_connection <start> [<end>]

Returns
No return value.

Arguments

start  The start interface that you connect, in 
       <instance_name>.<interface_name> format. If you do not specify the end argument, the connection must be of the form <instance1>.<interface>/<instance2>.<interface>.

end (optional)  The end interface that you connect, in 
                <instance_name>.<interface_name> format.

Example
add_connection dma.read_master sdram.s1

Related Information
- get_connection_parameter_value on page 221
- get_connection_property on page 224
- get_connections on page 225
- remove_connection on page 226
- set_connection_parameter_value on page 228
1.19.7.6.2. auto_connect

Description
Creates connections from an instance or instance interface to matching interfaces of other instances in the system. For example, Avalon-MM slaves connect to Avalon-MM masters.

Usage
auto_connect <element>

Returns
No return value.

Arguments

<element> The instance interface name, or the instance name.

Example
auto_connect sdram
auto_connect uart_0.s1

Related Information
add_connection on page 218
1.19.7.6.3. get_connection_parameter_property

**Description**
Returns the property value of a parameter in a connection. Parameter properties are metadata about how Platform Designer uses the parameter.

**Usage**
get_connection_parameter_property <connection> <parameter> <property>

**Returns**
*various*  The parameter property value.

**Arguments**

- **connection**  The connection to query.
- **parameter**  The parameter name.
- **property**  The property of the connection. Refer to *Parameter Properties*.

**Example**
```
get_connection_parameter_property cpu.data_master/dma0 csr baseAddress UNITS
```

**Related Information**
- *get_connection_parameter_value* on page 221
- *get_connection_property* on page 224
- *get_connections* on page 225
- *get_parameter_properties* on page 260
- *Parameter Properties* on page 280
1.19.7.6.4. get_connection_parameter_value

**Description**
Returns the parameter value of the connection. Parameters represent aspects of the connection that you can modify, such as the base address for an Avalon-MM connection.

**Usage**
get_connection_parameter_value <connection> <parameter>

**Returns**
*various* The parameter value.

**Arguments**
- *connection* The connection to query.
- *parameter* The parameter name.

**Example**
```
get_connection_parameter_value cpu.data_master/dma0.csr baseAddress
```

**Related Information**
- [get_connection_parameters](#) on page 222
- [get_connections](#) on page 225
- [set_connection_parameter_value](#) on page 228
1.19.7.6.5. `get_connection_parameters`

**Description**
Returns the list of parameters of a connection.

**Usage**
`get_connection_parameters <connection>`

**Returns**

`String[]` The list of parameter names.

**Arguments**

`connection` The connection to query.

**Example**
```
get_connection_parameters cpu.data_master/dma0.csr
```

**Related Information**
- `get_connection_parameter_property` on page 220
- `get_connection_parameter_value` on page 221
- `get_connection_property` on page 224
1.19.7.6.6. get_connection_properties

**Description**
Returns the properties list of a connection.

**Usage**
get_connection_properties

**Returns**

`String[]`  The list of connection properties.

**Arguments**
No arguments.

**Example**

```get_connection_properties```

**Related Information**
- `get_connection_property` on page 224
- `get_connections` on page 225
1.19.7.6.7. get_connection_property

Description
Returns the property value of a connection. Properties represent aspects of the connection that you can modify, such as the connection type.

Usage
get_connection_property <connection> <property>

Returns
String  The connection property value.

Arguments
connection  The connection to query.

property  The connection property name. Refer to Connection Properties.

Example

get_connection_property cpu.data_master/dma0.csr TYPE

Related Information
• get_connection_properties on page 223
• Connection Properties on page 272
1.19.7.6.8. get_connections

Description
Returns the list of all connections in the system if you do not specify any element. If you specify a child instance, for example cpu, Platform Designer returns all connections to any interface on the instance. If you specify an interface of a child instance, for example cpu.instruction_master, Platform Designer returns all connections to that interface.

Usage
get_connections [<element>]

Returns
String[] The list of connections.

Arguments

element (optional) The child instance name, or the qualified interface name on a child instance.

Example

<table>
<thead>
<tr>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>get_connections</td>
</tr>
<tr>
<td>get_connections cpu</td>
</tr>
<tr>
<td>get_connections cpu.instruction_master</td>
</tr>
</tbody>
</table>

Related Information
- add_connection on page 218
- remove_connection on page 226
1.19.7.6.9. `remove_connection`

**Description**
Removes a connection from the system.

**Usage**
`remove_connection <connection>`

**Returns**
No return value.

**Arguments**

`connection`  The connection name to remove.

**Example**

```
remove_connection cpu.data_master/sdram.s0
```

**Related Information**
- `add_connection` on page 218
- `get_connections` on page 225
1.19.7.6.10. remove_dangling_connections

Description
Removes connections where both end points of the connection no longer exist in the system.

Usage
remove_dangling_connections

Returns
No return value.

Arguments
No arguments.

Example
remove_dangling_connections

Related Information
- add_connection on page 218
- get_connections on page 225
- remove_connection on page 226
1.19.7.6.11. set_connection_parameter_value

Description
Sets the parameter value for a connection.

Usage
set_connection_parameter_value <connection> <parameter> <value>

Returns
No return value.

Arguments

connection The connection name.

parameter The parameter name.

value The new parameter value.

Example

set_connection_parameter_value cpu.data_master/dma0.csr baseAddress "0x000a0000"

Related Information

- get_connection_parameter_value on page 221
- get_connection_parameters on page 222
1.19.7.7. Top-level Exports

This section lists the commands that allow you to manipulate the exported interfaces in your Platform Designer system.

- `add_interface` on page 230
- `get_exported_interface_sysinfo_parameter_value` on page 231
- `get_exported_interface_sysinfo_parameters` on page 232
- `get_interface_port_property` on page 233
- `get_interface_ports` on page 234
- `get_interface_properties` on page 235
- `get_interface_property` on page 236
- `get_interfaces` on page 237
- `get_port_properties` on page 238
- `remove_interface` on page 239
- `set_exported_interface_sysinfo_parameter_value` on page 240
- `set_interface_port_property` on page 241
- `set_interface_property` on page 242
1.19.7.7.1. add_interface

**Description**

Adds an interface to your system, which Platform Designer uses to export an interface from within the system. You specify the exported internal interface with `set_interface_property <interface> EXPORT_OF instance.interface`.

**Usage**

`add_interface <name> <type> <direction>`.  

**Returns**

No return value.

**Arguments**

- **name**  The name of the interface that Platform Designer exports from the system.
- **type**  The type of interface.
- **direction**  The interface direction.

**Example**

```
add_interface my_export conduit end
set_interface_property my_export EXPORT_OF uart_0.external_connection
```

**Related Information**

- `get_interface_ports` on page 234
- `get_interface_properties` on page 235
- `get_interface_property` on page 236
- `set_interface_property` on page 242
### 1.19.7.7.2. get_exported_interface_sysinfo_parameter_value

**Description**
Gets the value of a system info parameter for an exported interface.

**Usage**
```
get_exported_interface_sysinfo_parameter_value <interface>
<parameter>
```

**Returns**

*various*   The system info parameter value.

**Arguments**

*interface*  Specifies the name of the exported interface.

*parameter*  Specifies the name of the system info parameter. Refer to *System Info Type*.

**Example**
```
get_exported_interface_sysinfo_parameter_value clk clock_rate
```

**Related Information**
- [get_exported_interface_sysinfo_parameters](#) on page 232
- [set_exported_interface_sysinfo_parameter_value](#) on page 240
- [System Info Type Properties](#) on page 286
1.19.7.7.3. get_exported_interface_sysinfo_parameters

Description
Returns the list of system info parameters for an exported interface.

Usage
get_exported_interface_sysinfo_parameters <interface> [<type>]

Returns
String[] The list of system info parameter names.

Arguments

interface Specifies the name of the exported interface.

type (optional) Specifies the parameters type to return. If you do not specify this option, the command returns all the parameters. Refer to Access Type.

Example
get_exported_interface_sysinfo_parameters clk

Related Information
- get_exported_interface_SYSINFO_PARAMETER_VALUE on page 231
- set_exported_interface_SYSINFO_PARAMETER_VALUE on page 240
- Access Type on page 292
1.19.7.7.4. get_interface_port_property

Description
Returns the value of a property of a port contained by one of the top-level exported interfaces.

Usage
get_interface_port_property <interface> <port> <property>

Returns
various  The property value.

Arguments
interface  The name of a top-level interface of the system.

port  The port name in the interface.

property  The property name on the port. Refer to Port Properties.

Example
get_interface_port_property uart_exports tx DIRECTION

Related Information
- get_interface_ports on page 234
- get_port_properties on page 238
- Port Properties on page 284
1.19.7.7.5. get_interface_ports

**Description**
Returns the names of all the added ports to a given interface.

**Usage**
get_interface_ports <interface>

**Returns**

String[] The list of port names.

**Arguments**

interface The top-level interface name of the system.

**Example**

```
get_interface_ports export_clk_out
```

**Related Information**
- get_interface_port_property on page 233
- get_interfaces on page 237
1.19.7.7.6. get_interface_properties

**Description**
Returns the names of all the available interface properties common to all interface types.

**Usage**
get_interface_properties

**Returns**

`String[]` The list of interface properties.

**Arguments**
No arguments.

**Example**

```
get_interface_properties
```

**Related Information**

- `get_interface_property` on page 236
- `set_interface_property` on page 242
1.19.7.7.7. get_interface_property

Description
Returns the value of a single interface property from the specified interface.

Usage
get_interface_property <interface> <property>

Returns
various The property value.

Arguments
interface The name of a top-level interface of the system.

property The name of the property. Refer to Interface Properties.

Example
get_interface_property export_clk_out EXPORT_OF

Related Information
- get_interface_properties on page 235
- set_interface_property on page 242
- Interface Properties on page 277
1.19.7.7.8. get_interfaces

**Description**
Returns the list of top-level interfaces in the system.

**Usage**
get_interfaces

**Returns**

*String[]* The list of the top-level interfaces exported from the system.

**Arguments**
No arguments.

**Example**

```
get_interfaces
```

**Related Information**
- add_interface on page 230
- get_interface_ports on page 234
- get_interface_property on page 236
- remove_interface on page 239
- set_interface_property on page 242
1.19.7.7.9. get_port_properties

Description
Returns the list of properties that you can query for ports.

Usage
get_port_properties

Returns

String[] The list of port properties.

Arguments
No arguments.

Example

get_port_properties

Related Information
- get_instance_interface_port_property on page 134
- get_instance_interface_ports on page 135
- get_instance_port_property on page 143
- get_interface_port_property on page 233
- get_interface_ports on page 234
1.19.7.7.10. remove_interface

**Description**
Removes an exported top-level interface from the system.

**Usage**
remove_interface <interface>

**Returns**
No return value.

**Arguments**

*interface*   The name of the exported top-level interface.

**Example**

```
remove_interface clk_out
```

**Related Information**
- [add_interface](#) on page 230
- [get_interfaces](#) on page 237
1.19.7.7.11. set_exported_interface_sysinfo_parameter_value

Description
Sets the system info parameter value for an exported interface.

Usage
set_exported_interface_sysinfo_parameter_value <interface> <parameter> <value>

Returns
No return value

Arguments

interface  Specifies the name of the exported interface.

parameter  Specifies the name of the system info parameter. Refer to System Info Type.

value  Specifies the system info parameter value.

Example

set_exported_interface_sysinfo_parameter_value clk clock_rate 5000000

Related Information

- get_exported_interface_sysinfo_parameter_value on page 231
- get_exported_interface_sysinfo_parameters on page 232
- System Info Type Properties on page 286
1.19.7.12. set_interface_port_property

**Description**
Sets the port property in a top-level interface of the system.

**Usage**
set_interface_port_property <interface> <port> <property> <value>

**Returns**
No return value

**Arguments**

*interface*  
Specifies the top-level interface name of the system.

*port*  
Specifies the port name in a top-level interface of the system.

*property*  
Specifies the property name of the port. Refer to *Port Properties*.

*value*  
Specifies the property value.

**Example**
```
set_interface_port_property clk clk_clk NAME my_clk
```

**Related Information**
- Port Properties on page 297
- get_interface_ports on page 234
- get_interfaces on page 237
- get_port_properties on page 238
1.19.7.7.13. set_interface_property

**Description**
Sets the value of a property on an exported top-level interface. You use this command to set the EXPORT_OF property to specify which interface of a child instance is exported via this top-level interface.

**Usage**
set_interface_property <interface> <property> <value>

**Returns**
No return value.

**Arguments**

*interface* The name of an exported top-level interface.

*property* The name of the property. Refer to *Interface Properties*.

*value* The property value.

**Example**

```plaintext```
set_interface_property clk_out EXPORT_OF clk.clk_out
```

**Related Information**
- `add_interface` on page 230
- `get_interface_properties` on page 235
- `get_interface_property` on page 236
- `Interface Properties` on page 277
1.19.7.8. Validation

This section lists the commands that allow you to validate the components, instances, interfaces and connections in your Platform Designer system.

- `set_validation_property` on page 244
- `sync_sysinfo_parameters` on page 245
- `validate_component` on page 246
- `validate_component_interface` on page 247
- `validate_connection` on page 248
- `validate_instance` on page 249
- `validate_instance_interface` on page 250
- `validate_system` on page 251
- `validate_component_footprint` on page 252
- `reload_component_footprint` on page 213
1.19.7.8.1. set_validation_property

Description
Sets a property that affects how and when validation is run. To disable system validation after each scripting command, set AUTOMATIC_VALIDATION to False.

Usage
set_validation_property <property> <value>

Returns
No return value.

Arguments

property The name of the property. Refer to Validation Properties.

value The new property value.

Example

set_validation_property AUTOMATIC_VALIDATION false

Related Information

- validate_system on page 251
- Validation Properties on page 289
1.19.7.8.2. sync_sysinfo_parameters

Description
Updates the system info parameters of the specified generic component.

Usage
sync_sysinfo_parameters [instance]

Returns
String[] A list of update messages.

Arguments

instance (optional) Specifies the name of the instance to sync. If you do not specify this option, the command synchronizes all the generic components in the system.

Example

```
sync_sysinfo_parameters cpu_0
```

Related Information

- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.8.3. validate_component

Description
Validates the loaded component.

Usage
validate_component

Returns

String[] A list of validation messages.

Arguments
No arguments

Example
validate_component

Related Information
- validate_component_interface on page 247
- load_component on page 212
1.19.7.8.4. `validate_component_interface`

**Description**
Validates an interface of the loaded component.

**Usage**
`validate_component_interface <interface>`

**Returns**
`String[]` List of validation messages

**Arguments**

`instance` Specifies the name of the instance for the loaded component.

**Example**

```
validate_instance_interface data_master
```

**Related Information**
- `load_component` on page 212
- `validate_component` on page 246
1.19.7.8.5. validate_connection

Description
Validates the specified connection and returns validation messages.

Usage
validate_connection <connection>

Returns
A list of validation messages.

Arguments

calendar  The connection name to validate.

Example

validate_connection cpu.data_master/sdram.s1

Related Information
- validate_instance on page 249
- validate_instance_interface on page 250
- validate_system on page 251
1.19.7.8.6. validate_instance

Description
Validates the specified child instance and returns validation messages.

Usage
validate_instance <instance>

Returns
A list of validation messages.

Arguments

instance  The child instance name to validate.

Example

validate_instance cpu

Related Information
- validate_connection on page 248
- validate_instance_interface on page 250
- validate_system on page 251
1.19.7.8.7. validate_instance_interface

**Description**
Validates an interface of an instance and returns validation messages.

**Usage**
validate_instance_interface <instance> <interface>

**Returns**
A list of validation messages.

**Arguments**

*instance*  The child instance name.

*interface*  The interface to validate.

**Example**

```
validate_instance_interface cpu data_master
```

**Related Information**

- validate_connection on page 248
- validate_instance on page 249
- validate_system on page 251
1.19.7.8.8. validate_system

**Description**
Validates the system and returns validation messages.

**Usage**
validate_system

**Returns**
A list of validation messages.

**Arguments**
No arguments.

**Example**
```
validate_system
```

**Related Information**
- validate_connection on page 248
- validate_instance on page 249
- validate_instance_interface on page 250
1.19.7.8.9. validate_component_footprint

**Description**
Validates the footprint of the specified child instance.

**Usage**
validate_component_footprint <instance>

**Returns**

String[] List of validation messages.

**Arguments**

instance (optional) Specifies the child instance name. If you omit this option, the command validates all generic components in the system.

**Example**

```
validate_component_footprint cpu_0
```

**Related Information**

- load_instantiation on page 179
- save_instantiation on page 183
1.19.7.8.10. reload_component_footprint

**Description**
Validates the footprint of a specified child instance, and updates the footprint of the instance in case of issues.

**Usage**
reload_component_footprint [<instance>]

**Returns**
String[] A list of validation messages.

**Arguments**

instance (optional) Specifies the child instance name to validate. If you do not specify this option, the command validates all the generic components in the system.

**Example**

```
reload_component_footprint cpu_0
```

**Related Information**
- load_instantiation on page 179
- save_instantiation on page 183
- validate_component_footprint on page 252
1.19.7.9. Miscellaneous

This section lists the miscellaneous commands that you can use for your Platform Designer systems.

- auto_assign_base_addresses on page 255
- auto_assign_irqs on page 256
- auto_assign_system_base_addresses on page 257
- get_interconnect_requirement on page 258
- get_interconnect_requirements on page 259
- get_parameter_properties on page 260
- lock_avalon_base_address on page 261
- send_message on page 262
- set_interconnect_requirement on page 263
- set_use_testbench_naming_pattern on page 264
- unlock_avalon_base_address on page 265
- get_testbench_dutname on page 266
- get_use_testbench_naming_pattern on page 267
1.19.7.9.1. auto_assign_base_addresses

**Description**
Assigns base addresses to all memory-mapped interfaces of an instance in the system. Instance interfaces that are locked with `lock_avalon_base_address` keep their addresses during address auto-assignment.

**Usage**
`auto_assign_base_addresses <instance>`

**Returns**
No return value.

**Arguments**

`instance`  The name of the instance with memory-mapped interfaces.

**Example**
```
auto_assign_base_addresses sdom
```

**Related Information**
- `auto_assign_system_base_addresses` on page 257
- `lock_avalon_base_address` on page 261
- `unlock_avalon_base_address` on page 265
1.19.7.9.2. auto_assign_irqs

Description
Assigns interrupt numbers to all connected interrupt senders of an instance in the system.

Usage
auto_assign_irqs <instance>

Returns
No return value.

Arguments

instance The name of the instance with an interrupt sender.

Example

auto_assign_irqs uart_0
1.19.7.9.3. auto_assign_system_base_addresses

**Description**
Assigns legal base addresses to all memory-mapped interfaces of all instances in the system. Instance interfaces that are locked with `lock_avalon_base_address` keep their addresses during address auto-assignment.

**Usage**
`auto_assign_system_base_addresses`

**Returns**
No return value.

**Arguments**
No arguments.

**Example**
```
auto_assign_system_base_addresses
```

**Related Information**
- `auto_assign_base_addresses` on page 255
- `lock_avalon_base_address` on page 261
- `unlock_avalon_base_address` on page 265
1.19.7.9.4. get_interconnect_requirement

Description
Returns the value of an interconnect requirement for a system or interface of a child instance.

Usage
get_interconnect_requirement <element_id> <requirement>

Returns
String The value of the interconnect requirement.

Arguments

  element_id  ($system) for the system, or the qualified name of the interface of an instance, in <instance>.<interface> format. In Tcl, the system identifier is escaped, for example, ($system).

  requirement  The name of the requirement.

Example

  get_interconnect_requirement {$system} qsys_mm.maxAdditionalLatency
1.19.7.9.5. get_interconnect_requirements

Description
Returns the list of all interconnect requirements in the system.

Usage
get_interconnect_requirements

Returns

String[] A flattened list of interconnect requirements. Every sequence of three elements in the list corresponds to one interconnect requirement. The first element in the sequence is the element identifier. The second element is the requirement name. The third element is the value. You can loop over the returned list with a foreach loop, for example:

```bash
foreach { element_id name value } $requirement_list { loop_body }
```

Arguments
No arguments.

Example

get_interconnect_requirements
1.19.7.9.6. get_parameter_properties

**Description**
Returns the list of properties that you can query for any parameters, for example parameters of instances, interfaces, instance interfaces, and connections.

**Usage**
get_parameter_properties

**Returns**

`String[]` The list of parameter properties.

**Arguments**
No arguments.

**Example**

```
get_parameter_properties
```

**Related Information**
- `get_connection_parameter_property` on page 220
- `get_instance_interface_parameter_property` on page 131
- `get_instance_parameter_property` on page 139
1.19.7.9.7. lock_avalon_base_address

**Description**
Prevents the memory-mapped base address from being changed for connections to the specified interface of an instance when Platform Designer runs the `auto_assign_base_addresses` or `auto_assign_system_base_addresses` commands.

**Usage**
`lock_avalon_base_address <instance.interface>`

**Returns**
No return value.

**Arguments**

`instance.interface` The qualified name of the interface of an instance, in `<instance>.<interface>` format.

**Example**

```plaintext
lock_avalon_base_address sdram.s1
```

**Related Information**
- `auto_assign_base_addresses` on page 255
- `auto_assign_system_base_addresses` on page 257
- `unlock_avalon_base_address` on page 265
1.19.7.9.8. send_message

Description
Sends a message to the user of the component. The message text is normally HTML. You can use the <b> element to provide emphasis. If you do not want the message text to be HTML, then pass a list like { Info Text } as the message level.

Usage
send_message <level> <message>

Returns
No return value.

Arguments

level Intel Quartus Prime supports the following message levels:

- ERROR—provides an error message.
- WARNING—provides a warning message.
- INFO—provides an informational message.
- PROGRESS—provides a progress message.
- DEBUG—provides a debug message when debug mode is enabled.

message The text of the message.

Example

send_message ERROR "The system is down!"
send_message { Info Text } "The system is up!"
1.19.7.9.9. set_interconnect_requirement

**Description**
Sets the value of an interconnect requirement for a system or an interface of a child instance.

**Usage**
set_interconnect_requirement <element_id> <requirement> <value>

**Returns**
No return value.

**Arguments**

*element_id*  
{$system} for the system, or qualified name of the interface of an instance, in <instance>..<interface> format. In Tcl, the system identifier is escaped, for example, {$system}.

*requirement*  
The name of the requirement.

*value*  
The requirement value.

**Example**

```
set_interconnect_requirement {$system} qsys_mm.clockCrossingAdapter HANDSHAKE
```
1.19.7.9.10. set_use_testbench_naming_pattern

Description
Use this command to create testbench systems so that the generated file names for
the test system match the system's original generated file names. Without setting this
command, the generated file names for the test system receive the top-level
testbench system name.

Usage
set_use_testbench_naming_pattern <value>

Returns
No return value.

Arguments
value  True or false.

Example
set_use_testbench_naming_pattern true

Notes
Use this command only to create testbench systems.
1.19.7.9.11. unlock_avalon_base_address

**Description**
Allows the memory-mapped base address to change for connections to the specified interface of an instance when Platform Designer runs the `auto_assign_base_addresses` or `auto_assign_system_base_addresses` commands.

**Usage**
`unlock_avalon_base_address <instance.interface>`

**Returns**
No return value.

**Arguments**

`instance.interface` The qualified name of the interface of an instance, in `<instance>.<interface>` format.

**Example**
```
unlock_avalon_base_address sdram.s1
```

**Related Information**
- `auto_assign_base_addresses` on page 255
- `auto_assign_system_base_addresses` on page 257
- `lock_avalon_base_address` on page 261
1.19.7.9.12. get_testbench_dutname

**Description**

Returns the currently set dutname for the test-bench systems. Use this command only when creating test-bench systems.

**Usage**

get_testbench_dutname

**Returns**

*String*  The currently set dutname. Returns NULL if empty.

**Arguments**

No arguments.

**Example**

```
get_testbench_dutname
```

**Related Information**

- [get_use_testbench_naming_pattern](#) on page 267
- [set_use_testbench_naming_pattern](#) on page 264
1.19.7.13. get_use_testbench_naming_pattern

Description
Verifies if the test-bench naming pattern is set to be used. Use this command only when creating test-bench systems.

Usage
get_use_testbench_naming_pattern

Returns
boolean  True, if the test-bench naming pattern is set to be used.

Arguments
No arguments.

Example
get_use_testbench_naming_pattern

Related Information
• get_testbench_dutname on page 266
• set_use_testbench_naming_pattern on page 264

1.19.7.10. Wire-Level Connection Commands

Wire-level commands accept optional input ports and wire-level expressions as arguments for the qsys-script utility and in _hw.tcl files.

You can use wire-level commands to:
• Apply a wire-level expression to a port with set_wirelevel_expression.
• Retrieve a list of expressions from a port, instance, or all expressions in the current level of system hierarchy with get_wirelevel_expression.
• Remove a list of expressions from a port, instance, or all expressions in the current level of system hierarchy with remove_wirelevel_expression.

Note: The following restrictions apply when using wire-level commands _hw.tcl files:
• Wire-level commands are only valid in a composition callback.
• Wire-level expressions can only be applied to instances created by add_instance.

Related Information
• Scripting Flow for Wire-Level Expressions on page 30
• Wire-Level Connectivity on page 23
• Create a Composed Component or Subsystem on page 336
1.19.7.10.1. set_wirelevel_expression

Description
Applies a wire-level expression to an optional input port or instance in the system.

Usage
set_wirelevel_expression <instance_or_port_bitselection> <expression>

Returns
No return value.

Arguments

instance_or_port_bitselection Specify the instance or port to which the wire-level expression using the <instance_name>).<port_name>[<bit_selection>] format. The bit selection can be a bit-select, for example [0], or a partial range defined in descending order, for example [7:0]. If no bit selection is specified, the full range of the port is selected.

expression The expression to be applied to an optional input port.

Examples

set_wirelevel_expression {module0.portA[7:0]} "8'b0"
set_wirelevel_expression module0.portA "8'b0"
set_wirelevel_expression {module0.portA[0]} "1'b0"

Related Information
- Scripting Flow for Wire-Level Expressions on page 30
- Wire-Level Connectivity on page 23

1.19.7.10.2. get_wirelevel_expressions

Description
Retrieve a list of wire-level expressions from an optional input port, instance, or all expressions in the current level of system hierarchy. If the port bit selection is specified as an argument, the range must be identical to what was used in the set_wirelevel_expression statement.

Usage
get_wirelevel_expressions <instance_or_port_bitselection>

Returns
String[] A flattened list of wire-level expressions. Every item in the list consists of right- and left-hand clauses of a wire-level expression. You can loop over the returned list using foreach(port expr) $return_list().
**Arguments**

*instance_or_port_bitselection*  
Specifies which instance or port from which a list of wire-level expressions are retrieved using the `<instance_name>.[<port_name>[<bit_selection>]]` format.

- If no `<port_name>[<bit_selection>]` is specified, the command causes the return of all expressions from the specified instance.
- If no argument is present, the command causes the return of all expressions from the current level of system hierarchy.

The *bit selection* can be a bit-select, for example `[0]`, or a partial range defined in descending order, for example `[7:0]`. If no *bit selection* is specified, the full range of the port is selected.

**Example**

```
get_wirelevel_expressions
get_wirelevel_expressions module0
get_wirelevel_expressions {module0.portA[7:0]}
```

**Related Information**

- [Scripting Flow for Wire-Level Expressions](#) on page 30
- [Wire-Level Connectivity](#) on page 23

### 1.19.7.10.3. remove_wirelevel_expressions

**Description**

Remove a list of wire-level expressions from an optional input port, instance, or all expressions in the current level of system hierarchy. If the port *bit selection* is specified as an argument, the range must be identical to what was used in the `set_wirelevel_expressions` statement.

**Usage**

```
remove_wirelevel_expressions <instance_or_port_bitselection>
```

**Returns**

No return value.

**Arguments**

*instance_or_port_bitselection*  
Specifies which instance or port from which a list of wire-level expressions are removed using the `<instance_name>.[<port_name>[<bit_selection>]]` format.
• If no `<port_name>[<bit_selection>]` is specified, the command causes the removal of all expressions from the specified instance.

• If no argument is present, the command causes the return of all expressions from the current level of system hierarchy.

The *bit selection* can be a bit-select, for example `[0]`, or a partial range defined in descending order, for example `[7:0]`. If no *bit selection* is specified, the full range of the port is selected.

## Examples

```bash
remove_wirelevel_expressions
remove_wirelevel_expressions module0
remove_wirelevel_expressions {module0.portA[7:0]}
```

## Related Information

- [Scripting Flow for Wire-Level Expressions](#) on page 30
- [Wire-Level Connectivity](#) on page 23
1.19.8. Platform Designer Scripting Property Reference

Interface properties work differently for `_hw.tcl` scripting than with Platform Designer scripting. In `_hw.tcl`, interfaces do not distinguish between properties and parameters. In Platform Designer scripting, the properties and parameters are unique.

The following are the Platform Designer scripting properties:

- Connection Properties on page 272
- Design Environment Type Properties on page 273
- Direction Properties on page 274
- Element Properties on page 275
- Instance Properties on page 276
- Interface Properties on page 277
- Message Levels Properties on page 278
- Module Properties on page 279
- Parameter Properties on page 280
- Parameter Status Properties on page 282
- Parameter Type Properties on page 283
- Port Properties on page 284
- Project Properties on page 285
- System Info Type Properties on page 286
- Units Properties on page 288
- Validation Properties on page 289
- Interface Direction on page 290
- File Set Kind on page 291
- Access Type on page 292
- Instantiation Hdl File Properties on page 293
- Instantiation Interface Duplicate Type on page 294
- Instantiation Interface Properties on page 295
- Instantiation Properties on page 296
- Port Properties on page 297
- VHDL Type on page 298
## 1.19.8.1. Connection Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>string</td>
<td>END</td>
<td>Indicates the end interface of the connection.</td>
</tr>
<tr>
<td>string</td>
<td>NAME</td>
<td>Indicates the name of the connection.</td>
</tr>
<tr>
<td>string</td>
<td>START</td>
<td>Indicates the start interface of the connection.</td>
</tr>
<tr>
<td>String</td>
<td>TYPE</td>
<td>The type of the connection.</td>
</tr>
</tbody>
</table>
1.19.8.2. Design Environment Type Properties

Description
IP cores use the design environment to identify the most appropriate interfaces to connect to the parent system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NATIVE</td>
<td>Supports native IP interfaces.</td>
</tr>
<tr>
<td>QSYS</td>
<td>Supports standard Platform Designer interfaces.</td>
</tr>
</tbody>
</table>
### 1.19.8.3. Direction Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIDIR</td>
<td>Indicates the direction for a bidirectional signal.</td>
</tr>
<tr>
<td>INOUT</td>
<td>Indicates the direction for an input signal.</td>
</tr>
<tr>
<td>OUTPUT</td>
<td>Indicates the direction for an output signal.</td>
</tr>
</tbody>
</table>
1.19.8.4. Element Properties

Description

Element properties are, with the exception of ENABLED and NAME, read-only properties of the types of instances, interfaces, and connections. These read-only properties represent metadata that does not vary between copies of the same type. ENABLED and NAME properties are specific to particular instances, interfaces, or connections.

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>AUTHOR</td>
<td>The author of the component or interface.</td>
</tr>
<tr>
<td>Boolean</td>
<td>AUTO_EXPORT</td>
<td>Indicates whether unconnected interfaces on the instance are automatically exported.</td>
</tr>
<tr>
<td>String</td>
<td>CLASS_NAME</td>
<td>The type of the instance, interface or connection, for example, altera_nios2 or avalon_slave.</td>
</tr>
<tr>
<td>String</td>
<td>DESCRIPTION</td>
<td>The description of the instance, interface or connection type.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_NAME</td>
<td>The display name for referencing the type of instance, interface or connection.</td>
</tr>
<tr>
<td>Boolean</td>
<td>EDITABLE</td>
<td>Indicates whether you can edit the component in the Platform Designer Component Editor.</td>
</tr>
<tr>
<td>Boolean</td>
<td>ENABLED</td>
<td>Indicates whether the instance is enabled.</td>
</tr>
<tr>
<td>String</td>
<td>GROUP</td>
<td>The IP Catalog category.</td>
</tr>
<tr>
<td>Boolean</td>
<td>INTERNAL</td>
<td>Hides internal IP components or sub-components from the IP Catalog.</td>
</tr>
<tr>
<td>String</td>
<td>NAME</td>
<td>The name of the instance, interface or connection.</td>
</tr>
<tr>
<td>String</td>
<td>VERSION</td>
<td>The version number of the instance, interface or connection, for example, 16.1.</td>
</tr>
</tbody>
</table>
### 1.19.8.5. Instance Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>AUTO_EXPORT</td>
<td>Indicates whether Platform Designer automatically exports the unconnected interfaces on the instance.</td>
</tr>
<tr>
<td>Boolean</td>
<td>ENABLED</td>
<td>If true, Platform Designer includes this instance in the generated system.</td>
</tr>
<tr>
<td>String</td>
<td>NAME</td>
<td>The name of the system, which Platform Designer uses as the name of the top-level module in the generated HDL.</td>
</tr>
</tbody>
</table>
### 1.19.8.6. Interface Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| String| EXPORT_OF | Indicates which interface of a child instance to export through the top-level interface. Before using this command, you must create the top-level interface using the add_interface command. You must use the format: `<instanceName.interfaceName>`. For example:  

```
set_interface_property CSC_input EXPORT_OF my_colorSpaceConverter.input_port
``` |
### 1.19.8.7. Message Levels Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPONENT_INFO</td>
<td>Reports an informational message only during component editing.</td>
</tr>
<tr>
<td>DEBUG</td>
<td>Provides messages when debug mode is enabled.</td>
</tr>
<tr>
<td>ERROR</td>
<td>Provides an error message.</td>
</tr>
<tr>
<td>INFO</td>
<td>Provides an informational message.</td>
</tr>
<tr>
<td>PROGRESS</td>
<td>Reports progress during generation.</td>
</tr>
<tr>
<td>TODOERROR</td>
<td>Provides an error message that indicates the system is incomplete.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Provides a warning message.</td>
</tr>
</tbody>
</table>
### 1.19.8.8. Module Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>GENERATION_ID</td>
<td>The generation ID for the system.</td>
</tr>
<tr>
<td>String</td>
<td>NAME</td>
<td>The name of the instance.</td>
</tr>
</tbody>
</table>
### 1.19.8.9. Parameter Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>AFFECTS_ELABORATION</td>
<td>Set <code>AFFECTS_ELABORATION</code> to false for parameters that do not affect the external interface of the module. An example of a parameter that does not affect the external interface is <code>isNonVolatileStorage</code>. An example of a parameter that does affect the external interface is <code>width</code>. When the value of a parameter changes and <code>AFFECTS_ELABORATION</code> is false, the elaboration phase does not repeat and improves performance. When <code>AFFECTS_ELABORATION</code> is set to true, the default value, Platform Designer reanalyzes the HDL file to determine the port widths and configuration each time a parameter changes.</td>
</tr>
<tr>
<td>Boolean</td>
<td>AFFECTS_GENERATION</td>
<td>The default value of <code>AFFECTS_GENERATION</code> is false if you provide a top-level HDL module. The default value is true if you provide a fileset callback. Set <code>AFFECTS_GENERATION</code> to false if the value of a parameter does not change the results of fileset generation.</td>
</tr>
<tr>
<td>Boolean</td>
<td>AFFECTS_VALIDATION</td>
<td>The <code>AFFECTS_VALIDATION</code> property determines whether a parameter’s value sets derived parameters, and whether the value affects validation messages. Setting this property to false may improve response time in the parameter editor when the value changes.</td>
</tr>
<tr>
<td>String[]</td>
<td>ALLOWED_RANGES</td>
<td>Indicates the range or ranges of the parameter. For integers, each range is a single value, or a range of values defined by a start and end value, and delimited by a colon, for example, 11:15. This property also specifies the legal values and description strings for integers, for example, [0:None 1:Monophonic 2:Stereo 4:Quadrophonic], where 0, 1, 2, and 4 are the legal values. You can assign description strings in the parameter editor for string variables. For example, <code>ALLOWED_RANGES {&quot;dev1:Cyclone IV GX&quot;&quot;dev2:Stratix V GT&quot;}</code></td>
</tr>
<tr>
<td>String</td>
<td>DEFAULT_VALUE</td>
<td>The default value.</td>
</tr>
<tr>
<td>Boolean</td>
<td>DERIVED</td>
<td>When <code>True</code>, indicates that the parameter value is set by the component and cannot be set by the user. Derived parameters are not saved as part of an instance's parameter values. The default value is <code>False</code>.</td>
</tr>
<tr>
<td>String</td>
<td>DESCRIPTION</td>
<td>A short user-visible description of the parameter, suitable for a tooltip description in the parameter editor.</td>
</tr>
<tr>
<td>String[]</td>
<td>DISPLAY_HINT</td>
<td>Provides a hint about how to display a property.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>boolean</code>—For integer parameters whose value are 0 or 1. The parameter displays as an option that you can turn on or off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>radio</code>—displays a parameter with a list of values as radio buttons.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>hexadecimal</code>—for integer parameters, displays and interprets the value as a hexadecimal number, for example: <code>0x00000010</code> instead of <code>16</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>fixed_size</code>—for <code>string_list</code> and <code>integer_list</code> parameters, the <code>fixed_size DISPLAY_HINT</code> eliminates the <code>Add</code> and <code>Remove</code> buttons from tables.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_NAME</td>
<td>The GUI label that appears to the left of this parameter.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_UNITS</td>
<td>The GUI label that appears to the right of the parameter.</td>
</tr>
<tr>
<td>Boolean</td>
<td>ENABLED</td>
<td>When <code>False</code>, the parameter is disabled. The parameter displays in the parameter editor but is grayed out, indicating that you cannot edit this parameter.</td>
</tr>
<tr>
<td>String</td>
<td>GROUP</td>
<td>Controls the layout of parameters in the GUI.</td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Boolean</td>
<td>HDL_PARAMETER</td>
<td>When True, Platform Designer passes the parameter to the HDL component description. The default value is False.</td>
</tr>
<tr>
<td>String</td>
<td>LONG_DESCRIPTION</td>
<td>A user-visible description of the parameter. Similar to DESCRIPTION, but allows a more detailed explanation.</td>
</tr>
<tr>
<td>String</td>
<td>NEW_INSTANCE_VALUE</td>
<td>Changes the default value of a parameter without affecting older components that do not explicitly set a parameter value, and use the DEFAULT_VALUE property. Older instances continue to use DEFAULT_VALUE for the parameter and new instances use the value assigned by NEW_INSTANCE_VALUE.</td>
</tr>
<tr>
<td>String[]</td>
<td>SYSTEM_INFO</td>
<td>Allows you to assign information about the instantiating system to a parameter that you define. SYSTEM_INFO requires an argument specifying the type of information. For example: SYSTEM_INFO &lt;info-type&gt;</td>
</tr>
<tr>
<td>String</td>
<td>SYSTEM_INFO_ARG</td>
<td>Defines an argument to pass to SYSTEM_INFO. For example, the name of a reset interface.</td>
</tr>
<tr>
<td>(various)</td>
<td>SYSTEM_INFO_TYPE</td>
<td>Specifies the types of system information that you can query. Refer to System Info Type Properties.</td>
</tr>
<tr>
<td>(various)</td>
<td>TYPE</td>
<td>Specifies the type of the parameter. Refer to Parameter Type Properties.</td>
</tr>
<tr>
<td>(various)</td>
<td>UNITS</td>
<td>Sets the units of the parameter. Refer to Units Properties.</td>
</tr>
<tr>
<td>Boolean</td>
<td>VISIBLE</td>
<td>Indicates whether or not to display the parameter in the parameter editor.</td>
</tr>
<tr>
<td>String</td>
<td>WIDTH</td>
<td>Indicates the width of the logic vector for the STD_LOGIC_VECTOR parameter.</td>
</tr>
</tbody>
</table>

**Related Information**
- [System Info Type Properties](#) on page 286
- [Parameter Type Properties](#) on page 283
- [Units Properties](#) on page 288
### 1.19.8.10. Parameter Status Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>ACTIVE</td>
<td>Indicates that this parameter is an active parameter.</td>
</tr>
<tr>
<td>Boolean</td>
<td>DEPRECATED</td>
<td>Indicates that this parameter exists only for backwards compatibility, and may not have any effect.</td>
</tr>
<tr>
<td>Boolean</td>
<td>EXPERIMENTAL</td>
<td>Indicates that this parameter is experimental and not exposed in the design flow.</td>
</tr>
</tbody>
</table>
### 1.19.8.11. Parameter Type Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOLEAN</td>
<td>A boolean parameter set to true or false.</td>
</tr>
<tr>
<td>FLOAT</td>
<td>A signed 32-bit floating point parameter. (Not supported for HDL parameters.)</td>
</tr>
<tr>
<td>INTEGER</td>
<td>A signed 32-bit integer parameter.</td>
</tr>
<tr>
<td>INTEGER_LIST</td>
<td>A parameter that contains a list of 32-bit integers. (Not supported for HDL parameters.)</td>
</tr>
<tr>
<td>LONG</td>
<td>A signed 64-bit integer parameter. (Not supported for HDL parameters.)</td>
</tr>
<tr>
<td>NATURAL</td>
<td>A 32-bit number that contains values 0 to 2147483647 (0x7fffffff).</td>
</tr>
<tr>
<td>POSITIVE</td>
<td>A 32-bit number that contains values 1 to 2147483647 (0x7fffffff).</td>
</tr>
<tr>
<td>STD_LOGIC</td>
<td>A single bit parameter set to 0 or 1.</td>
</tr>
<tr>
<td>STD_LOGIC_VECTOR</td>
<td>An arbitrary-width number. The parameter property WIDTH determines the size of the logic vector.</td>
</tr>
<tr>
<td>STRING</td>
<td>A string parameter.</td>
</tr>
<tr>
<td>STRING_LIST</td>
<td>A parameter that contains a list of strings. (Not supported for HDL parameters.)</td>
</tr>
</tbody>
</table>
## 1.19.8.12. Port Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(various)</td>
<td>DIRECTION</td>
<td>The direction of the signal. Refer to Direction Properties.</td>
</tr>
<tr>
<td>String</td>
<td>ROLE</td>
<td>The type of the signal. Each interface type defines a set of interface types for its ports.</td>
</tr>
<tr>
<td>Integer</td>
<td>WIDTH</td>
<td>The width of the signal in bits.</td>
</tr>
</tbody>
</table>

**Related Information**

Direction Properties on page 274
1.19.8.13. Project Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>DEVICE</td>
<td>The device part number in the Intel Quartus Prime project that contains the Platform Designer system.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_FAMILY</td>
<td>The device family name in the Intel Quartus Prime project that contains the Platform Designer system.</td>
</tr>
</tbody>
</table>
### 1.19.8.14. System Info Type Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>ADDRESS_MAP</td>
<td>An XML-formatted string that describes the address map for the interface specified in the SYSTEM_INFO parameter property.</td>
</tr>
<tr>
<td>Integer</td>
<td>ADDRESS_WIDTH</td>
<td>The number of address bits that Platform Designer requires to address memory-mapped slaves connected to the specified memory-mapped master in this instance.</td>
</tr>
<tr>
<td>String</td>
<td>AVALON_SPEC</td>
<td>The version of the Platform Designer interconnect. Refer to Avalon Interface Specifications.</td>
</tr>
<tr>
<td>Integer</td>
<td>CLOCK_DOMAIN</td>
<td>An integer that represents the clock domain for the interface specified in the SYSTEM_INFO parameter property. If this instance has interfaces on multiple clock domains, you can use this property to determine which interfaces are on each clock domain. The absolute value of the integer is arbitrary.</td>
</tr>
<tr>
<td>Long, Integer</td>
<td>CLOCK_RATE</td>
<td>The rate of the clock connected to the clock input specified in the SYSTEM_INFO parameter property. If zero, the clock rate is currently unknown.</td>
</tr>
<tr>
<td>String</td>
<td>CLOCK_RESET_INFO</td>
<td>The name of this instance's primary clock or reset sink interface. You use this property to determine the reset sink for global reset when you use SOPC Builder interconnect that conforms to Avalon Interface Specifications.</td>
</tr>
<tr>
<td>String</td>
<td>CUSTOM_INSTRUCTION_SLAVES</td>
<td>Provides slave information, including the name, base address, address span, and clock cycle type.</td>
</tr>
<tr>
<td>String</td>
<td>DESIGN_ENVIRONMENT</td>
<td>A string that identifies the current design environment. Refer to Design Environment Type Properties.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE</td>
<td>The device part number of the selected device.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_FAMILY</td>
<td>The family name of the selected device.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_FEATURES</td>
<td>A list of key/value pairs delimited by spaces that indicate whether a device feature is available in the selected device family. The format of the list is suitable for passing to the array command. The keys are device features. The values are 1 if the feature is present, and 0 if the feature is absent.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_SPEEDGRADE</td>
<td>The speed grade of the selected device.</td>
</tr>
<tr>
<td>Integer</td>
<td>GENERATION_ID</td>
<td>An integer that stores a hash of the generation time that Platform Designer uses as a unique ID for a generation run.</td>
</tr>
<tr>
<td>BigInteger, Long</td>
<td>INTERRUPTS_USED</td>
<td>A mask indicating which bits of an interrupt receiver are connected to interrupt senders. The interrupt receiver is specified in the system info argument.</td>
</tr>
<tr>
<td>Integer</td>
<td>MAX_SLAVE_DATA_WIDTH</td>
<td>The data width of the widest slave connected to the specified memory-mapped master.</td>
</tr>
<tr>
<td>String, Boolean, Integer</td>
<td>QUARTUS_INI</td>
<td>The value of the quartus.ini setting specified in the system info argument.</td>
</tr>
<tr>
<td>Integer</td>
<td>RESET_DOMAIN</td>
<td>An integer representing the reset domain for the interface specified in the SYSTEM_INFO parameter property if this instance has interfaces on multiple reset domains. No absolute value of the integer is arbitrary.</td>
</tr>
</tbody>
</table>
domains, you can use this property to determine which interfaces are on each reset domain. The absolute value of the integer is arbitrary.

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>TRISTATECONDUIT_INFO</td>
<td>An XML description of the tri-state conduit masters connected to a tri-state conduit slave. The slave is specified as the SYSTEM_INFO parameter property. The value contains information about the slave, connected master instance and interface names, and signal names, directions, and widths.</td>
</tr>
<tr>
<td>String</td>
<td>TRISTATECONDUIT_MASTERS</td>
<td>The names of the instance's interfaces that are tri-state conduit slaves.</td>
</tr>
<tr>
<td>String</td>
<td>UNIQUE_ID</td>
<td>A string guaranteed to be unique to this instance.</td>
</tr>
</tbody>
</table>

**Related Information**

- Design Environment Type Properties on page 273
- Avalon Interface Specifications
- Platform Designer Interconnect on page 357
### 1.9.8.15. Units Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDRESS</td>
<td>A memory-mapped address.</td>
</tr>
<tr>
<td>BITS</td>
<td>Memory size in bits.</td>
</tr>
<tr>
<td>BITSPERSECOND</td>
<td>Rate in bits per second.</td>
</tr>
<tr>
<td>BYTES</td>
<td>Memory size in bytes.</td>
</tr>
<tr>
<td>CYCLES</td>
<td>A latency or count in clock cycles.</td>
</tr>
<tr>
<td>GIGABITSPERSECOND</td>
<td>Rate in gigabits per second.</td>
</tr>
<tr>
<td>GIGABYTES</td>
<td>Memory size in gigabytes.</td>
</tr>
<tr>
<td>GIGAHERTZ</td>
<td>Frequency in GHz.</td>
</tr>
<tr>
<td>HERTZ</td>
<td>Frequency in Hz.</td>
</tr>
<tr>
<td>KILOBITSPERSECOND</td>
<td>Rate in kilobits per second.</td>
</tr>
<tr>
<td>KILOBYTES</td>
<td>Memory size in kilobytes.</td>
</tr>
<tr>
<td>KILOHERTZ</td>
<td>Frequency in kHz.</td>
</tr>
<tr>
<td>MEGABITSPERSECOND</td>
<td>Rate, in megabits per second.</td>
</tr>
<tr>
<td>MEGABYTES</td>
<td>Memory size in megabytes.</td>
</tr>
<tr>
<td>MEGAHERTZ</td>
<td>Frequency in MHz.</td>
</tr>
<tr>
<td>MICROSECONDS</td>
<td>Time in microseconds.</td>
</tr>
<tr>
<td>MILLISECONDS</td>
<td>Time in milliseconds.</td>
</tr>
<tr>
<td>NANoseconds</td>
<td>Time in nanoseconds.</td>
</tr>
<tr>
<td>NONE</td>
<td>Unspecified units.</td>
</tr>
<tr>
<td>PERCENT</td>
<td>A percentage.</td>
</tr>
<tr>
<td>PICOSECONDS</td>
<td>Time in picoseconds.</td>
</tr>
<tr>
<td>SECONDS</td>
<td>Time in seconds.</td>
</tr>
</tbody>
</table>


1.19.8.16. Validation Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>AUTOMATIC_VALIDATION</td>
<td>When true, Platform Designer runs system validation and elaboration after each scripting command. When false, Platform Designer runs system validation with validation scripting commands. Some queries affected by system elaboration may be incorrect if automatic validation is disabled. You can disable validation to make a system script run faster.</td>
</tr>
</tbody>
</table>
### 1.19.8.17. Interface Direction

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>INPUT</td>
<td>Indicates that the interface is a slave (input, transmitter, sink, or end).</td>
</tr>
<tr>
<td>String</td>
<td>OUTPUT</td>
<td>Indicates that the interface is a master (output, receiver, source, or start).</td>
</tr>
</tbody>
</table>
### 1.19.8.18. File Set Kind

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXAMPLE_DESIGN</td>
<td>This file-set contains example design files.</td>
</tr>
<tr>
<td>QUARTUS_SYNTH</td>
<td>This file-set contains files that Platform Designer uses for Intel Quartus Prime Synthesis</td>
</tr>
<tr>
<td>SIM_VERILOG</td>
<td>This file-set contains files that Platform Designer uses for Verilog HDL Simulation.</td>
</tr>
<tr>
<td>SIM_VHDL</td>
<td>This file-set contains files that Platform Designer uses for VHDL Simulation.</td>
</tr>
</tbody>
</table>
1.19.8.19. Access Type

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>READ_ONLY</td>
<td>Indicates that the parameter can be only read-only.</td>
</tr>
<tr>
<td>String</td>
<td>WRITABLE</td>
<td>Indicates that the parameter has read/write properties.</td>
</tr>
</tbody>
</table>
### 1.19.8.20. Instantiation Hdl File Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>CONTAINS_INLINE_CONFIGURATION</td>
<td>Returns True if the HDL file contains inline configuration.</td>
</tr>
<tr>
<td>Boolean</td>
<td>IS_CONFIGURATION_PACKAGE</td>
<td>Returns True if the HDL file is a configuration package.</td>
</tr>
<tr>
<td>Boolean</td>
<td>IS_TOP_LEVEL</td>
<td>Returns True if the HDL file is the top-level HDL file.</td>
</tr>
<tr>
<td>String</td>
<td>OUTPUT_PATH</td>
<td>Specifies the output path of the HDL file.</td>
</tr>
<tr>
<td>String</td>
<td>TYPE</td>
<td>Specifies the HDL file type of the HDL file.</td>
</tr>
</tbody>
</table>
### 1.19.8.21. Instantiation Interface Duplicate Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>CLONE</td>
<td>Creates a copy of an interface and all the interface ports.</td>
</tr>
<tr>
<td>String</td>
<td>MIRROR</td>
<td>Creates a copy of an interface with all the port roles and directions reversed.</td>
</tr>
</tbody>
</table>
### 1.19.8.22. Instantiation Interface Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>DIRECTION</td>
<td>The direction of the interface.</td>
</tr>
<tr>
<td>String</td>
<td>TYPE</td>
<td>The type of the interface.</td>
</tr>
</tbody>
</table>
### 1.19.8.23. Instantiation Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String HDL_COMPILATION_LIBRARY</td>
<td>Indicated the HDL compilation library name of the generic component.</td>
<td></td>
</tr>
<tr>
<td>String HDL_ENTITY_NAME</td>
<td>Indicates the HDL entity name of the Generic Component.</td>
<td></td>
</tr>
<tr>
<td>String IP_FILE</td>
<td>Indicates the .ip file path that implements the generic component.</td>
<td></td>
</tr>
</tbody>
</table>
### 1.19.8.24. Port Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>DIRECTION</td>
<td>Specifies the direction of the signal</td>
</tr>
<tr>
<td>String</td>
<td>NAME</td>
<td>Renames a top-level port. Only use with <code>set_interface_port_property</code></td>
</tr>
<tr>
<td>String</td>
<td>ROLE</td>
<td>Specifies the type of the signal. Each interface type defines a set of interface types for its ports.</td>
</tr>
<tr>
<td>String</td>
<td>VHDL_TYPE</td>
<td>Specifies the VHDL type of the signal. Can be either <code>STANDARD_LOGIC</code>, or <code>STANDARD_LOGIC_VECTOR</code>.</td>
</tr>
<tr>
<td>Integer</td>
<td>WIDTH</td>
<td>Specifies the width of the signal in bits.</td>
</tr>
</tbody>
</table>

**Related Information**

Direction Properties on page 274
### 1.19.8.25. VHDL Type

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STD_LOGIC</td>
<td>Represents the value of a digital signal in a wire.</td>
</tr>
<tr>
<td>STD_LOGIC_VECTOR</td>
<td>Represents an array of digital signals and variables.</td>
</tr>
</tbody>
</table>

### 1.19.9. Parameterizing an Instantiated IP Core after `save_system` Command

When you call the `save_system` command in your Tcl script, Platform Designer converts all the instantiated IP cores in your system to generic components.

To modify these IP cores after saving your system, you must first load the actual component within the instantiated generic component. Re-parameterize an instantiated IP core using one of the following methods:

1. Load the component in the Platform Designer system, modify the component's parameter value, and save the component:

   ```
   ...
   save_system kernel_system.qsys
   ...
   load_component cra_root
   set_component_parameter_value DATA_W 64
   save_component
   ...
   ```

2. Load the `.ip` file specific to the component, modify the instance's parameter value, and save the `.ip` file:

   ```
   ...
   save_system kernel_system.qsys
   ...
   load_system cra_root.ip
   set_instance_parameter_value cra_root DATA_W 64
   save_system
   ...
   ```

   **Note:** To directly modify an instance parameter value after the `save_system` command, you must load the `.ip` file corresponding to the IP component.

**Related Information**

- `set_component_parameter_value` on page 215
- `load_component` on page 212
- `save_component` on page 214
- `save_system` on page 107
1.19.10. Validate the Generic Components in a System with qsys-validate

Use the qsys-validate utility to run IP component footprint validation on the .qsys file for the system.

Table 35. qsys-validate Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st arg file</td>
<td>Optional</td>
<td>The name of the .qsys system file to validate.</td>
</tr>
</tbody>
</table>
| --search-path[=<value>] | Optional| If omitted, Platform Designer uses a standard default path. If provided, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use "$", for example: /extra/dir.$.
| --strict                | Optional| Enables strict validation. All warnings are reported as errors.             |
| --jvm-max-heap-size=<value> | Optional| The maximum memory size Platform Designer uses for allocations when running qsys-edit. You specify this value as <size><unit>, where unit is m (or M) for multiples of megabytes, or g (or G) for multiples of gigabytes. The default value is 512m. |
| --help                  | Optional| Display help for qsys-validate.                                             |

1.19.11. Archive a Platform Designer System with qsys-archive

The qsys-archive command allows you to archive a system, extract an archived system, and retrieve information about the system's dependencies.

Table 36. qsys-archive Command-Line Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1st arg file&gt;</td>
<td>Required</td>
<td>The filename of the root Platform Designer system, Platform Designer file archive, or the Intel Quartus Prime project file.</td>
</tr>
<tr>
<td>--search-path[=&lt;value&gt;]</td>
<td>Optional</td>
<td>If you omit this option, Platform Designer uses a standard default path. If you specify this option, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use &quot;$&quot;, for example: /extra/dir.$.</td>
</tr>
<tr>
<td>--archive</td>
<td>Optional</td>
<td>Creates a zip archive of the specified Platform Designer system or the Intel Quartus Prime project.</td>
</tr>
<tr>
<td>--report-file[=&lt;value&gt;]</td>
<td>Optional</td>
<td>Lists the files that the Platform Designer system or the Intel Quartus Prime project reference, and writes the files list to the specified name in .txt format.</td>
</tr>
<tr>
<td>--output-directory[=&lt;file&gt;]</td>
<td>Optional</td>
<td>Specifies the output directory to save the archive.</td>
</tr>
<tr>
<td>--extract</td>
<td>Optional</td>
<td>Extracts all the files in the given archive.</td>
</tr>
<tr>
<td>--output-name[=&lt;value&gt;]</td>
<td>Optional</td>
<td>Specifies the output name to save the archive or report.</td>
</tr>
<tr>
<td>collect-to-common-directory[=&lt;true</td>
<td>false&gt;]</td>
<td>Optional</td>
</tr>
</tbody>
</table>

continued...
### Table

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>new-quartus-project [=value]</code></td>
<td>Optional</td>
<td>Creates a new Intel Quartus Prime project which contains all the .ip and system files referenced by the Platform Designer system or the Intel Quartus Prime project.</td>
</tr>
</tbody>
</table>
| `quartus-project [=value]`    | Optional       | When you use this command in combination with:  
  - `--report-file`—adds all the referenced files to the Intel Quartus Prime project.  
  - `--extract`—adds all extracted files to the specified project.  
  - `--archive`—archives all the system and .ip files referenced in the Intel Quartus Prime project. |
| `--rev`                       | Optional       | Specifies the name of the Intel Quartus Prime project revision.                                                                           |
| `--include-generated-files`   | Optional       | Includes all the generated files of the Platform Designer system.                                                                           |
| `--force`                     | Optional       | Forcefully creates the specified archive or report, overwriting any existing archives or reports.                                           |
| `--jvm-max-heap-size=value`   | Optional       | Specifies the maximum memory size Platform Designer uses for allocations when running `qsys-edit`. Specify this value as `<size><unit>`, where unit is `m` (or `M`) for multiples of megabytes, or `g` (or `G`) for multiples of gigabytes. The default value is 512m. |
| `--help`                      | Optional       | Displays help for `qsys-archive`.                                                                                                           |

Alternatively, you can archive and restore your system using the Platform Designer GUI. For more information, refer to *Archive your System* section.

**Related Information**

*Archive your System* on page 45

### 1.19.12. Generate an IP Component or Platform Designer System with `quartus_ipgenerate`

The `quartus_ipgenerate` command allows you to generate IP components or a Platform Designer system in your Intel Quartus Prime project. Ensure that you include the IP component or the Platform Designer system you wish to generate in your Intel Quartus Prime project.

To run the `quartus_ipgenerate` command from the Intel Quartus Prime shell, type:

```
quartus_ipgenerate <project name> [options]
```

Use any of the following options with the `quartus_ipgenerate` utility:

---

Platform Designer User Guide Intel® Quartus® Prime Pro Edition 300
Table 37.  **quartus_ipgenerate Command-Line Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1st arg file&gt;</td>
<td>Required</td>
<td>Specifies the name of the Intel Quartus Prime project file (.qpf). This option generates all the .qsys and .ip files in the specified Intel Quartus Prime project (&lt;project name&gt;).</td>
</tr>
<tr>
<td>-f [&lt;argument file&gt;]</td>
<td>Optional</td>
<td>Specifies a file containing additional command-line arguments. Arguments that you specify after this option can conflict or override the options you specify in the argument file.</td>
</tr>
<tr>
<td>--rev=&lt;revision name&gt; or -c=&lt;revision name&gt;</td>
<td>Optional</td>
<td>Specifies the Intel Quartus Prime project revision and the associated .qsf file to use. If you omit this option, Platform Designer uses the same revision name as your Intel Quartus Prime project.</td>
</tr>
<tr>
<td>--clear_ip_generation_dirs or --clean</td>
<td>Optional</td>
<td>Clears the generation directories of all the .qsys or the .ip files in the specified Intel Quartus Prime project. For example, to clear the generation directories in the project test, run the following command: quartus_ipgenerate --clear_ip_generation_dirs test or quartus_ipgenerate --clean test</td>
</tr>
<tr>
<td>--generate_ip_file --ip_file=[&lt;ip file name&gt;]</td>
<td>Optional</td>
<td>Generates the files for &lt;file name&gt;.ip file in the specified Intel Quartus Prime project. Use the following optional flags with --generate_ip_file: • --synthesis=[&lt;value&gt;]—optional argument that specifies the synthesis target type. Specify the value as either verilog or vhdl. The default value is verilog. • --simulation=[&lt;value&gt;]—optional argument that specifies the simulation target type. Specify the value as either verilog or vhdl. If you omit this flag, Platform Designer does not generate any simulation files. • --clear_ip_generation_dirs—clears the preexisting generation directories before generation. If you omit this command, Platform Designer does not clear the generation directories. For example, to generate the files for a test.qsys file within the project, test: quartus_ipgenerate --generate_ip_file --synthesis=vhdl --simulation=verilog --clear_ip_generation_dirs --ip_file=test.qsys test</td>
</tr>
<tr>
<td>--generate_project_ip_files [&lt;project name&gt;]</td>
<td>Optional</td>
<td>Generates the files for all the .qsys and .ip files in the specified Intel Quartus Prime project. Use any of the following optional flags with --generate_project_ip_files: • --synthesis=[&lt;value&gt;]—optional argument that specifies the synthesis target type. Specify the value as either verilog or vhdl. The default value is verilog. • --simulation=[&lt;value&gt;]—optional argument that specifies the simulation target type. Specify the value as either verilog or vhdl. If you omit this flag, Platform Designer does not generate any simulation files. • --clear_ip_generation_dirs—clears the preexisting generation directories before generation. If you omit this command, Platform Designer does not clear the generation directories.</td>
</tr>
</tbody>
</table>

*continued...*
For example, to generate all the .qsys and .ip files within the project, test:

```
quartus_ipgenerate --generate_project_ip_files --synthesis=vhdl --simulation=verilog --clear_ip_generation_dirs test
```

---

Optional

Returns a list of the .qsys or .ip files in the specified Intel Quartus Prime project. This option displays each file in a separate Intel Quartus Prime message line. For example, to get a list of .qsys files in the project test, and revision rev:

```
quartus_ipgenerate --get_project_ip_files test -c rev
```

---

Optional

Allows you to lower the priority of the current process. This option is useful if you use a single-processor computer, allowing you to use other applications more easily while the Intel Quartus Prime software runs the command in the background.

---

### 1.19.13. Generate an IP Variation File with ip-deploy

Use the `ip-deploy` utility to generate an IP variation file (.ip file) in the specified location.

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>--component-name[=value]</code></td>
<td>Required</td>
<td>The name of a component you instantiate.</td>
</tr>
<tr>
<td><code>--output-name[=value]</code></td>
<td>Optional</td>
<td>Name for the resulting component; defaults to the component’s type name.</td>
</tr>
<tr>
<td><code>--component-parameter[=value]</code></td>
<td>Optional</td>
<td>Repeatable. A single value assignment, like <code>--component-param=WIDTH=11</code>. To assign multiple parameters, use this option several times.</td>
</tr>
<tr>
<td><code>--preset[=value]</code></td>
<td>Optional</td>
<td>Repeatable. The name of a saved preset to use in creating a variation of the IP component. Presets are additive and repeatable.</td>
</tr>
<tr>
<td><code>--family[=value]</code></td>
<td>Optional</td>
<td>Sets the device family</td>
</tr>
<tr>
<td><code>--part[=value]</code></td>
<td>Optional</td>
<td>Sets the device part number. You can also use this command to set the base device, device speed-grade, device family, and device feature’s system information.</td>
</tr>
<tr>
<td><code>--output-directory[=value]</code></td>
<td>Optional</td>
<td>This directory contains the output IP variation file. Platform Designer automatically creates the directory if the directory does not exist. If you do not specify an output directory, the output directory is the current working directory.</td>
</tr>
<tr>
<td><code>--search-path[=value]</code></td>
<td>Optional</td>
<td>If you do not specify the search path, the command uses a standard default path. If you provide a search path, Platform Designer searches a comma-separated list of paths. To include the standard path in your replacement, use &quot;$&quot;, like /extra/dir,$.</td>
</tr>
<tr>
<td><code>--jvm-max-heap-size[=value]</code></td>
<td>Optional</td>
<td>The maximum memory size Platform Designer uses for allocations when running qsys-edit. You specify this value as <code>&lt;size&gt;&lt;unit&gt;</code>, where unit is m (or M) for multiples of megabytes, or g (or G) for multiples of gigabytes. The default value is 512m.</td>
</tr>
<tr>
<td><code>--help</code></td>
<td>Optional</td>
<td>Displays help for ip-deploy</td>
</tr>
</tbody>
</table>
# 1.20. Creating a System With Platform Designer Revision History

The table below indicates edits made to the Creating a System With Platform Designer content since its creation.

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2018.06.15        | 18.0.0                     | • Updated description of Enable ECC protection in table: System-Wide Interconnect Requirements.  
                      • Updated example in topic: Generate a Platform Design System with qsys-script. |
| 2018.05.07        | 18.0.0                     | • Added support for hierarchical simscripts, and the Xcelium Parallel Simulator in .  
                      • Added support for --debug command used with qsys-edit.  
                      • Added support for wire-level expressions and connectivity.  
                      • Added _hw.tcl commands to support wire-level expressions. |
| 2017.11.06        | 17.1.0                     | • Changed instances of Qsys Pro to Platform Designer |
| 2017.05.06        | 17.0.0                     | • Updated the topic - Create/Open Project in Qsys Pro  
                      • Updated the topic - Modify the Target Device  
                      • Updated the topic - Modify the IP Search Path  
                      • Added new topic - Save your System  
                      • Added new topic - Archive your System  
                      • Added new topic - Synchronize IP File References  
                      • Updated the topic - Upgrade Outdated IP Components in Qsys Pro  
                      • Added new topic - Run System Scripts  
                      • Added new topic - View Avalon Memory Mapped Domains in Your Qsys Pro System  
                      • Updated the topic - Qsys Pro Scripting Command Reference for new Tcl scripting commands  
                      • Updated the topic - Qsys Pro Scripting Property Reference for new Tcl scripting property |
| 2016.10.31        | 16.1.0                     | • Implemented Intel rebranding.  
                      • Implemented Qsys rebranding.  
                      • Integrated Qsys Pro chapter with Qsys.  
                      • Added command-line options for qsys-archive.  
                      • Added command-line options for quartus_ipgenerate.  
                      • Updated the Qsys Pro scripting commands.  
                      • Added topic on Qsys Pro design conversion. |
| 2016.05.03        | 16.0.0                     | • Qsys Command-Line Utilities updated with latest supported command-line options.  
                      • Added: Generate Header Files |
| 2015.11.02        | 15.1.0                     | • Added: Troubleshooting IP or Qsys Pro System Upgrade.  
                      • Added: Generating Version-Agnostic IP and Qsys Pro Simulation Scripts.  
                      • Changed instances of Quartus II to Intel Quartus Prime. |
| 2015.11.02        | 15.1.0                     | • Changed instances of Quartus II to Quartus Prime. |

continued...
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2015.05.04       | 15.0.0                     | • New figure: Avalon-MM Write Master Timing Waveforms in the Parameters Tab.  
• Added Enable ECC protection option, Specify Qsys Interconnect Requirements.  
• Added External Memory Interface Debug Toolkit note, Generate a Qsys System.  
• ModelSim-Altera now supports native mixed-language (VHDL/Verilog/SystemVerilog) simulation, Generating Files for Synthesis and Simulation. |
| December 2014    | 14.1.0                     | • Create and Manage Hierarchical Qsys Systems.  
• Schematic tab.  
• View and Filter Clock and Reset Domains.  
• File ➤ Recent Projects menu item.  
• Updated example: Hierarchical System Using Instance Parameters |
| August 2014      | 14.0a10.0                  | • Added distinction between legacy and standard device generation.  
• Updated: Upgrading Outdated IP Components.  
• Updated: Generating a Qsys System.  
• Updated: Integrating a Qsys System with the Quartus II Software.  
• Added screen shot: Displaying Your Qsys System. |
| June 2014        | 14.0.0                     | • Added tab descriptions: Details, Connections.  
• Added Managing IP Settings in the Quartus II Software.  
• Added Upgrading Outdated IP Components.  
• Added Support for Avalon-MM Non-Power of Two Data Widths. |
| November 2013    | 13.1.0                     | • Added Integrating with the .qsys File.  
• Added Using the Hierarchy Tab.  
• Added Managing Interconnect Requirements.  
• Added Viewing Qsys Interconnect. |
| May 2013         | 13.0.0                     | • Added AMBA APB support.  
• Added qsys-generate utility.  
• Added VHDL BFM ID support.  
• Added Creating Secure Systems (TrustZones).  
• Added CMSIS Support for Qsys Systems With An HPS Component.  
• Added VHDL language support options. |
| November 2012    | 12.1.0                     | • Added AMBA AXI4 support. |
| June 2012        | 12.0.0                     | • Added AMBA AXI3 support.  
• Added Preset Editor updates.  
• Added command-line utilities, and scripts. |
| November 2011    | 11.1.0                     | • Added Synopsys VCS and VCS MX Simulation Shell Script.  
• Added Cadence Incisive Enterprise (NCSIM) Simulation Shell Script.  
• Added Using Instance Parameters and Example Hierarchical System Using Parameters. |
| May 2011         | 11.0.0                     | • Added simulation support in Verilog HDL and VHDL.  
• Added testbench generation support.  
• Updated simulation and file generation sections. |
| December 2010    | 10.1.0                     | Initial release. |

**Related Information**

**Documentation Archive**

For previous versions of the *Intel Quartus Prime Handbook*, search the documentation archives.
3. Creating Platform Designer Components

You can create a Hardware Component Definition File (\_hw.tcl) to describe and package IP components for use in a Platform Designer system.

Note: Intel now refers to Qsys Pro as Platform Designer.

A \_hw.tcl describes IP components, interfaces and HDL files. Platform Designer provides the Component Editor to help you create a simple \_hw.tcl file.

The Demo AXI Memory example on the Platform Designer Design Examples page of the Altera® web site provides the full code examples that appear in the following topics.

Platform Designer supports Avalon, AMBA 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

Platform Designer allows you to establish connections between Avalon and AXI interface by generating an interconnect logic. This logic enables you to handle the protocol difference. Platform Designer creates the interconnect logic by converting all the protocols to a proprietary packet format. Then, the tool routes the packet through network switches to the appropriate slaves. Here, the packet converts to the slave's protocol.

Related Information
- Avalon Interface Specifications
- Protocol Specifications
- Demo AXI Memory Example

3.1. Platform Designer Components

A Platform Designer component includes the following elements:

- Information about the component type, such as name, version, and author.
- HDL description of the component’s hardware, including SystemVerilog, Verilog HDL, or VHDL files.
- A Synopsys* Design Constraints File .sdc that defines the component for synthesis and simulation.
- A .ip file that defines the component's parameters.
- A component's interfaces, including I/O signals.
3.1.1. Interface Support in Platform Designer

IP components (IP Cores) can have any number of interfaces in any combination. Each interface represents a set of signals that you can connect within a Platform Designer system, or export outside of a Platform Designer system.

Platform Designer IP components can include the following interface types:

<table>
<thead>
<tr>
<th>Interface Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory-Mapped</td>
<td>Connects memory-referencing master devices with slave memory devices. Master devices may be processors and DMAs, while slave memory devices may be RAMs, ROMs, and control registers. Data transfers between master and slave may be uni-directional (read only or write only), or bi-directional (read and write).</td>
</tr>
<tr>
<td>Streaming</td>
<td>Connects Avalon Streaming (Avalon-ST) sources and sinks that stream unidirectional data, as well as high-bandwidth, low-latency IP components. Streaming creates datapaths for unidirectional traffic, including multichannel streams, packets, and DSP data. The Avalon-ST interconnect is flexible and can implement on-chip interfaces for industry standard telecommunications and data communications cores, such as Ethernet, Interlaken, and video. You can define bus widths, packets, and error conditions.</td>
</tr>
<tr>
<td>Interrupts</td>
<td>Connects interrupt senders to interrupt receivers. Platform Designer supports individual, single-bit interrupt requests (IRQs). In the event that multiple senders assert their IRQs simultaneously, the receiver logic (typically under software control) determines which IRQ has highest priority, then responds appropriately.</td>
</tr>
<tr>
<td>Clocks</td>
<td>Connects clock output interfaces with clock input interfaces. Clock outputs can fan-out without the use of a bridge. A bridge is required only when a clock from an external (exported) source connects internally to more than one source.</td>
</tr>
<tr>
<td>Resets</td>
<td>Connects reset sources with reset input interfaces. If your system requires a particular positive-edge or negative-edge synchronized reset, Platform Designer inserts a reset controller to create the appropriate reset signal. If you design a system with multiple reset inputs, the reset controller ORs all reset inputs and generates a single reset output.</td>
</tr>
<tr>
<td>Conduits</td>
<td>Connects point-to-point conduit interfaces, or represent signals that are exported from the Platform Designer system. Platform Designer uses conduits for component I/O signals that are not part of any supported standard interface. You can connect two conduits directly within a Platform Designer system as a point-to-point connection, or conduit interfaces can be exported and brought to the top-level of the system as top-level system I/O. You can use conduits to connect to external devices, for example external DDR SDRAM memory, and to FPGA logic defined outside of the Platform Designer system.</td>
</tr>
</tbody>
</table>

3.1.2. Component Structure

Intel provides components automatically installed with the Intel Quartus Prime software. You can obtain a list of Platform Designer-compliant components provided by third-party IP developers on Altera's Intellectual Property & Reference Designs page by typing: qsys certified in the Search box, and then selecting IP Core & Reference Designs. Components are also provided with Intel development kits, which are listed on the All Development Kits page.

Every component is defined with a <component_name>_hw.tcl file, a text file written in the Tcl scripting language that describes the component to Platform Designer. When you design your own custom component, you can create the _hw.tcl file manually, or by using the Platform Designer Component Editor.
The Component Editor simplifies the process of creating \_hw.tcl files by creating a file that you can edit outside of the Component Editor to add advanced procedures. When you edit a previously saved \_hw.tcl file, Platform Designer automatically backs up the earlier version as \_hw.tcl~.

You can move component files into a new directory, such as a network location, so that other users can use the component in their systems. The \_hw.tcl file contains relative paths to the other files, so if you move an \_hw.tcl file, you should also move all the HDL and other files associated with it.

There are four component types:
- **Static**—static components always generate the same output, regardless of their parameterization. Components that instantiate static components must have only static children.
- **Generated**—generated component’s fileset callback allows an instance of the component to create unique HDL design files based on the instance’s parameter values.
- **Composed**—composed components are subsystems constructed from instances of other components. You can use a composition callback to manage the subsystem in a composed component.
- **Generic**—generic components allow instantiation of IP components without an HDL implementation. Generic components enable hierarchical isolation between system interconnect and IP components.

**Related Information**
- Create a Composed Component or Subsystem on page 336
- Add Component Instances to a Static or Generated Component on page 338

### 3.1.3. Component File Organization

A typical component uses the following directory structure where the names of the directories are not significant:

```
<component_directory>/
```

- `<hdl>/`—Contains the component HDL design files, for example .v, .sv, or .vhd files that contain the top-level module, along with any required constraint files.
- `<component_name>\_hw.tcl`—The component description file.
- `<component_name>\_sw.tcl`—The software driver configuration file. This file specifies the paths for the .c and .h files associated with the component, when required.
- `<software>/`—Contains software drivers or libraries related to the component.

**Note:** Refer to the *Nios II Software Developer's Handbook* for information about writing a device driver or software package suitable for use with the Nios II processor.

**Related Information**

*Nios II Software Developer’s Handbook*
- Refer to the "Nios II Software Build Tools" and "Overview of the Hardware Abstraction Layer" chapters.
3.1.4. Component Versions

Platform Designer systems support multiple versions of the same component within the same system; you can create and maintain multiple versions of the same component.

If you have multiple _hw.tcl files for components with the same NAME module properties and different VERSION module properties, both versions of the component are available.

If multiple versions of the component are available in the IP Catalog, you can add a specific version of a component by right-clicking the component, and then selecting Add version <version_number>.

3.1.4.1. Upgrade IP Components to the Latest Version

When you open a Platform Designer design, if Platform Designer detects IP components that require regeneration, the Upgrade IP Cores dialog box appears and allows you to upgrade outdated components.

Components that you must upgrade in order to successfully compile your design appear in red. Status icons indicate whether a component is currently being regenerated, the component is encrypted, or that there is not enough information to determine the status of component. To upgrade a component, in the Upgrade IP Cores dialog box, select the component that you want to upgrade, and then click Upgrade. The Intel Quartus Prime software maintains a list of all IP components associated with your design on the Components tab in the Project Navigator.

Related Information
 Upgrade IP Components Dialog Box
 In Intel Quartus Prime Help

3.2. Design Phases of an IP Component

When you define a component with the Platform Designer Component Editor, or a custom _hw.tcl file, you specify the information that Platform Designer requires to instantiate the component in a Platform Designer system and to generate the appropriate output files for synthesis and simulation.
The following phases describe the process when working with components in Platform Designer:

- **Discovery**—During the discovery phase, Platform Designer reads the _hw.tcl file to identify information that appears in the IP Catalog, such as the component’s name, version, and documentation URLs. Each time you open Platform Designer, the tool searches for the following file types using the default search locations and entries in the IP Search Path:
  - _hw.tcl files—Each _hw.tcl file defines a single component.
  - IP Index (.ipx) files—Each .ipx file indexes a collection of available components, or a reference to other directories to search.

- **Static Component Definition**—During the static component definition phase, Platform Designer reads the _hw.tcl file to identify static parameter declarations, interface properties, interface signals, and HDL files that define the component. At this stage of the life cycle, the component interfaces may be only partially defined.

- **Parameterization**—During the parameterization phase, after an instance of the component is added to a Platform Designer system, the user of the component specifies parameters with the component's parameter editor.

- **Validation**—During the validation phase, Platform Designer validates the values of each instance's parameters against the allowed ranges specified for each parameter. You can use callback procedures that run during the validation phase to provide validation messages. For example, if there are dependencies between parameters where only certain combinations of values are supported, you can report errors for the unsupported values.

- **Elaboration**—During the elaboration phase, Platform Designer queries the component for its interface information. Elaboration is triggered when an instance of a component is added to a system, when its parameters are changed, or when a system property changes. You can use callback procedures that run during the elaboration phase to dynamically control interfaces, signals, and HDL files based on the values of parameters. For example, interfaces defined with static declarations can be enabled or disabled during elaboration. When elaboration is complete, the component's interfaces and design logic must be completely defined.

- **Composition**—During the composition phase, a component can manipulate the instances in the component's subsystem. The _hw.tcl file uses a callback procedure to provide parameterization and connectivity of sub-components.

- **Generation**—During the generation phase, Platform Designer generates synthesis or simulation files for each component in the system into the appropriate output directories, as well as any additional files that support associated tools.

### 3.3. Create IP Components in the Platform Designer Component Editor

The Platform Designer Component Editor allows you to create and package an IP component. When you use the Component Editor to define a component, Platform Designer writes the information to an _hw.tcl file.
The Platform Designer Component Editor allows you to perform the following tasks:

- Specify component's identifying information, such as name, version, author, etc.
- Specify the SystemVerilog, Verilog HDL, VHDL files, and constraint files that define the component for synthesis and simulation.
- Create an HDL template to define a component interfaces, signals, and parameters.
- Set parameters on interfaces and signals that can alter the component's structure or functionality.

If you add the top-level HDL file that defines the component on the Files tab in the Platform Designer Component Editor, you must define the component's parameters and signals in the HDL file. You cannot add or remove them in the Component Editor.

If you do not have a top-level HDL component file, you can use the Platform Designer Component Editor to add interfaces, signals, and parameters. In the Component Editor, the order in which the tabs appear reflects the recommended design flow for component development. You can use the Prev and Next buttons to guide you through the tabs.

In a Platform Designer system, the interfaces of a component are connected in the system, or exported as top-level signals from the system.

If the component is not based on an existing HDL file, enter the parameters, signals, and interfaces first, and then return to the Files tab to create the top-level HDL file template. When you click Finish, Platform Designer creates the component _hw.tcl file with the details that you enter in the Component Editor.

When you save the component, it appears in the IP Catalog.

If you require custom features that the Platform Designer Component Editor does not support, for example, an elaboration callback, use the Component Editor to create the _hw.tcl file, and then manually edit the file to complete the component definition.

**Note:** If you add custom coding to a component, do not open the component file in the Platform Designer Component Editor. The Platform Designer Component Editor overwrites your custom edits.

**Example 5.** 
Platform Designer Creates an _hw.tcl File from Entries in the Component Editor

```tcl
# connection point clock
add_interface clock clock end
set_interface_property clock clockRate 0
set_interface_property clock ENABLED true
add_interface_port clock clk clk Input 1

# connection point reset
add_interface reset reset end
set_interface_property reset associatedClock clock
set_interface_property reset synchronousEdges DEASSERT
set_interface_property reset ENABLED true
add_interface_port reset reset_n reset_n Input 1
```
connection point streaming

```
# add_interface streaming avalon_streaming start
set_interface_property streaming associatedClock clock
set_interface_property streaming associatedReset reset
set_interface_property streaming dataBitsPerSymbol 8
set_interface_property streaming errorDescriptor ""
set_interface_property streaming firstSymbolInHighOrderBits true
set_interface_property streaming maxChannel 0
set_interface_property streaming readyLatency 0
set_interface_property streaming ENABLED true
add_interface_port streaming aso_data data Output 8
add_interface_port streaming aso_valid valid Output 1
add_interface_port streaming aso_ready ready Input 1
```

connection point slave

```
# add_interface slave axi end
set_interface_property slave associatedClock clock
set_interface_property slave associatedReset reset
set_interface_property slave readAcceptanceCapability 1
set_interface_property slave writeAcceptanceCapability 1
set_interface_property slave combinedAcceptanceCapability 1
set_interface_property slave readDataReorderingDepth 1
set_interface_property slave ENABLED true
add_interface_port slave axs_awid awid Input AXI_ID_W
... add_interface_port slave axs_rresp rresp Output 2
```

### Related Information

Component Interface Tcl Reference on page 492

#### 3.3.1. Save an IP Component and Create the _hw.tcl File

You save a component by clicking Finish in the Platform Designer Component Editor. The Component Editor saves the component as `<component_name>_hw.tcl` file.

Intel recommends that you move `_hw.tcl` files and their associated files to an `ip/` directory within your Intel Quartus Prime project directory. You can use IP components with other applications, such as the C compiler and a board support package (BSP) generator.

Refer to Creating a System with Platform Designer for information on how to search for and add components to the IP Catalog for use in your designs.

### Related Information

- Publishing Component Information to Embedded Software (Nios II Gen 2 Software Developer’s Handbook)
- Creating a System with Platform Designer on page 9
- Publishing Component Information to Embedded Software (Nios II Software Developer’s Handbook)
- Creating a System with Platform Designer on page 9
3.3.2. Edit an IP Component with the Platform Designer Component Editor

In Platform Designer, you make changes to a component by right-clicking the component in the **System Contents** tab, and then clicking **Edit**. After making changes, click **Finish** to save the changes to the _hw.tcl file.

You can open an _hw.tcl file in a text editor to view the hardware Tcl for the component. If you edit the _hw.tcl file to customize the component with advanced features, you cannot use the Component Editor to make further changes without overwriting your customized file.

You cannot use the Component Editor to edit components installed with the Intel Quartus Prime software, such as Intel-provided components. If you edit the HDL for a component and change the interface to the top-level module, you must edit the component to reflect the changes you make to the HDL.

3.4. Specify IP Component Type Information

The **Component Type** tab in the Platform Designer Component Editor allows you to specify the following information about the component:

- **Name**—Specifies the name used in the _hw.tcl filename, as well as in the top-level module name when you create a synthesis wrapper file for a non HDL-based component.

- **Display name**—Identifies the component in the parameter editor, which you use to configure and instance of the component, and also appears in the IP Catalog under **Project** and on the **System Contents** tab.

- **Version**—Specifies the version number of the component.

- **Group**—Represents the category of the component in the list of available components in the IP Catalog. You can select an existing group from the list, or define a new group by typing a name in the **Group** box. Separating entries in the **Group** box with a slash defines a subcategory. For example, if you type **Memories and Memory Controllers/On-Chip**, the component appears in the IP Catalog under the **On-Chip** group, which is a subcategory of the **Memories and Memory Controllers** group. If you save the component in the project directory, the component appears in the IP Catalog in the group you specified under **Project**. Alternatively, if you save the component in the Intel Quartus Prime installation directory, the component appears in the specified group under **IP Catalog**.

- **Description**—Allows you to describe the component. This description appears when the user views the component details.
• **Created By**—Allows you to specify the author of the component.

• **Icon**—Allows you to enter the relative path to an icon file (.gif, .jpg, or .png format) that represents the component and appears as the header in the parameter editor for the component. The default image is the Intel FPGA IP function icon.

• **Documentation**—Allows you to add links to documentation for the component, and appears when you right-click the component in the IP Catalog, and then select Details.

  — To specify an Internet file, begin your path with `http://`, for example: `http://mydomain.com/datasheets/my_memory_controller.html`.

  — To specify a file in the file system, begin your path with `file://` for Linux, and `file:///` for Windows; for example (Windows): `file:///company_server/datasheets my_memory_controller.pdf`.

**Figure 48. Component Type Tab in the Component Editor**

The **Display name**, **Group**, **Description**, **Created By**, **Icon**, and **Documentation** entries are optional.

When you use the Component Editor to create a component, it writes this basic component information in the `_hw.tcl` file. The `package require` command specifies the Intel Quartus Prime software version that Platform Designer uses to create the `_hw.tcl` file, and ensures compatibility with this version of the Platform Designer API in future ACDS releases.
Example 6. _hw.tcl Created from Entries in the Component Type Tab

The component defines its basic information with various module properties using the
set_module_property command. For example, set_module_property NAME specifies the name of the component, while set_module_property VERSION allows you to specify the version of the component. When you apply a version to the _hw.tcl file, it allows the file to behave exactly the same way in future releases of the Intel Quartus Prime software.

```tcl
# request TCL package from ACDS 14.0
package require -exact qsys 14.0

# demo_axi_memory
set_module_property DESCRIPTION \
"Demo AXI-3 memory with optional Avalon-ST port"
set_module_property NAME demo_axi_memory
set_module_property VERSION 1.0
set_module_property GROUP "My Components"
set_module_property AUTHOR Altera
set_module_property DISPLAY_NAME "Demo AXI Memory"
```

Related Information
Component Interface Tcl Reference on page 492

3.5. Create an HDL File in the Platform Designer Component Editor

If you do not have an HDL file for your component, you can use the Platform Designer Component Editor to define the component signals, interfaces, and parameters of your component, and then create a simple top-level HDL file.

You can then edit the HDL file to add the logic that describes the component's behavior.

1. In the Platform Designer Component Editor, specify the information about the component in the Signals & Interfaces, and Interfaces, and Parameters tabs.
2. Click the Files tab.
3. Click Create Synthesis File from Signals.
   The Component Editor creates an HDL file from the specified signals, interfaces, and parameters, and the .v file appears in the Synthesis File table.

Related Information
Specify Synthesis and Simulation Files in the Platform Designer Component Editor on page 316

3.6. Create an HDL File Using a Template in the Platform Designer Component Editor

You can use a template to create interfaces and signals for your Platform Designer component
3. Creating Platform Designer Components

UG-20130 | 2018.06.15

1. In Platform Designer, click **New Component** in the IP Catalog.

2. On the **Component Type** tab, define your component information in the **Name**, **Display Name**, **Version**, **Group**, **Description**, **Created by**, **Icon**, and **Documentation** boxes.

3. Click **Finish**.
   Your new component appears in the IP Catalog under the category that you define for "Group".

4. In Platform Designer, right-click your new component in the IP Catalog, and then click **Edit**.

5. In the Platform Designer Component Editor, click any interface from the Templates drop-down menu.
   The Component Editor fills the **Signals** and **Interfaces** tabs with the component interface template details.

6. On the **Files** tab, click **Create Synthesis File from Signals**.

7. Do the following in the **Create HDL Template** dialog box as shown below:
   a. Verify that the correct files appears in **File** path, or browse to the location where you want to save your file.
   
   b. Select the HDL language.
   
   c. Click **Save** to save your new interface, or **Cancel** to discard the new interface definition.
8. Verify the `<component_name>.v` file appears in the **Synthesis Files** table on the **Files** tab.

**Related Information**
Specify Synthesis and Simulation Files in the Platform Designer Component Editor on page 316

3.7. Specify Synthesis and Simulation Files in the Platform Designer Component Editor

The **Files** tab in the Platform Designer Component Editor allows you to specify synthesis and simulation files for your custom component.

If you already have an HDL file that describes the behavior and structure of your component, you can specify those files on the **Files** tab.
If you do not yet have an HDL file, you can specify the signals, interfaces, and parameters of the component in the Component Editor, and then use the **Create Synthesis File from Signals** option on the **Files** tab to create the top-level HDL file. The Component Editor generates the `_hw.tcl` commands to specify the files.

**Note:** After you analyze the component's top-level HDL file (on the **Files** tab), you cannot add or remove signals or change the signal names on the **Signals & Interfaces** tab. If you need to edit signals, edit your HDL source, and then click **Create Synthesis File from Signals** on the **Files** tab to integrate your changes.

A component uses filesets to specify the different sets of files that you can generate for an instance of the component. The supported fileset types are: **QUARTUS_SYNTH**, for synthesis and compilation in the Intel Quartus Prime software, **SIM_VERILOG**, for Verilog HDL simulation, and **SIM_VHDL**, for VHDL simulation.

In an `_hw.tcl` file, you can add a fileset with the `add_fileset` command. You can then list specific files with the `add_fileset_file` command. The `add_fileset_property` command allows you to add properties such as **TOP_LEVEL**.

You can populate a fileset with a a fixed list of files, add different files based on a parameter value, or even generate an HDL file with a custom HDL generator function outside of the `_hw.tcl` file.

**Related Information**
- Create an HDL File in the Platform Designer Component Editor on page 314
- Create an HDL File Using a Template in the Platform Designer Component Editor on page 314

### 3.7.1. Specify HDL Files for Synthesis in the Platform Designer Component Editor

In the Platform Designer Component Editor, you can add HDL files and other support files with options on the **Files** tab.

A component must specify an HDL file as the top-level file. The top-level HDL file contains the top-level module. The **Synthesis Files** list may also include supporting HDL files, such as timing constraints, or other files required to successfully synthesize and compile in the Intel Quartus Prime software. The synthesis files for a component are copied to the generation output directory during Platform Designer system generation.
3.7.2. Analyze Synthesis Files in the Platform Designer Component Editor

After you specify the top-level HDL file in the Platform Designer Component Editor, click Analyze Synthesis Files to analyze the parameters and signals in the top-level, and then select the top-level module from the Top Level Module list. If there is a single module or entity in the HDL file, Platform Designer automatically populates the Top-level Module list.

Once analysis is complete and the top-level module is selected, you can view the parameters and signals on the Parameters and Signals & Interfaces tabs. The Component Editor may report errors or warnings at this stage, because the signals and interfaces are not yet fully defined.

Note: At this stage in the Component Editor flow, you cannot add or remove parameters or signals created from a specified HDL file without editing the HDL file itself.

The synthesis files are added to a fileset with the name QUARTUS_SYNTH and type QUARTUS_SYNTH in the _hw.tcl file created by the Component Editor. The top-level module is used to specify the TOP_LEVEL fileset property. Each synthesis file is individually added to the fileset. If the source files are saved in a different directory from the working directory where the _hw.tcl is located, you can use standard fixed or relative path notation to identify the file location for the PATH variable.

Example 7. _hw.tcl Created from Entries in the Files tab in the Synthesis Files Section

```tcl
# file sets
add_fileset QUARTUS_SYNTH QUARTUS_SYNTH "" ""
set_fileset_property QUARTUS_SYNTH TOP_LEVEL demo_axi_memory

add_fileset_file demo_axi_memory.sv
SYSTEM_VERILOG PATH demo_axi_memory.sv

add_fileset_file single_clk_ram.v VERILOG PATH single_clk_ram.v
```
Related Information

- Specify HDL Files for Synthesis in the Platform Designer Component Editor on page 317
- Component Interface Tcl Reference on page 492

3.7.3. Name HDL Signals for Automatic Interface and Type Recognition in the Platform Designer Component Editor

If you create the component’s top-level HDL file before using the Component Editor, the Component Editor recognizes the interface and signal types based on the signal names in the source HDL file. This auto-recognition feature eliminates the task of manually assigning each interface and signal type in the Component Editor.

To enable auto-recognition, you must create signal names using the following naming convention:

\(<interface\ type\ prefix>_{<interface\ name>}_{<signal\ type}>\)

Specifying an interface name with \(<interface\ name>\) is optional if you have only one interface of each type in the component definition. For interfaces with only one signal, such as clock and reset inputs, the \(<interface\ type\ prefix>\) is also optional.

### Table 40. Interface Type Prefixes for Automatic Signal Recognition

When the Component Editor recognizes a valid prefix and signal type for a signal, it automatically assigns an interface and signal type to the signal based on the naming convention. If no interface name is specified for a signal, you can choose an interface name on the Signals & Interfaces tab in the Component Editor.

<table>
<thead>
<tr>
<th>Interface Prefix</th>
<th>Interface Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>asi</td>
<td>Avalon-ST sink (input)</td>
</tr>
<tr>
<td>aso</td>
<td>Avalon-ST source (output)</td>
</tr>
<tr>
<td>avm</td>
<td>Avalon-MM master</td>
</tr>
<tr>
<td>avs</td>
<td>Avalon-MM slave</td>
</tr>
<tr>
<td>axm</td>
<td>AXI master</td>
</tr>
<tr>
<td>axs</td>
<td>AXI slave</td>
</tr>
<tr>
<td>apm</td>
<td>APB master</td>
</tr>
<tr>
<td>aps</td>
<td>APB slave</td>
</tr>
<tr>
<td>coe</td>
<td>Conduit</td>
</tr>
<tr>
<td>csi</td>
<td>Clock Sink (input)</td>
</tr>
<tr>
<td>cso</td>
<td>Clock Source (output)</td>
</tr>
<tr>
<td>inr</td>
<td>Interrupt receiver</td>
</tr>
<tr>
<td>ins</td>
<td>Interrupt sender</td>
</tr>
<tr>
<td>ncm</td>
<td>Nios II custom instruction master</td>
</tr>
<tr>
<td>ncs</td>
<td>Nios II custom instruction slave</td>
</tr>
<tr>
<td>rsi</td>
<td>Reset sink (input)</td>
</tr>
</tbody>
</table>

*continued...*


<table>
<thead>
<tr>
<th>Interface Prefix</th>
<th>Interface Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>rso</td>
<td>Reset source (output)</td>
</tr>
<tr>
<td>tcm</td>
<td>Avalon-TC master</td>
</tr>
<tr>
<td>tcs</td>
<td>Avalon-TC slave</td>
</tr>
</tbody>
</table>

Refer to the *Avalon Interface Specifications* or the *AMBA Protocol Specification* for the signal types available for each interface type.

**Related Information**
- Avalon Interface Specifications
- Protocol Specifications

### 3.7.4. Specify Files for Simulation in the Component Editor

To support Platform Designer system generation for your custom component, you must specify VHDL or Verilog simulation files.

You can choose to generate Verilog or VHDL simulation files. In most cases, these files are the same as the synthesis files. If there are simulation-specific HDL files or simulation models, you can use them in addition to, or in place of the synthesis files.

To use your synthesis files as your simulation files, click **Copy From Synthesis Files** on the **Files** tab in the Platform Designer Component Editor.

**Note:**
The order that you add files to the fileset determines the order of compilation. For VHDL filesets with VHDL files, you must add the files bottom-up, adding the top-level file last.

**Figure 50. Specifying the Simulation Output Files on the Files Tab**

You specify the simulation files in a similar way as the synthesis files with the fileset commands in a `_hw.tcl` file. The code example below shows **SIM_VERILOG** and **SIM_VHDL** filesets for Verilog and VHDL simulation output files. In this example, the same Verilog files are used for both Verilog and VHDL outputs, and there is one additional SystemVerilog file added. This method works for designers of Verilog IP to
support users who want to generate a VHDL top-level simulation file when they have a mixed-language simulation tool and license that can read the Verilog output for the component.

Example 8. _hw.tcl Created from Entries in the Files tab in the Simulation Files Section

```
add_fileset SIM_VERILOG SIM_VERILOG "" ""
set_fileset_property SIM_VERILOG TOP_LEVEL demo_axi_memory
add_fileset_file single_clk_ram.v VERILOG PATH single_clk_ram.v
add_fileset_file verbosity_pkg.sv SYSTEM_VERILOG PATH \verification_lib/verbosity_pkg.sv
add_fileset_file demo_axi_memory.sv SYSTEM_VERILOG PATH \demo_axi_memory.sv
add_fileset SIM_VHDL SIM_VHDL "" ""
set_fileset_property SIM_VHDL TOP_LEVEL demo_axi_memory
set_fileset_property SIM_VHDL ENABLE_RELATIVE_INCLUDE_PATHS false
add_fileset_file demo_axi_memory.sv SYSTEM_VERILOG PATH \demo_axi_memory.sv
add_fileset_file single_clk_ram.v VERILOG PATH single_clk_ram.v
add_fileset_file verbosity_pkg.sv SYSTEM_VERILOG PATH \verification_lib/verbosity_pkg.sv
```

Related Information
Component Interface Tcl Reference on page 492

3.7.5. Include an Internal Register Map Description in the .svd for Slave Interfaces Connected to an HPS Component

Platform Designer supports the ability for IP component designers to specify register map information on their slave interfaces. This allows components with slave interfaces that are connected to an HPS component to include their internal register description in the generated .svd file.

To specify their internal register map, the IP component designer must write and generate their own .svd file and attach it to the slave interface using the following command:

```
set_interface_property <slave interface> CMSIS_SVD_FILE <file path>
```

The CMSIS_SVD_VARIABLES interface property allows for variable substitution inside the .svd file. You can dynamically modify the character data of the .svd file by using the CMSIS_SVD_VARIABLES property.

Example 9. Setting the CMSIS_SVD_VARIABLES Interface Property

For example, if you set the CMSIS_SVD_VARIABLES in the _hw.tcl file, then in the .svd file if there is a variable {width} that describes the element <size>$\{width\}</size>, it is replaced by <size>{width}</size> during generation of the .svd file. Note that substitution works only within character data (the data enclosed by <element>...</element>) and not on element attributes.

```
set_interface_property <interface_name> \CMSIS_SVD_VARIABLES "\{width\} {23}"\`
```
3.8. Add Signals and Interfaces in the Platform Designer Component Editor

In the Platform Designer Component Editor, the Signals & Interfaces tab allows you to add signals and interfaces for your custom IP component.

As you select interfaces and associated signals, you can customize the parameters. Messages appear as you add interfaces and signals to guide you when customizing the component. In the parameter editor, a block diagram displays for each interface. Some interfaces display waveforms to show the timing of the interface. If you update timing parameters, the waveforms update automatically.

1. In Platform Designer, click New Component in the IP Catalog.
2. In the Platform Designer Component Editor, click the Signals & Interfaces tab.
3. To add an interface, click << add interface >> in the left pane. A drop-down list appears where you select the interface type.
4. Select an interface from the drop-down list. The selected interface appears in the parameter editor where you can specify its parameters.
5. To add signals for the selected interface click << add signal >> below the selected interface.
6. To move signals between interfaces, select the signal, and then drag it to another interface.
7. To rename a signal or interface, select the element, and then press F2.
8. To remove a signal or interface, right-click the element, and then click Remove. Alternatively, to remove an signal or interface, you can select the element, and then press Delete. When you remove an interface, Platform Designer also removes all of its associated signals.
Components can include parameterized HDL, which allows users of the component flexibility in meeting their system requirements. For example, a component may have a configurable memory size or data width, where one HDL implementation can be used in different systems, each with unique parameters values.

The Parameters tab allows you specify the parameters that are used to configure instances of the component in a Platform Designer system. You can specify various properties for each parameter that describe how to display and use the parameter. You can also specify a range of allowed values that are checked during the validation phase. The Parameters table displays the HDL parameters that are declared in the top-level HDL module. If you have not yet created the top-level HDL file, the parameters that you create on the Parameters tab are included in the top-level synthesis file template created from the Files tab.

When the component includes HDL files, the parameters match those defined in the top-level module, and you cannot be add or remove them on the Parameters tab. To add or remove the parameters, edit your HDL source, and then re-analyze the file.

If you used the Component Editor to create a top-level template HDL file for synthesis, you can remove the newly-created file from the Synthesis Files list on the Files tab, make your parameter changes, and then re-analyze the top-level synthesis file.

You can use the Parameters table to specify the following information about each parameter:

- **Name**—Specifies the name of the parameter.
- **Default Value**—Sets the default value used in new instances of the component.
- **Editable**—Specifies whether or not the user can edit the parameter value.
• **Type**—Defines the parameter type as string, integer, boolean, std_logic, logic vector, natural, or positive.

• **Group**—Allows you to group parameters in parameter editor.

• **Tooltip**—Allows you to add a description of the parameter that appears when the user of the component points to the parameter in the parameter editor.

**Figure 52. Parameters Tab in the Platform Designer Components Editor**

On the **Parameters** tab, you can click **Preview the GUI** at any time to see how the declared parameters appear in the parameter editor. Parameters with their default values appear with checks in the **Editable** column, indicating that users of this component are allowed to modify the parameter value. Editable parameters cannot contain computed expressions. You can group parameters under a common heading or section in the parameter editor with the **Group** column, and a tooltip helps users of the component understand the function of the parameter. Various parameter properties allow you to customize the component’s parameter editor, such as using radio buttons for parameter selections, or displaying an image.

**Example 10. _hw.tcl Created from Entries in the Parameters Tab**

In this example, the first `add_parameter` command includes commonly-specified properties. The `set_parameter_property` command specifies each property individually. The **Tooltip** column on the **Parameters** tab maps to the **DESCRIPTION** property, and there is an additional unused **UNITS** property created in the code. The **HDL_PARAMETER** property specifies that the value of the parameter is specified in the HDL instance wrapper when creating instances of the component. The **Group** column in the **Parameters** tab maps to the display items section with the `add_display_item` commands.
Note: If a parameter \(<n>\) defines the width of a signal, the signal width must follow the format: \(<n-1>:0\).

```
# parameters
add_parameter AXI_ID_W INTEGER 4 "Width of ID fields"
set_parameter_property AXI_ID_W DEFAULT_VALUE 4
set_parameter_property AXI_ID_W DISPLAY_NAME AXI_ID_W
set_parameter_property AXI_ID_W TYPE INTEGER
set_parameter_property AXI_ID_W UNITS None
set_parameter_property AXI_ID_W DESCRIPTION "Width of ID fields"
set_parameter_property AXI_ID_W HDL_PARAMETER true
add_parameter AXI_ADDRESS_W INTEGER 12
set_parameter_property AXI_ADDRESS_W DEFAULT_VALUE 12
add_parameter AXI_DATA_W INTEGER 32

# display items
add_display_item "AXI Port Widths" AXI_ID_W PARAMETER ""
```

Note: If an AXI slave's ID bit width is smaller than required for your system, the AXI slave response may not reach all AXI masters. The formula of an AXI slave ID bit width is calculated as follows:

```
maximum_master_id_width_in_the_interconnect + \log_2 (number_of_masters_in_the_same_interconnect)
```

For example, if an AXI slave connects to three AXI masters and the maximum AXI master ID length of the three masters is 5 bits, then the AXI slave ID is 7 bits, and is calculated as follows:

```
5 \text{ bits} + 2 \text{ bits}\ (\log_2 (3 \text{ masters})) = 7
```

### Table 41. AXI Master and Slave Parameters

<table>
<thead>
<tr>
<th>AXI Master Parameters</th>
<th>AXI Slave Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>readIssuingCapability</td>
<td>readAcceptanceCapability</td>
</tr>
<tr>
<td>writeIssuingCapability</td>
<td>writeAcceptanceCapability</td>
</tr>
<tr>
<td>combinedIssuingCapability</td>
<td>combinedAcceptanceCapability</td>
</tr>
<tr>
<td></td>
<td>readDataReorderingDepth</td>
</tr>
</tbody>
</table>

**Related Information**

Component Interface Tcl Reference on page 492

**3.9.1. Valid Ranges for Parameters in the _hw.tcl File**

In the _hw.tcl file, you can specify valid ranges for parameters.
Platform Designer validation checks each parameter value against the ALLOWED_RANGES property. If the values specified are outside of the allowed ranges, Platform Designer displays an error message. Specifying choices for the allowed values enables users of the component to choose the parameter value from a drop-down list or radio button in the parameter editor GUI instead of entering a value.

The ALLOWED_RANGES property is a list of valid ranges, where each range is a single value, or a range of values defined by a start and end value.

<table>
<thead>
<tr>
<th>ALLOWED_RANGES Property</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a b c)</td>
<td>a, b, or c</td>
</tr>
<tr>
<td>(<em>No Control</em> <em>Single Control</em> <em>Dual Controls</em>)</td>
<td>Unique string values. Quotation marks are required if the strings include spaces</td>
</tr>
<tr>
<td>(1 2 4 8 16)</td>
<td>1, 2, 4, 8, or 16</td>
</tr>
<tr>
<td>(1:3)</td>
<td>1 through 3, inclusive.</td>
</tr>
<tr>
<td>(1 2 3 7:10)</td>
<td>1, 2, 3, or 7 through 10 inclusive.</td>
</tr>
</tbody>
</table>

**Related Information**

Declare Parameters with Custom _hw.tcl Commands on page 328

### 3.9.2. Types of Platform Designer Parameters

Platform Designer uses the following parameter types: user parameters, system information parameters, and derived parameters.

**Platform Designer User Parameters** on page 326

**Platform Designer System Information Parameters** on page 326

**Platform Designer Derived Parameters** on page 327

**Related Information**

Declare Parameters with Custom _hw.tcl Commands on page 328

### 3.9.2.1. Platform Designer User Parameters

User parameters are parameters that users of a component can control, and appear in the parameter editor for instances of the component. User parameters map directly to parameters in the component HDL. For user parameter code examples, such as AXI_DATA_W and ENABLE_STREAM_OUTPUT, refer to Declaring Parameters with Custom hw.tcl Commands.

### 3.9.2.2. Platform Designer System Information Parameters

A SYSTEM_INFO parameter is a parameter whose value is set automatically by the Platform Designer system. When you define a SYSTEM_INFO parameter, you provide an information type, and additional arguments.
For example, you can configure a parameter to store the clock frequency driving a clock input for your component. To do this, define the parameter as SYSTEM_INFO of type CLOCK_RATE:

```tcl
set_parameter_property <param> SYSTEM_INFO CLOCK_RATE
```

You then set the name of the clock interface as the SYSTEM_INFO argument:

```tcl
set_parameter_property <param> SYSTEM_INFO_ARG <clkname>
```

### 3.9.2.2.1. Obtaining Device Trait Information Using PART_TRAIT System Information Parameter

Within Platform Designer, an IP core can obtain information on the particular traits of a device using the PART_TRAIT system info parameter. This system info parameter takes an argument corresponding to the desired part trait. The requested trait must match the trait name as specified in the device database.

**Note:** Using this API declares your core as dependent on the requested trait.

To get the part number setting of Platform Designer system, use the value DEVICE, with the SYSTEM_INFO_ARG parameter property:

```tcl
add_parameter part_trait_device string ""
set_parameter_property part_trait_device SYSTEM_INFO_TYPE PART_TRAIT
set_parameter_property part_trait_device SYSTEM_INFO_ARG DEVICE
```

To get the base device of the part number setting of Platform Designer system, use the value BASE_DEVICE, with the SYSTEM_INFO_ARG parameter property:

```tcl
add_parameter part_trait_bd string ""
set_parameter_property part_trait_bd SYSTEM_INFO_TYPE PART_TRAIT
set_parameter_property part_trait_bd SYSTEM_INFO_ARG BASE_DEVICE
```

To get the device speed-grade of the part number setting of Platform Designer system, use the value DEVICE_SPEEDGRADE, with the SYSTEM_INFO_ARG parameter property:

```tcl
add_parameter part_trait_sg string ""
set_parameter_property part_trait_sg SYSTEM_INFO_TYPE PART_TRAIT
set_parameter_property part_trait_sg SYSTEM_INFO_ARG DEVICE_SPEEDGRADE
```

### 3.9.2.3. Platform Designer Derived Parameters

Derived parameter values are calculated from other parameters during the Elaboration phase, and are specified in the `hw.tcl` file with the DERIVED property. Derived parameter values are calculated from other parameters during the Elaboration phase, and are specified in the `hw.tcl` file with the DERIVED property. For example, you can derive a clock period parameter from a data rate parameter. Derived parameters are sometimes used to perform operations that are difficult to perform in HDL, such as using logarithmic functions to determine the number of address bits that a component requires.

**Related Information**

Declare Parameters with Custom _hw.tcl Commands on page 328
3.9.2.3.1. Parameterized Parameter Widths

Platform Designer allows a std_logic_vector parameter to have a width that is defined by another parameter, similar to derived parameters. The width can be a constant or the name of another parameter.

3.9.3. Declare Parameters with Custom _hw.tcl Commands

The example below illustrates a custom _hw.tcl file, with more advanced parameter commands than those generated when you specify parameters in the Component Editor. Commands include the ALLOWED_RANGES property to provide a range of values for the AXI_ADDRESS_W (Address Width) parameter, and a list of parameter values for the AXI_DATA_W (Data Width) parameter. This example also shows the parameter AXI_NUMBYTES (Data width in bytes) parameter; that uses the DERIVED property. In addition, these commands illustrate the use of the GROUP property, which groups some parameters under a heading in the parameter editor GUI. You use the ENABLE_STREAM_OUTPUT_GROUP (Include Avalon streaming source port) parameter to enable or disable the optional Avalon-ST interface in this design, and is displayed as a check box in the parameter editor GUI because the parameter is of type BOOLEAN. Refer to figure below to see the parameter editor GUI resulting from these hw.tcl commands.

Example 11. Parameter Declaration

In this example, the AXI_NUMBYTES parameter is derived during the Elaboration phase based on another parameter, instead of being assigned to a specific value. AXI_NUMBYTES describes the number of bytes in a word of data. Platform Designer calculates the AXI_NUMBYTES parameter from the DATA_WIDTH parameter by dividing by 8. The _hw.tcl code defines the AXI_NUMBYTES parameter as a derived parameter, since its value is calculated in an elaboration callback procedure. The AXI_NUMBYTES parameter value is not editable, because its value is based on another parameter value.

```tcl
add_parameter AXI_ADDRESS_W INTEGER 12
set_parameter_property AXI_ADDRESS_W DISPLAY_NAME "AXI Slave Address Width"
set_parameter_property AXI_ADDRESS_W DESCRIPTION "Address width."
set_parameter_property AXI_ADDRESS_W UNITS bits
set_parameter_property AXI_ADDRESS_W ALLOWED_RANGES 4:16
set_parameter_property AXI_ADDRESS_W HDL_PARAMETER true
set_parameter_property AXI_ADDRESS_W GROUP "AXI Port Widths"

add_parameter AXI_DATA_W INTEGER 32
set_parameter_property AXI_DATA_W DISPLAY_NAME "Data Width"
set_parameter_property AXI_DATA_W DESCRIPTION "Width of data buses."
set_parameter_property AXI_DATA_W UNITS bits
set_parameter_property AXI_DATA_W ALLOWED_RANGES {8 16 32 64 128 256 512 1024}
set_parameter_property AXI_DATA_W HDL_PARAMETER true
set_parameter_property AXI_DATA_W GROUP "AXI Port Widths"
```
Figure 53. Resulting Parameter Editor GUI from Parameter Declarations

3.9.4. Validate Parameter Values with a Validation Callback

You can use a validation callback procedure to validate parameter values with more complex validation operations than the ALLOWED_RANGES property allows. You define a validation callback by setting the VALIDATION_CALLBACK module property to the name of the Tcl callback procedure that runs during the validation phase. In the validation callback procedure, the current parameter values is queried, and warnings or errors are reported about the component’s configuration.
Example 12. Demo AXI Memory Example

If the optional Avalon streaming interface is enabled, then the control registers must be wide enough to hold an AXI RAM address, so the designer can add an error message to ensure that the user enters allowable parameter values.

```tcl
set_module_property VALIDATION_CALLBACK validate
proc validate {} {
   if {
      [get_parameter_value ENABLE_STREAM_OUTPUT] &&
      ([get_parameter_value AXI_ADDRESS_W] > [get_parameter_value AV_DATA_W])
   } send_message error "If the optional Avalon streaming port is enabled, the AXI Data Width must be equal to or greater than the Avalon control port Address Width"
}
}
```

Related Information

- Component Interface Tcl Reference on page 492
- Demo AXI Memory Example

3.10. Declaring SystemVerilog Interfaces in _hw.tcl

Platform Designer supports interfaces written in SystemVerilog. The following example is _hw.tcl for a module with a SystemVerilog interface. The sample code is divided into parts 1 and 2.

Part 1 defines the normal array of parameters, Platform Designer interface, and ports


```tcl
# request TCL package from ACDS 17.1
package require -exact qsys 17.1

# module ram_ip_sv_ifc_hw

# set_module_property DESCRIPTION ""
set_module_property NAME ram_ip_sv_ifc_hw
set_module_property VERSION 1.0
set_module_property INTERNAL false
set_module_property OPAQUE_ADDRESS_MAP true
set_module_property AUTHOR ""
set_module_property DISPLAY_NAME ram_ip_hw_with_SV_d0
set_module_property INSTANTIATE_IN_SYSTEM_MODULE true
set_module_property EDITABLE true
set_module_property REPORT_TO_TALKBACK false
set_module_property ALLOW_GREYBOX_GENERATION false
set_module_property REPORT_HIERARCHY false

# Part 1 - Add parameter, platform designer interface and ports
# Adding parameter
add_parameter my_interface_parameter STRING "" "I am an interface parameter"
# Adding platform designer interface clk
```
Part 2 defines the interface name, ports, and parameters of the SystemVerilog interface.

**Example 14. Example Part 2: SystemVerilog Interface Parameters in _hw.tcl**

```tcl
add_interface clk clock end
set_interface_property clk clockRate 0
# Adding ports to clk interface
add_interface_port clk clk clk Input 1

# Adding platform designer interface reset
add_interface reset reset end
set_interface_property reset associatedClock clk
# Adding ports to reset interface
add_interface_port reset reset reset Input 1

# Adding platform designer interface avalon_slave
add_interface avalon_slave avalon end
set_interface_property avalon_slave addressUnits WORDS
# Adding ports to avalon_slave interface
add_interface_port avalon_slave address address Input 10
add_interface_port avalon_slave write write Input 1
add_interface_port avalon_slave readdata readdata Output 32
add_interface_port avalon_slave writedata writedata Input 32
set_interface_property avalon_slave associatedClock clk
set_interface_property avalon_slave associatedReset reset

# Adding ram_ip files
add_fileset synthesis_fileset QUARTUS_SYNTH
set_fileset_property synthesis_fileset TOP_LEVEL ram_ip
add_fileset_file ram_ip.sv SYSTEM_VERILOG PATH ram_ip.sv
```

3.11. **User Alterable HDL Parameters in _hw.tcl**

Platform Designer supports the ability to reconfigure features of parameterized modules, such as data bus width or FIFO depth. Platform Designer creates an HDL wrapper when you perform Generate HDL. By modifying your _hw.tcl files to specify parameter attributes and port properties, you can use Platform Designer to generate reusable RTL.

1. To define an alterable HDL parameter, you must declare the following two attributes for the parameter:

```tcl
```
2. To have parameterized ports created in the instantiation wrapper, you can either set the width expression when adding a port to an interface, or set the width expression in the port property in _hw.tcl:
   - To set the width expression when adding a port:
     ```
     add_interface_port <interface> <port> <signal_type> <direction> <width_expression>
     ```
   - To set the width expression in the port property:
     ```
     set_port_property <port> WIDTH_EXPR <width_expression>
     ```

3. To create and generate the IP component in Platform Designer editor, click the Open System ➤ IP Variant tab, specify the new IP variant name in the IP Variant field and choose the _hw.tcl file that defines user alterable HDL parameters in the Component type field.

4. Click Generate HDL to generate the IP core. Platform Designer generates a parameterized HDL module for you directly.

To instantiate the IP component in your HDL file, click Generate ➤ Show Instantiation Template in the Platform Designer editor to display an instantiation template in Verilog or VHDL. Now you can instantiate the IP core in your top-level design HDL file with the template code.

Figure 54. Instantiation Template Dialog Box

The following sample contains _hw.tcl to set exportable width values:

Example 15. Sample _hw.tcl Component with User Alterable Expressions

```bash
package require -exact qsys 17.1
set_module_property NAME demo
set_module_property DISPLAY_NAME "Demo"
```
set_module_property ELABORATION_CALLBACK elaborate

# add exportable hdl parameter RECONFIG_DATA_WIDTH
add_parameter RECONFIG_DATA_WIDTH INTEGER 48
set_parameter_property RECONFIG_DATA_WIDTH AFFECTS_GENERATION false
set_parameter_property RECONFIG_DATA_WIDTH HDL_PARAMETER true

# add exportable hdl parameter RECONFIG_ADDR_WIDTH
add_parameter RECONFIG_ADDR_WIDTH INTEGER 32
set_parameter_property RECONFIG_ADDR_WIDTH AFFECTS_GENERATION false
set_parameter_property RECONFIG_ADDR_WIDTH HDL_PARAMETER true

# add non-exportable hdl parameter
add_parameter l_addr INTEGER 32
set_parameter l_addr HDL_PARAMETER false

# add interface
add_interface s0 conduit end

proc elaborate {} {
  add_interface_port s0 rdata readdata output "reconfig_data_width*2 + l_addr"
  add_interface_port s0 raddr readaddress output [get_parameter_value RECONFIG_ADDR_WIDTH]
  set_port_property raddr WIDTH_EXPR "RECONFIG_ADDR_WIDTH"
}

3.12. Scripting Flow for Wire-Level Expressions

Platform Designer includes new system scripting commands that you can use to apply wire-level expressions to your IP component input ports in either the qsys-script or _hw.tcl utilities. There are three Tcl commands for wire-level expressions.

You can use these commands to apply an expression to a port. You can also retrieve or remove expressions from a port, an instance, or the current system. You can use these commands with either the qsys-script utility or in a _hw.tcl file.

- Before using qsys-script, you must add new wire-level interfaces which moves the specified ports to a wire-level interface.
- When using _hw.tcl, you can apply a wire-level expression directly to the port.

Wire-Level Expression Scripting Commands

<table>
<thead>
<tr>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>set_wirelevel_expression &lt;instance_or_port_bitselection&gt; &lt;expression&gt;</td>
</tr>
<tr>
<td>get_wirelevel_expressions &lt;instance_or_port_bitselection&gt;</td>
</tr>
<tr>
<td>remove_wirelevel_expressions &lt;instance_or_port_bitselection&gt;</td>
</tr>
</tbody>
</table>

These commands take a string that is composed of the left-handed and right-handed components of the expression. Platform Designer posts errors if there are any problems with syntax, existence, or system hierarchy.

Related Information

- Wire-Level Connection Commands on page 267
- set_wirelevel_expression on page 268
- get_wirelevel_expressions on page 268
- remove_wirelevel_expressions on page 269
3.13. Control Interfaces Dynamically with an Elaboration Callback

You can allow user parameters to dynamically control your component's behavior with an elaboration callback procedure during the elaboration phase. Using an elaboration callback allows you to change interface properties, remove interfaces, or add new interfaces as a function of a parameter value. You define an elaboration callback by setting the module property `ELABORATION_CALLBACK` to the name of the Tcl callback procedure that runs during the elaboration phase. In the callback procedure, you can query the parameter values of the component instance, and then change the interfaces accordingly.

Example 16. Avalon-ST Source Interface Optionally Included in a Component Specified with an Elaboration Callback

```tcl
set_module_property ELABORATION_CALLBACK elaborate
proc elaborate {} {
    # Optionally disable the Avalon- ST data output
    if {[get_parameter_value ENABLE_STREAM_OUTPUT] == "false"} {
        set_port_property aso_data termination true
        set_port_property aso_valid termination true
        set_port_property aso_ready termination true
        set_port_property aso_ready termination_value 0
    }
    # Calculate the Data Bus Width in bytes
    set bytewidth_var [expr [get_parameter_value AXI_DATA_W]/8]
    set_parameter_value AXI_NUMBYTES $bytewidth_var
}
```

Related Information
- Declare Parameters with Custom _hw.tcl Commands on page 328
- Validate Parameter Values with a Validation Callback on page 329
- Component Interface Tcl Reference on page 492

3.14. Control File Generation Dynamically with Parameters and a Fileset Callback

You can use a fileset callback to control which files are created in the output directories during the generation phase based on parameter values, instead of providing a fixed list of files. In a callback procedure, you can query the values of the parameters and use them to generate the appropriate files. To define a fileset callback, you specify a callback procedure name as an argument in the `add_fileset` command. You can use the same fileset callback procedure for all of the filesets, or create separate procedures for synthesis and simulation, or Verilog and VHDL.

Example 17. Fileset Callback Using Parameters to Control Filesets in Two Different Ways

The `RAM_VERSION` parameter chooses between two different source files to control the implementation of a RAM block. For the top-level source file, a custom Tcl routine generates HDL that optionally includes control and status registers, depending on the value of the `CSR_ENABLED` parameter.
During the generation phase, Platform Designer creates a a top-level Platform Designer system HDL wrapper module to instantiate the component top-level module, and applies the component’s parameters, for any parameter whose parameter property HDL_PARAMETER is set to true.

```tcl
#Create synthesis fileset with fileset_callback and set top level
add_fileset my_synthesis_fileset QUARTUS_SYNTH fileset_callback
set_fileset_property my_synthesis_fileset TOP_LEVEL \
demo_axi_memory

# Create Verilog simulation fileset with same fileset_callback
# and set top level
add_fileset my_verilog_sim_fileset SIM_VERILOG fileset_callback
set_fileset_property my_verilog_sim_fileset TOP_LEVEL \
demo_axi_memory

# Add extra file needed for simulation only
add_fileset_file verbosity_pkg.sv SYSTEM_VERILOG PATH \
verification_lib/verbosity_pkg.sv

# Create VHDL simulation fileset (with Verilog files
# for mixed-language VHDL simulation)
add_fileset my_vhdl_sim_fileset SIM_VHDL fileset_callback
set_fileset_property my_vhdl_sim_fileset TOP_LEVEL demo_axi_memory
add_fileset_file verbosity_pkg.sv SYSTEM_VERILOG PATH \
verification_lib/verbosity_pkg.sv

# Define parameters required for fileset_callback
add_parameter RAM_VERSION INTEGER 1
set_parameter_property RAM_VERSION ALLOWED_RANGES {1 2}
set_parameter_property RAM_VERSION HDL_PARAMETER false
add_parameter CSR_ENABLED BOOLEAN enable
set_parameter_property CSR_ENABLED HDL_PARAMETER false

# Create Tcl callback procedure to add appropriate files to
# filesets based on parameters
proc fileset_callback { entityName } {
    send_message INFO "Generating top-level entity $entityName"
    set ram [get_parameter_value RAM_VERSION]
    set csr_enabled [get_parameter_value CSR_ENABLED]

    send_message INFO "Generating memory implementation based on RAM_VERSION $ram"
    if {$ram == 1} {
        add_fileset_file single_clk_ram1.v VERILOG PATH \
single_clk_ram1.v
    } else {
        add_fileset_file single_clk_ram2.v VERILOG PATH \
single_clk_ram2.v
    }

    send_message INFO "Generating top-level file for \CSR_ENABLED $csr_enabled"
    generate_my_custom_hdl $csr_enabled demo_axi_memory_gen.sv

    add_fileset_file demo_axi_memory_gen.sv VERILOG PATH \
demo_axi_memory_gen.sv
}
```
Related Information

- Specify Synthesis and Simulation Files in the Platform Designer Component Editor on page 316
- Component Interface Tcl Reference on page 492

3.15. Create a Composed Component or Subsystem

A composed component is a subsystem containing instances of other components. Unlike an HDL-based component, a composed component's HDL is created by generating HDL for the components in the subsystem, in addition to the Platform Designer interconnect to connect the subsystem instances.

You can add child instances in a composition callback of the _hw.tcl file.

With a composition callback, you can also instantiate and parameterize sub-components as a function of the composed component's parameter values. You define a composition callback by setting the COMPOSITION_CALLBACK module property to the name of the composition callback procedures.

A composition callback replaces the validation and elaboration phases. HDL for the subsystem is generated by generating all of the sub-components and the top-level that combines them.

To connect instances of your component, you must define the component's interfaces. Unlike an HDL-based component, a composed component does not directly specify the signals that are exported. Instead, interfaces of submodules are chosen as the external interface, and each internal interface’s ports are connected through the exported interface.

Exporting an interface means that you are making the interface visible from the outside of your component, instead of connecting it internally. You can set the EXPORT_OF property of the externally visible interface from the main program or the composition callback, to indicate that it is an exported view of the submodule’s interface.

Exporting an interface is different than defining an interface. An exported interface is an exact copy of the subcomponent’s interface, and you are not allowed to change properties on the exported interface. For example, if the internal interface is a 32-bit or 64-bit master without bursting, then the exported interface is the same. An interface on a subcomponent cannot be exported and also connected within the subsystem.

When you create an exported interface, the properties of the exported interface are copied from the subcomponent’s interface without modification. Ports are copied from the subcomponent’s interface with only one modification; the names of the exported ports on the composed component are chosen to ensure that they are unique.
Figure 55. Top-Level of a Composed Component

Example 18. Composed _hw.tcl File that Instantiates Two Sub-Components

Platform Designer connects the components, and also connects the clocks and resets. Note that clock and reset bridge components are required to allow both sub-components to see common clock and reset inputs.

```
package require -exact qsys 14.0
set_module_property name my_component
set_module_property COMPOSITION_CALLBACK composed_component

proc composed_component {} {
    add_instance clk altera_clock_bridge
    add_instance reset altera_reset_bridge
    add_instance regs my_regs_microcore
    add_instance phy my_phy_microcore

    add_interface clk clock end
    add_interface reset reset end
    add_interface slave avalon slave
    add_interface pins conduit end

    set_interface_property clk EXPORT_OF clk.in_clk
    set_interface_property_value reset synchronous_edges deassert
    set_interface_property reset EXPORT_OF reset.in_reset
    set_interface_property slave EXPORT_OF regs.slave
    set_interface_property pins EXPORT_OF phy.pins

    add_connection clk.out_clk reset.clk
    add_connection clk.out_clk regs.clk
    add_connection clk.out_clk phy.clk
    add_connection reset.out_reset regs.reset
    add_connection reset.out_reset phy.clk_reset
    add_connection regs.output phy.input
    add_connection phy.output regs.input
}
```

Related Information
Component Interface Tcl Reference on page 492
3.16. Add Component Instances to a Static or Generated Component

You can create nested components by adding component instances to an existing component. Both static and generated components can create instances of other components. You can add child instances of a component in a _hw.tcl using elaboration callback.

With an elaboration callback, you can also instantiate and parameterize sub-components with the add_hdl_instance command as a function of the parent component's parameter values.

When you instantiate multiple nested components, you must create a unique variation name for each component with the add_hdl_instance command. Prefixing a variation name with the parent component name prevents conflicts in a system. The variation name can be the same across multiple parent components if the generated parameterization of the nested component is exactly the same.

Note: If you do not adhere to the above naming variation guidelines, Platform Designer validation-time errors occur, which are often difficult to debug.

Related Information
- Static Components on page 338
- Generated Components on page 339

3.16.1. Static Components

Static components always generate the same output, regardless of their parameterization. Components that instantiate static components must have only static children.

A design file that is static between all parameterizations of a component can only instantiate other static design files. Since static IPs always render the same HDL regardless of parameterization, Platform Designer generates static IPs only once across multiple instantiations, meaning they have the same top-level name set.

Example 19. Typical Usage of the add_hdl_instance Command for Static Components

```tcl
package require -exact qsys 14.0
set_module_property name add_hdl_instance_example
add_fileset synth_fileset QUARTUS_SYNTH synth_callback
set_fileset_property synth_fileset TOP_LEVEL basic_static
set_module_property elaboration_callback elab
proc elab {} {
    # Actual API to instantiate an IP Core
    add_hdl_instance emif_instance_name altera_mem_if_ddr3_emif

    # Make sure the parameters are set appropriately
    set_instance_parameter_value emif_instance_name SPEED_GRADE {7}
    ...
}
proc synth_callback { output_name } {
    add_fileset_file "basic_static.v" VERILOG PATH basic_static.v
}
3.16.2. Generated Components

A generated component's filesset callback allows an instance of the component to create unique HDL design files based on the instance's parameter values. For example, you can write a filesset callback to include a control and status interface based on the value of a parameter. The callback overcomes a limitation of HDL languages, which do not allow run-time parameters.

Generated components change their generation output (HDL) based on their parameterization. If a component is generated, then any component that may instantiate it with multiple parameter sets must also be considered generated, since its HDL changes with its parameterization. This case has an effect that propagates up to the top-level of a design.

Since generated components are generated for each unique parameterized instantiation, when implementing the add_hdl_instance command, you cannot use the same fixed name (specified using instance_name) for the different variants of
the child HDL instances. To facilitate unique naming for the wrapper of each unique parameterized instantiation of child HDL instances, you must use the following command so that Platform Designer generates a unique name for each wrapper. You can then access this unique wrapper name with a fileset callback so that the instances are instantiated inside the component's top-level HDL.

- To declare auto-generated fixed names for wrappers, use the command:

  ```tcl
  set_instance_property instance_name HDLINSTANCE_USE_GENERATED_NAME true
  ```

  **Note:** You can only use this command with a generated component in the global context, or in an elaboration callback.

- To obtain auto-generated fixed name with a fileset callback, use the command:

  ```tcl
  get_instance_property instance_name HDLINSTANCE_GET_GENERATED_NAME
  ```

  **Note:** You can only use this command with a fileset callback. This command returns the value of the auto-generated fixed name, which you can then use to instantiate inside the top-level HDL.

**Example 21. Typical Usage of the add_hdl_instance Command for Generated Components**

Platform Designer generates a wrapper file for the instance name specified in the _hw.tcl file.

```tcl
package require -exact qsys 14.0
set_module_property name generated_toplevel_component
set_module_property ELABORATION_CALLBACK elaborate
add_fileset QUARTUS_SYNTH QUARTUS_SYNTH generate
add_fileset SIM_VERILOG SIM_VERILOG generate
add_fileset SIM_VHDL SIM_VHDL generate
proc elaborate {} {
    # Actual API to instantiate an IP Core
    add_hdl_instance emif_instance_name altera_mem_if_ddr3_emif
    # Make sure the parameters are set appropriately
    set_instance_parameter_value emif_instance_name SPEED_GRADE 7
    ...
    # instruct Platform Designer to use auto generated fixed name
    set_instance_property emif_instance_name HDLINSTANCE_USE_GENERATED_NAME 1
}
proc generate { entity_name } {
    # get the autogenerated name for emif_instance_name added
    # via add_hdl_instance
    set autogeneratedfixedname [get_instance_property emif_instance_name HDLINSTANCE_GET_GENERATED_NAME]
    set fileID [open "generated_toplevel_component.v" r]
    set temp ""
    # read the contents of the file
    while {![eof $fileID]} {
        gets $fileID lineInfo
        # replace the top level entity name with the name provided
        # during generation
        regsub -all "substitute_entity_name_here" $lineInfo \
        ...}
```
Example 22. Top-Level HDL Instance and Wrapper File Created By Platform Designer

```
// Top Level Component HDL
module substitute_entity_name_here (input_wire, output_wire, inout_wire);
  input [31:0] input_wire;
  output [31:0] output_wire;
  inout [31:0] inout_wire;

  // Instantiation of the instance added via add_hdl_instance
  // command. This is an example of how the instance added
  // via add_hdl_instance command can be used
  // in the top-level file of the component.

  substitute_autogenerated_emifinstancename_here
    fixed_name_instantiation_in_top_level ( 
      .pll_ref_clk (input_wire), // pll_ref_clk.clk
      .global_reset_n (input_wire), // global_reset.reset_n
      .soft_reset_n (input_wire), // soft_reset.reset_n
      ... );
endmodule

// Wrapper for added HDL instance
// generated_toplevel_component_0_emif_instance_name.v is the
// auto generated //emif_instance_name
// Generated using ACDS version 13.

`timescale 1 ps / 1 ps
module generated_toplevel_component_0_emif_instance_name ( 
  input wire pll_ref_clk, // pll_ref_clk.clk
  input wire global_reset_n, // global_reset.reset_n
  input wire soft_reset_n, // soft_reset.reset_n
  output wire afi_clk, // afi_clk.clk
  ... );
eexample_addhdlinstance_system_add_hdl_instance_example_0_emif_instance_name_emif_instance_name ( 
  .pll_ref_clk (pll_ref_clk), // pll_ref_clk.clk
  .global_reset_n (global_reset_n), // global_reset.reset_n
  .soft_reset_n (soft_reset_n), // soft_reset.reset_n
  ... );
endmodule
```

Related Information

- Control File Generation Dynamically with Parameters and a Fileset Callback on page 334
- Intellectual Property & Reference Designs
3.16.3. Design Guidelines for Adding Component Instances

In order to promote standard and predictable results when generating static and generated components, Intel recommends the following best-practices:

- For two different parameterizations of a component, a component must never generate a file of the same name with different instantiations. The contents of a file of the same name must be identical for every parameterization of the component.
- If a component generates a nested component, it must never instantiate two different parameterizations of the nested component using the same instance name. If the parent component's parameterization affects the parameters of the nested component, the parent component must use a unique instance name for each unique parameterization of the nested component.
- Static components that generate differently based on parameterization have the potential to cause problems in the following cases:
  - Different file names with the same entity names, results in same entity conflicts at compilation-time
  - Different contents with the same file name results in overwriting other instances of the component, and in either file, compile-time conflicts or unexpected behavior.
- Generated components that generate files not based on the output name and that have different content results in either compile-time conflicts, or unexpected behavior.

3.17. Adding a Generic Component to the Platform Designer System

The generic component is a type of Platform Designer component that enables hierarchical isolation of IP components. This component is available in the IP Catalog. Use this component as a mechanism to quickly define a custom component or import your RTL into a Platform Designer system.

By default, the generic component’s **Implementation Type** is set to **Blackbox**. This mode specifies that the RTL implementation is not provided in the generated RTL output of the Platform Designer system. When you generate a system containing a generic component, the system's RTL instantiates the component, but does not provide an implementation for the component. You must provide an implementation for the component in a downstream compiler such as Intel Quartus Prime software or RTL code.
To add a generic component to your system:

1. Type generic component in the IP Catalog.
2. To launch the Component Instantiation editor, double-click Generic Component. The default option is to create a Blackbox component.

The Component Instantiation editor allows you to select one of four implementation types:

- **IP**—Use the IP option to create a component from a .ip file.
- **HDL**—Use the HDL option to instantiate a component from RTL (.v/.sv/.vhd) without using _hw.tcl.
- **Blackbox**—The default option. Use the Blackbox option to create a generic component. You can either add interfaces and signals manually, clone/mirror from existing components in the current system, or import from an .ipxact file.
- **HLS**—Use the HLS option to add and compile High Level Synthesis (HLS) files, or add and import HLS files.

**Related Information**

- Creating Custom Interfaces in a Generic Component on page 344
- Instantiating RTL in a System as a Generic Component on page 347
- Implementing Generic Components Using High Level Synthesis Files on page 348
3.17.1. Creating Custom Interfaces in a Generic Component

The Signals & Interfaces tab of the Component Instantiation editor allows you to customize signals and interfaces for your generic component:

1. Double-click Generic Component in the IP Catalog.
2. In the Component Instantiation editor, click the Signals & Interfaces tab.
3. To add an interface, click <<add interface>> in the left pane and select the interface. The selected interface appears in the parameter editor to the right, where you specify its parameters.
4. To add signals to the selected interface, click <<add signal>> below the selected interface.
5. To move signals between interfaces, select the signal and drag it to another interface.
6. To rename a signal or interface, select the element, and then press F2.
7. To remove a signal or interface, right-click the element, and then click Remove.

*Note:* Alternatively, to remove a signal or interface, select the element and press Delete. When you remove an interface, Platform Designer also removes all of its associated signals.

**Figure 57. Creating Custom Interfaces**

![Creating Custom Interfaces](image)

*Note:* To add existing template interfaces to your generic component, select the interface from Templates menu in the Component Instantiation editor.

3.17.1.1. Mirroring Interfaces in a Generic Component

To mirror existing signals and interfaces from an IP component to your generic component:
1. Double-click **Generic Component** in the IP Catalog.
2. In the **Component Instantiation** editor, click the **Signals & Interfaces** tab.
3. Click the **Mirror** button. A list appears which lists all the available components in the system and their associated interfaces.
4. Select the desired interface. Platform Designer mirrors the interface and its associated signals and adds the mirrored interfaces and signals to the **Signals & Interfaces** tab of the generic component.

**Example 23. Mirroring Interfaces in a Generic Component Example**

<table>
<thead>
<tr>
<th>Selected Interface</th>
<th>Mirrored Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avalon Memory-Mapped Master (avalon_master)</td>
<td>Avalon Memory-Mapped Slave (avalon_slave)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Signals of the Selected Interface</th>
<th>Signals of the Mirrored Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>waitrequest(Input 1)</td>
<td>waitrequest(Output 1)</td>
</tr>
<tr>
<td>readdata(Input 32)</td>
<td>readdata(Output 32)</td>
</tr>
<tr>
<td>readdatavalid(Input 1)</td>
<td>readdatavalid(Output 1)</td>
</tr>
<tr>
<td>burstcount(Output 32)</td>
<td>burstcount(Input 32)</td>
</tr>
</tbody>
</table>

**Figure 58. Mirroring Interfaces**
3.17.1.2. Cloning Interfaces in a Generic Component

To clone existing signals and interfaces from an IP component to your generic component:

1. Double-click **Generic Component** in the IP Catalog.
2. In the **Component Instantiation** editor, click the **Signals & Interfaces** tab.
3. Click the **Clone** button. A list appears which lists all the available components in the system and their associated interfaces.
4. Select the desired interface. Platform Designer clones the interface and adds an exact replica of the interface and its associated signals to the **Signals & Interfaces** tab of the generic component.

**Figure 59. Cloning Interfaces**

3.17.1.3. Importing Interfaces to a Generic Component

To import interfaces from an existing IP or IP-XACT file to your generic component:
1. Double-click **Generic Component** in the IP Catalog.
2. In the **Component Instantiation** editor, click the **Signals & Interfaces** tab.
3. Click the **Import** button. A dialog box appears from where you choose the IP/IP-XACT file to import to your generic component.
4. Select the desired interface. Platform Designer populates the **Signals & Interfaces** tab with the signals and interfaces defined in the selected file.

**Figure 60. Importing Interfaces**

![Image of Importing Interfaces]

3.17.2. Instantiating RTL in a System as a Generic Component

To add an RTL file as a generic component:
1. Double-click **Generic Component** in the IP Catalog.
2. In the **Component Instantiation** editor, set the **Implementation Type** as **HDL**.
3. Select the **Files** tab.
4. Click **Add File** and select the RTL file to load to the generic component.
   a. If you are importing an HDL file with SystemVerilog interface definition, you should set the **Attributes** of this file to **File contains SystemVerilog interface definition used by the Top-level Module**.
5. Click **Analyze HDL files**. This option analyzes and populates the **Signals & Interfaces** tab of the generic component from the RTL file.
6. Verify, and modify the signals and interfaces if needed, in the **Signals & Interfaces** tab.

**Note:** You must treat a generic component with an **HDL Implementation Type** as a customized and centralized RTL, specific to your current system. When you set a generic component’s **Implementation Type** to **HDL**, the output of any RTL that you add to the component is within the system’s output directory.
3.17.3. Implementing Generic Components Using High Level Synthesis Files

High Level Synthesis (HLS) files can be compiled to create Platform Designer components and are written according to the i++ specification. HLS files can be in *.c, *.cc, *.cpp, *.c++, *.cp, or *.cxx format.

An HLS file defines one or more components in an i++ format that Platform Designer compiles into HDL. In order to add components from an HLS file there are two basic steps:

1. Identify and add the HLS file.
2. Import an already compiled file from a previous Platform Designer session or project, or Compile the HLS file in Platform Designer.

Once the component has been imported or compiled, Platform Designer performs the following actions:

- Imports an .ip resulting from the HLS compilation to the component name defined in the HLS file.
- Sets the HDL entity name and HDL compilation library to the component defined in the HLS file.
- Adds the .ip file to the empty generic component.
- Adds paths to the .ip and _hw.tcl output files to the Platform Designer search path to enable instantiation.
- Populates the signals and interfaces of the component from the .ip file.
After compilation, the HLS compiler creates a `<component_name>.prj` folder with the following directories:

Table 43. Contents of `<component_name>.prj` Folder

<table>
<thead>
<tr>
<th>Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/component</td>
<td>Contains IP and _hw.tcl files.</td>
</tr>
<tr>
<td>/quartus</td>
<td>Contains Intel Quartus Prime Pro Edition project files that instantiate the HLS component. You can use this to verify timing and logic usage.</td>
</tr>
<tr>
<td>/reports</td>
<td>Contains a compilation report in HTML.</td>
</tr>
<tr>
<td>/verification</td>
<td>Contains verification files, if you decided to create a verification executable.</td>
</tr>
</tbody>
</table>

Related Information

Intel High Level Synthesis Compiler Getting Started Guide

3.17.3.1. Add High Level Synthesis Files to a Generic Component

You can quickly add High Level Synthesis (HLS) components to a Platform Designer project by dragging and dropping files into the Platform Designer **System Contents** tab. The drag-and-drop process selects the **HLS** implementation type, and adds the HLS file to the **HLS files** box.

To add a component with an HLS implementation, perform the following steps in Platform Designer:

1. Drag an HLS file to the **System Contents** tab of Platform Designer.
   or
2. Type `generic component` in the IP Catalog.
3. To launch the **Component Instantiation** editor, double-click **Generic Component**.
4. To add a component from an HLS file to the empty generic component, select the **HLS Implementation Type**.
5. Click `+` and select an HLS file to add.

You can click `+` to add more than one HLS file. Click `-` to remove HLS files. The primary case for adding multiple HLS files is when you are using a library of components defined by one or more high level synthesis files.
3.17.3.2. Compile High Level Synthesis Files

The Compile option for High Level Synthesis (HLS) component instantiation in Platform Designer invokes the Intel HLS Compiler to compile HLS files and modify a generic component.

Performing a compile on an HLS file has the following results:

- Imports an .ip resulting from the HLS compilation to the component name defined in the HLS file.
- Sets the HDL entity name and HDL compilation library to the component defined in the HLS file.
- Adds the .ip file to the empty generic component.
- Adds paths to the .ip and _hw.tcl output files to the Platform Designer search path to enable instantiation.
- Populates the signals and interfaces of the component from the .ip file.

After you have added an HLS file:

1. Click Compile.
2. In the HLS Options dialog box, you can select from the following options:

**Figure 64. HLS Options Dialog Box**

![HLS Options Dialog Box](image)

- a. The project name defaults to the entity name defined in the HLS file. To set a new project name, select **new project name** and enter a new HLS project name in the dialog box.

**Figure 65. Change the Project Name**

![Change the Project Name](image)

- b. Provide additional arguments to the HLS compiler. Refer to *Command Compiler Options* in the *Intel High Level Synthesis Reference Manual* for information on compiler arguments.

- c. Disable or enable simulation file creation. A simulation file is required to use the **Run Verification** option after compilation is complete.

- d. Enable verbose logging to create a compilation log file.
e. Enable or disable display of the HLS report in a browser window directly after compilation is complete.
f. Perform verification with or without additional verification arguments if you chose to create a verification executable. Refer to the Intel High Level Synthesis Compiler User Guide for information on verification arguments.

3. Click **OK** to compile the HLS file and create the component.

4. If your HLS file defines more than one component, the **Choose File to Import** dialog box prompts you to select a specific component from a list.

5. After compiling, click **Show Report** to display a compilation report in a browser window.

6. If you created simulation files for your component, you can click **Run Verification** to perform verification.

**Related Information**
- Compiler Command Options
- Intel High Level Synthesis Compiler User Guide

### 3.17.3.3. Import High Level Synthesis Files

If you have a compiled High Level Synthesis (HLS) file, you can import it instead to save compilation time.
1. Click **Import**.

**Figure 66. HLS Component Instantiation**

You should only use **Import** when your HLS file defines previously compiled components.
2. In the **HLS Options** dialog box, you can select from the following options:
   a. The project name defaults to the entity name defined in the HLS file. To set a new project name, select **new project name** and enter a new HLS project name in the dialog box.

![Figure 67. HLS Options Dialog Box](image)

b. Enable or disable display of the HLS report in a browser window directly after compilation is complete.

c. Perform verification with or without additional verification arguments if you chose to create a verification executable. Refer to the *Intel High Level Synthesis Compiler User Guide* for information on verification arguments.

3. Click **OK**.

4. If your HLS file defines more than one component, the **Choose File to Import** dialog box prompts you to select a specific component .ip from a list.

5. After importing, click **Show Report** to display a compilation report in a browser window if the compilation report is enabled.

6. Click **Run Verification** to perform verification if it is enabled.

**Related Information**

*Intel High Level Synthesis Compiler User Guide*

### 3.17.4. Creating System Template for a Generic Component

To create a Platform Designer system template:

1. Double-click **Generic Component** in the IP Catalog.
2. In the **Component Instantiation** editor, add the interfaces and signals for the new component in the **Signals & Interfaces** tab.
3. Select the **Implementation Templates** tab.
4. Click **Create Platform Designer System Template** button. This option creates an empty Platform Designer system and saves the template as a .qsys file to implement this generic component.
To implement this component:

1. To open the template Platform Designer system, click **File ➤ Open** and choose the specific .qsys file.
2. Add either or both IP components and generic components then export their interfaces to satisfy the specified interface requirements.
3. To view the exported interfaces in the **Interface Requirements** tab, select **View ➤ Interface Requirements**.

**Figure 69. Creating System templates**

![Platform Designer System Template](image)

- **Platform Designer System Template**
  - When you create a Platform Designer system template, an empty Platform Designer system will be created for you. Use this template to implement your Generic Component. The Platform Designer system will be setup to have Interface Requirements which mirror the requirements of this Generic Component. By that way, when constructing the Platform Designer system, you can know whether what you've created matches the interface expectations of the parent system.
  - It is important that the Generic Component and the template Platform Designer system's interfaces match exactly so that the fabric connections created by the parent system work as expected.

- **HDL Template**
  - This will export an empty HDL entity with ports matching those of the Generic Component.

**Figure 70. Viewing the Interface Requirements from the System Template**

![Interface Requirements](image)

- **About Interface Requirements**
  - **Interface Requirements**
    - **Current System**
      - (Current system has no exports)

Legend: missing items different items
3.17.5. Exporting a Generic Component

You can export a generic component as a .ipxact file as well as _hw.tcl file:
1. Double-click **Generic Component** in the IP Catalog.
2. Select the **Export** tab.
3. To export generic component as an IP-XACT file, click **Export IP-XACT File** and select the location to save your IP-XACT file.
4. To export generic component as a _hw.tcl file, click **Export _hw.tcl File** and select the location to save your _hw.tcl file.

3.18. Creating Platform Designer Components Revision History

The table below indicates edits made to the *Creating Platform Designer Components* content since its creation.

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2018.05.07        | 18.0                        | Initial release.  
• Added scripting support for wire-level expressions. |

Table 44. Document Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2017.11.06        | 17.1.0  | • Changed instances of Qsys Pro to Platform Designer  
• Replaced mentions of altera_axi_default_slave to altera_error_response_slave  
• Added support for SystemVerilog interfaces with _hw.tcl.  
• Added support for user alterable HDL parameters with _hw.tcl.  
• Added support for High Level Synthesis file compilation. |
| 2017.05.08        | 17.0.0  | • Updated Figure: Address Span Extender |
| 2016.10.31        | 16.1.0  | • Implemented Intel rebranding.  
• Implemented Platform Designer rebranding.  
• Added topics for Generic Component. |
| 2015.11.02        | 15.1.0  | Changed instances of Quartus II to Quartus Prime. |
| 2015.05.04        | 15.0.0  | • Updated screen shots Files tab, Platform Designer Component Editor.  
• Added topic: Specify Interfaces and Signals in the Platform Designer Component Editor.  
• Added topic: Create an HDL File in the Platform Designer Component Editor.  
• Added topic: Create an HDL File Using a Template in the Platform Designer Component Editor. |
| November 2013     | 13.1.0  | • add_hdl_instance  
• Added Creating a Component With Differing Structural Platform Designer View and Generated Output Files. |
| May 2013          | 13.0.0  | • Consolidated content from other Platform Designer chapters.  
• Added Upgrading IP Components to the Latest Version.  
• Updated for AMBA APB support. |
| November 2012     | 12.1.0  | • Added AMBA AXI4 support.  
• Added the demo_axi_memory example with screen shots and example _hw.tcl code. |
| June 2012         | 12.0.0  | • Added new tab structure for the Component Editor.  
• Added AMBA 3 AXI support.  

*continued...*
### Related Information

**Documentation Archive**

For previous versions of the Intel Quartus Prime Handbook, search the documentation archives.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>November 2011</td>
<td>11.1.0</td>
<td>Template update.</td>
</tr>
<tr>
<td>May 2011</td>
<td>11.0.0</td>
<td>• Removed beta status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Avalon Tri-state Conduit (Avalon-TC) interface type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added many interface templates for Nios custom instructions and Avalon-TC interfaces.</td>
</tr>
<tr>
<td>December 2010</td>
<td>10.1.0</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>
4. Platform Designer Interconnect

Platform Designer interconnect is a high-bandwidth structure that allows you to connect IP components to other IP components with various interfaces.

Note: Intel now refers to Qsys Pro as Platform Designer.

Platform Designer supports Avalon, AMBA 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

Note: The video AMBA AXI and Intel Avalon Interoperation Using Platform Designer, describes seamless integration of IP components using the AMBA AXI interface, and the Intel Avalon interface.

Platform Designer allows you to establish connections between Avalon and AXI interface by generating an interconnect logic. This logic enables you to handle the protocol differences. Platform Designer creates the interconnect logic by converting all the protocols to a proprietary packet format. Then, the tool routes the packet through network switches to the appropriate slaves. Here, the packet converts to the slave's protocol.

Related Information
- Creating a System with Platform Designer on page 9
- Creating Platform Designer Components on page 305
- Platform Designer System Design Components on page 620
- AMBA AXI and Intel Avalon Interoperation Using Platform Designer
- Avalon Interface Specifications

4.1. Memory-Mapped Interfaces

Platform Designer supports the implementation of memory-mapped interfaces for Avalon, AXI, and APB protocols.

Platform Designer interconnect transmits memory-mapped transactions between masters and slaves in packets. The command network transports read and write packets from master interfaces to slave interfaces. The response network transports response packets from slave interfaces to master interfaces.

For each component interface, Platform Designer interconnect manages memory-mapped transfers and interacts with signals on the connected interface. Master and slave interfaces can implement different signals based on interface parameterizations, and Platform Designer interconnect provides any necessary adaptation between them.
In the path between master and slaves, Platform Designer interconnect may introduce registers for timing synchronization, finite state machines for event sequencing, or nothing at all, depending on the services required by the interfaces.

Platform Designer interconnect supports the following implementation scenarios:

- Any number of components with master and slave interfaces. The master-to-slave relationship can be one-to-one, one-to-many, many-to-one, or many-to-many.
- Masters and slaves of different data widths.
- Masters and slaves operating in different clock domains.
- IP Components with different interface properties and signals. Platform Designer adapts the component interfaces so that interfaces with the following differences can be connected:
  - Avalon and AXI interfaces that use active-high and active-low signaling. AXI signals are active high, except for the reset signal.
  - Interfaces with different burst characteristics.
  - Interfaces with different latencies.
  - Interfaces with different data widths.
  - Interfaces with different optional interface signals.

  Note: Since interface connections between AMBA 3 AXI and AMBA 4 AXI declare a fixed set of signals with variable latency, there is no need for adapting between active-low and active-high signaling, burst characteristics, different latencies, or port signatures. Adaptation might be necessary between Avalon interfaces.

In this example, there are two components mastering the system, a processor and a DMA controller, each with two master interfaces. The masters connect through the Platform Designer interconnect to slaves in the Platform Designer system.

The dark blue blocks represent interconnect components. The dark grey boxes indicate items outside of the Platform Designer system and the Intel Quartus Prime software design, and show how to export component interfaces and how to connect these interfaces to external devices.
4.1.1. Platform Designer Packet Format

The Platform Designer packet format supports Avalon, AXI, and APB transactions. Memory-mapped transactions between masters and slaves are encapsulated in Platform Designer packets. For Avalon systems without AXI or APB interfaces, some fields are ignored or removed.
4.1.1.1. Fields in the Platform Designer Packet Format

The fields of the Platform Designer packet format are of variable length to minimize resource usage. However, if most components in a design have a single data width, for example 32-bits, and a single component has a data width of 64-bits, Platform Designer inserts a width adapter to accommodate 64-bit transfers.

Table 45. Platform Designer Packet Format for Memory-Mapped Master and Slave Interfaces

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Specifies the byte address for the lowest byte in the current cycle. There are no restrictions on address alignment.</td>
</tr>
<tr>
<td>Size</td>
<td>Encodes the run-time size of the transaction. In conjunction with address, this field describes the segment of the payload that contains valid data for a beat within the packet.</td>
</tr>
<tr>
<td>Address Sideband</td>
<td>Carries &quot;address&quot; sideband signals. The interconnect passes this field from master to slave. This field is valid for each beat in a packet, even though it is only produced and consumed by an address cycle. Up to 8-bit sideband signals are supported for both read and write address channels.</td>
</tr>
<tr>
<td>Cache</td>
<td>Carries the AXI cache signals.</td>
</tr>
<tr>
<td>Transaction (Exclusive)</td>
<td>Indicates whether the transaction has exclusive access.</td>
</tr>
<tr>
<td>Transaction (Posted)</td>
<td>Used to indicate non-posted writes (writes that require responses).</td>
</tr>
<tr>
<td>Data</td>
<td>For command packets, carries the data to be written. For read response packets, carries the data that has been read.</td>
</tr>
</tbody>
</table>
| Byteenable       | Specifies which symbols are valid. AXI can issue or accept any byteenable pattern. For compatibility with Avalon, Intel recommends that you use the following legal values for 32-bit data transactions between Avalon masters and slaves:  
  • 1111—Writes full 32 bits  
  • 0011—Writes lower 2 bytes  
  • 1100—Writes upper 2 bytes  
  • 0001—Writes byte 0 only  
  • 0010—Writes byte 1 only  
  • 0100—Writes byte 2 only  
  • 1000—Writes byte 3 only |
| Source_ID        | The ID of the master or slave that initiated the command or response.                        |
| Destination_ID   | The ID of the master or slave to which the command or response is directed.                   |
| Response         | Carries the AXI response signals.                                                             |
| Thread ID        | Carries the AXI transaction ID values.                                                         |
| Byte count       | The number of bytes remaining in the transaction, including this beat. Number of bytes requested by the packet. |

continued...
The burstwrap value specifies the wrapping behavior of the current burst. The burstwrap value is of the form $2^{<n>}-1$. The following types are defined:

- Variable wrap—Variable wrap bursts can wrap at any integer power of 2 value. When the burst reaches the wrap boundary, it wraps back to the previous burst boundary so that only the low order bits are used for addressing. For example, a burst starting at address 0x1C, with a burst wrap boundary of 32 bytes and a burst size of 20 bytes, would write to addresses 0x1C, 0x0, 0x4, 0x8, and 0xC.
- For a burst wrap boundary of size $<m>$, Burstwrap = $<m> - 1$, or for this case Burstwrap = $(32 - 1) = 31$ which is $2^5 - 1$.
- For AXI masters, the burstwrap boundary value ($m$) is based on the different AXBURST:
  - Burstwrap set to all 1’s. For example, for a 6-bit burstwrap, burstwrap is $6'b111111$.
  - For WRAP bursts, burstwrap = AXLEN * size – 1.
  - For FIXED bursts, burstwrap = size – 1.
  - Sequential bursts increment the address for each transfer in the burst. For sequential bursts, the Burstwrap field is set to all 1s. For example, with a 6-bit Burstwrap field, the value for a sequential burst is $6'b111111$ or 63, which is $2^6 - 1$.

For Avalon masters, Platform Designer adaptation logic sets a hardwired value for the burstwrap field, according the declared master burst properties. For example, for a master that declares sequential bursting, the burstwrap field is set to ones. Similarly, masters that declare burst have their burstwrap field set to the appropriate constant value.

AXI masters choose their burst type at run-time, depending on the value of the AX or ARBURST signal. The interconnect calculates the burstwrap value at run-time for AXI masters.

### Protection
Access level protection. When the lowest bit is 0, the packet has normal access. When the lowest bit is 1, the packet has privileged access. For Avalon-MM interfaces, this field maps directly to the privileged access signal, which allows a memory-mapped master to write to an on-chip memory ROM instance. The other bits in this field support AXI secure accesses and uses the same encoding, as described in the AXI specification.

### QoS
QoS (Quality of Service Signaling) is a 4-bit field that is part of the AMBA 4 AXI interface that carries QoS information for the packet from the AXI master to the AXI slave. Transactions from AMBA 3 AXI and Avalon masters have the default value $4'b0000$, that indicates that they are not participating in the QoS scheme. QoS values are dropped for slaves that do not support QoS.

### Data sideband
Carries data sideband signals for the packet. On a write command, the data sideband directly maps to WUSER. On a read response, the data sideband directly maps to RUSER. On a write response, the data sideband directly maps to BUSER.

---

### 4.1.1.2. Transaction Types for Memory-Mapped Interfaces

#### Table 46. Transaction Types for Memory-Mapped Interfaces

The table below describes the information that each bit transports in the packet format’s transaction field.

<table>
<thead>
<tr>
<th>Bit</th>
<th>Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>PKT_TRANS_READ</td>
<td>When asserted, indicates a read transaction.</td>
</tr>
<tr>
<td>1</td>
<td>PKT_TRANS_COMPRESSED_READ</td>
<td>For read transactions, specifies whether the read command can be expressed in a single cycle (all byteenable asserted on every cycle).</td>
</tr>
<tr>
<td>2</td>
<td>PKT_TRANS_WRITE</td>
<td>When asserted, indicates a write transaction.</td>
</tr>
<tr>
<td>3</td>
<td>PKT_TRANS_POSTED</td>
<td>When asserted, no response is required.</td>
</tr>
<tr>
<td>4</td>
<td>PKT_TRANS_LOCK</td>
<td>When asserted, indicates arbitration is locked. Applies to write packets.</td>
</tr>
</tbody>
</table>
4.1.1.3. Platform Designer Transformations

The memory-mapped master and slave components connect to network interface modules that encapsulate the transaction in Avalon-ST packets. The memory-mapped interfaces have no information about the encapsulation or the function of the layer transporting the packets. The interfaces operate in accordance with memory-mapped protocol and use the read and write signals and transfers.

Figure 72. Transformation when Generating a System with Memory-Mapped and Slave Components

Platform Designer components that implement the blocks appear shaded.

Related Information
- Master Network Interfaces on page 364
- Slave Network Interfaces on page 367

4.1.2. Interconnect Domains

An interconnect domain is a group of connected memory-mapped masters and slaves that share the same interconnect. The components in a single interconnect domain share the same packet format.

4.1.2.1. Using One Domain with Width Adaptation

When one of the masters in a system connects to all the slaves, Platform Designer creates a single domain with two packet formats: one with 64-bit data, and one with 16-bit data. A width adapter manages accesses between the 16-bit master and 64-bit slaves.
**Figure 73. One Domain with 1:4 and 4:1 Width Adapters**

In this system example, there are two 64-bit masters that access two 64-bit slaves. It also includes one 16-bit master, that accesses two 16-bit slaves and two 64-bit slaves. The 16-bit Avalon master connects through a 1:4 adapter, then a 4:1 adapter to reach its 16-bit slaves.
4.1.2.2. Using Two Separate Domains

Figure 74. Two Separate Domains

In this system example, Platform Designer uses two separate domains. The first domain includes two 64-bit masters connected to two 64-bit slaves. A second domain includes one 16-bit master connected to two 16-bit slaves. Because the interfaces in Domain 1 and Domain 2 do not share any connections, Platform Designer can optimize the packet format for the two separate domains. In this example, the first domain uses a 64-bit data width and the second domain uses 16-bit data.

4.1.3. Master Network Interfaces

Figure 75. Avalon-MM Master Network Interface

Avalon network interfaces drive default values for the QoS and BUSER, WUSER, and RUSER packet fields in the master agent, and drop the packet fields in the slave agent.

Note: The response signal from the Limiter to the Agent is optional.
Figure 76. **AXI Master Network Interface**

An AMBA 4 AXI master supports INCR bursts up to 256 beats, QoS signals, and data sideband signals.

**Note:** For a complete definition of the optional read response signal, refer to *Avalon Memory-Mapped Interface Signal Types* in the *Avalon Interface Specifications*.

**Related Information**
- Avalon Interface Specifications
- Creating a System with Platform Designer on page 9

### 4.1.3.1. Avalon-MM Master Agent

The Avalon-MM Master Agent translates Avalon-MM master transactions into Platform Designer command packets and translates the Platform Designer Avalon-MM slave response packets into Avalon-MM responses.

### 4.1.3.2. Avalon-MM Master Translator

The Avalon-MM Master Translator interfaces with an Avalon-MM master component and converts the Avalon-MM master interface to a simpler representation for use in Platform Designer.

The Avalon-MM Master translator performs the following functions:
- Translates active-low signaling to active-high signaling
- Inserts wait states to prevent an Avalon-MM master from reading invalid data
- Translates word and symbol addresses
- Translates word and symbol burst counts
- Manages re-timing and re-sequencing bursts
- Removes unnecessary address bits

### 4.1.3.3. AXI Master Agent

An AXI Master Agent accepts AXI commands and produces Platform Designer command packets. It also accepts Platform Designer response packets and converts those into AXI responses. This component has separate packet channels for read commands, write commands, read responses, and write responses. Avalon master agent drives the QoS and BUSER, WUSER, and RUSER packet fields with default values AXQO and b0000, respectively.
Note: For signal descriptions, refer to Platform Designer Packet Format.

Related Information
Fields in the Platform Designer Packet Format on page 360

4.1.3.4. AXI Translator

AMBA 4 AXI allows omitting signals from interfaces. The translator bridges between these “incomplete” AMBA 4 AXI interfaces and the “complete” AMBA 4 AXI interface on the network interfaces.

Attention: If an Avalon or AMBA 4 AXI slave is connected to a master without response ports, the interconnect could ignore transaction responses such as SLAVEERROR or DECODEERROR. This situation could lead to returning invalid data to the master.

The AXI translator is inserted for both AMBA 4 AXI masters and slaves and performs the following functions:

• Matches ID widths between the master and slave in 1x1 systems.
• Drives default values as defined in the AMBA Protocol Specifications for missing signals.
• Performs lock transaction bit conversion when an AMBA 3 AXI master connects to an AMBA 4 AXI slave in 1x1 systems.

Related Information
Arm AMBA Protocol Specifications

4.1.3.5. APB Master Agent

An APB master agent accepts APB commands and produces or generates Platform Designer command packets. It also converts Platform Designer response packets to APB responses.

4.1.3.6. APB Slave Agent

An APB slave agent issues resulting transaction to the APB interface. It also accepts creates Platform Designer response packets.

4.1.3.7. APB Translator

An APB peripheral does not require pslverr signals to support additional signals for the APB debug interface.

The APB translator is inserted for both the master and slave and performs the following functions:

• Sets the response value default to OKAY if the APB slave does not have a pslverr signal.
• Turns on or off additional signals between the APB debug interface, which is used with HPS (Intel SoC’s Hard Processor System).
4. Platform Designer Interconnect

4.1.3.8. AHB Slave Agent

The Platform Designer interconnect supports non-bursting Advanced High-performance Bus (AHB) slave interfaces.

4.1.3.9. Memory-Mapped Router

The Memory-Mapped Router routes command packets from the master to the slave, and response packets from the slave to the master. For master command packets, the router uses the address to set the Destination_ID and Avalon-ST channel. For the slave response packet, the router uses the Destination_ID to set the Avalon-ST channel. The demultiplexers use the Avalon-ST channel to route the packet to the correct destination.

4.1.3.10. Memory-Mapped Traffic Limiter

The Memory-Mapped Traffic Limiter ensures the responses arrive in order. It prevents any command from being sent if the response could conflict with the response for a command that has already been issued. By guaranteeing in-order responses, the Traffic Limiter simplifies the response network.

4.1.4. Slave Network Interfaces

4.1.4.1. Avalon-MM Slave Translator

The Avalon-MM Slave Translator converts the Avalon-MM slave interface to a simplified representation that the Platform Designer network can use.

Figure 77. Avalon-MM Slave Network Interface

An Avalon-MM Slave Translator performs the following functions:

- Drives the beginbursttransfer and bytenable signals.
- Supports Avalon-MM slaves that operate using fixed timing and or slaves that use the readdatavalid signal to identify valid data.
- Translates the read, write, and chipselect signals into the representation that the Avalon-ST slave response network uses.
• Converts active low signals to active high signals.
• Translates word and symbol addresses and burstcounts.
• Handles burstcount timing and sequencing.
• Removes unnecessary address bits.

**Related Information**

Slave Network Interfaces on page 367

### 4.1.4.2. AXI Translator

AMBA 4 AXI allows omitting signals from interfaces. The translator bridges between these “incomplete” AMBA 4 AXI interfaces and the “complete” AMBA 4 AXI interface on the network interfaces.

**Figure 78. AXI Slave Network Interface**

An AMBA 4 AXI slave supports up to 256 beat INCR bursts, QoS signals, and data sideband signals.

The AXI translator is inserted for both AMBA 4 AXI master and slave, and performs the following functions:

• Matches ID widths between master and slave in 1x1 systems.
• Drives default values as defined in the *AMBA Protocol Specifications* for missing signals.
• Performs lock transaction bit conversion when an AMBA 3 AXI master connects to an AMBA 4 AXI slave in 1x1 systems.

### 4.1.4.3. Wait State Insertion

Wait states extend the duration of a transfer by one or more cycles. Wait state insertion logic accommodates the timing needs of each slave, and causes the master to wait until the slave can proceed. Platform Designer interconnect inserts wait states into a transfer when the target slave cannot respond in a single clock cycle, as well as in cases when slave read and write signals have setup or hold time requirements.
Figure 79. **Wait State Insertion Logic for One Master and One Slave**

Wait state insertion logic is a small finite-state machine that translates control signal sequencing between the slave side and the master side. Platform Designer interconnect can force a master to wait for the wait state needs of a slave; for example, arbitration logic in a multi-master system. Platform Designer generates wait state insertion logic based on the properties of all slaves in the system.

4.1.4.4. **Avalon-MM Slave Agent**

The Avalon-MM Slave Agent accepts command packets and issues the resulting transactions to the Avalon interface. For pipelined slaves, an Avalon-ST FIFO stores information about pending transactions. The size of this FIFO is the maximum number of pending responses that you specify when creating the slave component. The Avalon-MM Slave Agent also backpressures the Avalon-MM master command interface when the FIFO is full if the slave component includes the waitrequest signal.

4.1.4.5. **AXI Slave Agent**

An AXI Slave Agent works like a reverse master agent. The AXI Slave Agent accepts Platform Designer command packets to create AXI commands, and accepts AXI responses to create Platform Designer response packets. This component has separate packet channels for read commands, write commands, read responses, and write responses.

4.1.5. **Arbitration**

When multiple masters contend for access to a slave, Platform Designer automatically inserts arbitration logic, which grants access in fairness-based, round-robin order. You can alternatively choose to designate a slave as a fixed priority arbitration slave, and then manually assign priorities in the Platform Designer GUI.

4.1.5.1. **Round-Robin Arbitration**

When multiple masters contend for access to a slave, Platform Designer automatically inserts arbitration logic which grants access in fairness-based, round-robin order.

In a fairness-based arbitration protocol, each master has an integer value of transfer shares with respect to a slave. One share represents permission to perform one transfer. The default arbitration scheme is equal share round-robin that grants equal, sequential access to all requesting masters. You can change the arbitration scheme to weighted round-robin by specifying a relative number of arbitration shares to the masters that access a given slave. AXI slaves have separate arbitration for their independent read and write channels, and the Arbitration Shares setting affects both the read and write arbitration. To display arbitration settings, right-click an instance on the System Contents tab, and then click Show Arbitration Shares.
### 4.1.5.1.1. Fairness-Based Shares

In a fairness-based arbitration scheme, each master-to-slave connection provides a transfer share count. This count is a request for the arbiter to grant a specific number of transfers to this master before giving control to a different master. One share represents permission to perform one transfer.

#### Figure 80. Arbitration Shares in the Connections Column

<table>
<thead>
<tr>
<th>Connections</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mm_master_bfm_0_avalon</td>
<td>Altera UVM Avalon-MM Master BFM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>no</td>
<td>Avalon Memory Mapped Master</td>
</tr>
<tr>
<td>mm_master_bfm_1_axi</td>
<td>Altera AXI Master Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>altera_axi_master</td>
<td>AXI Master</td>
</tr>
<tr>
<td>mm_master_bfm_2_axi</td>
<td>Altera AXI Master Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>altera_axi_master</td>
<td>AXI Master</td>
</tr>
<tr>
<td>mm_slave_bfm_0_avalon</td>
<td>Altera UVM Avalon-MM Slave BFM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>s0</td>
<td>Avalon Memory Mapped Slave</td>
</tr>
<tr>
<td>mm_slave_bfm_1_avalon</td>
<td>Altera UVM Avalon-MM Slave BFM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>s0</td>
<td>Avalon Memory Mapped Slave</td>
</tr>
<tr>
<td>mm_slave_bfm_2_axi</td>
<td>Altera AXI Slave Module</td>
<td></td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Input</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Input</td>
</tr>
<tr>
<td></td>
<td>altera_axi_slave</td>
<td>AXI Slave</td>
</tr>
<tr>
<td>clock_0</td>
<td></td>
<td>Altera Avalon Clock and Reset Source</td>
</tr>
<tr>
<td></td>
<td>clk</td>
<td>Clock Output</td>
</tr>
<tr>
<td></td>
<td>clk_reset</td>
<td>Reset Output</td>
</tr>
<tr>
<td></td>
<td>dummy_src</td>
<td>Avalon Streaming Source</td>
</tr>
<tr>
<td></td>
<td>dummy_sink</td>
<td>Avalon Streaming Sink</td>
</tr>
</tbody>
</table>
Figure 81. Arbitration of Continuous Transfer Requests from Two Masters

Consider a system with two masters connected to a single slave. Master 1 has its arbitration shares set to three, and Master 2 has its arbitration shares set to four. Master 1 and Master 2 continuously attempt to perform back-to-back transfers to the slave. The arbiter grants Master 1 access to the slave for three transfers, and then grants Master 2 access to the slave for four transfers. This cycle repeats indefinitely. The figure below describes the waveform for this scenario.

Figure 82. Arbitration of Two Masters with a Gap in Transfer Requests

If a master stops requesting transfers before it exhausts its shares, it forfeits all its remaining shares, and the arbiter grants access to another requesting master. After completing one transfer, Master 2 stops requesting for one clock cycle. As a result, the arbiter grants access back to Master 1, which gets a replenished supply of shares.

4.1.5.1.2. Round-Robin Scheduling

When multiple masters contend for access to a slave, the arbiter grants shares in round-robin order. Platform Designer includes only requesting masters in the arbitration for each slave transaction.

4.1.5.2. Fixed Priority Arbitration

Fixed priority arbitration is an alternative arbitration scheme to the default round-robin scheme.

You can selectively apply fixed priority arbitration to any slave in a Platform Designer system. You can design Platform Designer systems where a subset of slaves use the default round-robin arbitration, and other slaves use fixed priority arbitration. Fixed priority arbitration uses a fixed priority algorithm to grant access to a slave amongst its connected masters.

To set up fixed priority arbitration, you must first designate a fixed priority slave in your Platform Designer system in the **Interconnect Requirements** tab. You can then assign an arbitration priority number for each master connected to a fixed priority slave in the **System Contents** tab, where the highest numeric value receives the highest priority. When multiple masters request access to a fixed priority arbitrated slave, the arbiter gives the master with the highest priority first access to the slave.

For example, when a fixed priority slave receives requests from three masters on the same cycle, the arbiter grants the master with highest assigned priority first access to the slave, and backpressures the other two masters.
Note: When you connect an AXI master to an Avalon-MM slave designated to use a fixed priority arbitrator, the interconnect instantiates a command-path intermediary round-robin multiplexer in front of the designated slave.

4.1.5.2.1. Designate a Platform Designer Slave to Use Fixed Priority Arbitration

You can designate any slave in your Platform Designer system to use fixed priority arbitration. You must assign each master connected to a fixed priority slave a numeric priority. The master with the highest higher priority receives first access to the slave. No two masters can have the same priority.

1. In Platform Designer, navigate to the **Interconnect Requirements** tab.
2. Click **Add** to add a new requirement.
3. In the **Identifier** column, select the slave for fixed priority arbitration.
4. In the **Setting** column, select `qsys mm.arbitrationScheme`.
5. In the **Value** column, select `fixed-priority`.
6. Navigate to the **System Contents** tab.
7. In the **System Contents** tab, right-click the designated fixed priority slave, and then select **Show Arbitration Shares**.
8. For each master connected to the fixed priority arbitration slave, type a numerical arbitration priority in the box that appears in place of the connection circle.
9. Right click the designated fixed priority slave and uncheck **Show Arbitration Shares** to return to the connection circles.

4.1.5.2.2. Fixed Priority Arbitration with AXI Masters and Avalon-MM Slaves

When an AXI master is connected to a designated fixed priority arbitration Avalon-MM slave, Platform Designer interconnect automatically instantiates an intermediary multiplexer in front of the Avalon-MM slave.

Since AXI masters have separate read and write channels, each channel appears as two separate masters to the Avalon-MM slave. To support fairness between the AXI master’s read and write channels, the instantiated round-robin intermediary multiplexer arbitrates between simultaneous read and write commands from the AXI master to the fixed-priority Avalon-MM slave.

When an AXI master is connected to a fixed priority AXI slave, the master’s read and write channels are directly connected to the AXI slave’s fixed-priority multiplexers. In this case, there is one multiplexer for the read command, and one multiplexer for the write command and therefore an intermediary multiplexer is not required.

The red circles indicate placement of the intermediary multiplexer between the AXI master and Avalon-MM slave due to the separate read and write channels of the AXI master.
4.1.6. Memory-Mapped Arbiter

The input to the Memory-Mapped Arbiter is the command packet for all masters requesting access to a specific slave. The arbiter outputs the channel number for the selected master. This channel number controls the output of a multiplexer that selects the slave device. The figure below illustrates this logic.
Figure 84. Arbitration Logic

In this example, four Avalon-MM masters connect to four Avalon-MM slaves. In each cycle, an arbiter positioned in front of each Avalon-MM slave selects among the requesting Avalon-MM masters.

Note: If you specify a Limit interconnect pipeline stages to parameter greater than zero, the output of the Arbiter is registered. Registering this output reduces the amount of combinational logic between the master and the interconnect, increasing the $f_{\text{MAX}}$ of the system.

Note: You can use the Memory-Mapped Arbiter for both round-robin and fixed priority arbitration.
4.1.7. Datapath Multiplexing Logic

Datapath multiplexing logic drives the `writedata` signal from the granted master to the selected slave, and the `readdata` signal from the selected slave back to the requesting master. Platform Designer generates separate datapath multiplexing logic for every master in the system (`readdata`), and for every slave in the system (`writedata`). Platform Designer does not generate multiplexing logic if it is not needed.

Figure 85. Datapath Multiplexing Logic for One Master and Two Slaves

4.1.8. Width Adaptation

Platform Designer width adaptation converts between Avalon memory-mapped master and slaves with different data and byte enable widths, and manages the run-time size requirements of AXI. Width adaptation for AXI to Avalon interfaces is also supported.

4.1.8.1. Memory-Mapped Width Adapter

The Memory-Mapped Width Adapter is used in the Avalon-ST domain and operates with information contained in the packet format.

The memory-mapped width adapter accepts packets on its sink interface with one data width and produces output packets on its source interface with a different data width. The ratio of the narrow data width must be a power of two, such as 1:4, 1:8, and 1:16. The ratio of the wider data width to the narrower width must also be a power of two, such as 4:1, 8:1, and 16:1. These output packets may have a different size if the input size exceeds the output data bus width, or if data packing is enabled.

When the width adapter converts from narrow data to wide data, each input beat's data and byte enables are copied to the appropriate segment of the wider output data and byte enables signals.
Figure 86. **Width Adapter Timing for a 4:1 Adapter**

This adapter assumes that the field ordering of the input and output packets is the same, with the only difference being the width of the data and accompanying byte enable fields. When the width adapter converts from wide data to narrow data, the narrower data is transmitted over several beats. The first output beat contains the lowest addressed segment of the input data and byte enables.

![Diagram of Adapter Timing]

4.1.8.1.1. **AXI Wide-to-Narrow Adaptation**

For all cases of AXI wide-to-narrow adaptation, read data is re-packed to match the original size. Responses are merged, with the following error precedence: DECERR, SLVERR, OKAY, and EXOKAY.

Table 47. **AXI Wide-to-Narrow Adaptation (Downsizing)**

<table>
<thead>
<tr>
<th>Burst Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incrementing</td>
<td>If the transaction size is less than or equal to the output width, the burst is unmodified. Otherwise, it is converted to an incrementing burst with a larger length and size equal to the output width. If the resulting burst is unsuitable for the slave, the burst is converted to multiple sequential bursts of the largest allowable lengths. For example, for a 2:1 downsizing ratio, an INCR9 burst is converted into INCR16 + INCR2 bursts. This is true if the maximum burstcount a slave can accept is 16, which is the case for AMBA 3 AXI slaves. Avalon slaves have a maximum burstcount of 64.</td>
</tr>
<tr>
<td>Wrapping</td>
<td>If the transaction size is less than or equal to the output width, the burst is unmodified. Otherwise, it is converted to a wrapping burst with a larger length, with a size equal to the output width. If the resulting burst is unsuitable for the slave, the burst is converted to multiple sequential bursts of the largest allowable lengths; respecting wrap boundaries. For example, for a 2:1 downsizing ratio, a WRAP16 burst is converted into two or three INCR bursts, depending on the address.</td>
</tr>
<tr>
<td>Fixed</td>
<td>If the transaction size is less than or equal to the output width, the burst is unmodified. Otherwise, it is converted into repeated sequential bursts over the same addresses. For example, for a 2:1 downsizing ratio, a FIXED single burst is converted into an INCR2 burst.</td>
</tr>
</tbody>
</table>
4.1.8.1.2. AXI Narrow-to-Wide Adaptation

Table 48. AXI Narrow-to-Wide Adaptation (Upsizing)

<table>
<thead>
<tr>
<th>Burst Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incrementing</td>
<td>The burst (and its response) passes through unmodified. Data and write strobes are placed in the correct output segment.</td>
</tr>
<tr>
<td>Wrapping</td>
<td>The burst (and its response) passes through unmodified.</td>
</tr>
<tr>
<td>Fixed</td>
<td>The burst (and its response) passes through unmodified.</td>
</tr>
</tbody>
</table>

4.1.9. Burst Adapter

Platform Designer interconnect uses the memory-mapped burst adapter to accommodate the burst capabilities of each interface in the system, including interfaces that do not support burst transfers.

The maximum burst length for each interface is a property of the interface and is independent of other interfaces in the system. Therefore, a specific master may be capable of initiating a burst longer than a slave’s maximum supported burst length. In this case, the burst adapter translates the large master burst into smaller bursts, or into individual slave transfers if the slave does not support bursting. Until the master completes the burst, arbiter logic prevents other masters from accessing the target slave. For example, if a master initiates a burst of 16 transfers to a slave with maximum burst length of 8, the burst adapter initiates 2 bursts of length 8 to the slave.

Avalon-MM and AXI burst transactions allow a master uninterrupted access to a slave for a specified number of transfers. The master specifies the number of transfers when it initiates the burst. Once a burst begins between a master and slave, arbiter logic is locked until the burst completes. For burst masters, the length of the burst is the number of cycles that the master has access to the slave, and the selected arbitration shares have no effect.

Note: AXI masters can issue burst types that Avalon cannot accept, for example, fixed bursts. In this case, the burst adapter converts the fixed burst into a sequence of transactions to the same address.

Note: For AMBA 4 AXI slaves, Platform Designer allows 256-beat INCR bursts. You must ensure that 256-beat narrow-sized INCR bursts are shortened to 16-beat narrow-sized INCR bursts for AMBA 3 AXI slaves.

Avalon-MM masters always issue addresses that are aligned to the size of the transfer. However, when Platform Designer uses a narrow-to-wide width adaptation, the resulting address may be unaligned. For unaligned addresses, the burst adapter issues the maximum sized bursts with appropriate byte enables. This brings the burst-in-progress up to an aligned slave address. Then, it completes the burst on aligned addresses.

The burst adapter supports variable wrap or sequential burst types to accommodate different properties of memory-mapped masters. Some bursting masters can issue more than one burst type.

Burst adaptation is available for Avalon to Avalon, Avalon to AXI, and AXI to Avalon, and AXI to AXI connections. For information about AXI-to-AXI adaptation, refer to AXI Wide-to-Narrow Adaptation.
Note: For AMBA 4 AXI to AMBA 3 AXI connections, Platform Designer follows an AMBA 4 AXI 256 burst length to AMBA 3 AXI 16 burst length.

4.1.9.1. Burst Adapter Implementation Options

Platform Designer automatically inserts burst adapters into your system depending on your master and slave connections, and properties. You can select burst adapter implementation options on the Interconnect Requirements tab.

To access the implementation options, you must select the Burst adapter implementation setting for the $system identifier.

- **Generic converter (slower, lower area)**—Default. Controls all burst conversions with a single converter that can adapt incoming burst types. This results in an adapter that has lower $f_{MAX}$ but smaller area.
- **Per-burst-type converter (faster, higher area)**—Controls incoming bursts with a specific converter, depending on the burst type. This results in an adapter that has higher $f_{MAX}$ but higher area. This setting is useful when you have AXI masters or slaves and you want a higher $f_{MAX}$.

Note: For more information about the Interconnect Requirements tab, refer to Creating a System with Platform Designer.

Related Information
Creating a System with Platform Designer on page 9

4.1.9.2. Burst Adaptation: AXI to Avalon

Table 49. Burst Adaptation: AXI to Avalon

Entries specify the behavior when converting between AXI and Avalon burst types.

<table>
<thead>
<tr>
<th>Burst Type</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incrementing</td>
<td><strong>Sequential Slave</strong>&lt;br&gt;Bursts that exceed slave_max_burst_length are converted to multiple sequential bursts of a length less than or equal to the slave_max_burst_length. Otherwise, the burst is unconverted. For example, for an Avalon slave with a maximum burst length of 4, an INCR7 burst is converted to INCR4 + INCR3. <strong>Wrapping Slave</strong>&lt;br&gt;Bursts that exceed the slave_max_burst_length are converted to multiple sequential bursts of length less than or equal to the slave_max_burst_length. Bursts that exceed the wrapping boundary are converted to multiple sequential bursts that respect the slave’s wrapping boundary.</td>
</tr>
<tr>
<td>Wrapping</td>
<td><strong>Sequential Slave</strong>&lt;br&gt;A WAP burst is converted to multiple sequential bursts. The sequential bursts are less than or equal to the max_burst_length and respect the transaction’s wrapping boundary <strong>Wrapping Slave</strong>&lt;br&gt;If the WAP transaction’s boundary matches the slave’s boundary, then the burst passes through. Otherwise, the burst is converted to sequential bursts that respect both the transaction and slave wrap boundaries.</td>
</tr>
<tr>
<td>Fixed</td>
<td>Fixed bursts are converted to sequential bursts of length 1 that repeatedly access the same address.</td>
</tr>
<tr>
<td>Narrow</td>
<td>All narrow-sized bursts are broken into multiple bursts of length 1.</td>
</tr>
</tbody>
</table>
4.1.9.3. Burst Adaptation: Avalon to AXI

Table 50. Burst Adaptation: Avalon to AXI

Entries specify the behavior when converting between Avalon and AXI burst types.

<table>
<thead>
<tr>
<th>Burst Type</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequential</td>
<td>Bursts of length greater than 16 are converted to multiple INCR bursts of a length less than or equal to 16. Bursts of length less than or equal to 16 are not converted.</td>
</tr>
<tr>
<td>Wrapping</td>
<td>Only Avalon masters with alwaysBurstMaxBurst = true are supported. The WRAP burst is passed through if the length is less than or equal to 16. Otherwise, it is converted to two or more INCR bursts that respect the transaction’s wrap boundary.</td>
</tr>
<tr>
<td>GENERIC_CONVERTER</td>
<td>Controls all burst conversions with a single converter that adapts all incoming burst types, resulting in an adapter that has smaller area, but lower fMAX.</td>
</tr>
</tbody>
</table>

4.1.10. Waitrequest Allowance Adapter

The Waitrequest Allowance Adapter allows a connection between a master and a slave interface with different waitrequestAllowance properties.

The Waitrequest Allowance adapter provides the following features:

- The adapter is used in the memory-mapped domain and operates with signals on the memory-mapped interface.
- Signal widths and all properties other than waitrequestAllowance are identical on master and slave interfaces.
- The adapter does not modify any command properties such as data width, burst type, or burst count.
- The adapter is inserted by the Platform Designer interconnect software when a master and slave with different waitrequestAllowance property are connected.

When the slave has a waitrequestAllowance = n the master must deassert read or write signals after <n> transfers when waitrequest is asserted.

Table 51. Interconnect Scenarios Requiring waitrequestAllowance

<table>
<thead>
<tr>
<th>Master (m) / Slave (n) waitrequestAllowance</th>
<th>Adaptation Required</th>
<th>Description</th>
<th>Adapter Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>m = n</td>
<td>No</td>
<td>The master waitrequestAllowance is equal to the slave’s waitrequestAllowance.</td>
<td>All signals are passed through.</td>
</tr>
<tr>
<td>m = 0; n &gt; 0</td>
<td>Yes</td>
<td>The master cannot send when waitrequest=1, but holds the value on the bus. This would result in the slave receiving multiple copies. Requires adaptation to prevent.</td>
<td>The adapter deasserts valid when input waitrequest is asserted.</td>
</tr>
<tr>
<td>m &lt; n; m ≠ 0</td>
<td>No</td>
<td>The master can send &lt;m&gt; transfers after waitrequest is asserted. The slave receives fewer than &lt;n&gt; transfers, which is acceptable.</td>
<td>All signals are passed through.</td>
</tr>
<tr>
<td>m &gt; n; n = 0</td>
<td>Yes</td>
<td>The slave cannot accept transfers when waitrequest is asserted. Transfers sent when waitrequest=1 can be lost.</td>
<td>If the input waitrequest is asserted, the adapter buffers the input data.</td>
</tr>
</tbody>
</table>
4.1.11. Read and Write Responses

Platform Designer merges write responses if a write is converted (burst adapted) into multiple bursts. Platform Designer requires read response merging for a downsized (wide-to-narrow width adapted) read.

Platform Designer merges responses based on the following precedence rule:

\[
\text{DECERR} > \text{SLVERR} > \text{OKAY} > \text{EXOKAY}
\]

Adaptation between a master with write responses and a slave without write responses can be costly, especially if there are multiple slaves, or if the slave supports bursts. To minimize the cost of logic between slaves, consider placing the slaves that do not have write responses behind a bridge so that the write response adaptation logic cost is only incurred once, at the bridge’s slave interface.

The following table describes what happens when there is a mismatch in response support between the master and slave.

<table>
<thead>
<tr>
<th>Slave with Response</th>
<th>Slave Without Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master with Response</td>
<td>Interconnect delivers response from the slave to the master. Response merging or duplication may be necessary for bus sizing.</td>
</tr>
<tr>
<td>Master without Response</td>
<td>Master ignores responses from the slave</td>
</tr>
</tbody>
</table>

**Note:** If there is a bridge between the master and the endpoint slave, and the responses must come from the endpoint slave, ensure that the bridge passes the appropriate response signals through from the endpoint slave to the master.

If the bridge does not support responses, then the responses are generated by the interconnect at the slave interface of the bridge, and responses from the endpoint slave are ignored.

For the response case where the transaction violates security settings or uses an illegal address, the interconnect routes the transactions to the default slave. For information about Platform Designer system security, refer to Manage System Security. For information about specifying a default slave, refer to Error Response Slave in Platform Designer System Design Components.
Avalon-MM slaves without a response signal are not able to notify a connected master that a transaction has not completed successfully. As a result, Platform Designer interconnect generates an OKAY response on behalf of the Avalon-MM slave.

**Related Information**

- Master Network Interfaces on page 364
- Error Response Slave on page 643
- Error Correction Coding (ECC) in Platform Designer Interconnect on page 417

### 4.1.12. Platform Designer Address Decoding

Address decoding logic forwards appropriate addresses to each slave.

Address decoding logic simplifies component design in the following ways:

- The interconnect selects a slave whenever it is being addressed by a master. Slave components do not need to decode the address to determine when they are selected.
- Slave addresses are properly aligned to the slave interface.
- Changing the system memory map does not involve manually editing HDL.

**Figure 87. Address Decoding for One Master and Two Slaves**

In this example, Platform Designer generates separate address decoding logic for each master in a system. The address decoding logic processes the difference between the master address width (<M>) and the individual slave address widths (<S> and <T>). The address decoding logic also maps only the necessary master address bits to access words in each slave's address space.
4. Platform Designer Interconnect

4.2. Avalon Streaming Interfaces

High bandwidth components with streaming data typically use Avalon-ST interfaces for the high throughput datapath. Streaming interfaces can also use memory-mapped connection interfaces to provide an access point for control. In contrast to the memory-mapped interconnect, the Avalon-ST interconnect always creates a point-to-point connection between a single data source and data sink.
Figure 89. Memory-Mapped and Avalon-ST Interfaces

In this example, there are the following connection pairs:

- Data source in the Rx Interface transfers data to the data sink in the FIFO.
- Data source in the FIFO transfers data to the Tx Interface data sink.

The memory-mapped interface allows a processor to access the data source, FIFO, or data sink to provide system control. If your source and sink interfaces have different formats, for example, a 32-bit source and an 8-bit sink, Platform Designer automatically inserts the necessary adapters. You can view the adapters on the System Contents tab by clicking System ➤ Show System with Platform Designer Interconnect.

Figure 90. Avalon-ST Connection Between the Source and Sink

This source-sink pair includes only the data signal. The sink must be able to receive data as soon as the source interface comes out of reset.
Signals Indicating the Start and End of Packets, Channel Numbers, Error Conditions, and Backpressure

All data transfers using Avalon-ST interconnect occur synchronously on the rising edge of the associated clock interface. Throughput and frequency of a system depends on the components and how they are connected.

The IP Catalog includes Avalon-ST components that you can use to create datapaths, including datapaths whose input and output streams have different properties. Generated systems that include memory-mapped master and slave components may also use these Avalon-ST components because Platform Designer generation creates interconnect with a structure similar to a network topology, as described in Platform Designer Transformations. The following sections introduce the Avalon-ST components.

Related Information
Platform Designer Transformations on page 362

4.2.1. Avalon-ST Adapters

Platform Designer automatically adds Avalon-ST adapters between two components during system generation when it detects mismatched interfaces. If you connect mismatched Avalon-ST sources and sinks, for example, a 32-bit source and an 8-bit sink, Platform Designer inserts the appropriate adapter type to connect the mismatched interfaces.

After generation, you can view the inserted adapters selecting System ➤ Show System With Platform Designer Interconnect. For each mismatched source-sink pair, Platform Designer inserts an Avalon-ST Adapter. The adapter instantiates the necessary adaptation logic as sub-components. You can review the logic for each adapter instantiation in the Hierarchy view by expanding each adapter's source and sink interface and comparing the relevant ports. For example, to determine why a channel adapter is inserted, expand the channel adapter's sink and source interfaces and review the channel port properties for each interface.

You can turn off the auto-inserted adapters feature by adding the qsys_enable_avalon_streaming_transform=off command to the quartus.ini file. When you turn off the auto-inserted adapters feature, if mismatched interfaces are detected during system generation, Platform Designer does not insert adapters and reports the mismatched interface with validation error message.
Note: The auto-inserted adapters feature does not work for video IP core connections.

4.2.1.1. Avalon-ST Adapter

The Avalon-ST adapter combines the logic of the channel, error, data format, and timing adapters. The Avalon-ST adapter provides adaptations between interfaces that have mismatched Avalon-ST endpoints. Based on the source and sink interface parameterizations for the Avalon-ST adapter, Platform Designer instantiates the necessary adapter logic (channel, error, data format, or timing) as hierarchal sub-components.

4.2.1.1.1. Avalon-ST Adapter Parameters Common to Source and Sink Interfaces

Table 53. Avalon-ST Adapter Parameters Common to Source and Sink Interfaces

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol Width</td>
<td>Width of a single symbol in bits.</td>
</tr>
<tr>
<td>Use Packet</td>
<td>Indicates whether the source and sink interfaces connected to the adapter's source and sink interfaces include the startofpacket and endofpacket signals, and the optional empty signal.</td>
</tr>
</tbody>
</table>

4.2.1.1.2. Avalon-ST Adapter Upstream Source Interface Parameters

Table 54. Avalon-ST Adapter Upstream Source Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Data Width</td>
<td>Controls the data width of the source interface data port.</td>
</tr>
<tr>
<td>Source Top Channel</td>
<td>Maximum number of output channels allowed.</td>
</tr>
<tr>
<td>Source Channel Port Width</td>
<td>Sets the bit width of the source interface channel port. If set to 0, there is no channel port on the sink interface.</td>
</tr>
<tr>
<td>Source Error Port Width</td>
<td>Sets the bit width of the source interface error port. If set to 0, there is no error port on the sink interface.</td>
</tr>
<tr>
<td>Source Error Descriptors</td>
<td>A list of strings that describe the error conditions for each bit of the source interface error signal.</td>
</tr>
<tr>
<td>Source Uses Empty Port</td>
<td>Indicates whether the source interface includes the empty port, and whether the sink interface should also include the empty port.</td>
</tr>
<tr>
<td>Source Empty Port Width</td>
<td>Indicates the bit width of the source interface empty port, and sets the bit width of the sink interface empty port.</td>
</tr>
<tr>
<td>Source Uses Valid Port</td>
<td>Indicates whether the source interface connected to the sink interface uses the valid port, and if set, configures the sink interface to use the valid port.</td>
</tr>
<tr>
<td>Source Uses Ready Port</td>
<td>Indicates whether the sink interface uses the ready port, and if set, configures the source interface to use the ready port.</td>
</tr>
<tr>
<td>Source Ready Latency</td>
<td>Specifies what ready latency to expect from the source interface connected to the adapter's sink interface.</td>
</tr>
</tbody>
</table>
4.2.1.1.3. Avalon-ST Adapter Downstream Sink Interface Parameters

Table 55.  Avalon-ST Adapter Downstream Sink Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sink Data Width</td>
<td>Indicates the bit width of the data port on the sink interface connected to the source interface.</td>
</tr>
<tr>
<td>Sink Top Channel</td>
<td>Maximum number of output channels allowed.</td>
</tr>
<tr>
<td>Sink Channel Port Width</td>
<td>Indicates the bit width of the channel port on the sink interface connected to the source interface.</td>
</tr>
<tr>
<td>Sink Error Port Width</td>
<td>Indicates the bit width of the error port on the sink interface connected to the adapter's source interface. If set to zero, there is no error port on the source interface.</td>
</tr>
<tr>
<td>Sink Error Descriptors</td>
<td>A list of strings that describe the error conditions for each bit of the error port on the sink interface connected to the source interface.</td>
</tr>
<tr>
<td>Sink Uses Empty Port</td>
<td>Indicates whether the sink interface connected to the source interface uses the empty port, and whether the source interface should also use the empty port.</td>
</tr>
<tr>
<td>Sink Empty Port Width</td>
<td>Indicates the bit width of the empty port on the sink interface connected to the source interface, and configures a corresponding empty port on the source interface.</td>
</tr>
<tr>
<td>Sink Uses Valid Port</td>
<td>Indicates whether the valid port on the sink interface is connected to the source interface, and if set, configures the source interface to use the valid port.</td>
</tr>
<tr>
<td>Sink Uses Ready Port</td>
<td>Indicates whether the ready port on the sink interface is connected to the source interface, and if set, configures the sink interface to use the ready port.</td>
</tr>
<tr>
<td>Sink Ready Latency</td>
<td>Specifies what ready latency to expect from the source interface connected to the sink interface.</td>
</tr>
</tbody>
</table>

4.2.1.2. Channel Adapter

The channel adapter provides adaptations between interfaces that have different channel signal widths.

Table 56.  Channel Adapter Adaptations

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description of Adapter Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>The source uses channels, but the sink does not.</td>
<td>Platform Designer gives a warning at generation time. The adapter provides a simulation error and signals an error for data for any channel from the source other than 0.</td>
</tr>
<tr>
<td>The sink has channel, but the source does not.</td>
<td>Platform Designer gives a warning at generation time, and the channel inputs to the sink are all tied to a logical 0.</td>
</tr>
<tr>
<td>The source and sink both support channels, and the source's maximum channel number is less than the sink's maximum channel number.</td>
<td>The source's channel is connected to the sink's channel unchanged. If the sink's channel signal has more bits, the higher bits are tied to a logical 0.</td>
</tr>
<tr>
<td>The source and sink both support channels, but the source's maximum channel number is greater than the sink's maximum channel number.</td>
<td>The source's channel is connected to the sink's channel unchanged. If the source's channel signal has more bits, the higher bits are left unconnected. Platform Designer gives a warning that channel information may be lost. An adapter provides a simulation error message and an error indication if the value of channel from the source is greater than the sink's maximum number of channels. In addition, the valid signal to the sink is deasserted so that the sink never sees data for channels that are out of range.</td>
</tr>
</tbody>
</table>
4.2.1.2.1. Avalon-ST Channel Adapter Input Interface Parameters

Table 57. Avalon-ST Channel Adapter Input Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Signal Width (bits)</td>
<td>Width of the input channel signal in bits</td>
</tr>
<tr>
<td>Max Channel</td>
<td>Maximum number of input channels allowed.</td>
</tr>
</tbody>
</table>

4.2.1.2.2. Avalon-ST Channel Adapter Output Interface Parameters

Table 58. Avalon-ST Channel Adapter Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Signal Width (bits)</td>
<td>Width of the output channel signal in bits.</td>
</tr>
<tr>
<td>Max Channel</td>
<td>Maximum number of output channels allowed.</td>
</tr>
</tbody>
</table>

4.2.1.2.3. Avalon-ST Channel Adapter Common to Input and Output Interface Parameters

Table 59. Avalon-ST Channel Adapter Common to Input and Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Bits Per Symbol</td>
<td>Number of bits for each symbol in a transfer.</td>
</tr>
<tr>
<td>Include Packet Support</td>
<td>When the Avalon-ST Channel adapter supports packets, the startofpacket, endofpacket, and optional empty signals are included on its sink and source interfaces.</td>
</tr>
<tr>
<td>Include Empty Signal</td>
<td>Indicates whether an empty signal is required.</td>
</tr>
<tr>
<td>Data Symbols Per Beat</td>
<td>Number of symbols per transfer.</td>
</tr>
<tr>
<td>Support Backpressure with the ready signal</td>
<td>Indicates whether a ready signal is required.</td>
</tr>
<tr>
<td>Ready Latency</td>
<td>Specifies the ready latency to expect from the sink connected to the module's source interface.</td>
</tr>
<tr>
<td>Error Signal Width (bits)</td>
<td>Bit width of the error signal.</td>
</tr>
<tr>
<td>Error Signal Description</td>
<td>A list of strings that describes what each bit of the error signal represents.</td>
</tr>
</tbody>
</table>

4.2.1.3. Data Format Adapter

The data format adapter allows you to connect interfaces that have different values for the parameters defining the data signal, or interfaces where the source does not use the empty signal, but the sink does use the empty signal. One of the most common uses of this adapter is to convert data streams of different widths.

Table 60. Data Format Adapter Adaptations

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description of Adapter Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>The source and sink's bits per symbol parameters are different.</td>
<td>The connection cannot be made.</td>
</tr>
<tr>
<td>The source and sink have a different number of symbols per beat.</td>
<td>The adapter converts the source's width to the sink's width.</td>
</tr>
</tbody>
</table>

continued...
Condition | Description of Adapter Logic
--- | ---
If the adaptation is from a wider to a narrower interface, a beat of data at the input corresponds to multiple beats of data at the output. If the input error signal is asserted for a single beat, it is asserted on output for multiple beats. If the adaptation is from a narrow to a wider interface, multiple input beats are required to fill a single output beat, and the output error is the logical OR of the input error signal.
The source uses the empty signal, but the sink does not use the empty signal. | Platform Designer cannot make the connection.

Figure 92. Avalon Streaming Interconnect with Data Format Adapter
In this example, the data format adapter allows a connection between a 128-bit output data stream and three 32-bit input data streams.

4.2.1.3.1. Avalon-ST Data Format Adapter Input Interface Parameters

Table 61. Avalon-ST Data Format Adapter Input Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Symbols Per Beat</td>
<td>Number of symbols per transfer.</td>
</tr>
<tr>
<td>Include Empty Signal</td>
<td>Indicates whether an empty signal is required.</td>
</tr>
</tbody>
</table>

4.2.1.3.2. Avalon-ST Data Format Adapter Output Interface Parameters

Table 62. Avalon-ST Data Format Adapter Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Symbols Per Beat</td>
<td>Number of symbols per transfer.</td>
</tr>
<tr>
<td>Include Empty Signals</td>
<td>Indicates whether an empty signal is required.</td>
</tr>
</tbody>
</table>
4.2.1.3.3. Avalon-ST Data Format Adapter Common to Input and Output Interface Parameters

Table 63. Avalon-ST Data Format Adapter Common to Input and Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Bits Per Symbol</td>
<td>Number of bits for each symbol in a transfer.</td>
</tr>
<tr>
<td>Include Packet Support</td>
<td>When the Avalon-ST Data Format adapter supports packets, Platform Designer uses startofpacket, endofpacket, and empty signals.</td>
</tr>
<tr>
<td>Channel Signal Width (bits)</td>
<td>Width of the output channel signal in bits.</td>
</tr>
<tr>
<td>Max Channel</td>
<td>Maximum number of channels allowed.</td>
</tr>
<tr>
<td>Read Latency</td>
<td>Specifies the ready latency to expect from the sink connected to the module's source interface.</td>
</tr>
<tr>
<td>Error Signal Width (bits)</td>
<td>Width of the error signal output in bits.</td>
</tr>
<tr>
<td>Error Signal Description</td>
<td>A list of strings that describes what each bit of the error signal represents.</td>
</tr>
</tbody>
</table>

4.2.1.4. Error Adapter

The error adapter ensures that per-bit-error information provided by the source interface is correctly connected to the sink interface’s input error signal. Error conditions that both source and sink can process are connected. If the source has an error signal representing an error condition that is not supported by the sink, the signal is left unconnected; the adapter provides a simulation error message and an error indication if the error is asserted. If the sink has an error condition that is not supported by the source, the sink’s input error bit corresponding to that condition is set to 0.

Note: The output interface error signal descriptor accepts an error set with an other descriptor. Platform Designer assigns the bit-wise ORing of all input error bits that are unmatched, to the output interface error bits set with the other descriptor.

4.2.1.4.1. Avalon-ST Error Adapter Input Interface Parameters

Table 64. Avalon-ST Error Adapter Input Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Signal Width (bits)</td>
<td>The width of the error signal. Valid values are 0–256 bits. Type 0 if the error signal is not used.</td>
</tr>
<tr>
<td>Error Signal Description</td>
<td>The description for each of the error bits. If scripting, separate the description fields by commas. For a successful connection, the description strings of the error bits in the source and sink must match and are case sensitive.</td>
</tr>
</tbody>
</table>
4.2.1.4.2. Avalon-ST Error Adapter Output Interface Parameters

Table 65. Avalon-ST Error Adapter Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Signal Width (bits)</td>
<td>The width of the error signal. Valid values are 0–256 bits. Type 0 if you do not need to send error values.</td>
</tr>
<tr>
<td>Error Signal Description</td>
<td>The description for each of the error bits. Separate the description fields by commas. For successful connection, the description of the error bits in the source and sink must match, and are case sensitive.</td>
</tr>
</tbody>
</table>

4.2.1.4.3. Avalon-ST Error Adapter Common to Input and Output Interface Parameters

Table 66. Avalon-ST Error Adapter Common to Input and Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Backpressure with the ready signal</td>
<td>Turn on this option to add the backpressure functionality to the interface.</td>
</tr>
<tr>
<td>Ready Latency</td>
<td>When the ready signal is used, the value for ready_latency indicates the number of cycles between when the ready signal is asserted and when valid data is driven.</td>
</tr>
<tr>
<td>Channel Signal Width (bits)</td>
<td>The width of the channel signal. A channel width of 4 allows up to 16 channels. The maximum width of the channel signal is eight bits. Set to 0 if channels are not used.</td>
</tr>
<tr>
<td>Max Channel</td>
<td>The maximum number of channels that the interface supports. Valid values are 0–255.</td>
</tr>
<tr>
<td>Data Bits Per Symbol</td>
<td>Number of bits per symbol.</td>
</tr>
<tr>
<td>Data Symbols Per Beat</td>
<td>Number of symbols per active transfer.</td>
</tr>
<tr>
<td>Include Packet Support</td>
<td>Turn on this option if the connected interfaces support a packet protocol, including the startofpacket, endofpacket and empty signals.</td>
</tr>
<tr>
<td>Include Empty Signal</td>
<td>Turn this option on if the cycle that includes the endofpacket signal can include empty symbols. This signal is not necessary if the number of symbols per beat is 1.</td>
</tr>
</tbody>
</table>

4.2.1.5. Timing Adapter

The timing adapter allows you to connect component interfaces that require a different number of cycles before driving or receiving data. This adapter inserts a FIFO buffer between the source and sink to buffer data or pipeline stages to delay the backpressure signals. You can also use the timing adapter to connect interfaces that support the ready signal, and those that do not. The timing adapter treats all signals other than the ready and valid signals as payload, and simply drives them from the source to the sink.
Table 67. Timing Adapter Adaptations

<table>
<thead>
<tr>
<th>Condition</th>
<th>Adaptation</th>
</tr>
</thead>
<tbody>
<tr>
<td>The source has ready, but the sink does not.</td>
<td>In this case, the source can respond to backpressure, but the sink never needs to apply it. The ready input to the source interface is connected directly to logical 1.</td>
</tr>
<tr>
<td>The source does not have ready, but the sink does.</td>
<td>The sink may apply backpressure, but the source is unable to respond to it. There is no logic that the adapter can insert that prevents data loss when the source asserts valid but the sink is not ready. The adapter provides simulation time error messages if data is lost. The user is presented with a warning, and the connection is allowed.</td>
</tr>
<tr>
<td>The source and sink both support backpressure, but the sink's ready latency is greater than the source's.</td>
<td>The source responds to ready assertion or deassertion faster than the sink requires it. The number of pipeline stages equal to the difference in ready latency are inserted in the ready path from the sink back to the source, causing the source and the sink to see the same cycles as ready cycles.</td>
</tr>
<tr>
<td>The source and sink both support backpressure, but the sink's ready latency is less than the source's.</td>
<td>The source cannot respond to ready assertion or deassertion in time to satisfy the sink. A FIFO whose depth is equal to the difference in ready latency is inserted to compensate for the source's inability to respond in time.</td>
</tr>
</tbody>
</table>

4.2.1.5.1. Avalon-ST Timing Adapter Input Interface Parameters

Table 68. Avalon-ST Timing Adapter Input Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Backpressure with the ready signal</td>
<td>Indicates whether a ready signal is required.</td>
</tr>
<tr>
<td>Read Latency</td>
<td>Specifies the ready latency to expect from the sink connected to the module's source interface.</td>
</tr>
<tr>
<td>Include Valid Signal</td>
<td>Indicates whether the sink interface requires a valid signal.</td>
</tr>
</tbody>
</table>

4.2.1.5.2. Avalon-ST Timing Adapter Output Interface Parameters

Table 69. Avalon-ST Timing Adapter Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support Backpressure with the ready signal</td>
<td>Indicates whether a ready signal is required.</td>
</tr>
<tr>
<td>Read Latency</td>
<td>Specifies the ready latency to expect from the sink connected to the module's source interface.</td>
</tr>
<tr>
<td>Include Valid Signal</td>
<td>Indicates whether the sink interface requires a valid signal.</td>
</tr>
</tbody>
</table>

4.2.1.5.3. Avalon-ST Timing Adapter Common to Input and Output Interface Parameters

Table 70. Avalon-ST Timing Adapter Common to Input and Output Interface Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Bits Per Symbol</td>
<td>Number of bits for each symbol in a transfer.</td>
</tr>
<tr>
<td>Include Packet Support</td>
<td>Turn this option on if the connected interfaces support a packet protocol, including the startofpacket, endofpacket and empty signals.</td>
</tr>
<tr>
<td>Include Empty Signal</td>
<td>Turn this option on if the cycle that includes the endofpacket signal can include empty symbols. This signal is not necessary if the number of symbols per beat is 1.</td>
</tr>
<tr>
<td>Data Symbols Per Beat</td>
<td>Number of symbols per active transfer.</td>
</tr>
</tbody>
</table>

continued...
### 4.3. Interrupt Interfaces

Using individual requests, the interrupt logic can process up to 32 IRQ inputs connected to each interrupt receiver. With this logic, the interrupt sender connected to interrupt receiver_0 is the highest priority with sequential receivers being successively lower priority. You can redefine the priority of interrupt senders by instantiating the IRQ mapper component. For more information refer to [IRQ Mapper](#).

You can define the interrupt sender interface as asynchronous with no associated clock or reset interfaces. You can also define the interrupt receiver interface as asynchronous with no associated clock or reset interfaces. As a result, the receiver does its own synchronization internally. Platform Designer does not insert interrupt synchronizers for such receivers.

For clock crossing adaption on interrupts, Platform Designer inserts a synchronizer, which is clocked with the interrupt end point interface clock when the corresponding starting point interrupt interface has no clock or a different clock (than the end point). Platform Designer inserts the adapter if there is any kind of mismatch between the start and end points. Platform Designer does not insert the adapter if the interrupt receiver does not have an associated clock.

**Related Information**

[IRQ Mapper](#) on page 394

#### 4.3.1. Individual Requests IRQ Scheme

In the individual requests IRQ scheme, Platform Designer interconnect passes IRQs directly from the sender to the receiver, without making assumptions about IRQ priority. If multiple senders assert their IRQs simultaneously, the receiver logic determines which IRQ has highest priority, and then responds appropriately.
**Figure 93. Interrupt Controller Mapping IRQs**

Using individual requests, the interrupt controller can process up to 32 IRQ inputs. The interrupt controller generates a 32-bit signal \( \text{irq}[31:0] \) to the receiver, and maps slave IRQ signals to the bits of \( \text{irq}[31:0] \). Any unassigned bits of \( \text{irq}[31:0] \) are disabled.

4.3.2. Assigning IRQs in Platform Designer

You assign IRQ connections on the **System Contents** tab of Platform Designer. After adding all components to the system, you connect interrupt senders and receivers. You can use the **IRQ** column to specify an IRQ number with respect to each receiver, or to specify a receiver’s IRQ as unconnected. Platform Designer uses the following three components to implement interrupt handling: IRQ Bridge, IRQ Mapper, and IRQ Clock Crosser.

**4.3.2.1. IRQ Bridge**

The IRQ Bridge allows you to route interrupt wires between Platform Designer subsystems.
The peripheral subsystem example below has three interrupt senders that are exported to the to-level of the subsystem. The interrupts are then routed to the CPU subsystem using the IRQ bridge.

**Figure 94. Platform Designer IRQ Bridge Application**

![Platform Designer IRQ Bridge Application Diagram]

Note: Nios II BSP tools support the IRQ Bridge. Interrupts connected via an IRQ Bridge appear in the generated system.h file. You can use the following properties with the IRQ Bridge, which do not effect Platform Designer interconnect generation. Platform Designer uses these properties to generate the correct IRQ information for downstream tools:

1. `set_interface_property <sender port> bridgesToReceiver <receiver port>`— The `<sender port>` of the IP generates a signal that is received on the IP's `<receiver port>`. Sender ports are single bits. Receivers ports can be multiple bits. Platform Designer requires the `bridgedReceiverOffset` property to identify the `<receiver port>` bit that the `<sender port>` sends.

2. `set_interface_property <sender port> bridgedReceiverOffset <port number>`— Indicates the `<port number>` of the receiver port that the `<sender port>` sends.

4.3.2.2. IRQ Mapper

Platform Designer inserts the IRQ Mapper automatically during generation. The IRQ Mapper converts individual interrupt wires to a bus, and then maps the appropriate IRQ priority number onto the bus.

By default, the interrupt sender connected to the `receiver0` interface of the IRQ mapper is the highest priority, and sequential receivers are successively lower priority. You can modify the interrupt priority of each IRQ wire by modifying the IRQ priority number in Platform Designer under the IRQ column. The modified priority is reflected in the `IRQ_MAP` parameter for the auto-inserted IRQ Mapper.
Figure 95. **IRQ Column in Platform Designer**

Circled in the **IRQ** column are the default interrupt priorities allocated for the CPU subsystem.

### Related Information

**IRQ Bridge** on page 393

#### 4.3.2.3. IRQ Clock Crosser

The IRQ Clock Crosser synchronizes interrupt senders and receivers that are in different clock domains. To use this component, connect the clocks for both the interrupt sender and receiver, and for both the interrupt sender and receiver interfaces. Platform Designer automatically inserts this component when it is required.

#### 4.4. Clock Interfaces

Clock interfaces define the clocks used by a component. Components can have clock inputs, clock outputs, or both. To update the clock frequency of the component, use the **Parameters** tab for the clock source.
The Clock Source parameters allows you to set the following options:

- **Clock frequency**—The frequency of the output clock from this clock source.
- **Clock frequency is known**—When turned on, the clock frequency is known. When turned off, the frequency is set from outside the system.

  *Note:* If turned off, system generation may fail because the components do not receive the necessary clock information. For best results, turn this option on before system generation.

- **Reset synchronous edges**
  - **None**—The reset is asserted and deasserted asynchronously. You can use this setting if you have internal synchronization circuitry that matches the reset required for the IP in the system.
  - **Both**—The reset is asserted and deasserted synchronously.
  - **Deassert**—The reset is deasserted synchronously and asserted asynchronously.

For more information about synchronous design practices, refer to *Recommended Design Practices*

**Related Information**

Recommended Design Practices

4.4.1. (High Speed Serial Interface) HSSI Clock Interfaces

You can use HSSI Serial Clock and HSSI Bonded Clock interfaces in Platform Designer to enable high speed serial connectivity between clocks that are used by certain IP protocols.

4.4.1.1. HSSI Serial Clock Interface

You can connect the HSSI Serial Clock interface with only similar type of interfaces, for example, you can connect a HSSI Serial Clock Source interface to a HSSI Serial Clock Sink interface.

4.4.1.1.1. HSSI Serial Clock Source

The HSSI Serial Clock interface includes a source in the **Start** direction.

You can instantiate the HSSI Serial Clock Source interface in the `_hw.tcl` file as:

```
add_interface <name> hssi_serial_clock start
```

You can connect the HSSI Serial Clock Source to multiple HSSI Serial Clock Sinks because the HSSI Serial Clock Source supports multiple fan-outs. This Interface has a single `clk` port role limited to a 1 bit width, and a `clockRate` parameter, which is the frequency of the clock driven by the HSSI Serial Clock Source interface.

An unconnected and unexported HSSI Serial Source is valid and does not generate error messages.
4.4.1.1.2. HSSI Serial Clock Sink

The HSSI Serial Clock interface includes a sink in the End direction.

You can instantiate the HSSI Serial Clock Sink interface in the _hw.tcl file as:

```
add_interface <name> hssi_serial_clock end
```

You can connect the HSSI Serial Clock Sink interface to a single HSSI Serial Clock Source interface; you cannot connect it to multiple sources. This Interface has a single clk port role limited to a 1 bit width, and a clockRate parameter, which is the frequency of the clock driven by the HSSI Serial Clock Source interface.

An unconnected and unexported HSSI Serial Sink is invalid and generates error messages.

4.4.1.1.3. HSSI Serial Clock Connection

The HSSI Serial Clock Connection defines a connection between a HSSI Serial Clock Source connection point, and a HSSI Serial Clock Sink connection point.

A valid HSSI Serial Clock Connection exists when all the following criteria are satisfied. If the following criteria are not satisfied, Platform Designer generates error messages and the connection is prohibited.

- The starting connection point is an HSSI Serial Clock Source with a single port role clk and maximum 1 bit in width. The direction of the starting port is Output.
- The ending connection point is an HSSI Serial Clock Sink with a single port role clk, and maximum 1 bit in width. The direction of the ending port is Input.
- If the parameter, clockRate of the HSSI Serial Clock Sink is greater than 0, the connection is only valid if the clockRate of the HSSI Serial Clock Source is the same as the clockRate of the HSSI Serial Clock Sink.
4.4.1.1.4. HSSI Serial Clock Example

Example 24. HSSI Serial Clock Interface Example

You can make connections to declare the HSSI Serial Clock interfaces in the `_hw.tcl`.

```tcl
package require -exact qsys 14.0
set_module_property name hssi_serial_component
set_module_property ELABORATION_CALLBACK elaborate
add_fileset QUARTUS_SYNTH QUARTUS_SYNTH generate
add_fileset SIM_VERILOG SIM_VERILOG generate
add_fileset SIM_VHDL SIM_VHDL generate
set_fileset_property QUARTUS_SYNTH TOP_LEVEL \ "hssi_serial_component"
set_fileset_property SIM_VERILOG TOP_LEVEL "hssi_serial_component"
set_fileset_property SIM_VHDL TOP_LEVEL "hssi_serial_component"
proc elaborate {} {
    # declaring HSSI Serial Clock Source
    add_interface my_clock_start hssi_serial_clock start
    set_interface_property my_clock_start ENABLED true
    add_interface_port my_clock_start hssi_serial_clock_port_out clk Output 1

    # declaring HSSI Serial Clock Sink
    add_interface my_clock_end hssi_serial_clock end
    set_interface_property my_clock_end ENABLED true
    add_interface_port my_clock_end hssi_serial_clock_port_in clk Input 1
}
proc generate { output_name } {
    add_fileset_file hssi_serial_component.v VERILOG PATH \ "hssi_serial_component.v"
}
```

Example 25. HSSI Serial Clock Instantiated in a Composed Component

If you use the components in a hierarchy, for example, instantiated in a composed component, you can declare the connections as illustrated in this example.

```tcl
add_instance myinst1 hssi_serial_component
add_instance myinst2 hssi_serial_component
# add connection from source of myinst1 to sink of myinst2
add_connection myinst1.my_clock_start myinst2.my_clock_end \ hssi_serial_clock
# adding connection from source of myinst2 to sink of myinst1
add_connection myinst2.my_clock_start myinst2.my_clock_end \ hssi_serial_clock
```

4.4.1.2. HSSI Bonded Clock Interface

You can connect the HSSI Bonded Clock interface only with similar type of interfaces, for example, you can connect a HSSI Bonded Clock Source interface to a HSSI Bonded Clock Sink interface.
4.4.1.2.1. HSSI Bonded Clock Source

The HSSI Bonded Clock interface includes a source in the Start direction.

You can instantiate the HSSI Bonded Clock Source interface in the _hw.tcl file as:

```
add_interface <name> hssi_bonded_clock start
```

You can connect the HSSI Bonded Clock Source to multiple HSSI Bonded Clock Sinks because the HSSI Serial Clock Source supports multiple fanouts. This Interface has a single clk port role limited to a width range of 1 to 1024 bits. The HSSI Bonded Clock Source interface has two parameters: clockRate and serializationFactor.

clockRate is the frequency of the clock driven by the HSSI Bonded Clock Source interface, and the serializationFactor is the parallel data width that operates the HSSI TX serializer. The serialization factor determines the required frequency and phases of the individual clocks within the HSSI Bonded Clock interface.

An unconnected and unexported HSSI Bonded Source is valid, and does not generate error messages.

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clk</td>
<td>Output</td>
<td>1 to 24 bits</td>
<td>A multiple bit wide port role which provides synchronization for internal logic.</td>
</tr>
</tbody>
</table>

Table 76. HSSI Bonded Clock Source Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default</th>
<th>Derived</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clockRate</td>
<td>long</td>
<td>0</td>
<td>No</td>
<td>The frequency of the clock driven byte HSSI Serial Clock Source interface.</td>
</tr>
<tr>
<td>serialization</td>
<td>long</td>
<td>0</td>
<td>No</td>
<td>The serialization factor is the parallel data width that operates the HSSI TX serializer. The serialization factor determines the necessary frequency and phases of the individual clocks within the HSSI Bonded Clock interface.</td>
</tr>
</tbody>
</table>

4.4.1.2.2. HSSI Bonded Clock Sink

The HSSI Bonded Clock interface includes a sink in the End direction.

You can instantiate the HSSI Bonded Clock Sink interface in the _hw.tcl file as:

```
add_interface <name> hssi_bonded_clock end
```

You can connect the HSSI Bonded Clock Sink interface to a single HSSI Bonded Clock Source interface; you cannot connect it to multiple sources. This Interface has a single clk port role limited to a width range of 1 to 1024 bits. The HSSI Bonded Clock Source interface has two parameters: clockRate and serializationFactor. clockRate is the frequency of the clock driven by the HSSI Bonded Clock Source interface, and the serialization factor is the parallel data width that operates the HSSI TX serializer. The serialization factor determines the required frequency and phases of the individual clocks within the HSSI Bonded Clock interface.

An unconnected and unexported HSSI Bonded Sink is invalid and generates error messages.
Table 77. **HSSI Bonded Clock Source Port Roles**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clk</td>
<td>Output</td>
<td>1 to 24 bits</td>
<td>A multiple bit wide port role which provides synchronization for internal logic.</td>
</tr>
</tbody>
</table>

Table 78. **HSSI Bonded Clock Source Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Default</th>
<th>Derived</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clockRate</td>
<td>long</td>
<td>0</td>
<td>No</td>
<td>The frequency of the clock driven byte HSSI Serial Clock Source interface.</td>
</tr>
<tr>
<td>serialization</td>
<td>long</td>
<td>0</td>
<td>No</td>
<td>The serialization factor is the parallel data width that operates the HSSI TX serializer. The serialization factor determines the necessary frequency and phases of the individual clocks within the HSSI Bonded Clock interface.</td>
</tr>
</tbody>
</table>

4.4.1.2.3. **HSSI Bonded Clock Connection**

The HSSI Bonded Clock Connection defines a connection between a HSSI Bonded Clock Source connection point, and a HSSI Bonded Clock Sink connection point.

A valid HSSI Bonded Clock Connection exists when all the following criteria are satisfied. If the following criteria are not satisfied, Platform Designer generates error messages and the connection is prohibited.

- The starting connection point is an HSSI Bonded Clock Source with a single port role **clk** with a width range of 1 to 24 bits. The direction of the starting port is **Output**.
- The ending connection point is an HSSI Bonded Clock Sink with a single port role **clk** with a width range of 1 to 24 bits. The direction of the ending port is **Input**.
- The width of the starting connection point **clk** must be the same as the width of the ending connection point.
- If the parameter, **clockRate** of the HSSI Bonded Clock Sink greater than 0, then the connection is only valid if the **clockRate** of the HSSI Bonded Clock Source is same as the **clockRate** of the HSSI Bonded Clock Sink.
- If the parameter, **serializationFactor** of the HSSI Bonded Clock Sink greater than 0, Platform Designer generates a warning if the **serializationFactor** of HSSI Bonded Clock Source is not same as the **serializationFactor** of the HSSI Bonded Clock Sink.

4.4.1.2.4. **HSSI Bonded Clock Example**

**Example 26. HSSI Bonded Clock Interface Example**

You can make connections to declare the HSSI Bonded Clock interfaces in the `_hw.tcl` file.

```tcl
package require -exact qsys 14.0
set_module_property name hssi_bonded_component
set_module_property ELABORATION_CALLBACK elaborate
add_fileset synthesis QUARTUS_SYNTH generate
add_fileset verilog_simulation SIM_VERILOG generate
set_fileset_property synthesis TOP_LEVEL "hssi_bonded_component"
set_fileset_property verilog_simulation TOP_LEVEL "hssi_bonded_component"
```
"hssi_bonded_component"

```plaintext
proc elaborate {} {
    add_interface my_clock_start hssi_bonded_clock start
    set_interface_property my_clock_start  ENABLED true

    add Interface_port my_clock_start hssi_bonded_clock_port_out \  
    clk Output 1024

    add_interface my_clock_end hssi_bonded_clock end
    set_interface_property my_clock_end  ENABLED true

    add_interface_port my_clock_end hssi_bonded_clock_port_in \  
    clk Input 1024
}

proc generate { output_name } {
    add_fileset_file hssi_bonded_component.v VERILOG PATH \
    "hssi_bonded_component.v"
}
```

If you use the components in a hierarchy, for example, instantiated in a composed component, you can declare the connections as illustrated in this example.

**Example 27. HSII Bonded Clock Instantiated in a Composed Component**

```plaintext
add_instance myinst1 hssi_bonded_component
add_instance myinst2 hssi_bonded_component
# add connection from source of myinst1 to sink of myinst2
add_connection myinst1.my_clock_start myinst2.my_clock_end \  
   hssi_bonded_clock
# adding connection from source of myinst2 to sink of myinst1
add_connection myinst2.my_clock_start myinst2.my_clock_end \  
   hssi_bonded_clock
```

### 4.5. Reset Interfaces

Reset interfaces provide both soft and hard reset functionality. Soft reset logic typically re-initializes registers and memories without powering down the device. Hard reset logic initializes the device after power-on. You can define separate reset sources for each clock domain, a single reset source for all clocks, or any combination in between.

You can choose to create a single global reset domain by selecting **Create Global Reset Network** on the System menu. If your design requires more than one reset domain, you can implement your own reset logic and connectivity. The IP Catalog includes a reset controller, reset sequencer, and a reset bridge to implement the reset functionality. You can also design your own reset logic.

**Note:** If you design your own reset circuitry, you must carefully consider situations which may result in system lockup. For example, if an Avalon-MM slave is reset in the middle of a transaction, the Avalon-MM master may lockup.

#### 4.5.1. Single Global Reset Signal Implemented by Platform Designer

When you select **System ➤ Create Global Reset Network**, the Platform Designer interconnect creates a global reset bus. All the reset requests are ORed together, synchronized to each clock domain, and fed to the reset inputs. The duration of the reset signal is at least one clock period.
The Platform Designer interconnect inserts the system-wide reset under the following conditions:

- The global reset input to the Platform Designer system is asserted.
- Any component asserts its \texttt{reset request} signal.

### 4.5.2. Reset Controller

Platform Designer automatically inserts a reset controller block if the input reset source does not have a reset request, but the connected reset sink requires a reset request.

The Reset Controller has the following parameters that you can specify to customize its behavior:

- **Number of inputs** — Indicates the number of individual reset interfaces the controller ORs to create a signal reset output.

- **Output reset synchronous edges** — Specifies the level of synchronization. You can select one of the following options:
  - **None** — The reset is asserted and deasserted asynchronously. You can use this setting if you have designed internal synchronization circuitry that matches the reset style required for the IP in the system.
  - **Both** — The reset is asserted and deasserted synchronously.
  - **Deassert** — The reset is deasserted synchronously and asserted asynchronously.

- **Synchronization depth** — Specifies the number of register stages the synchronizer uses to eliminate the propagation of metastable events.

- **Reset request** — Enables reset request generation, which is an early signal that is asserted before reset assertion. The reset request is used by blocks that require protection from asynchronous inputs, for example, M20K blocks.

Platform Designer automatically inserts reset synchronizers under the following conditions:

- More than one reset source is connected to a reset sink
- There is a mismatch between the reset source’s synchronous edges and the reset sinks’ synchronous edges

### 4.5.3. Reset Bridge

The Reset Bridge allows you to use a reset signal in two or more subsystems of your Platform Designer system. You can connect one reset source to local components, and export one or more to other subsystems, as required.
The Reset Bridge parameters are used to describe the incoming reset and include the following options:

- **Active low reset**—When turned on, reset is asserted low.
- **Synchronous edges**—Specifies the level of synchronization and includes the following options:
  - **None**—The reset is asserted and deasserted asynchronously. Use this setting if you have internal synchronization circuitry.
  - **Both**—The reset is asserted and deasserted synchronously.
  - **Deassert**—The reset is deasserted synchronously, and asserted asynchronously.
- **Number of reset outputs**—The number of reset interfaces that are exported.

*Note:* Platform Designer supports multiple reset sink connections to a single reset source interface. However, there are situations in composed systems where an internally generated reset must be exported from the composed system in addition to being used to connect internal components. In this situation, you must declare one reset output interface as an export, and use another reset output to connect internal components.

### 4.5.4. Reset Sequencer

The Reset Sequencer allows you to control the assertion and deassertion sequence for Platform Designer system resets.

The Parameter Editor displays the expected assertion and deassertion sequences based on the current settings. You can connect multiple reset sources to the reset sequencer, and then connect the outputs of the Reset Sequencer to components in the system.
**Figure 96. Elements and Flow of a Reset Sequencer**

- **Reset Controller**—Reused reset controller block. It synchronizes the reset inputs into one and feeds into the main FSM of the sequencer block.
- **Sync**—Synchronization block (double flipflop).
- **Deglitch**—Deglitch block. This block waits for a signal to be at a level for X clocks before propagating the input to the output.
- **CSR**—This block contains the CSR Avalon interface and related CSR register and control block in the sequencer.
- **Main FSM**—Main sequencer. This block determines when assertion/deassertion and assertion hold timing occurs.
- **[A/D]SRT SEQ**—Generic sequencer block that sequences out assertion/deassertion of reset from 0:N. The block has multiple counters that saturate upon reaching count.
- **RESET_OUT**—Controls the end output via:
  - Set/clear from the ASRT_SEQ/DSRT_SEQ.
  - Masking/forcing from CSR controls.
  - Remap of numbering (parameterization).

### 4.5.4.1. Reset Sequencer Parameters

#### Table 79. Reset Sequencer Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of reset outputs</td>
<td>Sets the number of output resets to be sequenced, which is the number of output reset signals defined in the component with a range of 2 to 10.</td>
</tr>
<tr>
<td>Number of reset inputs</td>
<td>Sets the number of input reset signals to be sequenced, which is the number of input reset signals defined in the component with a range of 1 to 10.</td>
</tr>
<tr>
<td>Minimum reset assertion time</td>
<td>Specifies the minimum assertion cycles between the assertion of the last sequenced reset, and the deassertion of the first sequenced reset. The range is 0 to 1023.</td>
</tr>
<tr>
<td>Enable Reset Sequencer CSR</td>
<td>Enables CSR functionality of the Reset Sequencer through an Avalon interface.</td>
</tr>
<tr>
<td>reset_out#</td>
<td>Lists the reset output signals. Set the parameters in the other columns for each reset signal in the table.</td>
</tr>
<tr>
<td>ASRT Seq#</td>
<td>Determines the order of reset assertion. Enter the values 1, 2, 3, etc. to specify the required non-overlapping assertion order. This value determines the ASRT_REMAP value in the component HDL.</td>
</tr>
<tr>
<td>ASRT Cycle#</td>
<td>Number of cycles to wait before assertion of the reset. The value set here corresponds to the ASRT_DELAY value in the component HDL. The range is 0 to 1023.</td>
</tr>
</tbody>
</table>

*continued*
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSRT Seq#</td>
<td>Determines the reset order of reset deassertion. Enter the values 1, 2, 3, etc. to specify the required non-overlapping deassertion order. This value determines the DSRT_REMAP value in the component HDL.</td>
</tr>
<tr>
<td>DSRT Cycle#/Deglitch#</td>
<td>Number of cycles to wait before deasserting or deglitching the reset. If the USE_DSRT_QUAL parameter is set to 0, specifies the number of cycles to wait before deasserting the reset. If USE_DSRT_QUAL is set to 1, specifies the number of cycles to deglitch the input reset_dsrt_qual signal. This value determines either the DSRT_DELAY, or the DSRT_QUALCNT value in the component HDL, depending on the USE_DSRT_QUAL parameter setting. The range is 0 to 1023.</td>
</tr>
<tr>
<td>USE_DSRT_QUAL</td>
<td>If you set USE_DSRT_QUAL to 1, the deassertion sequence waits for an external input signal for sequence qualification instead of waiting for a fixed delay count. To use a fixed delay count for deassertion, set this parameter to 0.</td>
</tr>
</tbody>
</table>

#### 4.5.4.2. Reset Sequencer Timing Diagrams

**Figure 97. Basic Sequencing**

![Basic Sequencing Diagram](image)

**Figure 98. Sequencing with USE_DSRT_QUAL Set**

![Sequencing with USE_DSRT_QUAL Set Diagram](image)
4.5.4.3. Reset Sequencer CSR Registers

The Reset Sequencer's CSR registers provide the following functionality:

- **Support reset logging**
  - Ability to identify which reset is asserted.
  - Ability to determine whether any reset is currently active.

- **Support software triggered resets**
  - Ability to generate reset by writing to the register.
  - Ability to disable assertion or deassertion sequence.

- **Support software sequenced reset**
  - Ability for the software to fully control the assertion/deassertion sequence by writing to registers and stepping through the sequence.

- **Support reset override**
  - Ability to assert a specific component reset through software.

### Table 80. Reset Sequencer CSR Register Map

<table>
<thead>
<tr>
<th>Register</th>
<th>Offset</th>
<th>Width</th>
<th>Reset Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Register</td>
<td>0x00</td>
<td>32</td>
<td>0x0</td>
<td>The Status register indicates which sources are allowed to cause a reset.</td>
</tr>
<tr>
<td>Interrupt Enable Register</td>
<td>0x04</td>
<td>32</td>
<td>0x0</td>
<td>The Interrupt Enable register bits enable events triggering the IRQ of the reset sequencer.</td>
</tr>
<tr>
<td>Control Register</td>
<td>0x08</td>
<td>32</td>
<td>0x0</td>
<td>The Control register allows you to control the Reset Sequencer.</td>
</tr>
<tr>
<td>Software Sequenced Reset Assert Control Register</td>
<td>0x0C</td>
<td>32</td>
<td>0x3FF</td>
<td>You can program the Software Sequenced Reset Assert control register to control the reset assertion sequence.</td>
</tr>
<tr>
<td>Software Sequenced Reset Deassert Control Register</td>
<td>0x10</td>
<td>32</td>
<td>0x3FF</td>
<td>You can program the Software Sequenced Reset Deassert control register to control the reset deassertion sequence.</td>
</tr>
<tr>
<td>Software Direct Controlled Resets</td>
<td>0x14</td>
<td>32</td>
<td>0x0</td>
<td>You can write a bit to 1 to assert the reset_outN signal, and to 0 to deassert the reset_outN signal.</td>
</tr>
<tr>
<td>Software Reset Masking</td>
<td>0x18</td>
<td>32</td>
<td>0x0</td>
<td>Masking off (writing 1) to a reset_outN &quot;Reset Mask Enable&quot; signal prevents the corresponding reset from being asserted. Writing a bit to 0 to a reset mask enable signal allows assertion of reset_outN.</td>
</tr>
</tbody>
</table>

#### 4.5.4.3.1. Reset Sequencer Status Register

The Status register indicates which sources are allowed to cause a reset.

You can clear bits by writing 1 to the bit location. The Reset Sequencer ignores attempts to write bits with a value of 0. If the sequencer is reset (power-on-reset), all bits are cleared, except the power-on-reset bit.
### Table 81. Values for the Status Register at Offset 0x00

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>RO</td>
<td>0</td>
<td>Reset Active—Indicates that the sequencer is currently active in reset sequence (assertion or deassertion).</td>
</tr>
<tr>
<td>30</td>
<td>RW1C</td>
<td>0</td>
<td>Reset Asserted and waiting for SW to proceed—Set when there is an active reset assertion, and the next sequence is waiting for the software to proceed. Only valid when the Enable SW sequenced reset assert option is turned on.</td>
</tr>
<tr>
<td>29</td>
<td>RW1C</td>
<td>0</td>
<td>Reset Deasserted and waiting for SW to proceed—Set when there is an active reset deassertion, and the next sequence is waiting for the software to proceed. Only valid when the Enable SW sequenced reset deassert option is turned on.</td>
</tr>
<tr>
<td>28:26</td>
<td></td>
<td>Reserved.</td>
<td></td>
</tr>
<tr>
<td>25:16</td>
<td>RW1C</td>
<td>0</td>
<td>Reset deassertion input qualification signal reset_dsrt_qual [9:0] status—Indicates that the reset deassertion’s input signal qualification signal is set. This bit is set on the detection of assertion of the signal.</td>
</tr>
<tr>
<td>15:12</td>
<td>Reserved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in9 was triggered—Indicates that reset_in9 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>10</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in8 was triggered—Indicates that reset_in8 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>9</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in7 was triggered—Indicates that reset_in7 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>8</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in6 was triggered—Indicates that reset_in6 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>7</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in5 was triggered—Indicates that reset_in5 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>6</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in4 was triggered—Indicates that reset_in4 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>5</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in3 was triggered—Indicates that reset_in3 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>4</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in2 was triggered—Indicates that reset_in2 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>3</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in1 was triggered—Indicates that reset_in1 triggered the reset. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>2</td>
<td>RW1C</td>
<td>0</td>
<td>reset_in0 was triggered—Indicates that reset_in0 triggered. Software clears this bit by writing 1 to this location.</td>
</tr>
<tr>
<td>1</td>
<td>RW1C</td>
<td>0</td>
<td>Software-triggered reset—Indicates that the software-triggered reset is set by the software, and triggering a reset.</td>
</tr>
<tr>
<td>0</td>
<td>RW1C</td>
<td>0</td>
<td>Power-on-reset was triggered—Asserted whenever the reset to the sequencer is triggered. This bit is NOT reset when sequencer is reset. Software clears this bit by writing 1 to this location.</td>
</tr>
</tbody>
</table>

**Related Information**

*Reset Sequencer CSR Registers* on page 406
4.5.4.3.2. Reset Sequencer Interrupt Enable Register

The Interrupt Enable register bits enable events triggering the IRQ of the reset sequencer.

Table 82. Values for the Interrupt Enable Register at Offset 0x04

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td></td>
<td>Reserved.</td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on Reset Asserted and waiting for SW to proceed enable. When set, the IRQ is set when the sequencer is waiting for the software to proceed in an assertion sequence.</td>
</tr>
<tr>
<td>29</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on Reset Deasserted and waiting for SW to proceed enable. When set, the IRQ is set when the sequencer is waiting for the software to proceed in a deassertion sequence.</td>
</tr>
<tr>
<td>28:26</td>
<td>Reserved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25:16</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on Reset deassertion input qualification signal reset_dsrt_qual[9:0] status—When set, the IRQ is set when the reset_dsrt_qual[9:0] status bit (per bit enable) is set.</td>
</tr>
<tr>
<td>15:12</td>
<td>Reserved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in9 Enable—When set, the IRQ is set when the reset_in9 trigger status bit is set.</td>
</tr>
<tr>
<td>10</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in8 Enable—When set, the IRQ is set when the reset_in8 trigger status bit is set.</td>
</tr>
<tr>
<td>9</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in7 Enable—When set, the IRQ is set when the reset_in7 trigger status bit is set.</td>
</tr>
<tr>
<td>8</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in6 Enable—When set, the IRQ is set when the reset_in6 trigger status bit is set.</td>
</tr>
<tr>
<td>7</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in5 Enable—When set, the IRQ is set when the reset_in5 trigger status bit is set.</td>
</tr>
<tr>
<td>6</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in4 Enable—When set, the IRQ is set when the reset_in4 trigger status bit is set.</td>
</tr>
<tr>
<td>5</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in3 Enable—When set, the IRQ is set when the reset_in3 trigger status bit is set.</td>
</tr>
<tr>
<td>4</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in2 Enable—When set, the IRQ is set when the reset_in2 trigger status bit is set.</td>
</tr>
<tr>
<td>3</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in1 Enable—When set, the IRQ is set when the reset_in1 trigger status bit is set.</td>
</tr>
<tr>
<td>2</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on reset_in0 Enable—When set, the IRQ is set when the reset_in0 trigger status bit is set.</td>
</tr>
<tr>
<td>1</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on Software triggered reset Enable—When set, the IRQ is set when the software triggered reset status bit is set.</td>
</tr>
<tr>
<td>0</td>
<td>RW</td>
<td>0</td>
<td>Interrupt on Power-On-Reset Enable—When set, the IRQ is set when the power-on-reset status bit is set.</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406
4.5.4.3.3. Reset Sequencer Control Register

The Control register allows you to control the Reset Sequencer.

Table 83. Values for the Control Register at Offset 0x08

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:3</td>
<td>Reserved</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RW</td>
<td>0</td>
<td>Enable SW sequenced reset assert—Enable a software sequenced reset assert sequence. Timer delays and input qualification are ignored, and only the software can sequence the assert.</td>
</tr>
<tr>
<td>1</td>
<td>RW</td>
<td>0</td>
<td>Enable SW sequenced reset deassert—Enable a software sequenced reset deassert sequence. Timer delays and input qualification are ignored, and only the software can sequence the deassert.</td>
</tr>
<tr>
<td>0</td>
<td>WO</td>
<td>0</td>
<td>Initiate Reset Sequence—To trigger the hardware sequenced warm reset, the Reset Sequencer writes this bit to 1 a single time. The Reset Sequencer verifies that Reset Active is 0 before setting this bit, and always reads the value 0. To monitor this sequence, verify that Reset Active is asserted, and then subsequently deasserted.</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406

4.5.4.3.4. Reset Sequencer Software Sequenced Reset Assert Control Register

You can program the Software Sequenced Reset Assert control register to control the reset assertion sequence.

When the corresponding enable bit is set, the sequencer stops when the desired reset asserts, and then sets the Reset Asserted and waiting for SW to proceed bit. The Reset Sequencer proceeds only after the Reset Asserted and waiting for SW to proceed bit is cleared.

Table 84. Values for the Reset Sequencer Software Sequenced Reset Assert Control Register at Offset 0x0C

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:10</td>
<td>Reserved</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>9:0</td>
<td>RW</td>
<td>0x3FF</td>
<td>Per-reset SW sequenced reset assert enable—This is a per-bit enable for SW sequenced reset assert. If the register’s bitN is set, the sequencer sets the bit30 of the status register when a resetN is asserted. It then waits for the bit30 of the status register to clear before proceeding with the sequence. By default, all bits are enabled (fully SW sequenced).</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406

4.5.4.3.5. Reset Sequencer Software Sequenced Reset Deassert Control Register

You can program the Software Sequenced Reset Deassert register to control the reset deassertion sequence.
When the corresponding enable bit is set, the sequencer stops when the desired reset asserts, and then sets the Reset Deasserted and waiting for SW to proceed bit. The Reset Sequencer proceeds only after the Reset Deasserted and waiting for SW to proceed bit is cleared.

Table 85. Values for the Reset Sequencer Software Sequenced Reset Deassert Control Register at Offset 0x10

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:10</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:0</td>
<td>RW</td>
<td>0x3FF</td>
<td>Per-reset SW sequenced reset deassert enable—This is a per-bit enable for SW-sequenced reset deassert. If bitN of this register is set, the sequencer sets bit29 of the Status Register when a resetN is asserted. It then waits for the bit29 of the status register to clear before proceeding with the sequence. By default, all bits are enabled (fully SW sequenced).</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406

4.5.4.3.6. Reset Sequencer Software Direct Controlled Resets

You can write a bit to 1 to assert the reset_outN signal, and to 0 to deassert the reset_outN signal.

Table 86. Values for the Software Direct Controlled Resets at Offset 0x14

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:26</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25:16</td>
<td>WO</td>
<td>0</td>
<td>Reset Overwrite Trigger Enable—This is a per-bit control trigger bit for the overwrite value to take effect.</td>
</tr>
<tr>
<td>15:10</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:0</td>
<td>WO</td>
<td>0</td>
<td>reset_outN Reset Overwrite Value—This is a per-bit control of the reset_out bit. The Reset Sequencer can use this to forcefully drive the reset to a specific value. A value of 1 sets the reset_out. A value of 0 clears the reset_out. A write to this register only takes effect if the corresponding trigger bit in this register is set.</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406

4.5.4.3.7. Reset Sequencer Software Reset Masking

Masking off (writing 1) to a reset_outN "Reset Mask Enable" signal prevents the corresponding reset from being asserted. Writing a bit to 0 to a reset mask enable signal allows assertion of reset_outN.
Table 87. Values for the Reset Sequencer Software Reset Masking at Offset 0x18

<table>
<thead>
<tr>
<th>Bit</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>31:10</td>
<td>Reserved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9:0</td>
<td>RW</td>
<td>0</td>
<td>reset_outN &quot;Reset Mask Enable&quot;—This is a per-bit control to mask off the reset_outN bit. Software Reset Masking prevents the reset bit from being asserted during a reset assertion sequence. If reset_out is already asserted, it does not deassert the reset.</td>
</tr>
</tbody>
</table>

Related Information
Reset Sequencer CSR Registers on page 406
4.5.4.4. Reset Sequencer Software Flows

4.5.4.4.1. Reset Sequencer (Software-Triggered) Flow

**Figure 99. Reset Sequencer (Software-Triggered) Flow Diagram**

1. **Start**
   - SW reads Status Register’s reset active
   - Software clears all pending statuses by writing all 1s to the Status Register.
   - Software initiates reset by writing a 1 to the Control Register’s initiate reset sequence bit.
   - IRQ Asserted?
     - Yes: SW reads Status Register’s reset active
       - SW reads Status Register’s SW-triggered reset
     - No: keep polling
   - SW reads Status Register’s reset active
     - 1: keep polling
     - 0: keep polling
   - Reset Sequencer completed initiating a reset through the sequencer.
   - Software writes 1 to Status Register’s SW-Triggered reset to clear it

**Related Information**
- Reset Sequencer Status Register on page 406
- Reset Sequencer Control Register on page 409
4.5.4.4.2. Reset Assert Flow

The following flow sequence occurs for a Reset Assert Flow:

- A reset is triggered either by the software, or when input resets to the Reset Sequencer are asserted.
- The IRQ is asserted, if the IRQ is enabled.
- Software reads the Status register to determine which reset was triggered.

4.5.4.4.3. Reset Deassert Flow

The following flow sequence occurs for a Reset Deassert Flow:

- When a reset source is deasserted, or when the reset assert sequence has completed without pending resets asserted, the deassertion flow is initiated.
- The IRQ is asserted, if the IRQ is enabled.
- Software reads the Status Register to determine which reset was triggered.

4.5.4.4.4. Reset Assert (Software Sequenced) Flow

Figure 100. Reset Assert (Software Sequenced) Flow

- Related Information
  - Reset Sequencer Control Register on page 409
  - Reset Sequencer Software Sequenced Reset Assert Control Register on page 409
  - Reset Sequencer Interrupt Enable Register on page 408
  - Reset Sequencer Status Register on page 406
4.5.4.4.5. Reset Deassert (Software Sequenced) Flow

The sequence and flow is similar to the Reset Assert (SW Sequenced) flow, though, this flow uses the reset deassert registers/bits instead of the reset assert registers/bits.

Related Information
Reset Assert (Software Sequenced) Flow on page 413

4.6. Conduits

You can use the conduit interface type for interfaces that do not fit any of the other interface types, and to group any arbitrary collection of signals. Like other interface types, you can export or connect conduit interfaces.

The PCI Express-to-Ethernet example in Creating a System with Platform Designer is an example of using a conduit interface for export. You can declare an associated clock interface for conduit interfaces in the same way as memory-mapped interfaces with the associatedClock.

To connect two conduit interfaces inside Platform Designer, the following conditions must be met:

- The interfaces must match exactly with the same signal roles and widths.
- The interfaces must be the opposite directions.
- Clocked conduit connections must have matching associatedClocks on each of their endpoint interfaces.

Note: To connect a conduit output to more than one input conduit interface, you can create a custom component. The custom component could have one input that connects to two outputs, and you can use this component between other conduits that you want to connect. For information about the Avalon Conduit interface, refer to the Avalon Interface Specifications

Related Information
- Creating a System with Platform Designer on page 9
- Avalon Interface Specifications

4.7. Interconnect Pipelining

Platform Designer can automatically insert Avalon-ST pipeline stages when you generate your design. To do so, set the Limit interconnect pipeline stages to parameter to a value greater than 0 in the Project Settings tab. The pipeline stages increase the fMAX of your design by reducing the combinational logic depth. The cost is additional latency and logic.

The insertion of pipeline stages depends upon the existence of certain interconnect components. For example, in a single-slave system, no multiplexer exists; therefore, multiplexer pipelining does not occur. In an extreme case, of a single-master to single-slave system, no pipelining occurs, regardless of the value of the Limit interconnect pipeline stages to option.
Figure 101. Pipeline Placement in Arbitration Logic

The example below shows the possible placement of up to four potential pipeline stages, which could be, before the input to the demultiplexer, at the output of the multiplexer, between the arbiter and the multiplexer, and at the outputs of the demultiplexer.

Related Information

- Explore and Manage Platform Designer Interconnect on page 83
- Inserting Pipeline Stages to Increase System Frequency on page 454
4.7.1. Manually Control Pipelining in the Platform Designer Interconnect

The Memory-Mapped Interconnect tab allows you to manipulate pipeline connections in the Platform Designer interconnect. Access the Memory-Mapped Interconnect tab by clicking System ➤ Show System With Platform Designer Interconnect.

Note:
To increase interconnect frequency, you should first try increasing the value of the Limit interconnect pipeline stages to option on the Interconnect Requirements tab. You should only consider manually pipelining the interconnect if changes to this option do not improve frequency, and you have tried all other options to achieve timing closure, including the use of a bridge. Manually pipelining the interconnect should only be applied to complete systems.

1. In the Interconnect Requirements tab, first try increasing the value of the Limit interconnect pipeline stages to option until it no longer gives significant improvements in frequency, or until it causes unacceptable effects on other parts of the system.
2. In the Intel Quartus Prime software, compile your design and run timing analysis.
3. Using the timing report, identify the critical path through the interconnect and determine the approximate mid-point. The following is an example of a timing report:

```
2.800 0.000 cpu_instruction_master|out_shifter[63]|q
3.004 0.204 mm_domain_0|addr_router_001|Equal5~0|datac
3.246 0.242 mm_domain_0|addr_router_001|Equal5~0|combout
3.346 0.100 mm_domain_0|addr_router_001|Equal5~1|dataa
3.685 0.339 mm_domain_0|addr_router_001|Equal5~1|combout
4.153 0.468 mm_domain_0|addr_router_001|src_channel[5]~0|datad
4.373 0.220 mm_domain_0|addr_router_001|src_channel[5]~0|combout
```
5. In the Memory-Mapped Interconnect tab, select the interconnect module that contains the critical path. You can determine the name of the module from the hierarchical node names in the timing report.
6. Click Show Pipelinable Locations. Platform Designer display all possible pipeline locations in the interconnect. Right-click the possible pipeline location to insert or remove a pipeline stage.
7. Locate the possible pipeline location that is closest to the mid-point of the critical path. The names of the blocks in the memory-mapped interconnect tab correspond to the module instance names in the timing report.
8. Right-click the location where you want to insert a pipeline, and then click Insert Pipeline.
9. Regenerate the Platform Designer system, recompile the design, and then rerun timing analysis. If necessary, repeat the manual pipelining process again until timing requirements are met.

Manual pipelining has the following limitations:
• If you make changes to your original system's connectivity after manually pipelining an interconnect, your inserted pipelines may become invalid. Platform Designer displays warning messages when you generate your system if invalid pipeline stages are detected. You can remove invalid pipeline stages with the Remove Stale Pipelines option in the Memory-Mapped Interconnect tab. Intel recommends that you do not make changes to the system's connectivity after manual pipeline insertion.

• Review manually-inserted pipelines when upgrading to newer versions of Platform Designer. Manually-inserted pipelines in one version of Platform Designer may not be valid in a future version.

Related Information
Specify Platform Designer Interconnect Requirements on page 62

4.8. Error Correction Coding (ECC) in Platform Designer Interconnect

Error Correction Coding (ECC) logic allows the Platform Designer interconnect to detect and correct errors. Enabling ECC improves data integrity in memory blocks. Platform Designer supports ECC protection for Read Data FIFO (rdata_FIFO) instances only.

As transistors become smaller, computer hardware is more susceptible to data corruption. Data corruption causes Single Event Upsets (SEUs), and increases the probability of Failures in Time (FIT) rates in computer systems. SEU events without error notification can cause the system to be stuck in an unknown response status, and increase the FIT rate.

Before writing data to the memory device, the ECC logic encodes the data bus with a Hamming code. Then, the ECC logic decodes and performs error checking on the data output.

When you enable ECC, Platform Designer interconnect sends uncorrectable errors arising from memory as DECODEERROR (DECERR) on the Avalon response bus.

Figure 102. High-Level Implementation of RDATA FIFO with ECC Enabled

Enabling ECC logic may increase logic utilization and cause lower $f_{\text{MAX}}$.

Related Information
• Specify Platform Designer Interconnect Requirements on page 62
• Read and Write Responses on page 380
4.9. AMBA 3 AXI Protocol Specification Support (version 1.0)

Platform Designer allows memory-mapped connections between AMBA 3 AXI components, AMBA 3 AXI and AMBA 4 AXI components, and AMBA 3 AXI and Avalon interfaces with unique or exceptional support. Refer to the AMBA 3 Protocol Specifications on the ARM website for more information.

**Related Information**
- AMBA 3 Protocol Specifications
- Slave Network Interfaces on page 367

4.9.1. Channels

Platform Designer has the following support and restrictions for AMBA 3 AXI channels.

4.9.1.1. Read and Write Address Channels

Most signals are allowed. However, the following limitations are present in Platform Designer 14.0:
- Supports 64-bit addressing.
- ID width limited to 18-bits.
- HPS-FPGA master interface has a 12-bit ID.

4.9.1.2. Write Data, Write Response, and Read Data Channels

Most signals are allowed. However, the following limitations are present in Platform Designer 14.0:
- Data widths limited to a maximum of 1024-bits
- Limited to a fixed byte width of 8-bits

4.9.1.3. Low Power Channel

Low power extensions are not supported in Platform Designer, version 14.0.

4.9.2. Cache Support

AWCACHE and ARCACHE are passed to an AXI slave unmodified.

4.9.2.1. Bufferable

Platform Designer interconnect treats AXI transactions as non-bufferable. All responses must come from the terminal slave.
When connecting to Avalon-MM slaves, since they do not have write responses, the following exceptions apply:

- For Avalon-MM slaves, the write response are generated by the slave agent once the write transaction is accepted by the slave. The following limitation exists for an Avalon bridge:
- For an Avalon bridge, the response is generated before the write reaches the endpoint; users must be aware of this limitation and avoid multiple paths past the bridge to any endpoint slave, or only perform bufferable transactions to an Avalon bridge.

### 4.9.2.2. Cacheable (Modifiable)

Platform Designer interconnect acknowledges the cacheable (modifiable) attribute of AXI transactions.

It does not change the address, burst length, or burst size of non-modifiable transactions, with the following exceptions:

- Platform Designer considers a wide transaction to a narrow slave as modifiable because the size requires reduction.
- Platform Designer may consider AXI read and write transactions as modifiable when the destination is an Avalon slave. The AXI transaction may be split into multiple Avalon transactions if the slave is unable to accept the transaction. This may occur because of burst lengths, narrow sizes, or burst types.

Platform Designer ignores all other bits, for example, read allocate or write allocate because the interconnect does not perform caching. By default, Platform Designer considers Avalon master transactions as non-bufferable and non-cacheable, with the allocate bits tied low.

### 4.9.3. Security Support

TrustZone refers to the security extension of the ARM architecture, which includes the concept of "secure" and "non-secure" transactions, and a protocol for processing between the designations.

The interconnect passes the **AWPROT** and **ARPROT** signals to the endpoint slave without modification. It does not use or modify the **PROT** bits.

Refer to Manage System Security in Creating a System with Platform Designer for more information about secure systems and the TrustZone feature.

**Related Information**

Manage Platform Designer System Security on page 64

### 4.9.4. Atomic Accesses

Exclusive accesses are supported for AXI slaves by passing the lock, transaction ID, and response signals from master to slave, with the limitation that slaves that do not reorder responses. Avalon slaves do not support exclusive accesses, and always return **OKAY** as a response. Locked accesses are also not supported.
4.9.5. Response Signaling

Full response signaling is supported. Avalon slaves always return **OKAY** as a response.

4.9.6. Ordering Model

Platform Designer interconnect provides responses in the same order as the commands are issued.

To prevent reordering, for slaves that accept reordering depths greater than 0, Platform Designer does not transfer the transaction ID from the master, but provides a constant transaction ID of 0. For slaves that do not reorder, Platform Designer allows the transaction ID to be transferred to the slave. To avoid cyclic dependencies, Platform Designer supports a single outstanding slave scheme for both reads and writes. Changing the targeted slave before all responses have returned stalls the master, regardless of transaction ID.

4.9.6.1. AXI and Avalon Ordering

There is a potential read-after-write risk when Avalon masters transact to AXI slaves.

According to the **AMBA Protocol Specifications**, there is no ordering requirement between reads and writes. However, Avalon has an implicit ordering model that requires transactions from a master to the same slave to be in order.

In response to this potential risk, Avalon interfaces provide a compile-time option to enforce strict order. When turned on, the Avalon interface waits for outstanding write responses before issuing reads.

4.9.7. Data Buses

Narrow bus transfers are supported. AXI write strobes can have any pattern that is compatible with the address and size information. Intel recommends that transactions to Avalon slaves follow Avalon **byteenable** limitations for maximum compatibility.

*Note:* Byte 0 is always bits [7:0] in the interconnect, following AXI’s and Avalon’s byte (address) invariance scheme.

4.9.8. Unaligned Address Commands

Unaligned address commands are commands with addresses that do not conform to the data width of a slave. Since Avalon-MM slaves accept only aligned addresses, Platform Designer modifies unaligned commands from AXI masters to the correct data width. Platform Designer must preserve commands issued by AXI masters when passing the commands to AXI slaves.

*Note:* Unaligned transfers are aligned if downsizing occurs. For example, when downsizing to a bus width narrower than that required by the transaction size, **AWSIZE** or **ARSIZE**, the transaction must be modified.

4.9.9. Avalon and AXI Transaction Support

Platform Designer 14.0 supports transactions between Avalon and interfaces, with some limitations.
4.9.9.1. Transaction Cannot Cross 4KB Boundaries

When an Avalon master issues a transaction to an AXI slave, the transaction cannot
cross 4KB boundaries. Non-bursting Avalon masters already follow this boundary
restriction.

4.9.9.2. Handling Read Side Effects

Read side effects can occur when more bytes than necessary are read from the slave,
and the unwanted data that are read are later inaccessible on subsequent reads. For
write commands, the correct byteenable paths are asserted based on the size of the
transactions. For read commands, narrow-sized bursts are broken up into multiple
non-bursting commands, and each command with the correct byteenable paths
asserted.

Platform Designer always assumes that the byteenable is asserted based on the size
of the command, not the address of the command. The following scenarios are
examples:

- For a 32-bit AXI master that issues a read command with an unaligned address
  starting at address 0x01, and a burstcount of 2 to a 32-bit Avalon slave, the
  starting address is: 0x00.
- For a 32-bit AXI master that issues a read command with an unaligned address
  starting at address 0x01, with 4-bytes to an 8-bit AXI slave, the starting address
  is: 0x00.

4.10. AMBA 3 APB Protocol Specification Support (version 1.0)

APB (Advanced Peripheral Bus) interface is optimized for minimal power consumption
and reduced interface complexity. You can use APB to interface to peripherals which
are low-bandwidth and do not require the high performance of a pipelined bus
interface. Signal transitions are sampled at the rising edge of the clock to enable the
integration of APB peripherals easily into any design flow.

Platform Designer allows connections between APB components, and AMBA 3 AXI,
AMBA 4 AXI, and Avalon memory-mapped interfaces. The following sections describe
unique or exceptional APB support in the Platform Designer software.

Related Information

Arm AMBA Protocol Specifications

4.10.1. Bridges

With APB, you cannot use bridge components that use multiple PSELx in Platform
Designer. As a workaround, you can group PSELx, and then send the packet to the
slave directly.

Intel recommends as an alternative that you instantiate the APB bridge and all the
APB slaves in Platform Designer. You should then connect the slave side of the bridge
to any high speed interface and connect the master side of the bridge to the APB
slaves. Platform Designer creates the interconnect on either side of the APB bridge
and creates only one PSEL signal.
Alternatively, you can connect a bridge to the APB bus outside of Platform Designer. Use an Avalon/AXI bridge to export the Avalon/AXI master to the top-level, and then connect this Avalon/AXI interface to the slave side of the APB bridge. Alternatively, instantiate the APB bridge in Platform Designer and export APB master to the top-level, and from there connect to APB bus outside of Platform Designer.

4.10.2. Burst Adaptation

APB is a non-bursting interface. Therefore, for any AXI or Avalon master with bursting support, a burst adapter is inserted before the slave interface and the burst transaction is translated into a series of non-bursting transactions before reaching the APB slave.

4.10.3. Width Adaptation

Platform Designer allows different data width connections with APB. When connecting a wider master to a narrower APB slave, the width adapter converts the wider transactions to a narrower transaction to fit the APB slave data width. APB does not support Write Strobe. Therefore, when you connect a narrower transaction to a wider APB slave, the slave cannot determine which byte lane to write. In this case, the slave data may be overwritten or corrupted.

4.10.4. Error Response

Error responses are returned to the master. Platform Designer performs error mapping if the master is an AMBA 3 AXI or AMBA 4 AXI master, for example, \( \text{RRESP/BRESP}=\text{SLVERR} \). For the case when the slave does not use \( \text{SLVERR} \) signal, an \( \text{OKAY} \) response is sent back to master by default.

4.11. AMBA 4 AXI Memory-Mapped Interface Support (version 2.0)

Platform Designer allows memory-mapped connections between AMBA 4 AXI components, AMBA 4 AXI and AMBA 3 AXI components, and AMBA 4 AXI and Avalon interfaces with unique or exceptional support.

4.11.1. Burst Support

Platform Designer supports \( \text{INCR} \) bursts up to 256 beats. Platform Designer converts long bursts to multiple bursts in a packet with each burst having a length less than or equal to \( \text{MAX_BURST} \) when going to AMBA 3 AXI or Avalon slaves.

For narrow-sized transfers, bursts with Avalon slaves as destinations are shortened to multiple non-bursting transactions in order to transmit the correct address to the slaves, since Avalon slaves always perform full-sized datawidth transactions.

Bursts with AMBA 3 AXI slaves as destinations are shortened to multiple bursts, with each burst length less than or equal to 16. Bursts with AMBA 4 AXI slaves as destinations are not shortened.

4.11.2. QoS

Platform Designer routes 4-bit QoS signals (Quality of Service Signaling) on the read and write address channels directly from the master to the slave.
Transactions from AMBA 3 AXI and Avalon masters have a default value of 4'b0000, which indicates that the transactions are not part of the QoS flow. QoS values are not used for slaves that do not support QoS.

For Platform Designer 14.0, there are no programmable QoS registers or compile-time QoS options for a master that overrides its real or default value.

4.11.3. Regions

For Platform Designer 14.0, there is no support for the optional regions feature. AMBA 4 AXI slaves with AXREGION signals are allowed. AXREGION signals are driven with the default value of 0x0, and are limited to one entry in a master’s address map.

4.11.4. Write Response Dependency

Write response dependency as specified in the Arm AMBA Protocol Specifications for AMBA 4 AXI is not supported.

Related Information
Arm AMBA Protocol Specifications

4.11.5. AWCACHE and ARCACHE

For AMBA 4 AXI, Platform Designer meets the requirement for modifiable and non-modifiable transactions. The modifiable bit refers to ARCACHE[1] and AWCACHE[1].

4.11.6. Width Adaptation and Data Packing in Platform Designer

Data packing applies only to systems where the data width of masters is less than the data width of slaves.

The following rules apply:

- Data packing is supported when masters and slaves are Avalon-MM.
- Data packing is not supported when any master or slave is an AMBA 3 AXI, AMBA 4 AXI, or APB component.

For example, for a read/write command with a 32-bit master connected to a 64-bit slave, and a transaction of 2 burstcounts, Platform Designer sends 2 separate read/write commands to access the 64-bit data width of the slave. Data packing is only supported if the system does not contain AMBA 3 AXI, AMBA 4 AXI, or APB masters or slaves.

4.11.7. Ordering Model

Out of order support is not implemented in Platform Designer, version 14.0. Platform Designer processes AXI slaves as device non-bufferable memory types.
The following describes the required behavior for the device non-bufferable memory type:

- Write response must be obtained from the final destination.
- Read data must be obtained from the final destination.
- Transaction characteristics must not be modified.
- Reads must not be pre-fetched. Writes must not be merged.
- Non-modifiable read and write transactions.

\((\text{AWCACHE}[1] = 0 \text{ or ARCACHE}[1] = 0)\) from the same ID to the same slave must remain ordered. The interconnect always provides responses in the same order as the commands issued. Slaves that support reordering provide a constant transaction ID to prevent reordering. AXI slaves that do not reorder are provided with transaction IDs, which allows exclusive accesses to be used for such slaves.

### 4.11.8. Read and Write Allocate

Read and write allocate does not apply to Platform Designer interconnect, which does not have caching features, and always receives responses from an endpoint.

### 4.11.9. Locked Transactions

Locked transactions are not supported for Platform Designer, version 14.0.

### 4.11.10. Memory Types

For AMBA 4 AXI, Platform Designer processes transactions as though the endpoint is a device memory type. For device memory types, using non-bufferable transactions to force previous bufferable transactions to finish is irrelevant, because Platform Designer interconnect always identifies transactions as being non-bufferable.

### 4.11.11. Mismatched Attributes

There are rules for how multiple masters issue cache values to a shared memory region. The interconnect meets requirements if signals are not modified.

### 4.11.12. Signals

Platform Designer supports up to 64-bits for the BUSER, WUSER and RUSER sideband signals. AMBA 4 AXI allows some signals to be omitted from interfaces by aligning them with the default values as defined in the AMBA Protocol Specifications on the ARM website.

**Related Information**

Arm AMBA Protocol Specifications

### 4.12. AMBA 4 AXI Streaming Interface Support (version 1.0)
4.12.1. Connection Points

Platform Designer allows you to connect an AMBA 4 AXI-Stream interface to another AMBA 4 AXI-Stream interface.

The connection is point-to-point without adaptation and must be between an axi4stream_master and axi4stream_slave. Connected interfaces must have the same port roles and widths.

Non matching master to slave connections, and multiple masters to multiple slaves connections are not supported.

4.12.1.1. AMBA 4 AXI Streaming Connection Point Parameters

Table 88. AMBA 4 AXI Streaming Connection Point Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>associatedClock</td>
<td>string</td>
<td>Name of associated clock interface.</td>
</tr>
<tr>
<td>associatedReset</td>
<td>string</td>
<td>Name of associated reset interface</td>
</tr>
</tbody>
</table>

4.12.1.2. AMBA 4 AXI Streaming Connection Point Signals

Table 89. AMBA 4 AXI-Stream Connection Point Signals

<table>
<thead>
<tr>
<th>Port Role</th>
<th>Width</th>
<th>Master Direction</th>
<th>Slave Direction</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>tvalid</td>
<td>1</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>tready</td>
<td>1</td>
<td>Input</td>
<td>Output</td>
<td>No</td>
</tr>
<tr>
<td>tdata[2]</td>
<td>8:4096</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tstrb</td>
<td>1:512</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tkeep</td>
<td>1:512</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tid[3]</td>
<td>1:8</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tdest[4]</td>
<td>1:4</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tuser[5]</td>
<td>1:4096</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tlast</td>
<td>1</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
</tbody>
</table>

4.12.2. Adaptation

AMBA 4 AXI-Stream adaptation support is not available. AMBA 4 AXI-Stream master and slave interface signals and widths must match.

---

(2) integer in mutiple of bytes
(3) maximum 8-bits
(4) maximum 4-bits
(5) number of bits in multiple of the number of bytes of tdata
4.13. AMBA 4 AXI-Lite Protocol Specification Support (version 2.0)

AMBA 4 AXI-Lite is a sub-set of AMBA 4 AXI. It is suitable for simpler control register-style interfaces that do not require the full functionality of AMBA 4 AXI.

Platform Designer 14.0 supports the following AMBA 4 AXI-Lite features:

- Transactions with a burst length of 1.
- Data accesses use the full width of a data bus (32-bit or 64-bit) for data accesses, and no narrow-size transactions.
- Non-modifiable and non-bufferable accesses.
- No exclusive accesses.

4.13.1. AMBA 4 AXI-Lite Signals

Platform Designer supports all AMBA 4 AXI-Lite interface signals. All signals are required.

Table 90. AMBA 4 AXI-Lite Signals

<table>
<thead>
<tr>
<th>Global</th>
<th>Write Address Channel</th>
<th>Write Data Channel</th>
<th>Write Response Channel</th>
<th>Read Address Channel</th>
<th>Read Data Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACLK</td>
<td>AWVALID</td>
<td>WVALID</td>
<td>BVALID</td>
<td>ARVALID</td>
<td>RVALID</td>
</tr>
<tr>
<td>ARESETn</td>
<td>AWREADY</td>
<td>WREADY</td>
<td>BREADY</td>
<td>ARREADY</td>
<td>RREADY</td>
</tr>
<tr>
<td>-</td>
<td>AWADDR</td>
<td>WDATA</td>
<td>BRESP</td>
<td>ARADDR</td>
<td>RDATA</td>
</tr>
<tr>
<td>-</td>
<td>AWPROT</td>
<td>WSTRB</td>
<td>-</td>
<td>ARPROT</td>
<td>RRESP</td>
</tr>
</tbody>
</table>

4.13.2. AMBA 4 AXI-Lite Bus Width

AMBA 4 AXI-Lite masters or slaves must have either 32-bit or 64-bit bus widths. Platform Designer interconnect inserts a width adapter if a master and slave pair have different widths.

4.13.3. AMBA 4 AXI-Lite Outstanding Transactions

AXI-Lite supports outstanding transactions. The options to control outstanding transactions is set in the parameter editor for the selected component.

4.13.4. AMBA 4 AXI-Lite IDs

AMBA 4 AXI-Lite does not support IDs. Platform Designer performs ID reflection inside the slave agent.
4.13.5. Connections Between AMBA 3 AXI, AMBA 4 AXI and AMBA 4 AXI-Lite

4.13.5.1. AMBA 4 AXI-Lite Slave Requirements

For an AMBA 4 AXI-Lite slave side, the master can be any master interface type, such as an Avalon (with bursting), AMBA 3 AXI, or AMBA 4 AXI. Platform Designer allows the following connections and inserts adapters, if needed.

- **Burst adapter**—Avalon and AMBA 3 AXI and AMBA 4 AXI bursting masters require a burst adapter to shorten the burst length to 1 before sending a transaction to an AMBA 4 AXI-Lite slave.
- Platform Designer interconnect uses a width adapter for mismatched data widths.
- Platform Designer interconnect performs ID reflection inside the slave agent.
- An AMBA 4 AXI-Lite slave must have an address width of at least 12-bits.
- AMBA 4 AXI-Lite does not have the `AXSIZE` parameter. Narrow master to a wide AMBA 4 AXI-Lite slave is not supported. For masters that support narrow-sized bursts, for example, AMBA 3 AXI and AMBA 4 AXI, a burst to an AMBA 4 AXI-Lite slave must have a burst size equal to or greater than the slave's burst size.

4.13.5.2. AMBA 4 AXI-Lite Data Packing

Platform Designer interconnect does not support AMBA 4 AXI-Lite data packing.

4.13.6. AMBA 4 AXI-Lite Response Merging

When Platform Designer interconnect merges `SLVERR` and `DECERR`, the error responses are not sticky. The response is based on priority and the master always sees a `DECERR`. When `SLVERR` and `DECERR` are merged, it is based on their priorities, not stickiness. `DECERR` receives priority in this case, even if `SLVERR` returns first.

4.14. Port Roles (Interface Signal Types)

Each interface defines signal roles and their behavior. Many signal roles are optional, allowing IP component designers the flexibility to select only the signal roles necessary to implement the required functionality.

4.14.1. AXI Master Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>araddr</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arburst</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>arcache</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>arid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>arlen</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>arlock</td>
<td>output</td>
<td>2</td>
</tr>
</tbody>
</table>

...continued...
<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>arprot</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>arready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>arsize</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>aruser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>awaddr</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awburst</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>awcache</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>awid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>awlen</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>awlock</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>awprot</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>awready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>awsize</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>awuser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>bid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>bready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>bresp</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>bvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rdata</td>
<td>input</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>rid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>rlast</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rresp</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>rvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wdata</td>
<td>output</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>wid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>wlast</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>wready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wstrb</td>
<td>output</td>
<td>1, 2, 4, 8, 16, 32, 64, 128</td>
</tr>
<tr>
<td>wvalid</td>
<td>output</td>
<td>1</td>
</tr>
</tbody>
</table>
### 4.14.2. AXI Slave Interface Signal Types

#### Table 92. AXI Slave Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>araddr</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arburst</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>arcache</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>arid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>arlen</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>arlock</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>arprot</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>arready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>arsize</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>aruser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>awaddr</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awburst</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>awcache</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>awid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>awlen</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>awlock</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>awprot</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>awready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>awsize</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>awuser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>bid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>bready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>bresp</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>bvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rdata</td>
<td>output</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>rid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>rlast</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rresp</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>rvalid</td>
<td>output</td>
<td>1</td>
</tr>
</tbody>
</table>

*continued...*
### 4.14.3. AMBA 4 AXI Master Interface Signal Types

**Table 93. AMBA 4 AXI Master Interface Signal Types**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>wdata</td>
<td>input</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>wid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>wlast</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>wstrb</td>
<td>input</td>
<td>1, 2, 4, 8, 16, 32, 64, 128</td>
</tr>
<tr>
<td>wvalid</td>
<td>input</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>araddr</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arburst</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>arcache</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>arid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>arlen</td>
<td>output</td>
<td>8</td>
</tr>
<tr>
<td>arlock</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>arprot</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>arready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>arregion</td>
<td>output</td>
<td>1 - 4</td>
</tr>
<tr>
<td>arsize</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>aruser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>awaddr</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awburst</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>awcache</td>
<td>output</td>
<td>4</td>
</tr>
<tr>
<td>awid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>awlen</td>
<td>output</td>
<td>8</td>
</tr>
<tr>
<td>awlock</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>awprot</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>awqos</td>
<td>output</td>
<td>1 - 4</td>
</tr>
<tr>
<td>awready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>awregion</td>
<td>output</td>
<td>1 - 4</td>
</tr>
<tr>
<td>awsize</td>
<td>output</td>
<td>3</td>
</tr>
<tr>
<td>awuser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
</tbody>
</table>

*continued...*
<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>awvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>bid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>bready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>bresp</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>buser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>bvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rdata</td>
<td>input</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>rid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>rlast</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rresp</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>ruser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>rvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wdata</td>
<td>output</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>wid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>wlast</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>wready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wstrb</td>
<td>output</td>
<td>1, 2, 4, 8, 16, 32, 64, 128</td>
</tr>
<tr>
<td>wuser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>wvalid</td>
<td>output</td>
<td>1</td>
</tr>
</tbody>
</table>

### 4.14.4. AMBA 4 AXI Slave Interface Signal Types

#### Table 94. AMBA 4 AXI Slave Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>araddr</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arburst</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>arcache</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>arid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>arlen</td>
<td>input</td>
<td>8</td>
</tr>
<tr>
<td>arlock</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>arprot</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>argqs</td>
<td>input</td>
<td>1 - 4</td>
</tr>
<tr>
<td>arready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>arregion</td>
<td>input</td>
<td>1 - 4</td>
</tr>
</tbody>
</table>

*continued...*
<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>arsize</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>aruser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>arvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>awaddr</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awburst</td>
<td>input</td>
<td>2</td>
</tr>
<tr>
<td>awcache</td>
<td>input</td>
<td>4</td>
</tr>
<tr>
<td>awid</td>
<td>input</td>
<td>1 - 18</td>
</tr>
<tr>
<td>awlen</td>
<td>input</td>
<td>8</td>
</tr>
<tr>
<td>awlock</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>awprot</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>awqos</td>
<td>input</td>
<td>1 - 4</td>
</tr>
<tr>
<td>awready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>awregion</td>
<td>input</td>
<td>1 - 4</td>
</tr>
<tr>
<td>awsize</td>
<td>input</td>
<td>3</td>
</tr>
<tr>
<td>awuser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>awvalid</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>bid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>bready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>bresp</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>bvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rdata</td>
<td>output</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>rid</td>
<td>output</td>
<td>1 - 18</td>
</tr>
<tr>
<td>rlast</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>rready</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>rresp</td>
<td>output</td>
<td>2</td>
</tr>
<tr>
<td>ruser</td>
<td>output</td>
<td>1 - 64</td>
</tr>
<tr>
<td>rvalid</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>wdata</td>
<td>input</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
</tr>
<tr>
<td>wlast</td>
<td>input</td>
<td>1</td>
</tr>
<tr>
<td>wready</td>
<td>output</td>
<td>1</td>
</tr>
<tr>
<td>wstrb</td>
<td>input</td>
<td>1, 2, 4, 8, 16, 32, 64, 128</td>
</tr>
<tr>
<td>wuser</td>
<td>input</td>
<td>1 - 64</td>
</tr>
<tr>
<td>wvalid</td>
<td>input</td>
<td>1</td>
</tr>
</tbody>
</table>
4.14.5. AMBA 4 AXI-Stream Master and Slave Interface Signal Types

Table 95. AMBA 4 AXI-Stream Master and Slave Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
<th>Master Direction</th>
<th>Slave Direction</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>tvalid</td>
<td>1</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>tready</td>
<td>1</td>
<td>Input</td>
<td>Output</td>
<td>No</td>
</tr>
<tr>
<td>tdata</td>
<td>8:4096</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tsrb</td>
<td>1:512</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tkeep</td>
<td>1:512</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tid</td>
<td>1:8</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tdest</td>
<td>1:4</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tuser</td>
<td>1</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
<tr>
<td>tlast</td>
<td>1:4096</td>
<td>Output</td>
<td>Input</td>
<td>No</td>
</tr>
</tbody>
</table>

4.14.6. ACE-Lite Interface Signal Roles

Table 96. ACE-Lite Interface Signal Roles

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
<th>Master Direction</th>
<th>Slave Direction</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>arsnoop</td>
<td>4 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>ardomain</td>
<td>2 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>arbar</td>
<td>2 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>awsnoop</td>
<td>3 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>awdomain</td>
<td>2 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>awbar</td>
<td>2 bits</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>awunique</td>
<td>1 bit</td>
<td>Output</td>
<td>Input</td>
<td>Yes</td>
</tr>
</tbody>
</table>

4.14.7. APB Interface Signal Types

Table 97. APB Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
<th>Direction APB Master</th>
<th>Direction APB Slave</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>paddr</td>
<td>[1:32]</td>
<td>output</td>
<td>input</td>
<td>yes</td>
</tr>
<tr>
<td>psel</td>
<td>[1:16]</td>
<td>output</td>
<td>input</td>
<td>yes</td>
</tr>
<tr>
<td>penable</td>
<td>1</td>
<td>output</td>
<td>input</td>
<td>yes</td>
</tr>
<tr>
<td>pwrite</td>
<td>1</td>
<td>output</td>
<td>input</td>
<td>yes</td>
</tr>
<tr>
<td>pwdata</td>
<td>[1:32]</td>
<td>output</td>
<td>input</td>
<td>yes</td>
</tr>
<tr>
<td>prdata</td>
<td>[1:32]</td>
<td>input</td>
<td>output</td>
<td>yes</td>
</tr>
</tbody>
</table>

continued...

Signal roles define the signal types that are allowed on Avalon-MM master and slave ports.

This specification does not require all signals to exist in an Avalon-MM interface. There is no one signal that is always required. The minimum requirements for an Avalon-MM interface are readdata for a read-only interface, or writedata and write for a write-only interface.

The following table lists signal roles for the Avalon-MM interface:

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>address</td>
<td>1 - 64</td>
<td>Master → Slave</td>
<td>No</td>
<td>Masters: By default, the address signal represents a byte address. The value of the address must be aligned to the data width. To write to specific bytes within a data word, the master must use the byteenable signal. Refer to the addressUnits interface property for word addressing. Slaves: By default, the interconnect translates the byte address into a word address in the slave’s address space. Each slave access is for a word of data from the perspective of the slave. For example, address = 0 selects the first word of the slave. address = 1 selects the second word of the slave. Refer to the addressUnits interface property for byte addressing.</td>
</tr>
<tr>
<td>byteenable</td>
<td>2, 4, 8, 16, 32, 64, 128</td>
<td>Master → Slave</td>
<td>No</td>
<td>Enables one or more specific byte lanes during transfers on interfaces of width greater than 8 bits. Each bit in byteenable corresponds to a byte in writedata and readdata. The master bit &lt;n&gt; of byteenable indicates whether byte &lt;n&gt; is being written to. During writes, byteenables specify which bytes are being written to. Other bytes should be ignored by the slave. During reads, byteenables indicate which bytes the master is reading. Slaves that simply return readdata with no side effects are free to ignore byteenables during reads. If an interface does not have a byteenable signal, the transfer proceeds as if all byteenables are asserted. When more than one bit of the byteenable signal is asserted, all asserted lanes are adjacent. The number of adjacent lines must be a power of 2.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
<th>Direction APB Master</th>
<th>Direction APB Slave</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>pslverr</td>
<td>1</td>
<td>input</td>
<td>output</td>
<td>no</td>
</tr>
<tr>
<td>pready</td>
<td>1</td>
<td>input</td>
<td>output</td>
<td>yes</td>
</tr>
<tr>
<td>paddr31</td>
<td>1</td>
<td>output</td>
<td>input</td>
<td>no</td>
</tr>
<tr>
<td>Signal Role</td>
<td>Width</td>
<td>Direction</td>
<td>Required</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>---------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>debugaccess</td>
<td>1</td>
<td>Master → Slave</td>
<td>No</td>
<td>When asserted, allows the Nios II processor to write on-chip memories configured as ROMs.</td>
</tr>
<tr>
<td>read</td>
<td>1</td>
<td>Master → Slave</td>
<td>No</td>
<td>Asserted to indicate a read transfer. If present, readdata is required.</td>
</tr>
<tr>
<td>read_n</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>readdata</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
<td>Slave → Master</td>
<td>No</td>
<td>The readdata driven from the slave to the master in response to a read transfer. Required for interfaces that support reads.</td>
</tr>
<tr>
<td>response</td>
<td>2</td>
<td>Slave → Master</td>
<td>No</td>
<td>The response signal is an optional signal that carries the response status.</td>
</tr>
<tr>
<td>[1:0]</td>
<td></td>
<td></td>
<td></td>
<td>Note: Because the signal is shared, an interface cannot issue or accept a write response and a read response in the same clock cycle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 00: OKAY—Successful response for a transaction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 01: RESERVED—Encoding is reserved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 10: SLAVEERROR—Error from an endpoint slave. Indicates an unsuccessful transaction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• 11: DECODEERROR—Indicates attempted access to an undefined location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For read responses:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• One response is sent with each readdata. A read burst length of N results in N responses. It is not valid to produce fewer responses, even in</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>the event of an error. It is valid for the response signal value to be different for each readdata in the burst.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• The interface must have read control signals. Pipeline support is possible with the readdatavalid signal.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• On read errors, the corresponding readdata is &quot;don't care&quot;.</td>
</tr>
</tbody>
</table>

continued...
### Signal Role

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>write</td>
<td>1</td>
<td>Master → Slave</td>
<td>No</td>
<td>Asserted to indicate a write transfer. If present, writedata is required.</td>
</tr>
<tr>
<td>writedata</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024</td>
<td>Master → Slave</td>
<td>No</td>
<td>Data for write transfers. The width must be the same as the width of readdata if both are present. Required for interfaces that support writes.</td>
</tr>
</tbody>
</table>

### Wait-State Signals

<table>
<thead>
<tr>
<th>Signal</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lock</td>
<td>1</td>
<td>Master → Slave</td>
<td>No</td>
<td>lock ensures that once a master wins arbitration, it maintains access to the slave for multiple transactions. It is asserted coincident with the first read or write of a locked sequence of transactions. It is deasserted on the final transaction of a locked sequence of transactions. lock assertion does not guarantee that arbitration is won. After the lock-asserting master has been granted, it retains grant until it is deasserted. A master equipped with lock cannot be a burst master. Arbitration priority values for lock-equipped masters are ignored. lock is particularly useful for read-modify-write (RMW) operations. The typical read-modify-write operation includes the following steps: 1. Master A asserts lock and reads 32-bit data that has multiple bit fields. 2. Master A deasserts lock, changes one bit field, and writes the 32-bit data back. lock prevents master B from performing a write between Master A's read and write.</td>
</tr>
<tr>
<td>waitrequest</td>
<td>1</td>
<td>Slave → Master</td>
<td>No</td>
<td>Asserted by the slave when it is unable to respond to a read or write request. Forces the master to wait until the interconnect is ready to proceed with the transfer. At the start of all transfers, a master initiates the transfer and waits until waitrequest is deasserted. A master must make no assumption about the assertion state of waitrequest when the master is idle; waitrequest may be high or low, depending on system properties. When waitrequest is asserted, master control signals to the slave must remain constant with the exception of beginbursttransfer. For a timing diagram illustrating the beginbursttransfer signal, refer to the figure in Read Bursts. An Avalon-MM slave may assert waitrequest during idle cycles. An Avalon-MM master may initiate a transaction when waitrequest is asserted and wait for that signal to be deasserted. To avoid system lockup, a slave device should assert waitrequest when in reset.</td>
</tr>
</tbody>
</table>

### Pipeline Signals

```markdown
<table>
<thead>
<tr>
<th>Signal</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>continued...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>readdatavalid</td>
<td>1</td>
<td>Slave → Master</td>
<td>No</td>
<td>Used for variable-latency, pipelined read transfers. When asserted, indicates that the readdatal signal contains valid data. For a read burst with burstcount value (&lt;n&gt;), the readdatavalid signal must be asserted (&lt;n&gt;) times, once for each readdatal item. There must be at least one cycle of latency between acceptance of the read and assertion of readdatavalid. For a timing diagram illustrating the readdatavalid signal, refer to Pipelined Read Transfer with Variable Latency. A slave may assert readdatavalid to transfer data to the master independently of whether or not the slave is stalling a new command with waitrequest. Required if the master supports pipelined reads. Bursting masters with read functionality must include the readdatavalid signal.</td>
</tr>
<tr>
<td>readdatavalid_n</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>writeresponsevalid</td>
<td>1</td>
<td>Slave → Master</td>
<td>No</td>
<td>An optional signal. If present, the interface issues write responses for write commands. When asserted, the value on the response signal is a valid write response. writeresponsevalid is only asserted one clock cycle or more after the write command is accepted. There is at least a one clock cycle latency from command acceptance to assertion of writeresponsevalid.</td>
</tr>
<tr>
<td>burstcount</td>
<td>(1 \leq \text{Width} \leq 11)</td>
<td>Master → Slave</td>
<td>No</td>
<td>Used by bursting masters to indicate the number of transfers in each burst. The value of the maximum burstcount parameter must be a power of 2. A burstcount interface of width (&lt;n&gt;) can encode a max burst of size (2^{(\text{Width} - 1)}). For example, a 4-bit burstcount signal can support a maximum burst count of 8. The minimum burstcount is 1. The constantBurstBehavior property controls the timing of the burstcount signal. Bursting masters with read functionality must include the readdatavalid signal. For bursting masters and slaves using byte addresses, the following restriction applies to the width of the address: (&lt;\text{address}_w&gt; = &lt;\text{burstcount}_w&gt; + \log_2(&lt;\text{symbols_per_word_of_interface}&gt;) For bursting masters and slaves using word addresses, the (\log) term above is omitted.</td>
</tr>
<tr>
<td>beginbursttransfer</td>
<td>1</td>
<td>Interconnect → Slave</td>
<td>No</td>
<td>Asserted for the first cycle of a burst to indicate when a burst transfer is starting. This signal is deasserted after one cycle regardless of the value of waitrequest. For a timing diagram illustrating beginbursttransfer, refer to the figure in Read Bursts. beginbursttransfer is optional. A slave can always internally calculate the start of the next write burst transaction by counting data transfers. <strong>Warning:</strong> do not use this signal. This signal exists to support legacy memory controllers.</td>
</tr>
</tbody>
</table>

**Burst Signals**

Each signal in an Avalon-ST source or sink interface corresponds to one Avalon-ST signal role. An Avalon-ST interface may contain only one instance of each signal role. All Avalon-ST signal roles apply to both sources and sinks and have the same meaning for both.

Table 99. Avalon-ST Interface Signals

In the following table, all signal roles are active high.

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fundamental Signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>channel</td>
<td>1 – 128</td>
<td>Source → Sink</td>
<td>No</td>
<td>The channel number for data being transferred on the current cycle. If an interface supports the channel signal, it must also define the maxChannel parameter.</td>
</tr>
<tr>
<td>data</td>
<td>1 – 4,096</td>
<td>Source → Sink</td>
<td>No</td>
<td>The data signal from the source to the sink, typically carries the bulk of the information being transferred. The contents and format of the data signal is further defined by parameters.</td>
</tr>
<tr>
<td>error</td>
<td>1 – 256</td>
<td>Source → Sink</td>
<td>No</td>
<td>A bit mask used to mark errors affecting the data being transferred in the current cycle. A single bit in error is used for each of the errors recognized by the component, as defined by the errorDescriptor property.</td>
</tr>
<tr>
<td>ready</td>
<td>1</td>
<td>Sink → Source</td>
<td>No</td>
<td>Asserted high to indicate that the sink can accept data. ready is asserted by the sink on cycle (n) to mark cycle (n + \text{readyLatency}) as a ready cycle. The source may only assert valid and transfer data during ready cycles. Sources without a ready input cannot be backpressured. Sinks without a ready output never need to backpressure.</td>
</tr>
<tr>
<td>valid</td>
<td>1</td>
<td>Source → Sink</td>
<td>No</td>
<td>Asserted by the source to qualify all other source to sink signals. The sink samples data and other source-to-sink signals on ready cycles where valid is asserted. All other cycles are ignored. Sources without a valid output implicitly provide valid data on every cycle that they are not being backpressured. Sinks without a valid input expect valid data on every cycle that they are not backpressuring.</td>
</tr>
<tr>
<td><strong>Packet Transfer Signals</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>empty</td>
<td>1 – 5</td>
<td>Source → Sink</td>
<td>No</td>
<td>Indicates the number of symbols that are empty, that is, do not represent valid data. The empty signal is not used on interfaces where there is one symbol per beat.</td>
</tr>
<tr>
<td>endofpacket</td>
<td>1</td>
<td>Source → Sink</td>
<td>No</td>
<td>Asserted by the source to mark the end of a packet.</td>
</tr>
<tr>
<td>startofpacket</td>
<td>1</td>
<td>Source → Sink</td>
<td>No</td>
<td>Asserted by the source to mark the beginning of a packet.</td>
</tr>
</tbody>
</table>

4.14.10. Avalon Clock Source Signal Roles

An Avalon Clock source interface drives a clock signal out of a component.
### Table 100. Clock Source Signal Roles

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clk</td>
<td>1</td>
<td>Output</td>
<td>Yes</td>
<td>An output clock signal.</td>
</tr>
</tbody>
</table>

#### 4.14.11. Avalon Clock Sink Signal Roles

A clock sink provides a timing reference for other interfaces and internal logic.

### Table 101. Clock Sink Signal Roles

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clk</td>
<td>1</td>
<td>Input</td>
<td>Yes</td>
<td>A clock signal. Provides synchronization for internal logic and for other interfaces.</td>
</tr>
</tbody>
</table>


### Table 102. Conduit Signal Roles

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;any&gt;</td>
<td>&lt;n&gt;</td>
<td>In, out, or bidirectional</td>
<td>A conduit interface consists of one or more input, output, or bidirectional signals of arbitrary width. Conduits can have any user-specified role. You can connect compatible Conduit interfaces inside a Platform Designer system provided the roles and widths match and the directions are opposite.</td>
</tr>
</tbody>
</table>


The following table lists the signal defined for the Avalon Tristate Conduit interface. All Avalon-TC signals apply to both masters and slaves and have the same meaning for both

### Table 103. Tristate Conduit Interface Signal Roles

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>request</td>
<td>1</td>
<td>Master → Slave</td>
<td>Yes</td>
<td>The meaning of request depends on the state of the grant signal, as the following rules dictate. When request is asserted and grant is deasserted, request is requesting access for the current cycle. When request is asserted and grant is asserted, request is requesting access for the next cycle. Consequently, request should be deasserted on the final cycle of an access. The request is deasserted in the last cycle of a bus access. It can be reasserted immediately following the final cycle of a transfer. This protocol makes both rearbitration and continuous bus access possible if no other masters are requesting access.</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>grant</td>
<td>1</td>
<td>Slave ⊗ Master</td>
<td>Yes</td>
<td>When asserted, indicates that a tristate conduit master has been granted access to perform transactions. grant is asserted in response to the request signal. It remains asserted until 1 cycle following the deassertion of request.</td>
</tr>
<tr>
<td>&lt;name&gt;_in</td>
<td>1 - 1024</td>
<td>Slave ⊗ Master</td>
<td>No</td>
<td>The input signal of a logical tristate signal.</td>
</tr>
<tr>
<td>&lt;name&gt;_out</td>
<td>1 - 1024</td>
<td>Master ⊗ Slave</td>
<td>No</td>
<td>The output signal of a logical tristate signal.</td>
</tr>
<tr>
<td>&lt;name&gt;_outen</td>
<td>1</td>
<td>Master ⊗ Slave</td>
<td>No</td>
<td>The output enable for a logical tristate signal.</td>
</tr>
</tbody>
</table>

Once asserted, request must remain asserted until granted. Consequently, the shortest bus access is 2 cycles. Refer to Tristate Conduit Arbitration Timing for an example of arbitration timing.

#### Table 104. Tri-state Slave Interface Signal Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>address</td>
<td>1 - 32</td>
<td>input</td>
<td>No</td>
<td>Address lines to the slave port. Specifies a byte offset into the slave’s address space.</td>
</tr>
<tr>
<td>read</td>
<td>1</td>
<td>input</td>
<td>No</td>
<td>Read-request signal. Not required if the slave port never outputs data. If present, data must also be used.</td>
</tr>
<tr>
<td>write</td>
<td>1</td>
<td>input</td>
<td>No</td>
<td>Write-request signal. Not required if the slave port never receives data from a master. If present, data must also be present, and writebyteenable cannot be present.</td>
</tr>
<tr>
<td>chipselect</td>
<td>1</td>
<td>input</td>
<td>No</td>
<td>When present, the slave port ignores all Avalon-MM signals unless chipselect is asserted. chipselect is always present in combination with read or write.</td>
</tr>
<tr>
<td>outputenable</td>
<td>1</td>
<td>input</td>
<td>Yes</td>
<td>Output-enable signal. When deasserted, a tri-state slave port must not drive its data lines otherwise data contention may occur.</td>
</tr>
<tr>
<td>data</td>
<td>8,16, 32, 64, 128, 256, 512, 1024</td>
<td>bidir</td>
<td>No</td>
<td>Bidirectional data. During write transfers, the FPGA drives the data lines. During read transfers the slave device drives the data lines, and the FPGA captures the data signals and provides them to the master.</td>
</tr>
<tr>
<td>byteenable</td>
<td>2, 4, 8, 16, 32, 64, 128</td>
<td>input</td>
<td>No</td>
<td>Enables specific byte lanes during transfers. Each bit in byteenable corresponds to a byte lane in data. During writes, byteenables specify which bytes the master is writing to the slave. During reads, byteenables indicates which bytes the master is reading. Slaves that simply return data with no side effects are free to ignore byteenables during reads. When more than one byte lane is asserted, all asserted lanes are guaranteed to be adjacent. The number of adjacent lines must be a power of 2, and the specified bytes must be aligned on an address boundary for the size of the data. The are legal values for a 32-bit slave:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1111  writes full 32 bits</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0111  writes lower 2 bytes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1100  writes upper 2 bytes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0001  writes byte 0 only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0010  writes byte 1 only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0100  writes byte 2 only</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1000  writes byte 3 only</td>
</tr>
</tbody>
</table>

*continued...*
### Name | Width | Direction | Required | Description
--- | --- | --- | --- | ---
writebyteenable | 2,4,8,16, 32, 64,128 | input | No | Equivalent to the logical AND of the byteenable and write signals. When used, the write signal is not used.
writebyteenable_n |  |  |  |  |
begintransfer1 | 1 | input | No | Asserted for the first cycle of each transfer.

Note: All Avalon signals are active high. Avalon signals that can also be asserted low list both versions in the Signal Role column.

#### 4.14.15. Avalon Interrupt Sender Signal Roles

**Table 105. Interrupt Sender Signal Roles**

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>irq</td>
<td>1-32</td>
<td>Output</td>
<td>Yes</td>
<td>Interrupt Request. An interrupt sender drives an interrupt signal to an interrupt receiver.</td>
</tr>
<tr>
<td>irq_n</td>
<td>1-32</td>
<td>Output</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

#### 4.14.16. Avalon Interrupt Receiver Signal Roles

**Table 106. Interrupt Receiver Signal Roles**

<table>
<thead>
<tr>
<th>Signal Role</th>
<th>Width</th>
<th>Direction</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>irq</td>
<td>1–32</td>
<td>Input</td>
<td>Yes</td>
<td>irq is an &lt;n&gt;-bit vector, where each bit corresponds directly to one IRQ sender with no inherent assumption of priority.</td>
</tr>
</tbody>
</table>

#### 4.15. Platform Designer Interconnect Revision History

<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018.06.15</td>
<td>18.0</td>
<td>Clarified behavior of Error Correction Coding (ECC) in Interconnect.</td>
</tr>
<tr>
<td>2018.05.07</td>
<td>18.0</td>
<td>• Added support for waitrequestAllowance adapter. • Added support for ACE-Lite connections.</td>
</tr>
<tr>
<td>2017.11.06</td>
<td>17.1.0</td>
<td>• Changed instances of Qsys Pro to Platform Designer • Updated information about the Reset Sequencer.</td>
</tr>
<tr>
<td>2016.10.31</td>
<td>16.1.0</td>
<td>• Implemented Intel rebranding. • Implemented Qsys rebranding.</td>
</tr>
<tr>
<td>2015.11.02</td>
<td>15.1.0</td>
<td>Changed instances of Quartus II to Quartus Prime.</td>
</tr>
<tr>
<td>2015.05.04</td>
<td>15.0.0</td>
<td>• Fixed Priority Arbitration. • Added topic: Read and Write Responses. • Added topic: Error Correction Coding (ECC) in Qsys Interconnect. • Added: response [1:0], Avalon Memory-Mapped Interface Signal Roles. • Added writeresponsevalid, Avalon Memory-Mapped Interface Signal Roles.</td>
</tr>
</tbody>
</table>

*continued...*
<table>
<thead>
<tr>
<th>Document Version</th>
<th>Intel Quartus Prime Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| December 2014    | 14.1.0                     | • Read error responses, Avalon Memory-Mapped Interface Signal, response.  
|                  |                            | • Burst Adapter Implementation Options: Generic converter (slower, lower area), Per-burst-type converter (faster, higher area). |
| August 2014      | 14.0a10.0                  | • Updated Platform Designer Packet Format for Memory-Mapped Master and Slave Interfaces table, Protection.  
|                  |                            | • Streaming Interface renamed to Avalon Streaming Interfaces.  
|                  |                            | • Added Response Merging under Memory-Mapped Interfaces. |
| June 2014        | 14.0.0                     | • AXI4-Lite support.  
|                  |                            | • AXI4-Stream support.  
|                  |                            | • Avalon-ST adapter parameters.  
|                  |                            | • IRQ Bridge.  
|                  |                            | • Handling Read Side Effects note added. |
| November 2013    | 13.1.0                     | • HSSI clock support.  
|                  |                            | • Reset Sequence.  
|                  |                            | • Interconnect pipelining. |
| May 2013         | 13.0.0                     | • AMBA APB support.  
|                  |                            | • Auto-inserted Avalon-ST adapters feature.  
|                  |                            | • Moved Address Span Extender to the Qsys System Design Components chapter. |
| November 2012    | 12.1.0                     | • AMBA AXI4 support. |
| June 2012        | 12.0.0                     | • AMBA AXI3 support.  
|                  |                            | • Avalon-ST adapters.  
|                  |                            | • Address Span Extender. |
| November 2011    | 11.0.1                     | Template update. |
| May 2011         | 11.0.0                     | Removed beta status. |
| December 2010    | 10.1.0                     | Initial release. |

**Related Information**

**Documentation Archive**

For previous versions of the *Intel Quartus Prime Handbook*, search the documentation archives.
5. Optimizing Platform Designer System Performance

You can optimize system interconnect performance for Intel designs that you create with the Platform Designer system integration tool.

*Note:* Intel now refers to Qsys Pro as Platform Designer.

The foundation of any system is the interconnect logic that connects hardware blocks or components. Creating interconnect logic is prone to errors, is time consuming to write, and is difficult to modify when design requirements change. The Platform Designer system integration tool addresses these issues and provides an automatically generated and optimized interconnect designed to satisfy your system requirements.

Platform Designer supports Avalon, AMBA 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

*Note:* Recommended Intel practices may improve clock frequency, throughput, logic utilization, or power consumption of your Platform Designer design. When you design a Platform Designer system, use your knowledge of your design intent and goals to further optimize system performance beyond the automated optimization available in Platform Designer.

**Related Information**
- Creating a System with Platform Designer on page 9
- Creating Platform Designer Components on page 305
- Platform Designer Interconnect on page 357
- Avalon Interface Specifications
- AMBA Protocol Specifications

5.1. Designing with Avalon and AXI Interfaces

Platform Designer Avalon and AXI interconnect for memory-mapped interfaces is flexible, partial crossbar logic that connects master and slave interfaces.

Avalon Streaming (Avalon-ST) links connect point-to-point, unidirectional interfaces and are typically used in data stream applications. Each pair of components is connected without any requirement to arbitration between the data source and sink.

Because Platform Designer supports multiplexed memory-mapped and streaming connections, you can implement systems that use multiplexed logic for control and streaming for data in a single design.

**Related Information**
- Creating Platform Designer Components on page 305
5. Optimizing Platform Designer System Performance

5.1.1. Designing Streaming Components

When you design streaming component interfaces, you must consider integration and communication for each component in the system. One common consideration is buffering data internally to accommodate latency between components.

For example, if the component’s Avalon-ST output or source of streaming data is back-pressured because the ready signal is deasserted, then the component must back-pressured its input or sink interface to avoid overflow.

You can use a FIFO to back-pressure internally on the output side of the component so that the input can accept more data even if the output is back-pressured. Then, you can use the FIFO almost full flag to back-pressure the sink interface or input data when the FIFO has only enough space to satisfy the internal latency. You can drive the data valid signal of the output or source interface with the FIFO not empty flag when that data is available.

5.1.2. Designing Memory-Mapped Components

When designing with memory-mapped components, you can implement any component that contains multiple registers mapped to memory locations, for example, a set of four output registers to support software read back from logic. Components that implement read and write memory-mapped transactions require three main building blocks: an address decoder, a register file, and a read multiplexer.

The decoder enables the appropriate 32-bit or 64-bit register for writes. For reads, the address bits drive the multiplexer selection bits. The read signal registers the data from the multiplexer, adding a pipeline stage so that the component can achieve a higher clock frequency.
This slave component has four write wait states and one read wait state. Alternatively, if you want high throughput, you may set both the read and write wait states to zero, and then specify a read latency of one, because the component also supports pipelined reads.

5.2. Using Hierarchy in Systems

You can use hierarchy to sub-divide a system into smaller subsystems that you can then connect in a top-level Platform Designer system. Additionally, if a design contains one or more identical functional units, the functional unit can be defined as a subsystem and instantiated multiple times within a top-level system.
Hierarchy can simplify verification control of slaves connected to each master in a memory-mapped system. Before you implement subsystems in your design, you should plan the system hierarchical blocks at the top-level, using the following guidelines:

- **Plan shared resources**—Determine the best location for shared resources in the system hierarchy. For example, if two subsystems share resources, add the components that use those resources to a higher-level system for easy access.

- **Plan shared address space between subsystems**—Planning the address space ensures you can set appropriate sizes for bridges between subsystems.

- **Plan how much latency you may need to add to your system**—When you add an Avalon-MM Pipeline Bridge between subsystems, you may add latency to the overall system. You can reduce the added latency by parameterizing the bridge with zero cycles of latency, and by turning off the pipeline command and response signals.

**Figure 104. Avalon-MM Pipeline Bridge**
In this example, two Nios II processor subsystems share resources for message passing. Bridges in each subsystem export the Nios II data master to the top-level system that includes the mutex (mutual exclusion component) and shared memory component (which could be another on-chip RAM, or a controller for an off-chip RAM device).
You can also design systems that process multiple data channels by instantiating the same subsystem for each channel. This approach is easier to maintain than a larger, non-hierarchical system. Additionally, such systems are easier to scale because you can calculate the required resources as a multiple of the subsystem requirements.

**Related Information**

Avalon-MM Pipeline Bridge

### 5.3. Using Concurrency in Memory-Mapped Systems

Platform Designer interconnect uses parallel hardware in FPGAs, which allows you to design concurrency into your system and process transactions simultaneously.
5.3.1. Implementing Concurrency With Multiple Masters

Implementing concurrency requires multiple masters in a Platform Designer system. Systems that include a processor contain at least two master interfaces because the processors include separate instruction and data masters. You can categorize master components as follows:

- General purpose processors, such as Nios II processors
- DMA (direct memory access) engines
- Communication interfaces, such as PCI Express

Because Platform Designer generates an interconnect with slave-side arbitration, every master interface in a system can issue transfers concurrently, if they are not posting transfers to the same slave. Concurrency is limited by the number of master interfaces sharing any particular slave interface. If a design requires higher data throughput, you can increase the number of master and slave interfaces to increase the number of transfers that occur simultaneously. The example below shows a system with three master interfaces.

Figure 107. Avalon Multiple Master Parallel Access
In this Avalon example, the DMA engine operates with Avalon-MM read and write masters. The yellow lines represent active simultaneous connections.
Figure 108. AXI Multiple Master Parallel Access

In this example, the DMA engine operates with a single master, because in AXI, the write and read channels on the master are independent and can process transactions simultaneously. There is concurrency between the read and write channels, with the yellow lines representing concurrent datapaths.

5.3.2. Implementing Concurrency With Multiple Slaves

You can create multiple slave interfaces for a particular function to increase concurrency in your design.
In this example, there are two channel processing systems. In the first, four hosts must arbitrate for the single slave interface of the channel processor. In the second, each host drives a dedicated slave interface, allowing all master interfaces to simultaneously access the slave interfaces of the component. Arbitration is not necessary when there is a single host and slave interface.
5.3.3. Implementing Concurrency with DMA Engines

In some systems, you can use DMA engines to increase throughput. You can use a DMA engine to transfer blocks of data between interfaces, which then frees the CPU from doing this task. A DMA engine transfers data between a programmed start and end address without intervention, and the data throughput is dictated by the components connected to the DMA. Factors that affect data throughput include data width and clock frequency.

**Figure 110. Single or Dual DMA Channels**

**Single DMA Channel**
- Maximum of One Read & One Write Per Clock Cycle

**Dual DMA Channels**
- Maximum of Two Reads & Two Writes Per Clock Cycle
In this example, the system can sustain more concurrent read and write operations by including more DMA engines. Accesses to the read and write buffers in the top system are split between two DMA engines, as shown in the Dual DMA Channels at the bottom of the figure.

The DMA engine operates with Avalon-MM write and read masters. An AXI DMA typically has only one master, because in AXI, the write and read channels on the master are independent and can process transactions simultaneously.

5.4. Inserting Pipeline Stages to Increase System Frequency

Platform Designer provides the Limit interconnect pipeline stages to option on the Interconnect Requirements tab to automatically add pipeline stages to the Platform Designer interconnect when you generate a system.

You can specify between 0 to 4 pipeline stages, where 0 means that the interconnect has a combinational datapath. You can specify a unique interconnect pipeline stage value for each subsystem.

Adding pipeline stages may increase the $f_{MAX}$ of the design by reducing the combinational logic depth, at the cost of additional latency and logic utilization.

The insertion of pipeline stages requires certain interconnect components. For example, in a system with a single slave interface, there is no multiplexer; therefore multiplexer pipelining does not occur. When there is an Avalon or AXI single-master to single-slave system, no pipelining occurs, regardless of the Limit interconnect pipeline stages to option.

Related Information
- Interconnect Pipelining on page 414
- Pipelined Avalon-MM Interfaces on page 470
- Creating a System with Platform Designer on page 9

5.5. Using Bridges

You can use bridges to increase system frequency, minimize generated Platform Designer logic, minimize adapter logic, and to structure system topology when you want to control where Platform Designer adds pipelining. You can also use bridges with arbiters when there is concurrency in the system.

An Avalon bridge has an Avalon-MM slave interface and an Avalon-MM master interface. You can have many components connected to the bridge slave interface, or many components connected to the bridge master interface. You can also have a single component connected to a single bridge slave or master interface.

You can configure the data width of the bridge, which can affect how Platform Designer generates bus sizing logic in the interconnect. Both interfaces support Avalon-MM pipelined transfers with variable latency, and can also support configurable burst lengths.

Transfers to the bridge slave interface are propagated to the master interface, which connects to components downstream from the bridge. When you need greater control over interconnect pipelining, you can use bridges instead of the Limit Interconnect Pipeline Stages to option.
Note: You can use Avalon bridges between AXI interfaces, and between Avalon domains. Platform Designer automatically creates interconnect logic between the AXI and Avalon interfaces, so you do not have to explicitly instantiate bridges between these domains. For more discussion about the benefits and disadvantages of shared and separate domains, refer to the Platform Designer Interconnect.

Related Information
- Bridges on page 620
- AMBA 3 APB Protocol Specification Support (version 1.0) on page 421

5.5.1. Using Bridges to Increase System Frequency
In Platform Designer, you can introduce interconnect pipeline stages or pipeline bridges to increase clock frequency in your system. Bridges control the system interconnect topology and allow you to subdivide the interconnect, giving you more control over pipelining and clock crossing functionality.

5.5.1.1. Inserting Pipeline Bridges
You can insert an Avalon-MM pipeline bridge to insert registers in the path between the bridges and its master and slaves. If a critical register-to-register delay occurs in the interconnect, a pipeline bridge can help reduce this delay and improve system $f_{\text{MAX}}$.

The Avalon-MM pipeline bridge component integrates into any Platform Designer system. The pipeline bridge options can increase logic utilization and read latency. The change in topology may also reduce concurrency if multiple masters arbitrate for the bridge. You can use the Avalon-MM pipeline bridge to control topology without adding a pipeline stage. A pipeline bridge that does not add a pipeline stage is optimal in some latency-sensitive applications. For example, a CPU may benefit from minimal latency when accessing memory.

Figure 111. Avalon-MM Pipeline Bridge
5.5.1.1.1. Implementing Command Pipelining (Master-to-Slave)

When multiple masters share a slave device, you can use command pipelining to improve performance.

The arbitration logic for the slave interface must multiplex the address, writedata, and burstcount signals. The multiplexer width increases proportionally with the number of masters connecting to a single slave interface. The increased multiplexer width may become a timing critical path in the system. If a single pipeline bridge does not provide enough pipelining, you can instantiate multiple instances of the bridge in a tree structure to increase the pipelining and further reduce the width of the multiplexer at the slave interface.
5.5.1.1.2. Implementing Response Pipelining (Slave-to-Master)

When masters connect to multiple slaves that support read transfers, you can use slave-to-master pipelining to improve performance.
The interconnect inserts a multiplexer for every read datapath back to the master. As the number of slaves supporting read transfers connecting to the master increases, the width of the read data multiplexer also increases. If the performance increase is insufficient with one bridge, you can use multiple bridges in a tree structure to improve $f_{\text{MAX}}$.

### 5.5.1.2. Using Clock Crossing Bridges

The clock crossing bridge contains a pair of clock crossing FIFOs, which isolate the master and slave interfaces in separate, asynchronous clock domains. Transfers to the slave interface are propagated to the master interface.

When you use a FIFO clock crossing bridge for the clock domain crossing, you add data buffering. Buffering allows pipelined read masters to post multiple reads to the bridge, even if the slaves downstream from the bridge do not support pipelined transfers.

You can also use a clock crossing bridge to place high and low frequency components in separate clock domains. If you limit the fast clock domain to the portion of your design that requires high performance, you may achieve a higher $f_{\text{MAX}}$ for this portion of the design. For example, the majority of processor peripherals in embedded designs do not need to operate at high frequencies, therefore, you do not need to use a high-frequency clock for these components. When you compile a design with the Intel Quartus Prime software, compilation may take more time when the clock frequency requirements are difficult to meet because the Fitter needs more time to place registers to achieve the required $f_{\text{MAX}}$. To reduce the amount of effort that the Fitter uses on low priority and low performance components, you can place these behind a clock crossing bridge operating at a lower frequency, allowing the Fitter to increase the effort placed on the higher priority and higher frequency datapaths.

### 5.5.2. Using Bridges to Minimize Design Logic

Bridges can reduce interconnect logic by reducing the amount of arbitration and multiplexer logic that Platform Designer generates. This reduction occurs because bridges limit the number of concurrent transfers that can occur.

#### 5.5.2.1. Avoiding Speed Optimizations That Increase Logic

You can add an additional pipeline stage with a pipeline bridge between masters and slaves to reduce the amount of combinational logic between registers, which can increase system performance. If you can increase the $f_{\text{MAX}}$ of your design logic, you may be able to turn off the Intel Quartus Prime software optimization settings, such as the Perform register duplication setting. Register duplication creates duplicate registers in two or more physical locations in the FPGA to reduce register-to-register delays. You may also want to choose Speed for the optimization method, which typically results in higher logic utilization due to logic duplication. By making use of the registers or FIFOs available in the bridges, you can increase the design speed and avoid needless logic duplication or speed optimizations, thereby reducing the logic utilization of the design.
5.5.2.2. Limiting Concurrency

The amount of logic generated for the interconnect often increases as the system becomes larger because Platform Designer creates arbitration logic for every slave interface that is shared by multiple master interfaces. Platform Designer inserts multiplexer logic between master interfaces that connect to multiple slave interfaces if both support read datapaths.

Most embedded processor designs contain components that are either incapable of supporting high data throughput, or do not need to be accessed frequently. These components can contain master or slave interfaces. Because the interconnect supports concurrent accesses, you may want to limit concurrency by inserting bridges into the datapath to limit the amount of arbitration and multiplexer logic generated.

For example, if a system contains three master and three slave interfaces that are interconnected, Platform Designer generates three arbiters and three multiplexers for the read datapath. If these masters do not require a significant amount of simultaneous throughput, you can reduce the resources that your design consumes by connecting the three masters to a pipeline bridge. The bridge controls the three slave interfaces and reduces the interconnect into a bus structure. Platform Designer creates one arbitration block between the bridge and the three masters, and a single read datapath multiplexer between the bridge and three slaves, and prevents concurrency. This implementation is similar to a standard bus architecture.

You should not use this method for high throughput datapaths to ensure that you do not limit overall system performance.
5.5.3. Using Bridges to Minimize Adapter Logic

Platform Designer generates adapter logic for clock crossing, width adaptation, and burst support when there is a mismatch between the clock domains, widths, or bursting capabilities of the master and slave interface pairs.

Platform Designer creates burst adapters when the maximum burst length of the master is greater than the master burst length of the slave. The adapter logic creates extra logic resources, which can be substantial when your system contains master interfaces connected to many components that do not share the same characteristics. By placing bridges in your design, you can reduce the amount of adapter logic that Platform Designer generates.

5.5.3.1. Determining Effective Placement of Bridges

To determine the effective placement of a bridge, you should initially analyze each master in your system to determine if the connected slave devices support different bursting capabilities or operate in a different clock domain. The maximum burstcount of a component is visible as the burstcount signal in the HDL file of the component.
The maximum burst length is $2^{(\text{width(burstcount -1)})}$, therefore, if the burstcount width is four bits, the maximum burst length is eight. If no burstcount signal is present, the component does not support bursting or has a burst length of 1.

To determine if the system requires a clock crossing adapter between the master and slave interfaces, check the Clock column for the master and slave interfaces. If the clock is different for the master and slave interfaces, Platform Designer inserts a clock crossing adapter between them. To avoid creating multiple adapters, you can place the components containing slave interfaces behind a bridge so that Platform Designer creates a single adapter. By placing multiple components with the same burst or clock characteristics behind a bridge, you limit concurrency and the number of adapters.

You can also use a bridge to separate AXI and Avalon domains to minimize burst adaptation logic. For example, if there are multiple Avalon slaves that are connected to an AXI master, you can consider inserting a bridge to access the adaptation logic once before the bridge, instead of once per slave. This implementation results in latency, and you would also lose concurrency between reads and writes.

### 5.5.3.2. Changing the Response Buffer Depth

When you use automatic clock-crossing adapters, Platform Designer determines the required depth of FIFO buffering based on the slave properties. If a slave has a high Maximum Pending Reads parameter, the resulting deep response buffer FIFO that Platform Designer inserts between the master and slave can consume a lot of device resources. To control the response FIFO depth, you can use a clock crossing bridge and manually adjust its FIFO depth to trade off throughput with smaller memory utilization.

For example, if you have masters that cannot saturate the slave, you do not need response buffering. Using a bridge reduces the FIFO memory depth and reduces the Maximum Pending Reads available from the slave.

### 5.5.4. Considering the Effects of Using Bridges

Before you use pipeline or clock crossing bridges in a design, you should carefully consider their effects. Bridges can have any combination of consequences on your design, which could be positive or negative. Benchmarking your system before and after inserting bridges can help you determine the impact to the design.

#### 5.5.4.1. Increased Latency

Adding a bridge to a design has an effect on the read latency between the master and the slave. Depending on the system requirements and the type of master and slave, this latency increase may not be acceptable in your design.

#### 5.5.4.1.1. Acceptable Latency Increase

For a pipeline bridge, Platform Designer adds a cycle of latency for each pipeline option that is enabled. The buffering in the clock crossing bridge also adds latency. If you use a pipelined or burst master that posts many read transfers, the increase in latency does not impact performance significantly because the latency increase is very small compared to the length of the data transfer.
For example, if you use a pipelined read master such as a DMA controller to read data from a component with a fixed read latency of four clock cycles, but only perform a single word transfer, the overhead is three clock cycles out of the total of four. This is true when there is no additional pipeline latency in the interconnect. The read throughput is only 25%.

Figure 114. Low-Efficiency Read Transfer

However, if 100 words of data are transferred without interruptions, the overhead is three cycles out of the total of 103 clock cycles. This corresponds to a read efficiency of approximately 97% when there is no additional pipeline latency in the interconnect. Adding a pipeline bridge to this read path adds two extra clock cycles of latency. The transfer requires 105 cycles to complete, corresponding to an efficiency of approximately 94%. Although the efficiency decreased by 3%, adding the bridge may increase the \( f_{MAX} \) by 5%. For example, if the clock frequency can be increased, the overall throughput would improve. As the number of words transferred increases, the efficiency increases to nearly 100%, whether or not a pipeline bridge is present.

Figure 115. High Efficiency Read Transfer

5.5.4.1.2. Unacceptable Latency Increase

Processors are sensitive to high latency read times and typically retrieve data for use in calculations that cannot proceed until the data arrives. Before adding a bridge to the datapath of a processor instruction or data master, determine whether the clock frequency increase justifies the added latency.

A Nios II processor instruction master has a cache memory with a read latency of four cycles, which is eight sequential words of data return for each read. At 100 MHz, the first read takes 40 ns to complete. Each successive word takes 10 ns so that eight reads complete in 110 ns.
Figure 116. Performance of a Nios II Processor and Memory Operating at 100 MHz

Adding a clock crossing bridge allows the memory to operate at 125 MHz. However, this increase in frequency is negated by the increase in latency because if the clock crossing bridge adds six clock cycles of latency at 100 MHz, then the memory continues to operate with a read latency of four clock cycles. Consequently, the first read from memory takes 100 ns, and each successive word takes 10 ns because reads arrive at the frequency of the processor, which is 100 MHz. In total, eight reads complete after 170 ns. Although the memory operates at a higher clock frequency, the frequency at which the master operates limits the throughput.

Figure 117. Performance of a Nios II Processor and Eight Reads with Ten Cycles Latency

5.5.4.2. Limited Concurrency

Placing a bridge between multiple master and slave interfaces limits the number of concurrent transfers your system can initiate. This limitation is the same when connecting multiple master interfaces to a single slave interface. The slave interface of the bridge is shared by all the masters and, as a result, Platform Designer creates arbitration logic. If the components placed behind a bridge are infrequently accessed, this concurrency limitation may be acceptable.

Bridges can have a negative impact on system performance if you use them inappropriately. For example, if multiple memories are used by several masters, you should not place the memory components behind a bridge. The bridge limits memory performance by preventing concurrent memory accesses. Placing multiple memory components behind a bridge can cause the separate slave interfaces to appear as one large memory to the masters accessing the bridge; all masters must access the same slave interface.
A memory subsystem with one bridge that acts as a single slave interface for the Avalon-MM Nios II and DMA masters, which results in a bottleneck architecture. The bridge acts as a bottleneck between the two masters and the memories.

If the $f_{\text{MAX}}$ of your memory interfaces is low and you want to use a pipeline bridge between subsystems, you can place each memory behind its own bridge, which increases the $f_{\text{MAX}}$ of the system without sacrificing concurrency.
5.5.4.3. Address Space Translation

The slave interface of a pipeline or clock crossing bridge has a base address and address span. You can set the base address, or allow Platform Designer to set it automatically. The address of the slave interface is the base offset address of all the components connected to the bridge. The address of components connected to the bridge is the sum of the base offset and the address of that component.

The master interface of the bridge drives only the address bits that represent the offset from the base address of the bridge slave interface. Any time a master accesses a slave through a bridge, both addresses must be added together, otherwise the transfer fails. The Address Map tab displays the addresses of the slaves connected to each master and includes address translations caused by system bridges.
In this example, the Nios II processor connects to a bridge located at base address 0x1000, a slave connects to the bridge master interface at an offset of 0x20, and the processor performs a write transfer to the fourth 32-bit or 64-bit word within the slave. Nios II drives the address 0x102C to interconnect, which is within the address range of the bridge. The bridge master interface drives 0x2C, which is within the address range of the slave, and the transfer completes.

5.5.4.4. Address Coherency

To simplify the system design, all masters should access slaves at the same location. In many systems, a processor passes buffer locations to other mastering components, such as a DMA controller. If the processor and DMA controller do not access the slave at the same location, Platform Designer must compensate for the differences.
resource utilization. Because this second bridge has the same base address as the original bridge, the processor and DMA controller access the slave interface with the same address range.

**Figure 122. Address Translation Corrected With Bridge**

5.6. Increasing Transfer Throughput

Increasing the transfer efficiency of the master and slave interfaces in your system increases the throughput of your design. Designs with strict cost or power requirements benefit from increasing the transfer efficiency because you can then use less expensive, lower frequency devices. Designs requiring high performance also benefit from increased transfer efficiency because increased efficiency improves the performance of frequency-limited hardware.

Throughput is the number of symbols (such as bytes) of data that Platform Designer can transfer in a given clock cycle. Read latency is the number of clock cycles between the address and data phase of a transaction. For example, a read latency of two means that the data is valid two cycles after the address is posted. If the master must wait for one request to finish before the next begins, such as with a processor, then the read latency is very important to the overall throughput.

You can measure throughput and latency in simulation by observing the waveforms, or using the verification IP monitors.

**Related Information**
- Avalon Verification IP Suite User Guide
5.6.1. Using Pipelined Transfers

Pipelined transfers increase the read efficiency by allowing a master to post multiple reads before data from an earlier read returns. Masters that support pipelined transfers post transfers continuously, relying on the `readdatavalid` signal to indicate valid data. Slaves support pipelined transfers by including the `readdatavalid` signal or operating with a fixed read latency.

AXI masters declare how many outstanding writes and reads it can issue with the `writeIssuingCapability` and `readIssuingCapability` parameters. In the same way, a slave can declare how many reads it can accept with the `readAcceptanceCapability` parameter. AXI masters with a read issuing capability greater than one are pipelined in the same way as Avalon masters and the `readdatavalid` signal.

5.6.1.1. Using the Maximum Pending Reads Parameter

If you create a custom component with a slave interface supporting variable-latency reads, you must specify the **Maximum Pending Reads** parameter in the Component Editor. Platform Designer uses this parameter to generate the appropriate interconnect and represent the maximum number of read transfers that your pipelined slave component can process. If the number of reads presented to the slave interface exceeds the **Maximum Pending Reads** parameter, then the slave interface must assert `waitrequest`.

Optimizing the value of the **Maximum Pending Reads** parameter requires an understanding of the latencies of your custom components. This parameter should be based on the component’s highest read latency for the various logic paths inside the component. For example, if your pipelined component has two modes, one requiring two clock cycles and the other five, set the **Maximum Pending Reads** parameter to 5 to allow your component to pipeline five transfers, and eliminating dead cycles after the initial five-cycle latency.

You can also determine the correct value for the **Maximum Pending Reads** parameter by monitoring the number of reads that are pending during system simulation or while running the hardware. To use this method, set the parameter to a high value and use a master that issues read requests on every clock. You can use a DMA for this task if the data is written to a location that does not frequently assert `waitrequest`. If you implement this method, you can observe your component with a logic analyzer or built-in monitoring hardware.

Choosing the correct value for the **Maximum Pending Reads** parameter of your custom pipelined read component is important. If you underestimated the parameter value, you may cause a master interface to stall with a `waitrequest` until the slave responds to an earlier read request and frees a FIFO position.

The **Maximum Pending Reads** parameter controls the depth of the response FIFO inserted into the interconnect for each master connected to the slave. This FIFO does not use significant hardware resources. Overestimating the **Maximum Pending Reads** parameter results in a slight increase in hardware utilization. For these reasons, if you are not sure of the optimal value, you should overestimate this value.

If your system includes a bridge, you must set the **Maximum Pending Reads** parameter on the bridge as well. To allow maximum throughput, this value should be equal to or greater than the **Maximum Pending Reads** value for the connected slave that has the highest value. You can limit the maximum pending reads of a slave and...
reduce the buffer depth by reducing the parameter value on the bridge if the high throughput is not required. If you do not know the Maximum Pending Reads value for all the slave components, you can monitor the number of reads that are pending during system simulation while running the hardware. To use this method, set the Maximum Pending Reads parameter to a high value and use a master that issues read requests on every clock, such as a DMA. Then, reduce the number of maximum pending reads of the bridge until the bridge reduces the performance of any masters accessing the bridge.

5.6.2. Arbitration Shares and Bursts

Arbitration shares provide control over the arbitration process. By default, the arbitration algorithm allocates evenly, with all masters receiving one share.

You can adjust the arbitration process by assigning a larger number of shares to the masters that need greater throughput. The larger the arbitration share, the more transfers are allocated to the master to access a slave. The masters get uninterrupted access to the slave for its number of shares, as long as the master is reading or writing.

If a master cannot post a transfer and other masters are waiting to gain access to a particular slave, the arbiter grants another master access. This mechanism prevents a master from wasting arbitration cycles if it cannot post back-to-back transfers. A bursting transaction contains multiple beats (or words) of data, starting from a single address. Bursts allow a master to maintain access to a slave for more than a single word transfer. If a bursting master posts a write transfer with a burst length of eight, it is guaranteed arbitration for eight write cycles.

You can assign arbitration shares to an Avalon-MM bursting master and AXI masters (which are always considered a bursting master). Each share consists of one burst transaction (such as multi-cycle write), and allows a master to complete a number of bursts before arbitration switches to the next master.

**Related Information**

Arbitration on page 369

5.6.2.1. Differences Between Arbitration Shares and Bursts

The following three key characteristics distinguish arbitration shares and bursts:

- **Arbitration Lock**
- **Sequential Addressing**
- **Burst Adapters**

**Arbitration Lock**

When a master posts a burst transfer, the arbitration is locked for that master; consequently, the bursting master should be capable of sustaining transfers for the duration of the locked period. If, after the fourth write, the master deasserts the write signal (Avalon-MM write or AXI wvalid) for fifty cycles, all other masters continue to wait for access during this stalled period.

To avoid wasted bandwidth, your master designs should wait until a full burst transfer is ready before requesting access to a slave device. Alternatively, you can avoid wasted bandwidth by posting `burstcounts` equal to the amount of data that is ready.
For example, if you create a custom bursting write master with a maximum burstcount of eight, but only three words of data are ready, you can present a burstcount of three. This strategy does not result in optimal use of the system bandwidth if the slave is capable of handling a larger burst; however, this strategy prevents stalling and allows access for other masters in the system.

**Sequential Addressing**

An Avalon-MM burst transfer includes a base address and a burstcount, which represents the number of words of data that are transferred, starting from the base address and incrementing sequentially. Burst transfers are common for processors, DMAs, and buffer processing accelerators; however, sometimes a master must access non-sequential addresses. Consequently, a bursting master must set the burstcount to the number of sequential addresses, and then reset the burstcount for the next location.

The arbitration share algorithm has no restrictions on addresses; therefore, your custom master can update the address it presents to the interconnect for every read or write transaction.

**Burst Adapters**

Platform Designer allows you to create systems that mix bursting and non-bursting master and slave interfaces. This design strategy allows you to connect bursting master and slave interfaces that support different maximum burst lengths, with Platform Designer generating burst adapters when appropriate.

Platform Designer inserts a burst adapter whenever a master interface burst length exceeds the burst length of the slave interface, or if the master issues a burst type that the slave cannot support. For example, if you connect an AXI master to an Avalon slave, a burst adapter is inserted. Platform Designer assigns non-bursting masters and slave interfaces a burst length of one. The burst adapter divides long bursts into shorter bursts. As a result, the burst adapter adds logic to the address and burstcount paths between the master and slave interfaces.

### 5.6.2.2. Choosing Avalon-MM Interface Types

To avoid inefficient Avalon-MM transfers, custom master or slave interfaces must use the appropriate simple, pipelined, or burst interfaces.

#### 5.6.2.2.1. Simple Avalon-MM Interfaces

Simple interface transfers do not support pipelining or bursting for reads or writes; consequently, their performance is limited. Simple interfaces are appropriate for transfers between masters and infrequently used slave interfaces. In Platform Designer, the PIO, UART, and Timer include slave interfaces that use simple transfers.

#### 5.6.2.2.2. Pipelined Avalon-MM Interfaces

Pipelined read transfers allow a pipelined master interface to start multiple read transfers in succession without waiting for prior transfers to complete. Pipelined transfers allow master-slave pairs to achieve higher throughput, even though the slave port may require one or more cycles of latency to return data for each transfer.
In many systems, read throughput becomes inadequate if simple reads are used and pipelined transfers can increase throughput. If you define a component with a fixed read latency, Platform Designer automatically provides the pipelining logic necessary to support pipelined reads. You can use fixed latency pipelining as the default design starting point for slave interfaces. If your slave interface has a variable latency response time, use the readdatavalid signal to indicate when valid data is available. The interconnect implements read response FIFO buffering to handle the maximum number of pending read requests.

To use components that support pipelined read transfers, and to use a pipelined system interconnect efficiently, your system must contain pipelined masters. You can use pipelined masters as the default starting point for new master components. Use the readdatavalid signal for these master interfaces.

Because master and slaves sometimes have mismatched pipeline latency, the interconnect contains logic to reconcile the differences.

Table 107. Pipeline Latency in a Master-Slave Pair

<table>
<thead>
<tr>
<th>Master</th>
<th>Slave</th>
<th>Pipeline Management Logic Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>No pipeline</td>
<td>No pipeline</td>
<td>Platform Designer interconnect does not instantiate logic to handle pipeline latency.</td>
</tr>
<tr>
<td>No pipeline</td>
<td>Pipelined with</td>
<td>Platform Designer interconnect forces the master to wait through any slave-side latency cycles. This</td>
</tr>
<tr>
<td></td>
<td>fixed or variable</td>
<td>master-slave pair gains no benefits from pipelining, because the master waits for each transfer to</td>
</tr>
<tr>
<td></td>
<td>latency</td>
<td>complete before beginning a new transfer. However, while the master is waiting, the slave can accept</td>
</tr>
<tr>
<td></td>
<td>latency</td>
<td>transfers from a different master.</td>
</tr>
<tr>
<td>Pipelined</td>
<td>No pipeline</td>
<td>Platform Designer interconnect carries out the transfer as if neither master nor slave were pipelined,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>causing the master to wait until the slave returns data. An example of a non-pipeline slave is an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>asynchronous off-chip interface.</td>
</tr>
<tr>
<td>Pipelined</td>
<td>Pipelined with</td>
<td>Platform Designer interconnect allows the master to capture data at the exact clock cycle when data</td>
</tr>
<tr>
<td></td>
<td>fixed latency</td>
<td>from the slave is valid, to enable maximum throughput. An example of a fixed latency slave is an on-chip</td>
</tr>
<tr>
<td></td>
<td></td>
<td>memory.</td>
</tr>
<tr>
<td>Pipelined</td>
<td>Pipelined with</td>
<td>The slave asserts a signal when its readdata is valid, and the master captures the data. The master-slave</td>
</tr>
<tr>
<td></td>
<td>variable latency</td>
<td>pair can achieve maximum throughput if the slave has variable latency. Examples of variable latency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>slaves include SDRAM and FIFO memories.</td>
</tr>
</tbody>
</table>

5.6.2.2.3. Burst Avalon-MM Interfaces

Burst transfers are commonly used for latent memories such as SDRAM and off-chip communication interfaces, such as PCI Express. To use a burst-capable slave interface efficiently, you must connect to a bursting master. Components that require bursting to operate efficiently typically have an overhead penalty associated with short bursts or non-bursting transfers.

You can use a burst-capable slave interface if you know that your component requires sequential transfers to operate efficiently. Because SDRAM memories incur a penalty when switching banks or rows, performance improves when SDRAM memories are accessed sequentially with bursts.

Architectures that use the same signals to transfer address and data also benefit from bursting. Whenever an address is transferred over shared address and data signals, the throughput of the data transfer is reduced. Because the address phase adds overhead, using large bursts increases the throughput of the connection.
5.6.2.3. Avalon-MM Burst Master Example

Figure 123. Avalon Bursting Write Master

This example shows the architecture of a bursting write master that receives data from a FIFO and writes the contents to memory. You can use a bursting master as a starting point for your own bursting components, such as custom DMAs, hardware accelerators, or off-chip communication interfaces.

The master performs word accesses and writes to sequential memory locations. When \textit{go} is asserted, the \textit{start_address} and \textit{transfer_length} are registered. On the next clock cycle, the control logic asserts \textit{burst_begin}, which synchronizes the internal control signals in addition to the \textit{master_address} and \textit{master_burstcount} presented to the interconnect. The timing of these two signals is important because during bursting write transfers \textit{byteenable} and \textit{burstcount} must be held constant for the entire burst.

To avoid inefficient writes, the master posts a burst when enough data is buffered in the FIFO. To maximize the burst efficiency, the master should stall only when a slave asserts \textit{waitrequest}. In this example, the FIFO’s used signal tracks the number of words of data that are stored in the FIFO and determines when enough data has been buffered.

The \textit{address} register increments after every word transfer, and the \textit{length} register decrements after every word transfer. The address remains constant throughout the burst. Because a transfer is not guaranteed to complete on burst boundaries, additional logic is necessary to recognize the completion of short bursts and complete the transfer.
5.7. Reducing Logic Utilization

You can minimize logic size of Platform Designer systems. Typically, there is a trade-off between logic utilization and performance. Reducing logic utilization applies to both Avalon and AXI interfaces.

5.7.1. Minimizing Interconnect Logic to Reduce Logic Unitization

In Platform Designer, changes to the connections between master and slave reduce the amount of interconnect logic required in the system.

5.7.1.1. Creating Dedicated Master and Slave Connections to Minimize Interconnect Logic

You can create a system where a master interface connects to a single slave interface. This configuration eliminates address decoding, arbitration, and return data multiplexing, which simplifies the interconnect. Dedicated master-to-slave connections attain the same clock frequencies as Avalon-ST connections.

Typically, these one-to-one connections include an Avalon memory-mapped bridge or hardware accelerator. For example, if you insert a pipeline bridge between a slave and all other master interfaces, the logic between the bridge master and slave interface is reduced to wires. If a hardware accelerator connects only to a dedicated memory, no system interconnect logic is generated between the master and slave pair.

5.7.1.2. Removing Unnecessary Connections to Minimize Interconnect Logic

The number of connections between master and slave interfaces affects the $f_{\text{MAX}}$ of your system. Every master interface that you connect to a slave interface increases the width of the multiplexer width. As a multiplexer width increases, so does the logic depth and width that implements the multiplexer in the FPGA. To improve system performance, connect masters and slaves only when necessary.

When you connect a master interface to many slave interfaces, the multiplexer for the read data signal grows. Avalon typically uses a readdata signal. AXI read data signals add a response status and last indicator to the read response channel using rdata, rresp, and rlast. Additionally, bridges help control the depth of multiplexers.

5.7.1.3. Simplifying Address Decode Logic

If address code logic is in the critical path, you may be able to change the address map to simplify the decode logic. Experiment with different address maps, including a one-hot encoding, to see if results improve.
5.7.2. Minimizing Arbitration Logic by Consolidating Multiple Interfaces

As the number of components in a design increases, the amount of logic required to implement the interconnect also increases. The number of arbitration blocks increases for every slave interface that is shared by multiple master interfaces. The width of the read data multiplexer increases as the number of slave interfaces supporting read transfers increases on a per master interface basis. For these reasons, consider implementing multiple blocks of logic as a single interface to reduce interconnect logic utilization.

5.7.2.1. Logic Consolidation Trade-Offs

You should consider the following trade-offs before making modifications to your system or interfaces:

- Consider the impact on concurrency that results when you consolidate components. When a system has four master components and four slave interfaces, it can initiate four concurrent accesses. If you consolidate the four slave interfaces into a single interface, then the four masters must compete for access. Consequently, you should only combine low priority interfaces such as low speed parallel I/O devices if the combination does not impact the performance.

- Determine whether consolidation introduces new decode and multiplexing logic for the slave interface that the interconnect previously included. If an interface contains multiple read and write address locations, the interface already contains the necessary decode and multiplexing logic. When you consolidate interfaces, you typically reuse the decoder and multiplexer blocks already present in one of the original interfaces; however, combining interfaces may simply move the decode and multiplexer logic, rather than eliminate duplication.

- Consider whether consolidating interfaces makes the design complicated. If so, you should not consolidate interfaces.

Related Information

Using Concurrency in Memory-Mapped Systems on page 449

5.7.2.2. Consolidating Interfaces

In this example, we have a system with a mix of components, each having different burst capabilities: a Nios II/e core, a Nios II/f core, and an external processor, which off-loads some processing tasks to the Nios II/f core.

The Nios II/f core supports a maximum burst size of eight. The external processor interface supports a maximum burst length of 64. The Nios II/e core does not support bursting. The memory in the system is SDRAM with an Avalon maximum burst length of two.
Platform Designer automatically inserts burst adapters to compensate for burst length mismatches. The adapters reduce bursts to a single transfer, or the length of two transfers. For the external processor interface connecting to DDR SDRAM, a burst of 64 words is divided into 32 burst transfers, each with a burst length of two. When you generate a system, Platform Designer inserts burst adapters based on maximum burstcount values; consequently, the interconnect logic includes burst adapters between masters and slave pairs that do not require bursting, if the master is capable of bursts.

In this example, Platform Designer inserts a burst adapter between the Nios II processors and the timer, system ID, and PIO peripherals. These components do not support bursting and the Nios II processor performs a single word read and write accesses to these components.
Figure 125. Mixed Bursting System with Bridges

To reduce the number of adapters, you can add pipeline bridges. The pipeline bridge, between the Nios II/f core and the peripherals that do not support bursts, eliminates three burst adapters from the previous example. A second pipeline bridge between the Nios II/f core and the DDR SDRAM, with its maximum burst size set to eight, eliminates another burst adapter, as shown below.

5.7.3. Reducing Logic Utilization With Multiple Clock Domains

You specify clock domains in Platform Designer on the System Contents tab. Clock sources can be driven by external input signals to Platform Designer, or by PLLs inside Platform Designer. Clock domains are differentiated based on the name of the clock. You can create multiple asynchronous clocks with the same frequency.

Platform Designer generates Clock Domain Crossing (CDC) logic that hides the details of interfacing components operating in different clock domains. The interconnect supports the memory-mapped protocol with each port independently, and therefore
masters do not need to incorporate clock adapters in order to interface to slaves on a different domain. Platform Designer interconnect logic propagates transfers across clock domain boundaries automatically.

Clock-domain adapters provide the following benefits:

- Allows component interfaces to operate at different clock frequencies.
- Eliminates the need to design CDC hardware.
- Allows each memory-mapped port to operate in only one clock domain, which reduces design complexity of components.
- Enables masters to access any slave without communication with the slave clock domain.
- Allows you to focus performance optimization efforts on components that require fast clock speed.

A clock domain adapter consists of two finite state machines (FSM), one in each clock domain, that use a hand-shaking protocol to propagate transfer control signals (read_request, write_request, and the master waitrequest signals) across the clock boundary.

**Figure 126. Clock Crossing Adapter**

This example illustrates a clock domain adapter between one master and one slave. The synchronizer blocks use multiple stages of flipflops to eliminate the propagation of meta-stable events on the control signals that enter the handshake FSMs. The CDC logic works with any clock ratio.
The typical sequence of events for a transfer across the CDC logic is as follows:

- The master asserts address, data, and control signals.
- The master handshake FSM captures the control signals and immediately forces the master to wait. The FSM uses only the control signals, not address and data. For example, the master simply holds the address signal constant until the slave side has safely captured it.
- The master handshake FSM initiates a transfer request to the slave handshake FSM.
- The transfer request is synchronized to the slave clock domain.
- The slave handshake FSM processes the request, performing the requested transfer with the slave.
- When the slave transfer completes, the slave handshake FSM sends an acknowledge back to the master handshake FSM. The acknowledge is synchronized back to the master clock domain.
- The master handshake FSM completes the transaction by releasing the master from the wait condition.

Transfers proceed as normal on the slave and the master side, without a special protocol to handle crossing clock domains. From the perspective of a slave, there is nothing different about a transfer initiated by a master in a different clock domain. From the perspective of a master, a transfer across clock domains simply requires extra clock cycles. Similar to other transfer delay cases (for example, arbitration delay or wait states on the slave side), the Platform Designer forces the master to wait until the transfer terminates. As a result, pipeline master ports do not benefit from pipelining when performing transfers to a different clock domain.

Platform Designer automatically determines where to insert CDC logic based on the system and the connections between components, and places CDC logic to maintain the highest transfer rate for all components. Platform Designer evaluates the need for CDC logic for each master and slave pair independently, and generates CDC logic wherever necessary.

**Related Information**

Avalon Memory-Mapped Design Optimizations

### 5.7.4. Duration of Transfers Crossing Clock Domains

CDC logic extends the duration of master transfers across clock domain boundaries. In the worst case, which is for reads, each transfer is extended by five master clock cycles and five slave clock cycles. Assuming the default value of 2 for the master domain synchronizer length and the slave domain synchronizer length, the components of this delay are the following:

- Four additional master clock cycles, due to the master-side clock synchronizer.
- Four additional slave clock cycles, due to the slave-side clock synchronizer.
- One additional clock in each direction, due to potential metastable events as the control signals cross clock domains.
Note: Systems that require a higher performance clock should use the Avalon-MM clock crossing bridge instead of the automatically inserted CDC logic. The clock crossing bridge includes a buffering mechanism so that multiple reads and writes can be pipelined. After paying the initial penalty for the first read or write, there is no additional latency penalty for pending reads and writes, increasing throughput by up to four times, at the expense of added logic resources.

5.8. Reducing Power Consumption

Platform Designer provides various low power design changes that enable you to reduce the power consumption of the interconnect and custom components.

5.8.1. Reducing Power Consumption With Multiple Clock Domains

When you use multiple clock domains, you should put non-critical logic in the slower clock domain. Platform Designer automatically reconciles data crossing over asynchronous clock domains by inserting clock crossing logic (handshake or FIFO).

You can use clock crossing in Platform Designer to reduce the clock frequency of the logic that does not require a high frequency clock, which allows you to reduce power consumption. You can use either handshaking clock crossing bridges or handshaking clock crossing adapters to separate clock domains.

You can use the clock crossing bridge to connect master interfaces operating at a higher frequency to slave interfaces running at a lower frequency. Only connect low throughput or low priority components to a clock crossing bridge that operates at a reduced clock frequency. The following are examples of low throughput or low priority components:

- PIOs
- UARTs (JTAG or RS-232)
- System identification (SysID)
- Timers
- PLL (instantiated within Platform Designer)
- Serial peripheral interface (SPI)
- EPICS controller
- Tristate bridge and the components connected to the bridge

By reducing the clock frequency of the components connected to the bridge, you reduce the dynamic power consumption of the design. Dynamic power is a function of toggle rates and decreasing the clock frequency decreases the toggle rate.
Figure 127. Reducing Power Utilization Using a Bridge to Separate Clock Domains
Platform Designer automatically inserts clock crossing adapters between master and slave interfaces that operate at different clock frequencies. You can choose the type of clock crossing adapter in the Platform Designer **Project Settings** tab. Adapters do not appear in the **Connections** column because you do not insert them. The following clock crossing adapter types are available in Platform Designer:

- **Handshake**—Uses a simple handshaking protocol to propagate transfer control signals and responses across the clock boundary. This adapter uses fewer hardware resources because each transfer is safely propagated to the target domain before the next transfer begins. The Handshake adapter is appropriate for systems with low throughput requirements.

- **FIFO**—Uses dual-clock FIFOs for synchronization. The latency of the FIFO adapter is approximately two clock cycles more than the handshake clock crossing component, but the FIFO-based adapter can sustain higher throughput because it supports multiple transactions simultaneously. The FIFO adapter requires more resources, and is appropriate for memory-mapped transfers requiring high throughput across clock domains.

- **Auto**—Platform Designer specifies the appropriate FIFO adapter for bursting links and the Handshake adapter for all other links.

Because the clock crossing bridge uses FIFOs to implement the clock crossing logic, it buffers transfers and data. Clock crossing adapters are not pipelined, so that each transaction is blocking until the transaction completes. Blocking transactions may lower the throughput substantially; consequently, if you want to reduce power consumption without limiting the throughput significantly, you should use the clock crossing bridge or the FIFO clock crossing adapter. However, if the design requires single read transfers, a clock crossing adapter is preferable because the latency is lower.

The clock crossing bridge requires few logic resources other than on-chip memory. The number of on-chip memory blocks used is proportional to the address span, data width, buffering depth, and bursting capabilities of the bridge. The clock crossing adapter does not use on-chip memory and requires a moderate number of logic resources. The address span, data width, and the bursting capabilities of the clock crossing adapter determine the resource utilization of the device.

When you decide to use a clock crossing bridge or clock crossing adapter, you must consider the effects of throughput and memory utilization in the design. If on-chip memory resources are limited, you may be forced to choose the clock crossing adapter. Using the clock crossing bridge to reduce the power of a single component may not justify using more resources. However, if you can place all of the low priority components behind a single clock crossing bridge, you may reduce power consumption in the design.

**Related Information**

*Power Optimization*
5.8.2. Reducing Power Consumption by Minimizing Toggle Rates

A Platform Designer system consumes power whenever logic transitions between on and off states. When the state is held constant between clock edges, no charging or discharging occurs. You can use the following design methodologies to reduce the toggle rates of your design:

- Registering component boundaries
- Using clock enable signals
- Inserting bridges

Platform Designer interconnect is uniquely combinational when no adapters or bridges are present and there is no interconnect pipelining. When a slave interface is not selected by a master, various signals may toggle and propagate into the component. By registering the boundary of your component at the master or slave interface, you can minimize the toggling of the interconnect and your component. In addition, registering boundaries can improve operating frequency. When you register the signals at the interface level, you must ensure that the component continues to operate within the interface standard specification.

Avalon-MM waitrequest is a difficult signal to synchronize when you add registers to your component. The waitrequest signal must be asserted during the same clock cycle that a master asserts read or write to in order to prolong the transfer. A master interface can read the waitrequest signal too early and post more reads and writes prematurely.

**Note:** There is no direct AXI equivalent for waitrequest and burstcount, though the AMBA Protocol Specification implies that the AXI ready signal cannot depend combinatorially on the AXI valid signal. Therefore, Platform Designer typically buffers AXI component boundaries for the ready signal.

For slave interfaces, the interconnect manages the begintransfer signal, which is asserted during the first clock cycle of any read or write transfer. If the waitrequest is one clock cycle late, you can logically OR the waitrequest and the begintransfer signals to form a new waitrequest signal that is properly synchronized. Alternatively, the component can assert waitrequest before it is selected, guaranteeing that the waitrequest is already asserted during the first clock cycle of a transfer.
Figure 128. Variable Latency

Using Clock Enables

You can use clock enables to hold the logic in a steady state, and the write and read signals as clock enables for slave components. Even if you add registers to your component boundaries, the interface can potentially toggle without the use of clock enables. You can also use the clock enable to disable combinational portions of the component.

For example, you can use an active high clock enable to mask the inputs into the combinational logic to prevent it from toggling when the component is inactive. Before preventing inactive logic from toggling, you must determine if the masking causes the circuit to function differently. If masking causes a functional failure, it may be possible to use a register stage to hold the combinational logic constant between clock cycles.

Inserting Bridges

You can use bridges to reduce toggle rates, if you do not want to modify the component by using boundary registers or clock enables. A bridge acts as a repeater where transfers to the slave interface are repeated on the master interface. If the bridge is not accessed, the components connected to its master interface are also not accessed. The master interface of the bridge remains idle until a master accesses the bridge slave interface.

Bridges can also reduce the toggle rates of signals that are inputs to other master interfaces. These signals are typically readdata, readdatavalid, and waitrequest. Slave interfaces that support read accesses drive the readdata, readdatavalid, and waitrequest signals. A bridge inserts either a register or clock crossing FIFO between the slave interface and the master to reduce the toggle rate of the master input signals.

5.8.3. Reducing Power Consumption by Disabling Logic

There are typically two types of low power modes: volatile and non-volatile. A volatile low power mode holds the component in a reset state. When the logic is reactivated, the previous operational state is lost. A non-volatile low power mode restores the previous operational state. You can use either software-controlled or hardware-controlled sleep modes to disable a component in order to reduce power consumption.
Software-Controlled Sleep Mode

To design a component that supports software-controlled sleep mode, create a single memory-mapped location that enables and disables logic by writing a zero or one. You can use the register’s output as a clock enable or reset, depending on whether the component has non-volatile requirements. The slave interface must remain active during sleep mode so that the enable bit is set when the component needs to be activated.

If multiple masters can access a component that supports sleep mode, you can use the mutex core to provide mutually exclusive accesses to your component. You can also build in the logic to re-enable the component on the very first access by any master in your system. If the component requires multiple clock cycles to re-activate, then it must assert a wait request to prolong the transfer as it exits sleep mode.

Hardware-Controlled Sleep Mode

Alternatively, you can implement a timer in your component that automatically causes the component to enter a sleep mode based on a timeout value specified in clock cycles between read or write accesses. Each access resets the timer to the timeout value. Each cycle with no accesses decrements the timeout value by one. If the counter reaches zero, the hardware enters sleep mode until the next access.

This example provides a schematic for the hardware-controlled sleep mode. If restoring the component to an active state takes a long time, use a long timeout value so that the component is not continuously entering and exiting sleep mode. The slave interface must remain functional while the rest of the component is in sleep mode. When the component exits sleep mode, the component must assert the \texttt{waitrequest} signal until it is ready for read or write accesses.

Related Information

Mutex Core

5.9. Reset Polarity and Synchronization in Platform Designer

When you add a component interface with a reset signal, Platform Designer defines its polarity as \texttt{reset}(active-high) or \texttt{reset\_n}(active-low).

You can view the polarity status of a reset signal by selecting the signal in the \texttt{Hierarchy} tab, and then view its expanded definition in the open \texttt{Parameters} and \texttt{Block Symbol} tabs. When you generate your component, Platform Designer interconnect automatically inverts polarities as needed.
Each Platform Designer component has its own requirements for reset synchronization. Some blocks have internal synchronization and have no requirements, whereas other blocks require an externally synchronized reset. You can define how resets are synchronized in your Platform Designer system with the **Synchronous edges** parameter. In the clock source or reset bridge component, set the value of the **Synchronous edges** parameter to one of the following, depending on how the reset is externally synchronized:
• **None**—There is no synchronization on this reset.
• **Both**—The reset is synchronously asserted and deasserted with respect to the input clock.
• **Deassert**—The reset is synchronously asserted with respect to the input clock, and asynchronously deasserted.

**Figure 132. Synchronous Edges Parameter**

You can combine multiple reset sources to reset a particular component.

**Figure 133. Combine Multiple Reset Sources**
When you generate your component, Platform Designer inserts adapters to synchronize or invert resets if there are mismatches in polarity or synchronization between the source and destination. You can view inserted adapters on the Memory-Mapped Interconnect tab with the System ➤ Show System with Platform Designer Interconnect command.

5.10. Optimizing Platform Designer System Performance Design Examples

Avalon Pipelined Read Master Example on page 487
Multiplexer Examples on page 489

5.10.1. Avalon Pipelined Read Master Example

For a high throughput system using the Avalon-MM standard, you can design a pipelined read master that allows a system to issue multiple read requests before data returns. Pipelined read masters hide the latency of read operations by posting reads as frequently as every clock cycle. You can use this type of master when the address logic is not dependent on the data returning.

5.10.1.1. Avalon Pipelined Read Master Example Design Requirements

You must carefully design the logic for the control and datapaths of pipelined read masters. The control logic must extend a read cycle whenever the waitrequest signal is asserted. This logic must also control the master address, byteenable,
and read signals. To achieve maximum throughput, pipelined read masters should post reads continuously while \texttt{waitrequest} is deasserted. While read is asserted, the address presented to the interconnect is stored.

The datapath logic includes the \texttt{readdata} and \texttt{readdatavalid} signals. If your master can accept data on every clock cycle, you can register the data with the \texttt{readdatavalid} as an enable bit. If your master cannot process a continuous stream of read data, it must buffer the data in a FIFO. The control logic must stop issuing reads when the FIFO reaches a predetermined fill level to prevent FIFO overflow.

### 5.10.1.2. Expected Throughput Improvement

The throughput improvement that you can achieve with a pipelined read master is typically directly proportional to the pipeline depth of the interconnect and the slave interface. For example, if the total latency is two cycles, you can double the throughput by inserting a pipelined read master, assuming the slave interface also supports pipeline transfers. If either the master or slave does not support pipelined read transfers, then the interconnect asserts \texttt{waitrequest} until the transfer completes. You can also gain throughput when there are some cycles of overhead before a read response.

Where reads are not pipelined, the throughput is reduced. When both the master and slave interfaces support pipelined read transfers, data flows in a continuous stream after the initial latency. You can use a pipelined read master that stores data in a FIFO to implement a custom DMA, hardware accelerator, or off-chip communication interface.

#### Figure 135. Pipelined Read Master
This example shows a pipelined read master that stores data in a FIFO. The master performs word accesses that are word-aligned and reads from sequential memory addresses. The transfer length is a multiple of the word size.

When the go bit is asserted, the master registers the start_address and transfer_length signals. The master begins issuing reads continuously on the next clock cycle until the length register reaches zero. In this example, the word size is four bytes so that the address always increments by four, and the length decrements by four. The read signal remains asserted unless the FIFO fills to a predetermined level. The address register increments and the length register decrements if the length has not reached 0 and a read is posted.

The master posts a read transfer every time the read signal is asserted and the waitrequest is deasserted. The master issues reads until the entire buffer has been read or waitrequest is asserted. An optional tracking block monitors the done bit. When the length register reaches zero, some reads are outstanding. The tracking logic prevents assertion of done until the last read completes, and monitors the number of reads posted to the interconnect so that it does not exceed the space remaining in the readdata FIFO. This example includes a counter that verifies that the following conditions are met:

- If a read is posted and readdatavalid is deasserted, the counter increments.
- If a read is not posted and readdatavalid is asserted, the counter decrements.

When the length register and the tracking logic counter reach zero, all the reads have completed and the done bit is asserted. The done bit is important if a second master overwrites the memory locations that the pipelined read master accesses. This bit guarantees that the reads have completed before the original data is overwritten.

5.10.2. Multiplexer Examples

You can combine adapters with streaming components to create datapaths whose input and output streams have different properties. The following examples demonstrate datapaths in which the output stream exhibits higher performance than the input stream.

The diagram below illustrates a datapath that uses the dual clock version of the on-chip FIFO memory to boost the frequency of input data from 100 MHz to 110 MHz by sampling two input streams at differential rates. The on-chip FIFO memory has an input clock frequency of 100 MHz, and an output clock frequency of 110 MHz. The channel multiplexer runs at 110 MHz and samples one input stream 27.3 percent of the time, and the second 72.7 percent of the time. You must know what the typical and maximum input channel utilizations are before for this type of design. For example, if the first channel hits 50% utilization, the output stream exceeds 100% utilization.
The diagram below illustrates a datapath that uses a data format adapter and Avalon-ST channel multiplexer to merge the 8-bit 100 MHz input from two streaming data sources into a single 16-bit 100 MHz streaming output. This example shows an output with double the throughput of each interface with a corresponding doubling of the data width.

The diagram below illustrates a datapath that uses the dual clock version of the on-chip FIFO memory and Avalon-ST channel multiplexer to merge the 100 MHz input from two streaming data sources into a single 200 MHz streaming output. This example shows an output with double the throughput of each interface with a corresponding doubling of the clock frequency.

5.11. Document Revision History

The table below indicates edits made to the *Optimizing Platform Designer System Performance* content since its creation.
Table 108.  Document Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>2017.11.06</td>
<td>17.1.0</td>
<td>• Changed instances of Qsys Pro to Platform Designer</td>
</tr>
<tr>
<td>2016.10.31</td>
<td>16.1.0</td>
<td>• Implemented Intel rebranding.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Implemented Platform Designer rebranding.</td>
</tr>
<tr>
<td>2015.11.02</td>
<td>15.1.0</td>
<td>• Added: Reset Polarity and Synchronization in Platform Designer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Changed instances of Quartus II to Quartus Prime.</td>
</tr>
<tr>
<td>2015.05.04</td>
<td>15.0.0</td>
<td>Multiplexer Examples, rearranged description text for the figures.</td>
</tr>
<tr>
<td>May 2013</td>
<td>13.0.0</td>
<td>AMBA APB support.</td>
</tr>
<tr>
<td>November 2012</td>
<td>12.1.0</td>
<td>AMBA AXI4 support.</td>
</tr>
<tr>
<td>June 2012</td>
<td>12.0.0</td>
<td>AMBA AXI3 support.</td>
</tr>
<tr>
<td>November 2011</td>
<td>11.1.0</td>
<td>New document release.</td>
</tr>
</tbody>
</table>

Related Information

Documentation Archive

For previous versions of the Intel Quartus Prime Handbook, search the documentation archives.
6. Component Interface Tcl Reference

Tcl commands allow you to perform a wide range of functions in Platform Designer. Command descriptions contain the Platform Designer phases where you can use the command, for example, main program, elaboration, composition, or fileset callback. This reference denotes optional command arguments in brackets [ ].

Note: Intel now refers to Qsys Pro as Platform Designer.

Platform Designer supports Avalon, AMBA 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

For more information about procedures for creating IP component _hw.tcl files in the Platform Designer Component Editor, and supported interface standards, refer to Creating Platform Designer Components and Platform Designer Interconnect.

If you are developing an IP component to work with the Nios II processor, refer to Publishing Component Information to Embedded Software in section 3 of the Nios II Software Developer’s Handbook, which describes how to publish hardware IP component information for embedded software tools, such as a C compiler and a Board Support Package (BSP) generator.

Related Information
- Avalon Interface Specifications
- AMBA Protocol Specifications
- Creating Platform Designer Components on page 305
- Platform Designer Interconnect on page 357
- Publishing Component Information to Embedded Software In Nios II Gen2 Software Developer’s Handbook

6.1. Platform Designer _hw.tcl Command Reference
6. Component Interface Tcl Reference

6.1. Interfaces and Ports

add_interface on page 494
add_interface_port on page 496
get_interfaces on page 498
get_interface_assignment on page 499
get_interface_assignments on page 500
get_interface_ports on page 501
get_interface_properties on page 502
get_interface_property on page 503
get_port_properties on page 504
get_port_property on page 505
set_interface_assignment on page 506
set_interface_property on page 508
set_port_property on page 509
set_interface_upgrade_map on page 510
**6.1.1.1. add_interface**

**Description**
Adds an interface to your module. An interface represents a collection of related signals that are managed together in the parent system. These signals are implemented in the IP component's HDL, or exported from an interface from a child instance. As the IP component author, you choose the name of the interface.

**Availability**
Discovery, Main Program, Elaboration, Composition

**Usage**
\[
\text{add_interface} \ <\text{name}> \ <\text{type}> \ <\text{direction}> \ [\text{<associated_clock>}] \\
\]

**Returns**
No returns value.

**Arguments**

*name*  A name you choose to identify an interface.

*type*  The type of interface.

*direction*  The interface direction.

*associated_clock*  (deprecated) For interfaces requiring associated clocks, use:
\[
\text{set_interface_property} \ <\text{interface}> \ associatedClock \ <\text{clockInterface}> \\
\]

For interfaces requiring associated resets, use:
\[
\text{set_interface_property} \ <\text{interface}> \ associatedReset \ <\text{resetInterface}> \\
\]

**Example**

\[
\begin{align*}
\text{add_interface} \ &\text{mm_slave} \text{ avalon} \text{ slave} \\
\text{add_interface} \ &\text{my_export} \text{ conduit} \text{ end} \\
\text{set_interface_property} \ &\text{my_export} \text{ EXPORT_OF} \text{ uart_0.external_connection}
\end{align*}
\]

**Notes**
By default, interfaces are enabled. You can set the interface property `ENABLED` to `false` to disable an interface. If an interface is disabled, it is hidden and its ports are automatically terminated to their default values. Active high signals are terminated to 0. Active low signals are terminated to 1.

If the IP component is composed of child instances, the top-level interface is associated with a child instance's interface with `set_interface_property interface EXPORT_OF child_instance.interface`.

The following direction rules apply to Platform Designer-supported interfaces.
### Interface Type | Direction
---|---
avalon | master, slave
axi | master, slave
tristate_conduit | master, slave
avalon_streaming | source, sink
interrupt | sender, receiver
conduit | end
clock | source, sink
reset | source, sink
nios_custom_instruction | slave

**Related Information**
- [add_interface_port](#) on page 496
- [get_interface_assignments](#) on page 500
- [get_interface_properties](#) on page 502
- [get_interfaces](#) on page 498
6.1.1.2. add_interface_port

**Description**

Adds a port to an interface on your module. The name must match the name of a signal on the top-level module in the HDL of your IP component. The port width and direction must be set before the end of the elaboration phase. You can set the port width as follows:

- In the Main program, you can set the port width to a fixed value or a width expression.
- If the port width is set to a fixed value in the Main program, you can update the width in the elaboration callback.

**Availability**

Main Program, Elaboration

**Usage**

```
add_interface_port <interface> <port> [<signal_type> <direction> <width_expression>]
```

**Returns**

**Arguments**

- **interface**  The name of the interface to which this port belongs.
- **port**  The name of the port. This name must match a signal in your top-level HDL for this IP component.
- **signal_type** (optional)  The type of signal for this port, which must be unique. Refer to the Avalon Interface Specifications for the signal types available for each interface type.
- **direction** (optional)  The direction of the signal. Refer to Direction Properties.
- **width_expression** (optional)  The width of the port, in bits. The width may be a fixed value, or a simple arithmetic expression of parameter values.

**Example**

**fixed width:**
```
add_interface_port mm_slave s0_rdata readdata output 32
```

**width expression:**
```
add_parameter DATA_WIDTH INTEGER 32
add_interface_port s0 rdata readdata output "DATA_WIDTH/2"
```

**Related Information**

- add_interface on page 494
- get_port_properties on page 504
• get_port_property on page 505
• get_port_property on page 505
• Direction Properties on page 598
• Avalon Interface Specifications
6.1.1.3. get_interfaces

Description
Returns a list of top-level interfaces.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_interfaces

Returns
A list of the top-level interfaces exported from the system.

Arguments
No arguments.

Example
get_interfaces

Related Information
add_interface on page 494
6.1.1.4. get_interface_assignment

Description
Returns the value of the specified assignment for the specified interface.

Availability
Main Program, Elaboration, Validation, Composition

Usage
get_interface_assignment <interface> <assignment>

Returns
The value of the assignment.

Arguments

interface  The name of a top-level interface.

assignment  The name of an assignment.

Example

```
get_interface_assignment s1 embeddedsw.configuration.isFlash
```

Related Information
- add_interface on page 494
- get_interface_assignments on page 500
- get_interfaces on page 498
6.1.1.5. get_interface_assignments

Description
Returns the value of all interface assignments for the specified interface.

Availability
Main Program, Elaboration, Validation, Composition

Usage
get_interface_assignments <interface>

Returns
A list of assignment keys.

Arguments

interface The name of the top-level interface whose assignment is being retrieved.

Example
get_interface_assignments s1

Related Information
• add_interface on page 494
• get_interface_assignment on page 499
• get_interfaces on page 498
6.1.1.6. get_interface_ports

Description
Returns the names of all of the ports that have been added to a given interface. If the interface name is omitted, all ports for all interfaces are returned.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_interface_ports [<interface>]

Returns
A list of port names.

Arguments

interface (optional)  The name of a top-level interface.

Example

get_interface_ports mm_slave

Related Information
• add_interface_port on page 496
• get_port_property on page 505
• set_port_property on page 509
6.1.1.7. get_interface_properties

**Description**
Returns the names of all the interface properties for the specified interface as a space separated list

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_interface_properties <interface>

**Returns**
A list of properties for the interface.

**Arguments**

interface  The name of an interface.

**Example**

```
get_interface_properties interface
```

**Notes**
The properties for each interface type are different. Refer to the Avalon Interface Specifications for more information about interface properties.

**Related Information**
- get_interface_property on page 503
- set_interface_property on page 508
- Avalon Interface Specifications
6.1.1.8. get_interface_property

Description
Returns the value of a single interface property from the specified interface.

Availability
Discovery, Main Program, Elaboration, Composition, Fileset Generation

Usage
get_interface_property <interface> <property>

Returns

Arguments

interface  The name of an interface.

property  The name of the property whose value you want to retrieve. Refer to Interface Properties.

Example

```
get_interface_property mm_slave linewrapBursts
```

Notes
The properties for each interface type are different. Refer to the Avalon Interface Specifications for more information about interface properties.

Related Information

- get_interface_properties on page 502
- set_interface_property on page 508
- Avalon Interface Specifications
6.1.1.9. get_port_properties

Description
Returns a list of port properties.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_port_properties

Returns
A list of port properties. Refer to Port Properties.

Arguments
No arguments.

Example

```
get_port_properties
```

Related Information
- add_interface_port on page 496
- get_port_property on page 505
- set_port_property on page 509
- Port Properties on page 596
6.1.1.10. get_port_property

Description
Returns the value of a property for the specified port.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_port_property <port> <property>

Returns
The value of the property.

Arguments

port    The name of the port.

property    The name of a port property. Refer to Port Properties.

Example

get_port_property rdata WIDTH_VALUE

Related Information
• add_interface_port on page 496
• get_port_properties on page 504
• set_port_property on page 509
• Port Properties on page 596
6.1.11. set_interface_assignment

**Description**
Sets the value of the specified assignment for the specified interface.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
set_interface_assignment <interface> <assignment> [value]

**Returns**
No return value.

**Arguments**

- **interface**  The name of the top-level interface whose assignment is being set.
- **assignment**  The assignment whose value is being set.
- **value (optional)**  The new assignment value.

**Example**

```
set_interface_assignment s1 embeddedsw.configuration.isFlash 1
```

**Notes**

**Assignments for Nios II Software Build Tools**
Interface assignments provide extra data for the Nios II Software Build Tools working with the generated system.

**Assignments for Platform Designer Tools**
There are several assignments that guide behavior in the Platform Designer tools.

- **qs.sys.ui.export_name:**  If present, this interface should always be exported when an instance is added to a Platform Designer system. The value is the requested name of the exported interface in the parent system.

- **qs.sys.ui.connect:**  If present, this interface should be auto-connected when an instance is added to a Platform Designer system. The value is a comma-separated list of other interfaces on the same instance that should be connected with this interface.
ui.blockdiagram.direction: If present, the direction of this interface in the block diagram is set by the user. The value is either "output" or "input".

Related Information
- add_interface on page 494
- get_interface_assignment on page 499
- get_interface_assignments on page 500
6.1.1.12. set_interface_property

**Description**
Sets the value of a property on an exported top-level interface. You can use this command to set the EXPORT_OF property to specify which interface of a child instance is exported via this top-level interface.

**Availability**
Main Program, Elaboration, Composition

**Usage**
set_interface_property <interface> <property> <value>

**Returns**
No return value.

**Arguments**
- **interface**  The name of an exported top-level interface.
- **property**   The name of the property Refer to Interface Properties.
- **value**      The new property value.

**Example**
```
set_interface_property clk_out EXPORT_OF clk.clk_out
set_interface_property mm_slave linewrapBursts false
```

**Notes**
The properties for each interface type are different. Refer to the Avalon Interface Specifications for more information about interface properties.

**Related Information**
- get_interface_properties on page 502
- get_interface_property on page 503
- Interface Properties on page 590
- Avalon Interface Specifications
6.1.1.13. set_port_property

**Description**
Sets a port property.

**Availability**
Elaboration

**Usage**
set_port_property <port> <property> [<_value>]  

**Returns**
The new value.

**Arguments**

*port* The name of the port.

*property* One of the supported properties. Refer to *Port Properties*.

*value (optional)* The value to set.

**Example**

```
set_port_property rdata WIDTH 32
```

**Related Information**

- [add_interface_port](#) on page 496  
- [get_port_properties](#) on page 504  
- [set_port_property](#) on page 509
6.1.1.14. set_interface_upgrade_map

Description
Maps the interface name of an older version of an IP core to the interface name of the current IP core. The interface type must be the same between the older and newer versions of the IP cores. This allows system connections and properties to maintain proper functionality. By default, if the older and newer versions of IP core have the same name and type, then Platform Designer maintains all properties and connections automatically.

Availability
Parameter Upgrade

Usage

```
set_interface_upgrade_map { <old_interface_name> <new_interface_name>
<old_interface_name_2> <new_interface_name_2> ... }
```

Returns
No return value.

Arguments

- `{ <old_interface_name> <new_interface_name>}` List of mappings between between names of older and newer interfaces.

Example

```
set_interface_upgrade_map { avalon_master_interface
new_avalon_master_interface }
```
6. Component Interface Tcl Reference

6.1.2. Parameters

add_parameter on page 512
get_parameters on page 513
get_parameter_properties on page 514
get_parameter_property on page 515
get_parameter_value on page 516
get_string on page 517
load_strings on page 518
set_parameter_property on page 519
set_parameter_value on page 520
decode_address_map on page 521
6.1.2.1. add_parameter

**Description**
Adds a parameter to your IP component.

**Availability**
Main Program

**Usage**
add_parameter <name> <type> [default_value <description>]

**Returns**

**Arguments**

name The name of the parameter.

type The data type of the parameter Refer to Parameter Type Properties.

default_value (optional) The initial value of the parameter in a new instance of the IP component.

description (optional) Explains the use of the parameter.

**Example**

```
add_parameter seed INTEGER 17 "The seed to use for data generation."
```

**Notes**
Most parameter types have a single GUI element for editing the parameter value. string_list and integer_list parameters are different, because they are edited as tables. A multi-column table can be created by grouping multiple into a single table. To edit multiple list parameters in a single table, the display items for the parameters must be added to a group with a TABLE hint:

```tcl
add_parameter coefficients INTEGER_LIST add_parameter positions INTEGER_LIST
add_display_item "Table Group" coefficients PARAMETER
add_display_item "Table Group" positions PARAMETER
```

**Related Information**
- get_parameter_properties on page 514
- get_parameter_property on page 515
- get_parameter_value on page 516
- set_parameter_property on page 519
- set_parameter_value on page 520
- Parameter Type Properties on page 594
6.1.2.2. get_parameters

Description
Returns the names of all the parameters in the IP component.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_parameters

Returns
A list of parameter names

Arguments
No arguments.

Example

get_parameters

Related Information
- add_parameter on page 512
- get_parameter_property on page 515
- get_parameter_value on page 516
- get_parameters on page 513
- set_parameter_property on page 519
6.1.2.3. get_parameter_properties

**Description**
Returns a list of all the parameter properties as a list of strings. The `get_parameter_property` and `set_parameter_property` commands are used to get and set the values of these properties, respectively.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_parameter_properties

**Returns**
A list of parameter property names. Refer to *Parameter Properties*.

**Arguments**
No arguments.

**Example**
```
set property_summary [ get_parameter_properties ]
```

**Related Information**
- `add_parameter` on page 512
- `get_parameter_property` on page 515
- `get_parameter_value` on page 516
- `get_parameters` on page 513
- `set_parameter_property` on page 519
- *Parameter Properties* on page 592
6.1.2.4. get_parameter_property

Description
Returns the value of a property of a parameter.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_parameter_property <parameter> <property>

Returns
The value of the property.

Arguments

-parameter The name of the parameter whose property value is being retrieved.

-property The name of the property. Refer to Parameter Properties.

Example

set enabled [ get_parameter_property parameter1 ENABLED ]

Related Information
- add_parameter on page 512
- get_parameter_properties on page 514
- get_parameter_value on page 516
- get_parameters on page 513
- set_parameter_property on page 519
- set_parameter_value on page 520
- Parameter Properties on page 592
6.1.2.5. get_parameter_value

Description
Returns the current value of a parameter defined previously with the add_parameter command.

Availability
Discovery, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_parameter_value <parameter>

Returns
The value of the parameter.

Arguments

parameter  The name of the parameter whose value is being retrieved.

Example

```tcl
set width [ get_parameter_value fifo_width ]
```

Notes
If AFFECTS_ELABORATION is false for a given parameter, get_parameter_value is not available for that parameter from the elaboration callback. If AFFECTS_GENERATION is false then it is not available from the generation callback.

Related Information

- add_parameter on page 512
- get_parameter_property on page 515
- get_parameters on page 513
- set_parameter_property on page 519
- set_parameter_value on page 520
6.1.2.6. get_string

**Description**
Returns the value of an externalized string previously loaded by the `load_strings` command.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
`get_string <identifier>`

**Returns**
The externalized string.

**Arguments**

*identifier* The string identifier.

**Example**

```
hw.tcl:
load_strings test.properties
set_module_property NAME test
set_module_property VERSION [get_string VERSION]
set_module_property DISPLAY_NAME [get_string DISPLAY_NAME]
add_parameter firepower INTEGER 0 **
set_parameter_property firepower DISPLAY_NAME [get_string PARAM_DISPLAY_NAME]
set_parameter_property firepower TYPE INTEGER
set_parameter_property firepower DESCRIPTION [get_string PARAM_DESCRIPTION]
test.properties:
DISPLAY_NAME = Trogdor!
VERSION = 1.0
PARAM_DISPLAY_NAME = Firepower
PARAM_DESCRIPTION = The amount of force to use when breathing fire.
```

**Notes**
Use uppercase words separated with underscores to name string identifiers. If you are externalizing module properties, use the module property name for the string identifier:

```
set_module_property DISPLAY_NAME [get_string DISPLAY_NAME]
```

If you are externalizing a parameter property, qualify the parameter property with the parameter name, with uppercase format, if needed:

```
set_parameter_property my_param DISPLAY_NAME [get_string MY_PARAM_DISPLAY_NAME]
```

If you use a string to describe a string format, end the identifier with `_FORMAT`.

```
set formatted_string { format { get_string TWO_ARGUMENT_MESSAGE_FORMAT } "arg1" "arg2" }
```

**Related Information**
`load_strings` on page 518
6.1.2.7. load_strings

Description
Loads strings from an external .properties file.

Availability
Discovery, Main Program

Usage
load_strings <path>

Returns
No return value.

Arguments

path  The path to the properties file.

Example

hw.tcl:
load_strings test.properties
set_module_property NAME test
set_module_property VERSION [get_string VERSION]
set_module_property DISPLAY_NAME [get_string DISPLAY_NAME]
add_parameter firepower INTEGER 0 ""
set_parameter_property firepower DISPLAY_NAME [get_string PARAM_DISPLAY_NAME]
set_parameter_property firepower TYPE INTEGER
set_parameter_property firepower DESCRIPTION [get_string PARAM_DESCRIPTION]

test.properties:
DISPLAY_NAME = Trogdor!
VERSION = 1.0
PARAM_DISPLAY_NAME = Firepower
PARAM_DESCRIPTION = The amount of force to use when breathing fire.

Notes
Refer to the Java Properties File for properties file format. A .properties file is a
text file with KEY=value pairs. For externalized strings, the KEY is a string identifier
and the value is the externalized string.
For example:

TROGDOR = A dragon with a big beefy arm

Related Information

- get_string on page 517
- Java Properties File
6.1.2.8. set_parameter_property

Description
Sets a single parameter property.

Availability
Main Program, Edit, Elaboration, Validation, Composition

Usage
set_parameter_property <parameter> <property> <value>

Returns

Arguments

parameter  The name of the parameter that is being set.

property  The name of the property. Refer to Parameter Properties.

value  The new value for the property.

Example

```tcl
set_parameter_property BAUD_RATE ALLOWED_RANGES {9600 19200 38400}
```

Related Information
- add_parameter on page 512
- get_parameter_properties on page 514
- set_parameter_property on page 519
- Parameter Properties on page 592
6.1.2.9. set_parameter_value

**Description**
Sets a parameter value. The value of a derived parameter can be updated by the IP component in the elaboration callback or the edit callback. Any changes to the value of a derived parameter in the edit callback is not preserved.

**Availability**
Edit, Elaboration, Validation, Composition, Parameter Upgrade

**Usage**
set_parameter_value <parameter> <value>

**Returns**
No return value.

**Arguments**

*parameter*  The name of the parameter that is being set.

*value*  Specifies the new parameter value.

**Example**

```
set_parameter_value half_clock_rate [ expr { [ get_parameter_value clock_rate ] / 2 } ]
```
6.1.2.10. decode_address_map

**Description**
Converts an XML-formatted address map into a list of Tcl lists. Each inner list is in the correct format for conversion to an array. The XML code that describes each slave includes: its name, start address, and end address.

**Availability**
Elaboration, Generation, Composition

**Usage**
decode_address_map <address_map_XML_string>

**Returns**
No return value.

**Arguments**

*address_mapXML_string*  An XML string that describes the address map of a master.

**Example**
In this example, the code describes the address map for the master that accesses the ext_ssram, sys_clk_timer and sysid slaves. The format of the string may differ from the example below; it may have different white space between the elements and include additional attributes or elements. Use the decode_address_map command to decode the code that represents a master’s address map to ensure that your code works with future versions of the address map.

```
<address-map>
  <slave name='ext_ssram' start='0x01000000' end='0x01200000' />
  <slave name='sys_clk_timer' start='0x02120800' end='0x02120820' />
  <slave name='sysid' start='0x021208B8' end='0x021208C0' />
</address-map>
```

**Note:** Intel recommends that you use the code provided below to enumerate over the IP components within an address map, rather than writing your own parser.

```
set address_map_xml [get_parameter_value my_map_param]
set address_map_dec [decode_address_map $address_map_xml]
foreach i [address_map_dec] {
    array set info $i
    send_message info "Connected to slave $info(name)"
}
```
6.1.3. Display Items

- `add_display_item` on page 523
- `get_display_items` on page 525
- `get_display_item_properties` on page 526
- `get_display_item_property` on page 527
- `set_display_item_property` on page 528
6.1.3.1. add_display_item

Description
Specifies the following aspects of the IP component display:

- Creates logical groups for an IP component's parameters. For example, to create separate groups for the IP component's timing, size, and simulation parameters. An IP component displays the groups and parameters in the order that you specify the display items in the _hw.tcl file.
- Groups a list of parameters to create multi-column tables.
- Specifies an image to provide representation of a parameter or parameter group.
- Creates a button by adding a display item of type action. The display item includes the name of the callback to run.

Availability
Main Program

Usage
add_display_item <parent_group> <id> <type> [<args>]

Returns

Arguments

parent_group   Specifies the group to which a display item belongs

id   The identifier for the display item. If the item being added is a parameter, this is the parameter name. If the item is a group, this is the group name.

type   The type of the display item. Refer to Display Item Kind Properties.

args (optional)   Provides extra information required for display items.

Example

add_display_item "Timing" read_latency PARAMETER
add_display_item "Sounds" speaker_image_id ICON speaker.jpg
Notes

The following examples illustrate further illustrate the use of arguments:

- `add_display_item groupName id icon path-to-image-file`
- `add_display_item groupName parameterName parameter`
- `add_display_item groupName id text "your-text"`
  The `your-text` argument is a block of text that is displayed in the GUI. Some simple HTML formatting is allowed, such as `<b>` and `<i>`, if the text starts with `<html>`.
- `add_display_item parentGroupName childGroupName group [tab]`
  The tab is an optional parameter. If present, the group appears in separate tab in the GUI for the instance.
- `add_display_item parentGroupName actionName action buttonClickCallbackProc`

Related Information

- `get_display_item_properties` on page 526
- `get_display_item_property` on page 527
- `get_display_items` on page 525
- `set_display_item_property` on page 528
- Display Item Kind Properties on page 600
6.1.3.2. get_display_items

**Description**
Returns a list of all items to be displayed as part of the parameterization GUI.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_display_items

**Returns**
List of display item IDs.

**Arguments**
No arguments.

**Example**

```
get_display_items
```

**Related Information**
- [add_display_item on page 523](#)
- [get_display_item_properties on page 526](#)
- [get_display_item_property on page 527](#)
- [set_display_item_property on page 528](#)
6.1.3.3. get_display_item_properties

Description
Returns a list of names of the properties of display items that are part of the parameterization GUI.

Availability
Main Program

Usage
get_display_item_properties

Returns
A list of display item property names. Refer to Display Item Properties.

Arguments
No arguments.

Example
get_display_item_properties

Related Information
- add_display_item on page 523
- get_display_item_property on page 527
- set_display_item_property on page 528
- Display Item Properties on page 599
6.1.3.4. get_display_item_property

**Description**
Returns the value of a specific property of a display item that is part of the parameterization GUI.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
geet_display_item_property <display_item> <property>

**Returns**
The value of a display item property.

**Arguments**

display_item  The id of the display item.

property      The name of the property. Refer to Display Item Properties.

**Example**

```
set my_label [get_display_item_property my_action DISPLAY_NAME]
```

**Related Information**
- add_display_item on page 523
- get_display_item_properties on page 526
- get_display_items on page 525
- set_display_item_property on page 528
- Display Item Properties on page 599
6.1.3.5. set_display_item_property

Description
Sets the value of specific property of a display item that is part of the parameterization GUI.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Composition

Usage
set_display_item_property <display_item> <property> <value>

Returns
No return value.

Arguments

display_item  The name of the display item whose property value is being set.

property  The property that is being set. Refer to Display Item Properties.

value  The value to set.

Example

```tcl
set_display_item_property my_action DISPLAY_NAME "Click Me"
set_display_item_property my_action DESCRIPTION "clicking this button runs the click_me_callback proc in the hw.tcl file"
```

Related Information

- add_display_item on page 523
- get_display_item_properties on page 526
- get_display_item_property on page 527
- Display Item Properties on page 599
6.1.4. Module Definition

add_documentation_link on page 530
get_module_assignment on page 531
get_module_assignments on page 532
get_module_ports on page 533
get_module_properties on page 534
get_module_property on page 535
send_message on page 536
set_module_assignment on page 537
set_module_property on page 538
add_hdl_instance on page 539
package on page 540
6.1.4.1. add_documentation_link

Description
Allows you to link to documentation for your IP component.

Availability
Discovery, Main Program

Usage
add_documentation_link <title> <path>

Returns
No return value.

Arguments

title The title of the document for use on menus and buttons.

path A path to the IP component documentation, using a syntax that provides the entire URL, not a relative path. For example: http://www.mydomain.com/my_memory_controller.html or file:///datasheet.txt

Example

```
```
6.1.4.2. get_module_assignment

**Description**
This command returns the value of an assignment. You can use the `get_module_assignment` and `set_module_assignment` and the `get_interface_assignment` and `set_interface_assignment` commands to provide information about the IP component to embedded software tools and applications.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
get_module_assignment <assignment>

**Returns**
The value of the assignment

**Arguments**

*assignment*  The name of the assignment whose value is being retrieved

**Example**

```tcl
get_module_assignment embeddedsw.CMacro.colorSpace
```

**Related Information**
- [get_module_assignments](#) on page 532
- [set_module_assignment](#) on page 537
6.1.4.3. get_module_assignments

**Description**
Returns the names of the module assignments.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
get_module_assignments

**Returns**
A list of assignment names.

**Arguments**
No arguments.

**Example**

```tcl
get_module_assignments
```

**Related Information**
- [get_module_assignment](#) on page 531
- [set_module_assignment](#) on page 537
6.1.4.4. get_module_ports

**Description**
Returns a list of the names of all the ports which are currently defined.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_module_ports

**Returns**
A list of port names.

**Arguments**
No arguments.

**Example**
```
get_module_ports
```

**Related Information**
- `add_interface` on page 494
- `add_interface_port` on page 496
6.1.4.5. **get_module_properties**

**Description**
Returns the names of all the module properties as a list of strings. You can use the `get_module_property` and `set_module_property` commands to get and set values of individual properties. The value returned by this command is always the same for a particular version of Platform Designer.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
`get_module_properties`

**Returns**
List of strings. Refer to *Module Properties*.

**Arguments**
No arguments.

**Example**
```tcl
get_module_properties
```

**Related Information**
- `get_module_property` on page 535
- `set_module_property` on page 538
- *Module Properties* on page 602
6.1.4.6. get_module_property

**Description**
Returns the value of a single module property.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_module_property <property>

**Returns**
Various.

**Arguments**

property  The name of the property, Refer to Module Properties.

**Example**

```
set my_name [ get_module_property NAME ]
```

**Related Information**
- get_module_properties on page 534
- set_module_property on page 538
- Module Properties on page 602
6.1.4.7. send_message

Description
Sends a message to the user of the IP component. The message text is normally interpreted as HTML. You can use the `<b>` element to provide emphasis. If you do not want the message text to be interpreted as HTML, then pass a list as the message level, for example, `{ Info Text }.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
send_message <level> <message>

Returns
No return value.

Arguments

level  The following message levels are supported:

- **ERROR**--Provides an error message. The Platform Designer system cannot be generated with existing error messages.
- **WARNING**--Provides a warning message.
- **INFO**--Provides an informational message. The INFO level is not available in the Main Program.
- **PROGRESS**--Reports progress during generation.
- **DEBUG**--Provides a debug message when debug mode is enabled.

message  The text of the message.

Example

```tcl
send_message ERROR "The system is down!"
send_message { Info Text } "The system is up!"
```
6.1.4.8. set_module_assignment

Description
Sets the value of the specified assignment.

Availability
Main Program, Elaboration, Validation, Composition

Usage
set_module_assignment <assignment> [<value>]

Returns
No return value.

Arguments

assignment  The assignment whose value is being set

value (optional)  The value of the assignment

Example

set_module_assignment embeddedsw.CMacro.colorSpace CMYK

Related Information

- get_module_assignment on page 531
- get_module_assignments on page 532
6.1.4.9. set_module_property

**Description**
Allows you to set the values for module properties.

**Availability**
Discovery, Main Program

**Usage**
set_module_property <property> <value>

**Returns**
No return value.

**Arguments**

*property*  The name of the property. Refer to Module Properties.

*value*  The new value of the property.

**Example**

```
set_module_property VERSION 10.0
```

**Related Information**

- [get_module_properties](#) on page 534
- [get_module_property](#) on page 535
- Module Properties on page 602
6.1.4.10. *add_hdl_instance*

**Description**
Adds an instance of a predefined module, referred to as a *child* or *child instance*. The HDL entity generated from this instance can be instantiated and connected within this IP component’s HDL.

**Availability**
Main Program, Elaboration, Composition

**Usage**

```
add_hdl_instance <entity_name> <ip_core_type> [<version>]
```

**Returns**
The entity name of the added instance.

**Arguments**

- **entity_name** Specifies a unique local name that you can use to manipulate the instance. This name is used in the generated HDL to identify the instance.

- **ip_core_type** The type refers to a kind of instance available in the IP Catalog, for example `altera_avalon_uart`.

- **version (optional)** The required version of the specified instance type. If no version is specified, the latest version is used.

**Example**

```
add_hdl_instance my_uart altera_avalon_uart
```

**Related Information**

- `get_instance_parameter_value` on page 557
- `get_instance_parameters` on page 555
- `get_instances` on page 547
- `set_instance_parameter_value` on page 560
### 6.1.4.11. package

**Description**
Allows you to specify a particular version of the Platform Designer software to avoid software compatibility issues, and to determine which version of the `_hw.tcl` API to use for the IP component. You must use the package command at the beginning of your `_hw.tcl` file.

**Availability**
Main Program

**Usage**
```tcl
package require -exact qsys <version>
```

**Returns**
No return value

**Arguments**

*version*  The version of Platform Designer that you require, such as 14.1.

**Example**
```tcl
package require -exact qsys 14.1
```
6.1.5. Composition

- `add_instance` on page 542
- `add_connection` on page 543
- `get_connections` on page 544
- `get_connection_parameters` on page 545
- `get_connection_parameter_value` on page 546
- `get_instances` on page 547
- `get_instance_interfaces` on page 548
- `get_instance_interface_ports` on page 549
- `get_instance_interface_properties` on page 550
- `get_instance_property` on page 551
- `set_instance_property` on page 552
- `get_instance_properties` on page 553
- `get_instance_interface_property` on page 554
- `get_instance_parameters` on page 555
- `get_instance_parameter_property` on page 556
- `get_instance_parameter_value` on page 557
- `get_instance_port_property` on page 558
- `set_connection_parameter_value` on page 559
- `set_instance_parameter_value` on page 560
6.1.5.1. add_instance

**Description**
Adds an instance of an IP component, referred to as a child or child instance to the subsystem. You can use this command to create IP components that are composed of other IP component instances. The HDL for this subsystem generates; There is no need to write custom HDL for the IP component.

**Availability**
Main Program, Composition

**Usage**
add_instance <name> <type> [version]

**Returns**
No return value.

**Arguments**

`name` Specifies a unique local name that you can use to manipulate the instance. This name is used in the generated HDL to identify the instance.

`type` The type refers to a type available in the IP Catalog, for example `altera_avalon_uart`.

`version (optional)` The required version of the specified type. If no version is specified, the highest available version is used.

**Example**

```
add_instance my_uart altera_avalon_uart
add_instance my_uart altera_avalon_uart 14.1
```

**Related Information**
- `add_connection` on page 543
- `get_instance_interface_property` on page 554
- `get_instance_parameter_value` on page 557
- `get_instance_parameters` on page 555
- `get_instance_property` on page 551
- `get_instances` on page 547
- `set_instance_parameter_value` on page 560
6. Component Interface Tcl Reference

6.1.5.2. add_connection

Description
Connects the named interfaces on child instances together using an appropriate connection type. Both interface names consist of a child instance name, followed by the name of an interface provided by that module. For example, mux0.out is the interface named out on the instance named mux0. Be careful to connect the start to the end, and not the other way around.

Availability
Main Program, Composition

Usage
add_connection <start> [<end> <kind> <name>]

Returns
The name of the newly added connection in start.point/end.point format.

Arguments

start  The start interface to be connected, in
       <instance_name>.<interface_name> format.

end (optional)  The end interface to be connected,
                 <instance_name>.<interface_name>.

kind (optional)  The type of connection, such as avalon or clock.

name (optional)  A custom name for the connection. If unspecified, the name will be
                 <start_instance>.<interface>.<end_instance><interface>

Example
add_connection dma.read_master sdram.s1 avalon

Related Information
- add_instance on page 542
- get_instance_interfaces on page 548
6.1.5.3. get_connections

Description
Returns a list of all connections in the composed subsystem.

Availability
Main Program, Composition

Usage
get_connections

Returns
A list of connections.

Arguments
No arguments.

Example
```
set all_connections [ get_connections ]
```

Related Information
add_connection on page 543
6.1.5.4. get_connection_parameters

Description
Returns a list of parameters found on a connection.

Availability
Main Program, Composition

Usage
get_connection_parameters <connection>

Returns
A list of parameter names

Arguments

connection  The connection to query.

Example

get_connection_parameters cpu.data_master/dma0 csr

Related Information
• add_connection on page 543
• get_connection_parameter_value on page 546
6.1.5.5. get_connection_parameter_value

Description
Returns the value of a parameter on the connection. Parameters represent aspects of the connection that can be modified once the connection is created, such as the base address for an Avalon Memory Mapped connection.

Availability
Composition

Usage
get_connection_parameter_value <connection> <parameter>

Returns
The value of the parameter.

Arguments
connection  The connection to query.

parameter  The name of the parameter.

Example
get_connection_parameter_value cpu.data_master/dma0.csr baseAddress

Related Information
• add_connection on page 543
• get_connection_parameters on page 545
6. Component Interface Tcl Reference

6.1.5.6. get_instances

**Description**
Returns a list of the instance names for all child instances in the system.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
get_instances

**Returns**
A list of child instance names.

**Arguments**
No arguments.

**Example**

```tcl
get_instances
```

**Notes**
This command can be used with instances created by either add_instance or add_hdl_instance.

**Related Information**
- add_hdl_instance on page 539
- add_instance on page 542
- get_instance_parameter_value on page 557
- get_instance_parameters on page 555
- set_instance_parameter_value on page 560
6.1.5.7. get_instance_interfaces

**Description**

Returns a list of interfaces found in a child instance. The list of interfaces can change if the parameterization of the instance changes.

**Availability**

Validation, Composition

**Usage**

get_instance_interfaces <instance>

**Returns**

A list of interface names.

**Arguments**

*instance*  The name of the child instance.

**Example**

```tcl
get_instance_interfaces pixel_converter
```

**Related Information**

- [add_instance on page 542](#)
- [get_instance_interface_ports on page 549](#)
- [get_instance_interfaces on page 548](#)
6.1.5.8. `get_instance_interface_ports`

**Description**
Returns a list of ports found in an interface of a child instance.

**Availability**
Validation, Composition, Fileset Generation

**Usage**
`get_instance_interface_ports <instance> <interface>`

**Returns**
A list of port names found in the interface.

**Arguments**

- `instance` The name of the child instance.
- `interface` The name of an interface on the child instance.

**Example**

```
set port_names [ get_instance_interface_ports cpu data_master ]
```

**Related Information**
- `add_instance` on page 542
- `get_instance_interfaces` on page 548
- `get_instance_port_property` on page 558
6.1.5.9. get_instance_interface_properties

Description
Returns the names of all of the properties of the specified interface

Availability
Validation, Composition

Usage
get_instance_interface_properties <instance> <interface>

Returns
List of property names.

Arguments

instance  The name of the child instance.

interface  The name of an interface on the instance.

Example

```
set properties [ get_instance_interface_properties cpu data_master ]
```

Related Information

- add_instance on page 542
- get_instance_interface_property on page 554
- get_instance_interfaces on page 548
6.1.5.10. get_instance_property

Description
Returns the value of a single instance property.

Availability
Main Program, Elaboration, Validation, Composition, Fileset Generation

Usage
get_instance_property <instance> <property>

Returns
Various.

Arguments

instance The name of the instance.

property The name of the property. Refer to Instance Properties.

Example
set my_name [ get_instance_property myinstance NAME ]

Related Information
• add_instance on page 542
• get_instance_properties on page 553
• set_instance_property on page 552
• Instance Properties on page 591
6.1.5.11. set_instance_property

**Description**
Allows a user to set the properties of a child instance.

**Availability**
Main Program, Elaboration, Validation, Composition

**Usage**
set_instance_property <instance> <property> <value>

**Returns**

**Arguments**

*instance*  The name of the instance.

*property*  The name of the property to set. Refer to *Instance Properties*.

*value*  The new property value.

**Example**

set_instance_property myinstance SUPRESS_ALL_WARNINGS true

**Related Information**
- add_instance on page 542
- get_instance_properties on page 553
- get_instance_property on page 551
- Instance Properties on page 591
6. Component Interface Tcl Reference

6.1.5.12. get_instance_properties

**Description**
Returns the names of all the instance properties as a list of strings. You can use the `get_instance_property` and `set_instance_property` commands to get and set values of individual properties. The value returned by this command is always the same for a particular version of Platform Designer.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
`get_instance_properties`

**Returns**
List of strings. Refer to *Instance Properties*.

**Arguments**
No arguments.

**Example**
```
get_instance_properties
```

**Related Information**
- `add_instance` on page 542
- `get_instance_property` on page 551
- `set_instance_property` on page 552
- *Instance Properties* on page 591
6.1.5.13. get_instance_interface_property

**Description**
Returns the value of a property for an interface in a child instance.

**Availability**
Validation, Composition

**Usage**
get_instance_interface_property <instance> <interface> <property>

**Returns**
The value of the property.

**Arguments**

- **instance**  The name of the child instance.
- **interface** The name of an interface on the child instance.
- **property**  The name of the property of the interface.

**Example**

```
set value [ get_instance_interface_property cpu data_master setupTime ]
```

**Related Information**
- add_instance on page 542
- get_instance_interfaces on page 548
6.1.5.14. get_instance_parameters

**Description**

Returns a list of names of the parameters on a child instance that can be set using `set_instance_parameter_value`. It omits parameters that are derived and those that have the `SYSTEM_INFO` parameter property set.

**Availability**

Main Program, Elaboration, Validation, Composition

**Usage**

```tcl
get_instance_parameters <instance>
```

**Returns**

A list of parameters in the instance.

**Arguments**

`instance` The name of the child instance.

**Example**

```
set parameters [ get_instance_parameters instance ]
```

**Notes**

You can use this command with instances created by either `add_instance` or `add_hdl_instance`.

**Related Information**

- `add_hdl_instance` on page 539
- `add_instance` on page 542
- `get_instance_parameter_value` on page 557
- `get_instances` on page 547
- `set_instance_parameter_value` on page 560
6.1.5.15. get_instance_parameter_property

Description
Returns the value of a property on a parameter in a child instance. Parameter properties are metadata that describe how the Platform Designer tools use the parameter.

Availability
Validation, Composition

Usage
get_instance_parameter_property <instance> <parameter> <property>

Returns
The value of the parameter property.

Arguments

instance The name of the child instance.

parameter The name of the parameter in the instance.

property The name of the property of the parameter. Refer to Parameter Properties.

Example

```
get_instance_parameter_property instance parameter property
```

Related Information

- add_instance on page 542
- Parameter Properties on page 592
6.1.5.16. get_instance_parameter_value

Description
Returns the value of a parameter in a child instance. You cannot use this command to get the value of parameters whose values are derived or those that are defined using the SYSTEM_INFO parameter property.

Availability
Elaboration, Validation, Composition

Usage
get_instance_parameter_value <instance> <parameter>

Returns
The value of the parameter.

Arguments

instance  The name of the child instance.

parameter  Specifies the parameter whose value is being retrieved.

Example

```tcl
set dpi [ get_instance_parameter_value pixel_converter input_DPI ]
```

Notes
You can use this command with instances created by either add_instance or add_hdl_instance.

Related Information
- add_hdl_instance on page 539
- add_instance on page 542
- get_instance_parameters on page 555
- get_instances on page 547
- set_instance_parameter_value on page 560
6.1.5.17. get_instance_port_property

Description
Returns the value of a property of a port contained by an interface in a child instance.

Availability
Validation, Composition, Fileset Generation

Usage
get_instance_port_property <instance> <port> <property>

Returns
The value of the property for the port.

Arguments

instance  The name of the child instance.

port     The name of a port in one of the interfaces on the child instance.

property  The property whose value is being retrieved. Only the following port properties can be queried on ports of child instances: ROLE, DIRECTION, WIDTH, WIDTH_EXPR and VHDL_TYPE. Refer to Port Properties.

Example
get_instance_port_property instance port property

Related Information
- add_instance on page 542
- get_instance_interface_ports on page 549
- Port Properties on page 596
6.1.5.18. set_connection_parameter_value

**Description**
Sets the value of a parameter of the connection. The start and end are each interface names of the format `<instance>.<interface>`. Connection parameters depend on the type of connection, for Avalon-MM they include base addresses and arbitration priorities.

**Availability**
Main Program, Composition

**Usage**
```
set_connection_parameter_value <connection> <parameter> <value>
```

**Returns**
No return value.

**Arguments**
- `connection`: Specifies the name of the connection as returned by the `add_connection` command. It is of the form `start.point/end.point`.
- `parameter`: The name of the parameter.
- `value`: The new parameter value.

**Example**
```
set_connection_parameter_value cpu.data_master/dma0.csr baseAddress "0x000a0000"
```

**Related Information**
- `add_connection` on page 543
- `get_connection_parameter_value` on page 546
6.1.5.19. set_instance_parameter_value

**Description**

Sets the value of a parameter for a child instance. Derived parameters and SYSTEM_INFO parameters for the child instance can not be set with this command.

**Availability**

Main Program, Elaboration, Composition

**Usage**

```tcl
set_instance_parameter_value <instance> <parameter> <value>
```

**Returns**

Vo return value.

**Arguments**

- **instance** Specifies the name of the child instance.
- **parameter** Specifies the parameter that is being set.
- **value** Specifies the new parameter value.

**Example**

```tcl
set_instance_parameter_value uart_0 baudRate 9600
```

**Notes**

You can use this command with instances created by either add_instance or add_hdl_instance.

**Related Information**

- add_hdl_instance on page 539
- add_instance on page 542
- get_instance_parameter_value on page 557
- get_instances on page 547
6.1.6. Fileset Generation

add_fileset on page 562
add_fileset_file on page 563
set_fileset_property on page 564
get_fileset_file_attribute on page 565
set_fileset_file_attribute on page 566
get_fileset_properties on page 567
get_fileset_property on page 568
get_fileset_sim_properties on page 569
set_fileset_sim_properties on page 570
create_temp_file on page 571
6.1.6.1. add_fileset

Description
Adds a generation fileset for a particular target as specified by the kind. Platform Designer calls the target (SIM_VHDL, SIM_VERILOG, QUARTUS_SYNTH, or EXAMPLE_DESIGN) when the specified generation target is requested. You can define multiple filesets for each kind of fileset. Platform Designer passes a single argument to the specified callback procedure. The value of the argument is a generated name, which you must use in the top-level module or entity declaration of your IP component. To override this generated name, you can set the fileset property TOP_LEVEL.

Availability
Main Program

Usage
add_fileset <name> <kind> [ <callback_proc> <display_name> ]

Returns
No return value.

Arguments
name  The name of the fileset.

kind  The kind of fileset. Refer to Fileset Properties.

callback_proc (optional)  A string identifying the name of the callback procedure. If you add files in the global section, you can then specify a blank callback procedure.

display_name (optional)  A display string to identify the fileset.

Example
add_fileset my_synthesis_fileset QUARTUS_SYNTH mySynthCallbackProc "My Synthesis"
proc mySynthCallbackProc { topLevelName } { ... }

Notes
If using the TOP_LEVEL fileset property, all parameterizations of the component must use identical HDL.

Related Information
- add_fileset_file on page 563
- get_fileset_property on page 568
- Fileset Properties on page 604
6.1.6.2. **add_fileset_file**

**Description**
Adds a file to the generation directory. You can specify source file locations with either an absolute path, or a path relative to the IP component's _hw.tcl_ file. When you use the `add_fileset_file` command in a fileset callback, the Intel Quartus Prime software compiles the files in the order that they are added.

**Availability**
Main Program, Fileset Generation

**Usage**
```
add_fileset_file <output_file> <file_type> <file_source> <path_or_contents>
[<attributes>]
```

**Returns**
No return value.

**Arguments**

- **output_file**  Specifies the location to store the file after Platform Designer generation
- **file_type**  The kind of file. Refer to File Kind Properties.
- **file_source**  Specifies whether the file is being added by path, or by file contents. Refer to File Source Properties.
- **path_or_contents**  When the file_source is PATH, specifies the file to be copied to output_file. When the file_source is TEXT, specifies the text contents to be stored in the file.
- **attributes**  (optional)  An optional list of file attributes. Typically used to specify that a file is intended for use only in a particular simulator. Refer to File Attribute Properties.

**Example**
```
add_fileset_file "./implementation/rx_pma.sv" SYSTEM_VERILOG PATH
synth_rx_pma.sv
add_fileset_file gui.sv SYSTEM_VERILOG TEXT "Customize your IP core"
```

**Related Information**
- `add_fileset` on page 562
- `get_fileset_file_attribute` on page 565
- File Kind Properties on page 608
- File Source Properties on page 609
- File Attribute Properties on page 607
6.1.6.3. set_fileset_property

Description
Allows you to set the properties of a fileset.

Availability
Main Program, Elaboration, Fileset Generation

Usage
set_fileset_property <fileset> <property> <value>

Returns
No return value.

Arguments

fileset  The name of the fileset.

property  The name of the property to set. Refer to Fileset Properties.

value  The new property value.

Example

```
set_fileset_property mySynthFileset TOP_LEVEL simple_uart
```

Notes

When a fileset callback is called, the callback procedure is passed a single argument. The value of this argument is a generated name which must be used in the top-level module or entity declaration of your IP component. If set, the TOP_LEVEL specifies a fixed name for the top-level name of your IP component.

The TOP_LEVEL property must be set in the global section. It cannot be set in a fileset callback.

If using the TOP_LEVEL fileset property, all parameterizations of the IP component must use identical HDL.

Related Information

- add_fileset on page 562
- Fileset Properties on page 604
6.1.6.4. get_fileset_file_attribute

Description
Returns the attribute of a fileset file.

Availability
Main Program, Fileset Generation

Usage
get_fileset_file_attribute <output_file> <attribute>

Returns
Value of the fileset File attribute.

Arguments

output_file  Location of the output file.

attribute  Specifies the name of the attribute Refer to File Attribute Properties.

Example
get_fileset_file_attribute my_file.sv ALDEC_SPECIFIC

Related Information
- add_fileset on page 562
- add_fileset_file on page 563
- get_fileset_file_attribute on page 565
- File Attribute Properties on page 607
- add_fileset on page 562
- add_fileset_file on page 563
- get_fileset_file_attribute on page 565
- File Attribute Properties on page 607
6.1.6.5. set_fileset_file_attribute

**Description**
Sets the attribute of a fileset file.

**Availability**
Main Program, Fileset Generation

**Usage**

```
set_fileset_file_attribute <output_file> <attribute> <value>
```

**Returns**
The attribute value if it was set.

**Arguments**

- `output_file` Location of the output file.
- `attribute` Specifies the name of the attribute Refer to File Attribute Properties.
- `value` Value to set the attribute to.

**Example**

```
set_fileset_file_attribute my_file_pkg.sv COMMON_SYSTEMVERILOG_PACKAGE my_file_package
```
6.1.6.6. get_fileset_properties

Description
Returns a list of properties that can be set on a fileset.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Generation, Composition, Fileset Generation, Parameter Upgrade

Usage
get_fileset_properties

Returns
A list of property names. Refer to Fileset Properties.

Arguments
No arguments.

Example
get_fileset_properties

Related Information
- add_fileset on page 562
- get_fileset_properties on page 567
- set_fileset_property on page 564
- Fileset Properties on page 604
6.1.6.7. get_fileset_property

**Description**
Returns the value of a fileset property for a fileset.

**Availability**
Main Program, Elaboration, Fileset Generation

**Usage**
get_fileset_property <fileset> <property>

**Returns**
The value of the property.

**Arguments**

*fileset*  The name of the fileset.

*property*  The name of the property to query. Refer to Fileset Properties.

**Example**

```tcl
get_fileset_property fileset property
```

**Related Information**
Fileset Properties on page 604
6.1.6.8. get_fileset_sim_properties

Description
Returns simulator properties for a fileset.

Availability
Main Program, Fileset Generation

Usage
get_fileset_sim_properties <fileset> <platform> <property>

Returns
The fileset simulator properties.

Arguments

fileset  The name of the fileset.

platform  The operating system that applies to the property. Refer to Operating System Properties.

property  Specifies the name of the property to set. Refer to Simulator Properties.

Example
get_fileset_sim_properties my_fileset LINUX64 OPT_CADENCE_64BIT

Related Information
• add_fileset on page 562
• set_fileset_sim_properties on page 570
• Operating System Properties on page 616
• Simulator Properties on page 610
6.1.6.9. set_fileset_sim_properties

**Description**
Sets simulator properties for a given fileset

**Availability**
Main Program, Fileset Generation

**Usage**

```
set_fileset_sim_properties <fileset> <platform> <property> <value>
```

**Returns**
The fileset simulator properties if they were set.

**Arguments**

*fileset*  The name of the fileset.

*platform*  The operating system that applies to the property. Refer to *Operating System Properties*.

*property*  Specifies the name of the property to set. Refer to *Simulator Properties*.

*value*  Specifies the value of the property.

**Example**

```
set_fileset_sim_properties my_fileset LINUX64 OPT_MENTOR_PLI "\{libA\} \{libB\}"
```

**Related Information**

- *get_fileset_sim_properties* on page 569
- Operating System Properties on page 616
- Simulator Properties on page 610
6.1.6.10. create_temp_file

Description
Creates a temporary file, which you can use inside the fileset callbacks of a _hw.tcl file. This temporary file is included in the generation output if it is added using the add_fileset_file command.

Availability
Fileset Generation

Usage
create_temp_file <path>

Returns
The path to the temporary file.

Arguments

path    The name of the temporary file.

Example

set filelocation [create_temp_file "./hdl/compute_frequency.v" ]
add_fileset_file compute_frequency.v VERILOG PATH ${filelocation}

Related Information
- add_fileset on page 562
- add_fileset_file on page 563
6.1.7. Miscellaneous

check_device_family_equivalence on page 573
get_device_family_displayname on page 574
get_qip_strings on page 575
set_qip_strings on page 576
set_interconnect_requirement on page 577
6.1.7.1. check_device_family_equivalence

**Description**
Returns 1 if the device family is equivalent to one of the families in the device families list, Returns 0 if the device family is not equivalent to any families. This command ignores differences in capitalization and spaces.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
check_device_family_equivalence <device_family> <device_family_list>

**Returns**
1 if equivalent, 0 if not equivalent.

**Arguments**

*device_family*  The device family name that is being checked.

*device_family_list*  The list of device family names to check against.

**Example**
check_device_family_equivalence "CYLCONE III LS" { "stratixv" "Cyclone IV" "cycloneiiils" }

**Related Information**
get_device_family_displayname on page 574
6.1.7.2. get_device_family_displayname

**Description**
Returns the display name of a given device family.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Composition, Fileset Generation, Parameter Upgrade

**Usage**
get_device_family_displayname <device_family>

**Returns**
The preferred display name for the device family.

**Arguments**

`device_family`  A device family name.

**Example**
```
get_device_family_displayname cycloneiiiii ( returns: "Cyclone IV LS" )
```

**Related Information**
check_device_family_equivalence on page 573
6.1.7.3. get_qip_strings

**Description**
Returns a Tcl list of QIP strings for the IP component.

**Availability**
Discovery, Main Program, Edit, Elaboration, Validation, Composition, Parameter Upgrade

**Usage**
get_qip_strings

**Returns**
A Tcl list of qip strings set by this IP component.

**Arguments**
No arguments.

**Example**
```
set strings [get_qip_strings]
```

**Related Information**
set_qip_strings on page 576
6.1.7.4. set_qip_strings

Description
Places strings in the Intel Quartus Prime IP File (.qip) file, which Platform Designer passes to the command as a Tcl list. You add the .qip file to your Intel Quartus Prime project on the Files page, in the Settings dialog box. Successive calls to set_qip_strings are not additive and replace the previously declared value.

Availability
Discovery, Main Program, Edit, Elaboration, Validation, Composition, Parameter Upgrade

Usage
set_qip_strings <qip_strings>

Returns
The Tcl list which was set.

Arguments
qip_strings A space-delimited Tcl list.

Example
set_qip_strings {"QIP Entry 1" "QIP Entry 2"}

Notes
You can use the following macros in your QIP strings entry:

%entityName% The generated name of the entity replaces this macro when the string is written to the .qip file.

%libraryName% The compilation library this IP component was compiled into is inserted in place of this macro inside the .qip file.

%instanceName% The name of the instance is inserted in place of this macro inside the .qip file.

Related Information
get_qip_strings on page 575
6.1.7.5. set_interconnect_requirement

Description
Sets the value of an interconnect requirement for a system or an interface on a child instance.

Availability
Composition

Usage
set_interconnect_requirement <element_id> <name> <value>

Returns
No return value

Arguments

element_id  ($system) for system requirements, or qualified name of the interface of an instance, in <instance>.<interface> format. Note that the system identifier has to be escaped in TCL.

name  The name of the requirement.

value  The new requirement value.

Example

set_interconnect_requirement ($system) qsys_mm.maxAdditionalLatency 2
6.1.8. SystemVerilog Interface Commands

- add_sv_interface on page 579
- get_sv_interfaces on page 580
- get_sv_interface_property on page 581
- get_sv_interface_properties on page 582
- set_sv_interface_property on page 583
6.1.8.1. add_sv_interface

**Description**
Adds a SystemVerilog interface to the IP component.

**Availability**
Elaboration, Global

**Usage**
add_sv_interface <sv_interface_name> <sv_interface_type>

**Returns**
No return value.

**Arguments**

*sv_interface_name*  The name of the SystemVerilog interface in the IP component.

*sv_interface_type*  The type of the SystemVerilog interface used by the IP component.

**Example**

```
add_sv_interface my_sv_interface my_sv_interface_type
```
6.1.8.2. get_sv_interfaces

**Description**
Returns the list of SystemVerilog interfaces in the IP component.

**Availability**
Elaboration, Global

**Usage**
get_sv_interfaces

**Returns**

`String[]` Returns the list of SystemVerilog interfaces defined in the IP component.

**Arguments**
No arguments.

**Example**

```
get_sv_interfaces
```
6.1.8.3. get_sv_interface_property

**Description**
Returns the value of a single SystemVerilog interface property from the specified interface.

**Availability**
Elaboration, Global

**Usage**
get_sv_interface_property <sv_interface_name> <sv_interface_property>

**Returns**
various The property value.

**Arguments**

*sv_interface_name* The name of a SystemVerilog interface of the system.

*sv_interface_property* The name of the property. Refer to System Verilog Interface Properties.

**Example**

```
get_sv_interface_property my_sv_interface USE_ALL_PORTS
```
6.1.8.4. get_sv_interface_properties

**Description**
Returns the names of all the available SystemVerilog interface properties common to all interface types.

**Availability**
Elaboration, Global

**Usage**
get_sv_interface_properties

**Returns**

```
String[] The list of SystemVerilog interface properties.
```

**Arguments**
No arguments.

**Example**
```
get_sv_interface_properties
```
6. Component Interface Tcl Reference

6.1.8.5. set_sv_interface_property

**Description**
Sets the value of a property on a SystemVerilog interface.

**Availability**
Elaboration, Global

**Usage**

```
set_sv_interface_property <sv_interface_name> <sv_interface_property> <value>
```

**Returns**
No return value.

**Arguments**

- `interface`  The name of a SystemVerilog interface.
- `sv_interface_property`  The name of the property. Refer to SystemVerilog Interface Properties.
- `value`  The property value.

**Example**

```
set_sv_interface_property my_sv_interface USE_ALL_PORTS True
```
6.1.9. Wire-Level Expression Commands

set_wirelevel_expression on page 268
get_wirelevel_expressions on page 268
remove_wirelevel_expressions on page 269
6.1.9.1. set_wirelevel_expression

Description
Applies a wire-level expression to an optional input port or instance in the system.

Usage
set_wirelevel_expression <instance_or_port_bitselection> <expression>

Returns
No return value.

Arguments

instance_or_port_bitselection Specify the instance or port to which the wire-level expression using the <instance_name>.<port_name>[<bit_selection>] format. The bit selection can be a bit-select, for example [0], or a partial range defined in descending order, for example [7:0]. If no bit selection is specified, the full range of the port is selected.

expression The expression to be applied to an optional input port.

Examples

set_wirelevel_expression {module0.portA[7:0]} "8'b0"
set_wirelevel_expression module0.portA "8'b0"
set_wirelevel_expression {module0.portA[0]} "1'b0"

Related Information
- Scripting Flow for Wire-Level Expressions on page 30
- Wire-Level Connectivity on page 23
6.1.9.2. get_wirelevel_expressions

**Description**
Retrieve a list of wire-level expressions from an optional input port, instance, or all expressions in the current level of system hierarchy. If the port bit selection is specified as an argument, the range must be identical to what was used in the set_wirelevel_expression statement.

**Usage**
`get_wirelevel_expressions <instance_or_port_bitselection>`

**Returns**
`String[]` A flattened list of wire-level expressions. Every item in the list consists of right- and left-hand clauses of a wire-level expression. You can loop over the returned list using `foreach {port expr} $return_list{}`.

**Arguments**

- `instance_or_port_bitselection` Specifies which instance or port from which a list of wire-level expressions are retrieved using the `<instance_name>.<port_name>[<bit_selection>]` format.
  - If no `<port_name>[<bit_selection>]` is specified, the command causes the return of all expressions from the specified instance.
  - If no argument is present, the command causes the return of all expressions from the current level of system hierarchy.

The bit selection can be a bit-select, for example `[0]`, or a partial range defined in descending order, for example `[7:0]`. If no bit selection is specified, the full range of the port is selected.

**Example**
```
get_wirelevel_expressions
get_wirelevel_expressions module0
get_wirelevel_expressions {module0.portA[7:0]}
```

**Related Information**
- [Scripting Flow for Wire-Level Expressions](#) on page 30
- [Wire-Level Connectivity](#) on page 23
6.1.9.3. remove_wirelevel_expressions

**Description**
Remove a list of wire-level expressions from an optional input port, instance, or all expressions in the current level of system hierarchy. If the port bit selection is specified as an argument, the range must be identical to what was used in the set_wirelevel_expressions statement.

**Usage**
remove_wirelevel_expressions <instance_or_port_bitselection>

**Returns**
No return value.

**Arguments**

`instance_or_port_bitselection` Specifies which instance or port from which a list of wire-level expressions are removed using the `<instance_name>.<port_name>[<bit_selection>]` format.

- If no `<port_name>[<bit_selection>]` is specified, the command causes the removal of all expressions from the specified instance.
- If no argument is present, the command causes the return of all expressions from the current level of system hierarchy.

The bit selection can be a bit-select, for example [0], or a partial range defined in descending order, for example [7:0]. If no bit selection is specified, the full range of the port is selected.

**Examples**

```
remove_wirelevel_expressions
remove_wirelevel_expressions module0
remove_wirelevel_expressions {module0.portA[7:0]}
```

**Related Information**
- Scripting Flow for Wire-Level Expressions on page 30
- Wire-Level Connectivity on page 23
6.2. Platform Designer _hw.tcl Property Reference

Script Language Properties on page 589
Interface Properties on page 590
SystemVerilog Interface Properties on page 590
Instance Properties on page 591
Parameter Properties on page 592
Parameter Type Properties on page 594
Parameter Status Properties on page 595
Port Properties on page 596
Direction Properties on page 598
Display Item Properties on page 599
Display Item Kind Properties on page 600
Display Hint Properties on page 601
Module Properties on page 602
Fileset Properties on page 604
Fileset Kind Properties on page 605
Callback Properties on page 606
File Attribute Properties on page 607
File Kind Properties on page 608
File Source Properties on page 609
Simulator Properties on page 610
Port VHDL Type Properties on page 611
System Info Type Properties on page 612
Design Environment Type Properties on page 614
Units Properties on page 615
Operating System Properties on page 616
Quartus.ini Type Properties on page 617
### 6.2.1. Script Language Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCL</td>
<td>Implements the script in Tcl.</td>
</tr>
</tbody>
</table>
### 6.2.2. Interface Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMSIS_SVD_FILE</td>
<td>Specifies the connection point’s associated CMSIS file.</td>
</tr>
<tr>
<td>CMSIS_SVD_VARIABLES</td>
<td>Defines the variables inside a .svd file.</td>
</tr>
<tr>
<td>ENABLED</td>
<td>Specifies whether or not interface is enabled.</td>
</tr>
<tr>
<td>EXPORT_OF</td>
<td>For composed _hw1.tcl files, the EXPORT_OF property indicates which interface of a child instance is to be exported through this interface. Before using this command, you must have created the border interface using add_interface. The interface to be exported is of the form &lt;instanceName.interfaceName&gt;. Example: set_interface_property CSC_input EXPORT_OF my_colorSpaceConverter.input_port</td>
</tr>
<tr>
<td>PORT_NAME_MAP</td>
<td>A map of external port names to internal port names, formatted as a Tcl list. Example: set_interface_property &lt;interface name&gt; PORT_NAME_MAP &quot;&lt;new port name&gt; &lt;old port name&gt; &lt;new port name 2&gt; &lt;old port name 2&gt;&quot;</td>
</tr>
<tr>
<td>SVD_ADDRESS_GROUP</td>
<td>Generates a CMSIS SVD file. Masters in the same SVD address group write register data of their connected slaves into the same SVD file.</td>
</tr>
<tr>
<td>SVD_ADDRESS_OFFSET</td>
<td>Generates a CMSIS SVD file. Slaves connected to this master have their base address offset by this amount in the SVD file.</td>
</tr>
<tr>
<td>SV_INTERFACE</td>
<td>When SV_INTERFACE is set, all the ports in the given interface are part of the SystemVerilog interface. Example: set_interface_property my_qsys_interface SV_INTERFACE my_sv_interface</td>
</tr>
</tbody>
</table>

### 6.2.3. SystemVerilog Interface Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SV_INTERFACE_TYPE</td>
<td>Set the interface type of the SystemVerilog interface.</td>
</tr>
<tr>
<td>USE_ALL_PORTS</td>
<td>When USE_ALL_PORTS is set to true, all the ports defined in the Module, are declared in this SystemVerilog interface. USE_ALL_PORTS must be set to true only if the module has one SystemVerilog interface and the SystemVerilog interface signal names match with the port names declared for Platform Designer interface. When USE_ALL_PORTS is true, SV_INTERFACE_PORT or SV_INTERFACE_SIGNAL port properties should not be set.</td>
</tr>
</tbody>
</table>
6.2.4. Instance Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDLINSTANCE_GET_GENERATED_NAME</td>
<td>Platform Designer uses this property to get the auto-generated fixed name when the instance property HDLINSTANCE_USE_GENERATED_NAME is set to true, and only applies to fileSet callbacks.</td>
</tr>
<tr>
<td>HDLINSTANCE_USE_GENERATED_NAME</td>
<td>If true, instances added with the add_hdl_instance command are instructed to use unique auto-generated fixed names based on the parameterization.</td>
</tr>
<tr>
<td>SUPPRESS_ALL_INFO_MESSAGES</td>
<td>If true, allows you to suppress all Info messages that originate from a child instance.</td>
</tr>
<tr>
<td>SUPPRESS_ALL_WARNINGS</td>
<td>If true, allows you to suppress all warnings that originate from a child instance.</td>
</tr>
</tbody>
</table>
### 6.2.5. Parameter Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>AFFECTS_ELABORATION</td>
<td>Set AFFECTS_ELABORATION to false for parameters that do not affect the external interface of the module. An example of a parameter that does not affect the external interface is isNonVolatileStorage. An example of a parameter that does affect the external interface is width. When the value of a parameter changes, if that parameter has set AFFECTS_ELABORATION=false, the elaboration phase (calling the callback or hardware analysis) is not repeated, improving performance. Because the default value of AFFECTS_ELABORATION is true, the provided HDL file is normally re-analyzed to determine the new port widths and configuration every time a parameter changes.</td>
</tr>
<tr>
<td>Boolean</td>
<td>AFFECTS_GENERATION</td>
<td>The default value of AFFECTS_GENERATION is false if you provide a top-level HDL module; it is true if you provide a fileset callback. Set AFFECTS_GENERATION to false if the value of a parameter does not change the results of fileset generation.</td>
</tr>
<tr>
<td>Boolean</td>
<td>AFFECTS_VALIDATION</td>
<td>The AFFECTS_VALIDATION property marks whether a parameter's value is used to set derived parameters, and whether the value affects validation messages. When set to false, this may improve response time in the parameter editor UI when the value is changed.</td>
</tr>
<tr>
<td>String[]</td>
<td>ALLOWED_RANGES</td>
<td>Indicates the range or ranges that the parameter value can have. For integers, The ALLOWED_RANGES property is a list of ranges that the parameter can take on, where each range is a single value, or a range of values defined by a start and end value separated by a colon, such as 11:15. This property can also specify legal values and display strings for integers, such as {0:None 1:Monophonic 2:Stereo 4:Quadrophonic} meaning 0, 1, 2, and 4 are the legal values. You can also assign display strings to be displayed in the parameter editor for string variables. For example, ALLOWED_RANGES (&quot;dev1:Cyclone IV GX&quot;&quot;dev2:Stratix V GT&quot;).</td>
</tr>
<tr>
<td>String</td>
<td>DEFAULT_VALUE</td>
<td>The default value.</td>
</tr>
<tr>
<td>Boolean</td>
<td>DERIVED</td>
<td>When true, indicates that the parameter value can only be set by the IP component, and cannot be set by the user. Derived parameters are not saved as part of an instance’s parameter values. The default value is false.</td>
</tr>
<tr>
<td>String</td>
<td>DESCRIPTION</td>
<td>A short user-visible description of the parameter, suitable for a tooltip description in the parameter editor.</td>
</tr>
<tr>
<td>String[]</td>
<td>DISPLAY_HINT</td>
<td>Provides a hint about how to display a property. The following values are possible:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• boolean--for integer parameters whose value can be 0 or 1. The parameter displays as an option that you can turn on or off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• radio--displays a parameter with a list of values as radio buttons instead of a drop-down list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• hexadecimal--for integer parameters, display and interpret the value as a hexadecimal number, for example: 0x000000010 instead of 16.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• fixed_size--for string_list and integer_list parameters, the fixed_size DISPLAY_HINT eliminates the add and remove buttons from tables.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_NAME</td>
<td>This is the GUI label that appears to the left of this parameter.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_UNITS</td>
<td>This is the GUI label that appears to the right of the parameter.</td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Boolean</td>
<td>ENABLED</td>
<td>When false, the parameter is disabled, meaning that it is displayed, but greyed out, indicating that it is not editable on the parameter editor.</td>
</tr>
<tr>
<td>String</td>
<td>GROUP</td>
<td>Controls the layout of parameters in GUI</td>
</tr>
<tr>
<td>Boolean</td>
<td>HDL_PARAMETER</td>
<td>When true, the parameter must be passed to the HDL IP component description. The default value is false.</td>
</tr>
<tr>
<td>String</td>
<td>LONG_DESCRIPTION</td>
<td>A user-visible description of the parameter. Similar to DESCRIPTION, but allows for a more detailed explanation.</td>
</tr>
<tr>
<td>String</td>
<td>NEW_INSTANCE_VALUE</td>
<td>This property allows you to change the default value of a parameter without affecting older IP components that have not explicitly set a parameter value, and use the DEFAULT_VALUE property. The practical result is that older instances continue to use DEFAULT_VALUE for the parameter and new instances use the value that NEW_INSTANCE_VALUE assigns.</td>
</tr>
</tbody>
</table>
| String     | SV_INTERFACE_PARAMETER    | This parameter is used in the SystemVerilog interface instantiation. Example: \[
|            |                           | set_parameter_property my_parameter
|            |                           | SV_INTERFACE_PARAMETER my_sv_interface                                                                                                           |
| String[]   | SYSTEM_INFO               | Allows you to assign information about the instantiating system to a parameter that you define. SYSTEM_INFO requires an argument specifying the type of information requested, <info-type>. |
| String     | SYSTEM_INFO_ARG           | Defines an argument to be passed to a particular SYSTEM_INFO function, such as the name of a reset interface.                                                                                                 |
| (various)  | SYSTEM_INFO_TYPE          | Specifies one of the types of system information that can be queried. Refer to System Info Type Properties.                                                                                                    |
| (various)  | TYPE                      | Specifies the type of the parameter. Refer to Parameter Type Properties.                                                                                                                                    |
| (various)  | UNITS                     | Sets the units of the parameter. Refer to Units Properties.                                                                                                                                                  |
| Boolean    | VISIBLE                   | Indicates whether or not to display the parameter in the parameterization GUI.                                                                                                                               |
| String     | WIDTH                     | For a STD_LOGIC_VECTOR parameter, this indicates the width of the logic vector.                                                                                                                               |

Related Information
- System Info Type Properties on page 612
- Parameter Type Properties on page 594
- Units Properties on page 615
### 6.2.6. Parameter Type Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOLEAN</td>
<td>A boolean parameter whose value is true or false.</td>
</tr>
<tr>
<td>FLOAT</td>
<td>A signed 32-bit floating point parameter. Not supported for HDL parameters.</td>
</tr>
<tr>
<td>INTEGER</td>
<td>A signed 32-bit integer parameter.</td>
</tr>
<tr>
<td>INTEGER_LIST</td>
<td>A parameter that contains a list of 32-bit integers. Not supported for HDL parameters.</td>
</tr>
<tr>
<td>LONG</td>
<td>A signed 64-bit integer parameter. Not supported for HDL parameters.</td>
</tr>
<tr>
<td>NATURAL</td>
<td>A 32-bit number that contain values 0 to 2,147,483,647 (0x7fffffff).</td>
</tr>
<tr>
<td>POSITIVE</td>
<td>A 32-bit number that contains values 1 to 2,147,483,647 (0x7fffffff).</td>
</tr>
<tr>
<td>STD_LOGIC</td>
<td>A single bit parameter whose value can be 1 or 0;</td>
</tr>
<tr>
<td>STD_LOGIC_VECTOR</td>
<td>An arbitrary-width number. The parameter property WIDTH determines the size of the logic vector.</td>
</tr>
<tr>
<td>STRING</td>
<td>A string parameter.</td>
</tr>
<tr>
<td>STRING_LIST</td>
<td>A parameter that contains a list of strings. Not supported for HDL parameters.</td>
</tr>
</tbody>
</table>
### 6.2.7. Parameter Status Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>ACTIVE</td>
<td>Indicates the parameter is a regular parameter.</td>
</tr>
<tr>
<td>Boolean</td>
<td>DEPRECATED</td>
<td>Indicates the parameter exists only for backwards compatibility, and may not have any effect.</td>
</tr>
<tr>
<td>Boolean</td>
<td>EXPERIMENTAL</td>
<td>Indicates the parameter is experimental, and not exposed in the design flow.</td>
</tr>
</tbody>
</table>
### 6.2.8. Port Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(various)</td>
<td>DIRECTION</td>
<td>The direction of the port from the IP component's perspective. Refer to Direction Properties.</td>
</tr>
<tr>
<td>String</td>
<td>DRIVEN_BY</td>
<td>Indicates that this output port is always driven to a constant value or by an input port. If all outputs on an IP component specify a driven_by property, the HDL for the IP component is generated automatically.</td>
</tr>
<tr>
<td>String[]</td>
<td>FRAGMENT_LIST</td>
<td>This property can be used in 2 ways: First you can take a single RTL signal and split it into multiple Platform Designer signals. Second you can take multiple RTL signals and combine them into a single Platform Designer signal.</td>
</tr>
<tr>
<td>String</td>
<td>ROLE</td>
<td>Specifies an Avalon signal type such as waitrequest, readdata, or read. For a complete list of signal types, refer to the Avalon Interface Specifications.</td>
</tr>
<tr>
<td>String</td>
<td>SV_INTERFACE_PORT</td>
<td>This port from the module is used as I/O in the SystemVerilog interface instantiation. The top-level wrapper of the module which contains this port is from the SystemVerilog interface. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set_port_property port_x SV_INTERFACE_PORT my_sv_interface</td>
</tr>
<tr>
<td>String</td>
<td>SV_INTERFACE_PORT_NAME</td>
<td>This property is used only when the Platform Designer port name defined for the module is different from the port name in the SystemVerilog interface. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set_port_property port_x SV_INTERFACE_PORT_NAME port_a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When writing the RTL, the Platform Designer port name port_x is mapped to RTL name port_a in the SystemVerilog interface.</td>
</tr>
<tr>
<td>String</td>
<td>SV_INTERFACE_SIGNAL</td>
<td>This port from the module is assumed to be inside the SystemVerilog interface or the modport used by the module. The top-level wrapper of the module containing this port is unwrapped from SystemVerilog interface. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set_port_property port_y SV_INTERFACE_SIGNAL my_sv_interface</td>
</tr>
<tr>
<td>String</td>
<td>SV_INTERFACE_SIGNAL_NAME</td>
<td>This property is only used when the Platform Designer port name defined for the module is different from the port name in the SystemVerilog interface. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>set_port_property port_y SV_INTERFACE_SIGNAL_NAME port_b</td>
</tr>
<tr>
<td>Type</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Boolean</td>
<td>TERMINATION</td>
<td>When true, instead of connecting the port to the Platform Designer system, it is left unconnected for output and bidir or set to a fixed value for input. Has no effect for IP components that implement a generation callback instead of using the default wrapper generation.</td>
</tr>
<tr>
<td>BigInteger</td>
<td>TERMINATION_VALUE</td>
<td>The constant value to drive an input port.</td>
</tr>
<tr>
<td>(various)</td>
<td>VHDL_TYPE</td>
<td>Indicates the type of a VHDL port. The default value, auto, selects std_logic if the width is fixed at 1, and std_logic_vector otherwise. Refer to Port VHDL Type Properties.</td>
</tr>
<tr>
<td>String</td>
<td>WIDTH</td>
<td>The width of the port in bits. Cannot be set directly. Any changes must be set through the WIDTH_EXPR property.</td>
</tr>
<tr>
<td>String</td>
<td>WIDTH_EXPR</td>
<td>The width expression of a port. The width_value_expr property can be set directly to a numeric value if desired. When get_port_property is used width always returns the current integer width of the port while width_expr always returns the unevaluated width expression.</td>
</tr>
<tr>
<td>Integer</td>
<td>WIDTH_VALUE</td>
<td>The width of the port in bits. Cannot be set directly. Any changes must be set through the WIDTH_EXPR property.</td>
</tr>
</tbody>
</table>

**Related Information**
- Direction Properties on page 598
- Port VHDL Type Properties on page 611
- Avalon Interface Specifications
### 6.2.9. Direction Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bidir</td>
<td>Direction for a bidirectional signal.</td>
</tr>
<tr>
<td>Input</td>
<td>Direction for an input signal.</td>
</tr>
<tr>
<td>Output</td>
<td>Direction for an output signal.</td>
</tr>
</tbody>
</table>
### 6.2.10. Display Item Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>DESCRIPTION</td>
<td>A description of the display item, which you can use as a tooltip.</td>
</tr>
<tr>
<td>String[]</td>
<td>DISPLAY_HINT</td>
<td>A hint that affects how the display item displays in the parameter editor.</td>
</tr>
<tr>
<td>String</td>
<td>DISPLAY_NAME</td>
<td>The label for the display item in a the parameter editor.</td>
</tr>
<tr>
<td>Boolean</td>
<td>ENABLED</td>
<td>Indicates whether the display item is enabled or disabled.</td>
</tr>
<tr>
<td>String</td>
<td>PATH</td>
<td>The path to a file. Only applies to display items of type ICON.</td>
</tr>
<tr>
<td>String</td>
<td>TEXT</td>
<td>Text associated with a display item. Only applies to display items of type TEXT.</td>
</tr>
<tr>
<td>Boolean</td>
<td>VISIBLE</td>
<td>Indicates whether this display item is visible or not.</td>
</tr>
</tbody>
</table>
### 6.2.11. Display Item Kind Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTION</td>
<td>An action displays as a button in the GUI. When the button is clicked, it calls the callback procedure. The button label is the display item id.</td>
</tr>
<tr>
<td>GROUP</td>
<td>A group that is a child of the parent_group group. If the parent_group is an empty string, this is a top-level group.</td>
</tr>
<tr>
<td>ICON</td>
<td>A .gif, .jpg, or .png file.</td>
</tr>
<tr>
<td>PARAMETER</td>
<td>A parameter in the instance.</td>
</tr>
<tr>
<td>TEXT</td>
<td>A block of text.</td>
</tr>
</tbody>
</table>
## 6.2.12. Display Hint Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIT_WIDTH</td>
<td>Bit width of a number</td>
</tr>
<tr>
<td>BOOLEAN</td>
<td>Integer value either 0 or 1.</td>
</tr>
<tr>
<td>COLLAPSED</td>
<td>Indicates whether a group is collapsed when initially displayed.</td>
</tr>
<tr>
<td>COLUMNS</td>
<td>Number of columns in text field, for example, &quot;columns:N&quot;.</td>
</tr>
<tr>
<td>EDITABLE</td>
<td>Indicates whether a list of strings allows free-form text entry (editable combo box).</td>
</tr>
<tr>
<td>FILE</td>
<td>Indicates that the string is an optional file path, for example, &quot;file:jpg,png,gif&quot;.</td>
</tr>
<tr>
<td>FIXED_SIZE</td>
<td>Indicates a fixed size for a table or list.</td>
</tr>
<tr>
<td>GROW</td>
<td>If set, the widget can grow when the IP component is resized.</td>
</tr>
<tr>
<td>HEXADECIMAL</td>
<td>Indicates that the long integer is hexadecimal.</td>
</tr>
<tr>
<td>RADIO</td>
<td>Indicates that the range displays as radio buttons.</td>
</tr>
<tr>
<td>ROWS</td>
<td>Number of rows in text field, or visible rows in a table, for example, &quot;rows:N&quot;.</td>
</tr>
<tr>
<td>SLIDER</td>
<td>Range displays as slider.</td>
</tr>
<tr>
<td>TAB</td>
<td>If present for a group, the group displays in a tab</td>
</tr>
<tr>
<td>TABLE</td>
<td>If present for a group, the group must contain all list-type parameters, which display collectively in a single table.</td>
</tr>
<tr>
<td>TEXT</td>
<td>String is a text field with a limited character set, for example, &quot;text:A-Za-z0-9_&quot;.</td>
</tr>
<tr>
<td>WIDTH</td>
<td>Width of a table column</td>
</tr>
</tbody>
</table>
### 6.2.13. Module Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANALYZE_HDL</td>
<td>When set to false, prevents a call to the Intel Quartus Prime mapper to verify port widths and directions, speeding up generation time at the expense of fewer validation checks. If this property is set to false, invalid port widths and directions are discovered during the Intel Quartus Prime software compilation. This does not affect IP components using filesets to manage synthesis files.</td>
</tr>
<tr>
<td>AUTHOR</td>
<td>The IP component author.</td>
</tr>
<tr>
<td>COMPOSITION_CALLBACK</td>
<td>The name of the composition callback. If you define a composition callback, you cannot not define the generation or elaboration callbacks.</td>
</tr>
<tr>
<td>DATASHEET_URL</td>
<td>Deprecated. Use add_documentation_link to provide documentation links.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>The description of the IP component, such as &quot;This IP component puts the shizzle in the frobnitz.&quot;</td>
</tr>
<tr>
<td>DISPLAY_NAME</td>
<td>The name to display when referencing the IP component, such as &quot;My Platform Designer IP Component&quot;.</td>
</tr>
<tr>
<td>EDITABLE</td>
<td>Indicates whether you can edit the IP component in the Component Editor.</td>
</tr>
<tr>
<td>ELABORATION_CALLBACK</td>
<td>The name of the elaboration callback. When set, the IP component's elaboration callback is called to validate and elaborate interfaces for instances of the IP component.</td>
</tr>
<tr>
<td>GENERATION_CALLBACK</td>
<td>The name for a custom generation callback.</td>
</tr>
<tr>
<td>GROUP</td>
<td>The group in the IP Catalog that includes this IP component.</td>
</tr>
<tr>
<td>ICON_PATH</td>
<td>A path to an icon to display in the IP component's parameter editor.</td>
</tr>
<tr>
<td>INSTANTIATE_IN_SYSTEM_MODULE</td>
<td>If true, this IP component is implemented by HDL provided by the IP component. If false, the IP component creates exported interfaces allowing the implementation to be connected in the parent.</td>
</tr>
<tr>
<td>INTERNAL</td>
<td>An IP component which is marked as internal does not appear in the IP Catalog. This feature allows you to hide the sub-IP- components of a larger composed IP component.</td>
</tr>
<tr>
<td>MODULE_DIRECTORY</td>
<td>The directory in which the hw.tcl file exists.</td>
</tr>
<tr>
<td>MODULE_TCL_FILE</td>
<td>The path to the hw.tcl file.</td>
</tr>
<tr>
<td>NAME</td>
<td>The name of the IP component, such as my_qsys_component.</td>
</tr>
<tr>
<td>OPAQUE_ADDRESS_MAP</td>
<td>For composed IP components created using a _hw.tcl file that include children that are memory-mapped slaves, specifies whether the children's addresses are visible to downstream software tools. When true, the children's address are not visible. When false, the children's addresses are visible.</td>
</tr>
<tr>
<td>PREFERRED_SIMULATION_LANGUAGE</td>
<td>The preferred language to use for selecting the fileset for simulation model generation.</td>
</tr>
<tr>
<td>REPORT_HIERARCHY</td>
<td>null</td>
</tr>
<tr>
<td>STATIC_TOP_LEVEL_MODULE_NAME</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>STRUCTURAL_COMPOSITION_CALLBACK</td>
<td>The name of the structural composition callback. This callback is used to represent the structural hierarchical model of the IP component and the RTL can be generated either with module property COMPOSITION_CALLBACK or by ADD_FILESET with target QUARTUS_SYNTH</td>
</tr>
<tr>
<td>SUPPORTED_DEVICE_FAMILIES</td>
<td>A list of device family supported by this IP component.</td>
</tr>
<tr>
<td>TOP_LEVEL_HDL_FILE</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>TOP_LEVEL_HDL_MODULE</td>
<td>Deprecated.</td>
</tr>
<tr>
<td>UPGRADEABLE_FROM</td>
<td>null</td>
</tr>
<tr>
<td>VALIDATION_CALLBACK</td>
<td>The name of the validation callback procedure.</td>
</tr>
<tr>
<td>VERSION</td>
<td>The IP component’s version, such as 10.0.</td>
</tr>
</tbody>
</table>
### 6.2.14. Fileset Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLE_FILE_OVERWRITE_MODE</td>
<td>null</td>
</tr>
<tr>
<td>ENABLE_RELATIVE_INCLUDE_PATHS</td>
<td>If true, HDL files can include other files using relative paths in the fileset.</td>
</tr>
<tr>
<td>TOP_LEVEL</td>
<td>The name of the top-level HDL module that the fileset generates. If set, the HDL top level must match the TOP_LEVEL name, and the HDL must not be parameterized. Platform Designer runs the generate callback one time, regardless of the number of instances in the system.</td>
</tr>
</tbody>
</table>
### 6.2.15. Fileset Kind Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXAMPLE_DESIGN</td>
<td>Contains example design files.</td>
</tr>
<tr>
<td>QUARTUS_SYNTH</td>
<td>Contains files that Platform Designer uses for the Intel Quartus Prime software synthesis.</td>
</tr>
<tr>
<td>SIM_VERILOG</td>
<td>Contains files that Platform Designer uses for Verilog HDL simulation.</td>
</tr>
<tr>
<td>SIM_VHDL</td>
<td>Contains files that Platform Designer uses for VHDL simulation.</td>
</tr>
<tr>
<td>SYSTEMVERILOG_INTERFACE</td>
<td>This file is treated as SystemVerilog interface file by the Platform Designer. Example:</td>
</tr>
<tr>
<td></td>
<td><code>add_fileset_file mem_ifc.sv SYSTEMVERILOG_PATH &quot;.ifc/mem_ifc.sv&quot; SYSTEMVERILOG_INTERFACE</code></td>
</tr>
</tbody>
</table>
### 6.2.16. Callback Properties

**Description**

This list describes each type of callback. Each command may only be available in some callback contexts.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACTION</td>
<td>Called when an ACTION display item’s action is performed.</td>
</tr>
<tr>
<td>COMPOSITION</td>
<td>Called during instance elaboration when the IP component contains a subsystem.</td>
</tr>
<tr>
<td>EDITOR</td>
<td>Called when the IP component is controlling the parameterization editor.</td>
</tr>
<tr>
<td>ELABORATION</td>
<td>Called to elaborate interfaces and signals after a parameter change. In API 9.1 and later, validation is called before elaboration. In API 9.0 and earlier, elaboration is called before validation.</td>
</tr>
<tr>
<td>GENERATE_VERILOG_SIMULATION</td>
<td>Called when the IP component uses a custom generator to generates the Verilog simulation model for an instance.</td>
</tr>
<tr>
<td>GENERATE_VHDL_SIMULATION</td>
<td>Called when the IP component uses a custom generator to generates the VHDL simulation model for an instance.</td>
</tr>
<tr>
<td>GENERATION</td>
<td>Called when the IP component uses a custom generator to generates the synthesis HDL for an instance.</td>
</tr>
<tr>
<td>PARAMETER_UPGRADE</td>
<td>Called when attempting to instantiate an IP component with a newer version than the saved version. This allows the IP component to upgrade parameters between released versions of the component.</td>
</tr>
<tr>
<td>STRUCTURAL_COMPOSITION</td>
<td>Called during instance elaboration when an IP component is represented by a structural hierarchical model which may be different from the generated RTL.</td>
</tr>
<tr>
<td>VALIDATION</td>
<td>Called to validate parameter ranges and report problems with the parameter values. In API 9.1 and later, validation is called before elaboration. In API 9.0 and earlier, elaboration is called before validation.</td>
</tr>
</tbody>
</table>
### 6.2.17. File Attribute Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALDEC_SPECIFIC</td>
<td>Applies to Aldec simulation tools and for simulation filesets only.</td>
</tr>
<tr>
<td>CADENCE_SPECIFIC</td>
<td>Applies to Cadence simulation tools and for simulation filesets only.</td>
</tr>
<tr>
<td>COMMON_SYSTEMVERILOG_PACKAGE</td>
<td>The name of the common SystemVerilog package. Applies to simulation filesets only.</td>
</tr>
<tr>
<td>MENTOR_SPECIFIC</td>
<td>Applies to Mentor simulation tools and for simulation filesets only.</td>
</tr>
<tr>
<td>SYNOPSYS_SPECIFIC</td>
<td>Applies to Synopsys simulation tools and for simulation filesets only.</td>
</tr>
<tr>
<td>TOP_LEVEL_FILE</td>
<td>Contains the top-level module for the fileset and applies to synthesis filesets only.</td>
</tr>
</tbody>
</table>
### 6.2.18. File Kind Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAT</td>
<td>DAT Data</td>
</tr>
<tr>
<td>FLI_LIBRARY</td>
<td>FLI Library</td>
</tr>
<tr>
<td>HEX</td>
<td>HEX Data</td>
</tr>
<tr>
<td>MIF</td>
<td>MIF Data</td>
</tr>
<tr>
<td>OTHER</td>
<td>Other</td>
</tr>
<tr>
<td>PLI_LIBRARY</td>
<td>PLI Library</td>
</tr>
<tr>
<td>SDC</td>
<td>Timing Constraints</td>
</tr>
<tr>
<td>SYSTEM_VERILOG</td>
<td>SystemVerilog HDL</td>
</tr>
<tr>
<td>SYSTEM_VERILOG_ENCRYPT</td>
<td>Encrypted SystemVerilog HDL</td>
</tr>
<tr>
<td>SYSTEM_VERILOG_INCLUDE</td>
<td>SystemVerilog Include</td>
</tr>
<tr>
<td>VERILOG</td>
<td>Verilog HDL</td>
</tr>
<tr>
<td>VERILOG_ENCRYPT</td>
<td>Encrypted Verilog HDL</td>
</tr>
<tr>
<td>VERILOG_INCLUDE</td>
<td>Verilog Include</td>
</tr>
<tr>
<td>VHDL</td>
<td>VHDL</td>
</tr>
<tr>
<td>VHDL_ENCRYPT</td>
<td>Encrypted VHDL</td>
</tr>
<tr>
<td>VPI_LIBRARY</td>
<td>VPI Library</td>
</tr>
</tbody>
</table>
### 6.2.19. File Source Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATH</td>
<td>Specifies the original source file and copies to output_file.</td>
</tr>
<tr>
<td>TEXT</td>
<td>Specifies an arbitrary text string for the contents of output_file.</td>
</tr>
</tbody>
</table>
## 6.2.20. Simulator Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENV_ALDEC_LD_LIBRARY_PATH</td>
<td>LD_LIBRARY_PATH when running riviera-pro</td>
</tr>
<tr>
<td>ENV_CADENCE_LD_LIBRARY_PATH</td>
<td>LD_LIBRARY_PATH when running ncsim</td>
</tr>
<tr>
<td>ENV_MENTOR_LD_LIBRARY_PATH</td>
<td>LD_LIBRARY_PATH when running modelsim</td>
</tr>
<tr>
<td>ENV_SYNOPSYS_LD_LIBRARY_PATH</td>
<td>LD_LIBRARY_PATH when running vcs</td>
</tr>
<tr>
<td>OPT_ALDEC_PLI</td>
<td>-pli option for riviera-pro</td>
</tr>
<tr>
<td>OPT_CADENCE_64BIT</td>
<td>-64bit option for ncsim</td>
</tr>
<tr>
<td>OPT_CADENCE_PLI</td>
<td>-loadpli1 option for ncsim</td>
</tr>
<tr>
<td>OPT_CADENCE_SVLIB</td>
<td>-sv_lib option for ncsim</td>
</tr>
<tr>
<td>OPT_CADENCE_SVROOT</td>
<td>-sv_root option for ncsim</td>
</tr>
<tr>
<td>OPT_MENTOR_64</td>
<td>-64 option for modelsim</td>
</tr>
<tr>
<td>OPT_MENTOR_CPPPATH</td>
<td>-cpppath option for modelsim</td>
</tr>
<tr>
<td>OPT_MENTOR_LDFLAGS</td>
<td>-ldflags option for modelsim</td>
</tr>
<tr>
<td>OPT_MENTOR_PLI</td>
<td>-pli option for modelsim</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_ACC</td>
<td>+acc option for vcs</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_CPP</td>
<td>-cpp option for vcs</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_FULL64</td>
<td>-full64 option for vcs</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_LDFLAGS</td>
<td>-LDFLAGS option for vcs</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_LLIB</td>
<td>-l option for vcs</td>
</tr>
<tr>
<td>OPT_SYNOPSYS_VPI</td>
<td>+vpi option for vcs</td>
</tr>
</tbody>
</table>
### 6.2.21. Port VHDL Type Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>The VHDL type of this signal is automatically determined. Single-bit signals are STD_LOGIC; signals wider than one bit are STD_LOGIC_VECTOR.</td>
</tr>
<tr>
<td>STD_LOGIC</td>
<td>Indicates that the signal is not rendered in VHDL as a STD_LOGIC signal.</td>
</tr>
<tr>
<td>STD_LOGIC_VECTOR</td>
<td>Indicates that the signal is rendered in VHDL as a STD_LOGIC_VECTOR signal.</td>
</tr>
</tbody>
</table>
### 6.2.22. System Info Type Properties

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>ADDRESS_MAP</td>
<td>An XML-formatted string describing the address map for the interface specified in the system info argument.</td>
</tr>
<tr>
<td>Integer</td>
<td>ADDRESS_WIDTH</td>
<td>The number of address bits required to address all memory-mapped slaves connected to the specified memory-mapped master in this instance, using byte addresses.</td>
</tr>
<tr>
<td>String</td>
<td>AVALON_SPEC</td>
<td>The version of the interconnect. SOPC Builder interconnect uses Avalon Specification 1.0. Platform Designer interconnect uses Avalon Specification 2.0.</td>
</tr>
<tr>
<td>Integer</td>
<td>CLOCK_DOMAIN</td>
<td>An integer that represents the clock domain for the interface specified in the system info argument. If this instance has interfaces on multiple clock domains, this can be used to determine which interfaces are on each clock domain. The absolute value of the integer is arbitrary.</td>
</tr>
<tr>
<td>Long, Integer</td>
<td>CLOCK_RATE</td>
<td>The rate of the clock connected to the clock input specified in the system info argument. If 0, the clock rate is currently unknown.</td>
</tr>
<tr>
<td>String</td>
<td>CLOCK_RESET_INFO</td>
<td>The name of this instance’s primary clock or reset sink interface. This is used to determine the reset sink to use for global reset when using SOPC interconnect.</td>
</tr>
<tr>
<td>String</td>
<td>CUSTOM_INSTRUCTION_SLAVES</td>
<td>Provides custom instruction slave information, including the name, base address, address span, and clock cycle type.</td>
</tr>
<tr>
<td>(various)</td>
<td>DESIGN_ENVIRONMENT</td>
<td>A string that identifies the current design environment. Refer to Design Environment Type Properties.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE</td>
<td>The device part number of the currently selected device.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_FAMILY</td>
<td>The family name of the currently selected device.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_FEATURES</td>
<td>A list of key/value pairs delineated by spaces indicating whether a particular device feature is available in the currently selected device family. The format of the list is suitable for passing to the Tcl array set command. The keys are device features; the values are 1 if the feature is present, and 0 if the feature is absent.</td>
</tr>
<tr>
<td>String</td>
<td>DEVICE_SPEEDGRADE</td>
<td>The speed grade of the currently selected device.</td>
</tr>
<tr>
<td>Integer</td>
<td>GENERATION_ID</td>
<td>A integer that stores a hash of the generation time to be used as a unique ID for a generation run.</td>
</tr>
<tr>
<td>BigInteger, Long</td>
<td>INTERRUPTS_USED</td>
<td>A mask indicating which bits of an interrupt receiver are connected to interrupt senders. The interrupt receiver is specified in the system info argument.</td>
</tr>
<tr>
<td>Integer</td>
<td>MAX_SLAVE_DATA_WIDTH</td>
<td>The data width of the widest slave connected to the specified memory-mapped master.</td>
</tr>
<tr>
<td>String, Boolean, Integer</td>
<td>QUARTUS_INI</td>
<td>The value of the quartus.ini setting specified in the system info argument.</td>
</tr>
<tr>
<td>Integer</td>
<td>RESET_DOMAIN</td>
<td>An integer that represents the reset domain for the interface specified in the system info argument. If this instance has interfaces on multiple reset domains, this can be used to determine which interfaces are on each reset domain. The absolute value of the integer is arbitrary.</td>
</tr>
</tbody>
</table>
### Type

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>TRISTATECONDUIT_INFO</td>
<td>An XML description of the Avalon Tri-state Conduit masters connected to an Avalon Tri-state Conduit slave. The slave is specified as the system info argument. The value contains information about the slave, the connected master instance and interface names, and signal names, directions and widths.</td>
</tr>
<tr>
<td>String</td>
<td>TRISTATECONDUIT_MASTERS</td>
<td>The names of the instance's interfaces that are tri-state conduit slaves.</td>
</tr>
<tr>
<td>String</td>
<td>UNIQUE_ID</td>
<td>A string guaranteed to be unique to this instance.</td>
</tr>
</tbody>
</table>

**Related Information**

*Design Environment Type Properties on page 614*
6.2.23. Design Environment Type Properties

**Description**

A design environment is used by IP to tell what sort of interfaces are most appropriate to connect in the parent system.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NATIVE</td>
<td>Design environment prefers native IP interfaces.</td>
</tr>
<tr>
<td>QSYS</td>
<td>Design environment prefers standard Platform Designer interfaces.</td>
</tr>
</tbody>
</table>
### 6.2.24. Units Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>A memory-mapped address.</td>
</tr>
<tr>
<td>Bits</td>
<td>Memory size, in bits.</td>
</tr>
<tr>
<td>BitsPerSecond</td>
<td>Rate, in bits per second.</td>
</tr>
<tr>
<td>Bytes</td>
<td>Memory size, in bytes.</td>
</tr>
<tr>
<td>Cycles</td>
<td>A latency or count, in clock cycles.</td>
</tr>
<tr>
<td>GigabitsPerSecond</td>
<td>Rate, in gigabits per second.</td>
</tr>
<tr>
<td>Gigabytes</td>
<td>Memory size, in gigabytes.</td>
</tr>
<tr>
<td>Gigahertz</td>
<td>Frequency, in GHz.</td>
</tr>
<tr>
<td>Hertz</td>
<td>Frequency, in Hz.</td>
</tr>
<tr>
<td>KilobitsPerSecond</td>
<td>Rate, in kilobits per second.</td>
</tr>
<tr>
<td>Kilobytes</td>
<td>Memory size, in kilobytes.</td>
</tr>
<tr>
<td>Kilohertz</td>
<td>Frequency, in kHz.</td>
</tr>
<tr>
<td>MegabitsPerSecond</td>
<td>Rate, in megabits per second.</td>
</tr>
<tr>
<td>Megabytes</td>
<td>Memory size, in megabytes.</td>
</tr>
<tr>
<td>Megahertz</td>
<td>Frequency, in MHz.</td>
</tr>
<tr>
<td>Microseconds</td>
<td>Time, in micros.</td>
</tr>
<tr>
<td>Milliseconds</td>
<td>Time, in ms.</td>
</tr>
<tr>
<td>Nanoseconds</td>
<td>Time, in ns.</td>
</tr>
<tr>
<td>None</td>
<td>Unspecified units.</td>
</tr>
<tr>
<td>Percent</td>
<td>A percentage.</td>
</tr>
<tr>
<td>Picoseconds</td>
<td>Time, in ps.</td>
</tr>
<tr>
<td>Seconds</td>
<td>Time, in s.</td>
</tr>
</tbody>
</table>
### 6.2.25. Operating System Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>All operating systems</td>
</tr>
<tr>
<td>LINUX32</td>
<td>Linux 32-bit</td>
</tr>
<tr>
<td>LINUX64</td>
<td>Linux 64-bit</td>
</tr>
<tr>
<td>WINDOWS32</td>
<td>Windows 32-bit</td>
</tr>
<tr>
<td>WINDOWS64</td>
<td>Windows 64-bit</td>
</tr>
</tbody>
</table>
### 6.2.26. Quartus.ini Type Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLED</td>
<td>Returns 1 if the setting is turned on, otherwise returns 0.</td>
</tr>
<tr>
<td>STRING</td>
<td>Returns the string value of the <code>.ini</code> setting.</td>
</tr>
</tbody>
</table>
### 6.3. Component Interface Tcl Reference Revision History

The table below indicates edits made to the Component Interface Tcl Reference content since its creation.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 2014</td>
<td>14.1.0</td>
<td>• set_interface_upgrade_map</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Moved Port Roles (Interface Signal Types) section to Platform Designer Interconnect.</td>
</tr>
<tr>
<td>November 2013</td>
<td>13.1.0</td>
<td>• add_hdl_instance</td>
</tr>
<tr>
<td>May 2013</td>
<td>13.0.0</td>
<td>• Consolidated content from other Platform Designer chapters.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added AMBA APB support.</td>
</tr>
<tr>
<td>November 2012</td>
<td>12.1.0</td>
<td>• Added the demo_axi_memory example with screen shots and example_hw.tcl code.</td>
</tr>
<tr>
<td>June 2012</td>
<td>12.0.0</td>
<td>• Added AMBA 3 AXI support.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added: set_display_item_property, set_parameter_property,LONG_DESCRIPTION, and static filesets.</td>
</tr>
<tr>
<td>November 2011</td>
<td>11.1.0</td>
<td>• Template update.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added: set_qip_strings, get_qip_strings, get_device_family_displayname, check_device_family_equivalence.</td>
</tr>
<tr>
<td>May 2011</td>
<td>11.0.0</td>
<td>• Revised section describing HDL and composed component implementations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Separated reset and clock interfaces in example.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added: TRISTATECONDUIT_INFO, GENERATION_ID, UNIQUE_ID SYSTEM_INFO.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added: WIDTH and SYSTEM_INFO_ARG parameter properties.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed the doc_type argument from the add_documentation_link command.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Removed: get_instance_parameter_properties</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added: add_fileset, add_fileset_file, create_temp_file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated Tcl examples to show separate clock and reset interfaces.</td>
</tr>
<tr>
<td>December 2010</td>
<td>10.1.0</td>
<td>• Initial release.</td>
</tr>
</tbody>
</table>
**Related Information**

**Documentation Archive**

For previous versions of the *Intel Quartus Prime Handbook*, search the documentation archives.
7. Platform Designer System Design Components

You can use Platform Designer IP components to create Platform Designer systems. Platform Designer interfaces include components appropriate for streaming high-speed data, reading and writing registers and memory, controlling off-chip devices, and transporting data between components.

Note: Intel now refers to Qsys Pro as Platform Designer.

Platform Designer supports Avalon, AMBA 3 AXI (version 1.0), AMBA 4 AXI (version 2.0), AMBA 4 AXI-Lite (version 2.0), AMBA 4 AXI-Stream (version 1.0), and AMBA 3 APB (version 1.0) interface specifications.

Related Information
- Creating a System with Platform Designer on page 9
- Platform Designer Interconnect on page 357
- AMBA Protocol Specifications
- Embedded Peripherals IP User Guide
- Avalon Interface Specifications

7.1. Bridges

Bridges affect the way Platform Designer transports data between components. You can insert bridges between master and slave interfaces to control the topology of a Platform Designer system, which affects the interconnect that Platform Designer generates. You can also use bridges to separate components into different clock domains to isolate clock domain crossing logic.

A bridge has one slave interface and one master interface. In Platform Designer, one or more master interfaces from other components connect to the bridge slave. The bridge master connects to one or more slave interfaces on other components.
7. Platform Designer System Design Components

Figure 139. Using a Bridge in a Platform Designer System

In this example, three masters have logical connections to three slaves, although physically each master connects only to the bridge. Transfers initiated to the slave propagate to the master in the same order in which the transfers are initiated on the slave.

7.1.1. Clock Bridge

The Clock Bridge connects a clock source to multiple clock input interfaces. You can use the clock bridge to connect a clock source that is outside the Platform Designer system. Create the connection through an exported interface, and then connect to multiple clock input interfaces.

Clock outputs match fan-out performance without the use of a bridge. You require a bridge only when you want a clock from an exported source to connect internally to more than one source.
7.1.2. Avalon-MM Clock Crossing Bridge

The Avalon-MM Clock Crossing Bridge transfers Avalon-MM commands and responses between different clock domains. You can also use the Avalon-MM Clock Crossing Bridge between AXI masters and slaves of different clock domains.

The Avalon-MM Clock Crossing Bridge uses asynchronous FIFOs to implement clock crossing logic. The bridge parameters control the depth of the command and response FIFOs in both the master and slave clock domains. If the number of active reads exceeds the depth of the response FIFO, the Clock Crossing Bridge stops sending reads.

To maintain throughput for high-performance applications, increase the response FIFO depth from the default minimum depth, which is twice the maximum burst size.

Note: When you use the FIFO-based clock crossing a Platform Designer system, the DC FIFO is automatically inserted in the Platform Designer system. The reset inputs for the DC FIFO connect to the reset sources for the connected master and slave components on either side of the DC FIFO. For this configuration, you must assert both the resets on the master and the slave sides at the same time to ensure the DC FIFO resets properly. Alternatively, you can drive both resets from the same reset source to guarantee that the DC FIFO resets properly.

Note: The clock crossing bridge includes appropriate SDC constraints for its internal asynchronous FIFOs. For these SDC constraints to work correctly, do not set false paths on the pointer crossings in the FIFOs. Do not split the bridge's clocks into separate clock groups when you declare SDC constraints; the split has the same effect as setting false paths.
7.1.2.1. Avalon-MM Clock Crossing Bridge Example

In the example shown below, the Avalon-MM Clock Crossing bridges separate slave components into two groups. The Avalon-MM Clock Crossing Bridge places the low performance slave components behind a single bridge and clocks the components at a lower speed. The bridge places the high-performance components behind a second bridge and clocks it at a higher speed.

By inserting clock-crossing bridges, you simplify the Platform Designer interconnect and allow the Intel Quartus Prime Fitter to optimize paths that require minimal propagation delay.

**Figure 141. Avalon-MM Clock Crossing Bridge**
### 7.1.2.2. Avalon-MM Clock Crossing Bridge Parameters

**Table 109. Avalon-MM Clock Crossing Bridge Parameters**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data width</td>
<td>8, 16, 32, 64, 128, 256, 512, 1024 bits</td>
<td>Determines the data width of the interfaces on the bridge, and affects the size of both FIFOs. For the highest bandwidth, set Data width to be as wide as the widest master that connects to the bridge.</td>
</tr>
<tr>
<td>Symbol width</td>
<td>1, 2, 4, 8, 16, 32, 64 (bits)</td>
<td>Number of bits per symbol. For example, byte-oriented interfaces have 8-bit symbols.</td>
</tr>
<tr>
<td>Address width</td>
<td>1-32 bits</td>
<td>The address bits needed to address the downstream slaves.</td>
</tr>
<tr>
<td>Use automatically-determined address width</td>
<td>-</td>
<td>The minimum bridge address width that is required to address the downstream slaves.</td>
</tr>
<tr>
<td>Maximum burst size</td>
<td>1, 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024 bits</td>
<td>Determines the maximum length of bursts that the bridge supports.</td>
</tr>
<tr>
<td>Command FIFO depth</td>
<td>2, 4, 8, 16, 32, 64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384 bits</td>
<td>Command (master-to-slave) FIFO depth.</td>
</tr>
<tr>
<td>Respond FIFO depth</td>
<td>2, 4, 8, 16, 32, 64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384 bits</td>
<td>Slave-to-master FIFO depth.</td>
</tr>
<tr>
<td>Master clock domain synchronizer depth</td>
<td>2, 3, 4, 5 bits</td>
<td>The number of pipeline stages in the clock crossing logic in the issuing master to target slave direction. Increasing this value leads to a larger mean time between failures (MTBF). You can determine the MTBF for a design by running a timing analysis.</td>
</tr>
<tr>
<td>Slave clock domain synchronizer depth</td>
<td>2, 3, 4, 5 bits</td>
<td>The number of pipeline stages in the clock crossing logic in the target slave to master direction. Increasing this value leads to a larger meantime between failures (MTBF). You can determine the MTBF for a design by running a timing analysis.</td>
</tr>
</tbody>
</table>

### 7.1.3. Avalon-MM Pipeline Bridge

The Avalon-MM Pipeline Bridge inserts a register stage in the Avalon-MM command and response paths. The bridge accepts commands on its slave port and propagates the commands to its master port. The pipeline bridge provides separate parameters to turn on pipelining for command and response signals.

The **Maximum pending read transactions** parameter is the maximum number of pending reads that the Avalon-MM bridge can queue up. To determine the best value for this parameter, review this same option for the bridge's connected slaves and identify the highest value of the parameter, and then add the internal buffering requirements of the Avalon-MM bridge. In general, the value is between 4 and 32. The limit for maximum queued transactions is 64.

You can use the Avalon-MM bridge to export a single Avalon-MM slave interface to control multiple Avalon-MM slave devices. The pipelining feature is optional.
In this example, the bridge transfers commands received on its slave interface to its master port. Because the slave interface is exported to the pins of the device, having a single slave port, rather than separate ports for each slave device, reduces the pin count of the FPGA.

7.1.4. Avalon-MM Unaligned Burst Expansion Bridge

The Avalon-MM Unaligned Burst Expansion Bridge aligns read burst transactions from masters connected to its slave interface, to the address space of slaves connected to its master interface. This alignment ensures that all read burst transactions are delivered to the slave as a single transaction.
You can use the Avalon Unaligned Burst Expansion Bridge to align read burst transactions from masters that have narrower data widths than the target slaves. Using the bridge for this purpose improves bandwidth utilization for the master-slave pair, and ensures that unaligned bursts are processed as single transactions rather than multiple transactions.

**Note:** Do not use the Avalon-MM Unaligned Burst Expansion Bridge if any connected slave has read side effects from reading addresses that are exposed to any connected master's address map. This bridge can cause read side effects due to alignment modification to read burst transaction addresses.

**Note:** The Avalon-MM Unaligned Burst Expansion Bridge does not support VHDL simulation.

### 7.1.4.1. Using the Avalon-MM Unaligned Burst Expansion Bridge

When a master sends a read burst transaction to a slave, the Avalon-MM Unaligned Burst Expansion Bridge initially determines whether the start address of the read burst transaction is aligned to the slave's memory address space. If the base address is aligned, the bridge does not change the base address. If the base address is not aligned, the bridge aligns the base address to the nearest aligned address that is less than the requested base address.

The Avalon-MM Unaligned Burst Expansion Bridge then determines whether the final word requested by the master is the last word at the slave read burst address. If a single slave address contains multiple words, all those words must be requested for a single read burst transaction to occur.

- If the final word requested by the master is the last word at the slave read burst address, the bridge does not modify the burst length of the read burst command to the slave.
- If the final word requested by the master is not the last word at the slave read burst address, the bridge increases the burst length of the read burst command to the slave. The final word requested by the modified read burst command is then the last word at the slave read burst address.
The bridge stores information about each aligned read burst command that it sends to slaves connected to a master interface. When a read response is received on the master interface, the bridge determines if the base address or burst length of the issued read burst command was altered.

If the bridge alters either the base address or the burst length of the issued read burst command, it receives response words that the master did not request. The bridge suppresses words that it receives from the aligned burst response that are not part of the original read burst command from the master.

### 7.1.4.2. Avalon-MM Unaligned Burst Expansion Bridge Parameters

#### Table 110. Avalon-MM Unaligned Burst Expansion Bridge Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data width</td>
<td>Data width of the master connected to the bridge.</td>
</tr>
<tr>
<td>Address width (in WORDS)</td>
<td>The address width of the master connected to the bridge.</td>
</tr>
<tr>
<td>Burstcount width</td>
<td>The burstcount signal width of the master connected to the bridge.</td>
</tr>
<tr>
<td>Maximum pending read transactions</td>
<td>The <strong>Maximum pending read transactions</strong> parameter is the maximum number of pending reads that the Avalon-MM bridge can queue up. To determine the best value for this parameter, review this same option for the bridge’s connected slaves and identify the highest value of the parameter, and then add the internal buffering requirements of the Avalon-MM bridge. In general, the value is between 4 and 32. The limit for maximum queued transactions is 64.</td>
</tr>
<tr>
<td>Width of slave to optimize for</td>
<td>The data width of the connected slave. Supported values are: 16, 32, 64, 128, 256, 512, 1024, 2048, and 4096 bits.</td>
</tr>
</tbody>
</table>

*continued...*
7.1.4.3. Avalon-MM Unaligned Burst Expansion Bridge Example

**Figure 145. Unaligned Burst Expansion Bridge**

The example below shows an unaligned read burst command from a master that the Avalon-MM Unaligned Burst Expansion Bridge converts to an aligned request for a connected slave, and the suppression of words due to the aligned read burst command. In this example, a 32-bit master requests an 8-beat burst of 32-bit words from a 64-bit slave with a start address that is not 64-bit aligned.

Because the target slave has a 64-bit data width, address 1 is unaligned in the slave's address space. As a result, several smaller burst transactions are needed to request the data associated with the master's read burst command.

With an Avalon-MM Unaligned Burst Expansion Bridge in place, the bridge issues a new read burst command to the target slave beginning at address 0 with burst length 10, which requests data up to the word stored at address 9.

When the bridge receives the word corresponding to address 0, it suppresses it from the master, and then delivers the words corresponding to addresses 1 through 8 to the master. When the bridge receives the word corresponding to address 9, it suppresses that word from the master.

### 7.1.5. Bridges Between Avalon and AXI Interfaces

When designing a Platform Designer system, you can make connections between AXI and Avalon interfaces without the use of explicitly-instantiated bridges; the interconnect provides all necessary bridging logic. However, this does not prevent the use of explicit bridges to separate the AXI and Avalon domains.
7.1.6. AXI Bridge

With an AXI bridge, you can influence the placement of resource-intensive components, such as the width and burst adapters. Depending on its use, an AXI bridge may reduce throughput and concurrency, in return for higher $f_{\text{MAX}}$ and less logic.

You can use an AXI bridge to group different parts of your Platform Designer system. Other parts of the system can then connect to the bridge interface instead of to multiple separate master or slave interfaces. You can also use an AXI bridge to export AXI interfaces from Platform Designer systems.

Example 28. Reducing the Number of Adapters by Adding a Bridge

The figure shows a system with a single AXI master and three AXI slaves. It also has various interconnect components, such as routers, demultiplexers, and multiplexers. Two of the slaves have a narrower data width than the master; 16-bit slaves versus a 32-bit master.
Four width adapters (0 - 3) and four burst adapters (0 - 3) are inserted between the master and slaves for transaction adaptation for the example system.

In this system, Platform Designer interconnect creates four width adapters and four burst adapters to access the two slaves.

You can improve resource usage by adding an AXI bridge. Then, Platform Designer needs to add only two width adapters and two burst adapters; one pair for the read channels, and another pair for the write channel.
The figure shows the same system with an AXI bridge component, and the decrease in the number of width and burst adapters. Platform Designer creates only two width adapters and two burst adapters, as compared to the four width adapters and four burst adapters in the previous figure.

Even though this system includes more components, the overall system performance improves because there are fewer resource-intensive width and burst adapters.

### 7.1.6.1. AXI Bridge Signal Types

Based on parameter selections that you make for the AXI Bridge component, Platform Designer instantiates either the AMBA 3 AXI or AMBA 3 AXI master and slave interfaces into the component.
Note: In AMBA 3 AXI, aw/aruser accommodates sideband signal usage by hard processor systems (HPS).

Table 111. Sets of Signals for the AXI Bridge Based on the Protocol

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>AMBA 3 AXI</th>
<th>AMBA 3 AXI</th>
</tr>
</thead>
<tbody>
<tr>
<td>awid / arid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awaddr / araddr</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awlen / arlen</td>
<td>yes (4-bit)</td>
<td>yes (8-bit)</td>
</tr>
<tr>
<td>awsize / arsize</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awburst / arburst</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awlock / arlock</td>
<td>yes</td>
<td>yes (1-bit optional)</td>
</tr>
<tr>
<td>awcache / arcache</td>
<td>yes (2-bit)</td>
<td>yes (optional)</td>
</tr>
<tr>
<td>awprot / arprot</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awuser / aruser</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awvalid / arvalid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awready / arready</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>awqos / arqos</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>awregion / arregion</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>wid</td>
<td>yes</td>
<td>no (optional)</td>
</tr>
<tr>
<td>wdata / rdata</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>wstrb</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>wlast / rvalid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>wvalid / rvalid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>wready / rready</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>wuser / ruser</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>bid / rid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>bresp / rresp</td>
<td>yes</td>
<td>yes (optional)</td>
</tr>
<tr>
<td>bvalid</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>bready</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>

7.1.6.2. AXI Bridge Parameters

In the parameter editor, you can customize the parameters for the AXI bridge according to the requirements of your design.
**Table 112. AXI Bridge Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXI Version</td>
<td>string</td>
<td>AMBA 3, AXI or AMBA 3 AXI</td>
<td>Specifies the AXI version and signals that Platform Designer generates for the slave and master interfaces of the bridge.</td>
</tr>
<tr>
<td>Data Width</td>
<td>integer</td>
<td>8:1024</td>
<td>Controls the width of the data for the master and slave interfaces.</td>
</tr>
<tr>
<td>Address Width</td>
<td>integer</td>
<td>1-64 bits</td>
<td>Controls the width of the address for the master and slave interfaces.</td>
</tr>
<tr>
<td>AWUSER Width</td>
<td>integer</td>
<td>1-64 bits</td>
<td>Controls the width of the write address channel sideband signals of the master and slave interfaces.</td>
</tr>
<tr>
<td>ARUSER Width</td>
<td>integer</td>
<td>1-64 bits</td>
<td>Controls the width of the read address channel sideband signals of the master and slave interfaces.</td>
</tr>
<tr>
<td>WUSER Width</td>
<td>integer</td>
<td>1-64 bits</td>
<td>Controls the width of the write data channel sideband signals of the master and slave interfaces.</td>
</tr>
<tr>
<td>RUSER Width</td>
<td>integer</td>
<td>1-16 bits</td>
<td>Controls the width of the read data channel sideband signals of the master and slave interfaces.</td>
</tr>
<tr>
<td>BUSER Width</td>
<td>integer</td>
<td>1-16 bits</td>
<td>Controls the width of the write response channel sideband signals of the master and slave interfaces.</td>
</tr>
</tbody>
</table>
7.1.6.3. AXI Bridge Slave and Master Interface Parameters

Table 113. AXI Bridge Slave and Master Interface Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID Width</td>
<td>Controls the width of the thread ID of the master and slave interfaces.</td>
</tr>
<tr>
<td>Write/Read/Combined Acceptance Capability</td>
<td>Controls the depth of the FIFO that Platform Designer needs in the interconnect agents based on the maximum pending commands that the slave interface accepts.</td>
</tr>
<tr>
<td>Write/Read/Combined Issuing Capability</td>
<td>Controls the depth of the FIFO that Platform Designer needs in the interconnect agents based on the maximum pending commands that the master interface issues. Issuing capability must follow acceptance capability to avoid unnecessary creation of FIFOs in the bridge.</td>
</tr>
</tbody>
</table>

Note: Maximum acceptance/issuing capability is a model-only parameter and does not influence the bridge HDL. The bridge does not backpressure when this limit is reached. Downstream components or the interconnect must apply backpressure.

7.1.7. AXI Timeout Bridge

The AXI Timeout Bridge allows your system to recover when it freezes, and facilitates debugging. You can place an AXI Timeout Bridge between a single master and a single slave if you know that the slave may time out and cause your system to freeze. If a slave does not accept a command or respond to a command it accepted, its master can wait indefinitely.

For a domain with multiple masters and slaves, placement of an AXI Timeout Bridge in your design may be beneficial in the following scenarios:

- To recover from a freeze, place the bridge near the slave. If the master attempts to communicate with a slave that freezes, the AXI Timeout Bridge frees the master by generating error responses. The master is then able to communicate with another slave.
- When debugging your system, place the AXI Timeout Bridge near the master. This placement enables you to identify the origin of the burst, and to obtain the full address from the master. Additionally, placing an AXI Timeout Bridge near the master enables you to identify the target slave for the burst.

Note: If you place the bridge at the slave’s side and you have multiple slaves connected to the same master, you do not get the full address.
7.1.7.1. AXI Timeout Bridge Stages

A timeout occurs when the internal timer in the bridge exceeds the specified number of cycles within which a burst must complete from start to end.
Figure 152. AXI Timeout Bridge Stages

- **A** Slave is functional - The bridge passes through all bursts.
- **B** Slave is unresponsive - The bridge accepts commands and responds (with errors) to commands for the unresponsive slave. Commands are not passed through to the slave at this stage.
- **C** Slave is reset - The bridge does not accept new commands, and responds only to commands that are outstanding.

- When a timeout occurs, the AXI Timeout Bridge asserts an interrupt and reports the burst that caused the timeout to the Configuration and Status Register (CSR).
- The bridge then generates error responses back to the master on behalf of the unresponsive slave. This stage frees the master and certifies the unresponsive slave as dysfunctional.
- The AXI Timeout Bridge accepts subsequent write addresses, write data, and read addresses to the dysfunctional slave. The bridge does not accept outstanding write responses, and read data from the dysfunctional slave is not passed through to the master.
- The awvalid, wvalid, bready, arvalid, and rready ports are held low at the master interface of the bridge.

**Note:** After a timeout, awvalid, wvalid, and arvalid may be dropped before they are accepted by awready at the master interface. While the behavior violates the AXI specification, it occurs only on an interface connected to the slave which has been certified dysfunctional by the AXI Timeout Bridge.

Write channel refers to the AXI write address, data and response channels. Similarly, read channel refers to the AXI read address and data channels. AXI write and read channels are independent of each other. However, when a timeout occurs on either channel, the bridge generates error responses on both channels.
The AXI Timeout Bridge has four required interfaces: Master, Slave, Configuration and Status Register (CSR) (AMBA 3 AXI-Lite), and Interrupt. Platform Designer allows the AXI Timeout Bridge to connect to any AMBA 3 AXI, AMBA 3 AXI, or Avalon master or slave interface. Avalon masters must utilize the bridge's interrupt output to detect a timeout.

The bridge slave interface accepts write addresses, write data, and read addresses, and then generates the SLVERR response at the write response and read data channels. Do not use buser, rdata and ruser at this stage of processing.

To resume normal operation, the dysfunctional slave must be reset and the bridge notified of the change in status via the CSR. Once the CSR notifies the bridge that the slave is ready, the bridge does not accept new commands until all outstanding bursts are responded to with an error response.

The CSR has a 4-bit address width and a 32-bit data width. The CSR reports status and address information when the bridge asserts an interrupt.

### Table 115. CSR Interrupt Status Information for the AXI Timeout Bridge

<table>
<thead>
<tr>
<th>Address</th>
<th>Attribute</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0</td>
<td>write-only</td>
<td>Slave is reset</td>
</tr>
<tr>
<td>0x4</td>
<td>read-only</td>
<td>Timed out operation</td>
</tr>
<tr>
<td>0x8 through 0xF</td>
<td>read-only</td>
<td>Timed out address</td>
</tr>
</tbody>
</table>

### 7.1.7.2. AXI Timeout Bridge Parameters

### Table 116. AXI Timeout Bridge Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID width</td>
<td>The width of awid, bid, arid, or rid.</td>
</tr>
<tr>
<td>Address width</td>
<td>The width of awaddr or araddr.</td>
</tr>
<tr>
<td>Data width</td>
<td>The width of wdata or rdata.</td>
</tr>
<tr>
<td>User width</td>
<td>The width of awuser, wuser, buser, aruser, or ruser.</td>
</tr>
<tr>
<td>Maximum number of outstanding writes</td>
<td>The expected maximum number of outstanding writes.</td>
</tr>
<tr>
<td>Maximum number of outstanding reads</td>
<td>The expected maximum number of outstanding reads.</td>
</tr>
<tr>
<td>Maximum number of cycles</td>
<td>The number of cycles within which a burst must complete.</td>
</tr>
</tbody>
</table>
7.1.8. Address Span Extender

The **Address Span Extender** allows memory-mapped master interfaces to access a larger or smaller address map than the width of their address signals allows. The address span extender splits the addressable space into multiple separate windows, so that the master can access the appropriate part of the memory through the window.

The address span extender does not limit master and slave widths to a 32-bit and 64-bit configuration. You can use the address span extender with 1-64 bit address windows.

**Figure 153. Address Span Extender**

If a processor can address only 2 GB of an address span, and your system contains 4 GB of memory, the address span extender can provide two, 2 GB windows in the 4 GB memory address space. This issue sometimes occurs with Intel SoC devices.

For example, an HPS subsystem in an SoC device can address only 1 GB of an address span within the FPGA, using the HPS-to-FPGA bridge. The address span extender enables the SoC device to address all the address space in the FPGA using multiple 1 GB windows.

**Related Information**

Platform Designer 64-Bit Addressing Support on page 86

7.1.8.1. CTRL Register Layout

The control registers consist of one 64-bit register for each window, where you specify the window's base address. For example, if `CTRL_BASE` is the base address of the control register, and address span extender contains two windows (0 and 1), then window 0's control register starts at `CTRL_BASE`, and window 1's control register starts at `CTRL_BASE + 8` (using byte addresses).
### 7.1.8.2. Address Span Extender Parameters

#### Table 117. Address Span Extender Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datapath Width</td>
<td>Width of write data and read data signals.</td>
</tr>
<tr>
<td>Expanded Master Byte Address Width</td>
<td>Width of the master byte address port. That is, the address span size of all the downstream slaves that attach to the address span extender.</td>
</tr>
<tr>
<td>Slave Word Address Width</td>
<td>Width of the slave word address port. That is, the address span size of the downstream slaves that the upstream master accesses.</td>
</tr>
<tr>
<td>Burstcount Width</td>
<td>Burst count port width of the downstream slave and the upstream master that attach to the address span extender.</td>
</tr>
<tr>
<td>Number of sub-windows</td>
<td>The slave port can represent one or more windows in the master address span. You can subdivide the slave address span into ( N ) equal spans in ( N ) sub-windows. A remapping register in the CSR slave represents each sub-window, and configures the base address that each sub-window remaps to. The address span extender replaces the upper bits of the address with the stored index value in the remapping register before the master initiates a transaction.</td>
</tr>
<tr>
<td>Enable Slave Control Port</td>
<td>Dictates run-time control over the sub-window indexes. If you can define static re-mappings that do not need any change, you do not need to enable this CSR slave.</td>
</tr>
<tr>
<td>Maximum Pending Reads</td>
<td>Sets the bridge slave's <code>maximumPendingReadTransactions</code> property. In certain system configurations, you must increase this value to improve performance. This value usually aligns with the properties of the downstream slaves that you attach to this bridge.</td>
</tr>
</tbody>
</table>

### 7.1.8.3. Calculating the Address Span Extender Slave Address

The diagram describes how Platform Designer calculates the slave address. In this example, the address span extender is configured with a 28-bit address space for slaves. The upper 2 bits \([27:26]\) are used to select the control registers.

The lower 26 bits \([25:0]\) originate from the address span extender’s data port, and are the offset into a particular window.

#### Figure 154. Address Span Extender

![Address Span Extender Diagram](image)
7.1.8.4. Using the Address Span Extender

This example shows when and how to use address span extender component in your Platform Designer design.

**Figure 155. Block Diagram with Address Span Extender**

In the above design, a 32-bit master shares 4 GB SDRAM with an external streaming interface. The master has the path to access streaming data from the SDRAM DDR memory. However, if you connect the whole 32-bit address bus of the master to the SDRAM DDR memory, you cannot connect the master to peripherals such as LED or UART. To avoid this situation, you can implement the address span extender between the master and DDR memory. The address span extender allows the master to access the SDRAM DDR memory and the peripherals at the same time.

To implement address span extender for the above example, you can divide the address window of the address span extender into two sub-windows of 512 MB each. The sub-window 0 is for the master program area. You can dynamically map the sub-window 1 to any area other than the program area.

You can change the offset of the address window by setting the base address of sub-window 1 to the control register of the address span extender. However, you must make sure that the sub-window address span masks the base address. You can choose any arbitrary base address. If you set the value 0xa000_0000 to the control register, Platform Designer maps the sub-window 1 to 0xa000_0000.
Table 118. CSR Mapping Table

<table>
<thead>
<tr>
<th>Address</th>
<th>Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x8000_0000</td>
<td>0x0000_0000</td>
</tr>
<tr>
<td>0x8000_0008</td>
<td>0xa000_0000</td>
</tr>
</tbody>
</table>

Figure 156. Memory mapping for Address Span Extender

The table below indicates the Platform Designer parameter settings for this address span extender example.

Table 119. Parameter Settings for the Address Span Extender Example

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datapath Width</td>
<td>32 bits</td>
<td>The CPU has 32-bits data width and the SDRAM DDR memory has 512-bits data width. Since the transaction between the master and SDRAM DDR memory is minimal, set the datapath width to align with the upstream master.</td>
</tr>
<tr>
<td>Expanded Master Byte Address</td>
<td>32 bits</td>
<td>The address span extender has a 4 GB address span.</td>
</tr>
<tr>
<td>Slave Word Address Width</td>
<td>18 bits</td>
<td>There are two 512 MB sub-windows in reserve for the master. The number of bytes over the data word width in the Datapath Properties (4 bytes for this example) accounts for the slave address.</td>
</tr>
<tr>
<td>Burstcount Width</td>
<td>4 bits</td>
<td>The address span extender must handle up to 8 words burst in this example.</td>
</tr>
<tr>
<td>Number of sub-windows</td>
<td>2</td>
<td>Address window of the address span extender has two sub-windows of 512 MB each.</td>
</tr>
<tr>
<td>Enable Slave Control Port</td>
<td>true</td>
<td>The address span extender component must have control to change the base address of the sub-window.</td>
</tr>
<tr>
<td>Maximum Pending Reads</td>
<td>4</td>
<td>This number is the same as SDRAM DDR memory burst count.</td>
</tr>
</tbody>
</table>
Figure 157. Address Span Extender Parameter Editor

Note: You can view the address span extender connections in the **System Contents** tab. The windowed slave port and control port connect to the master. The expanded master port connects to the SDRAM DDR memory.

### 7.1.8.5. Alternate Options for the Address Span Extender

You can set parameters for the address span extender with an initial fixed address value. Enter an address for the **Reset Default for Master Window** option, and select **True** for the **Disable Slave Control Port** option. This allows the address span extender to function as a fixed, non-programmable component.

Each sub-window is equal in size and stacks sequentially in the windowed slave interface's address space. To control the fixed address bits of a particular sub-window, you can write to the sub-window's register in the register control slave interface. Platform Designer structures the logic so that Platform Designer can optimize and remove bits that are not needed.

If **Burstcount Width** is greater than 1, Platform Designer processes the read burst in a single cycle, and assumes all byteenable signals are asserted on every cycle.

### 7.1.8.6. Nios II Support

If the address span extender window is fixed, for example, the **Disable Slave Control Port** option is turned on, then the address span extender performs as a bridge. Components on the slave side of the address span extender that are within the window are visible to the Nios II processor. Components partially within a window appear to the Nios II processor as if they have a reduced span. For example, a memory partially within a window appears as having a smaller size.

You can also use the address span extender to provide a window for the Nios II processor, so that the HPS memory map is visible to the Nios II processor. This technique allows the Nios II processor to communicate with HPS peripherals.
In the example, a Nios II processor has an address span extender from address 0x40000 to 0x80000. There is a window within the address span extender starting at 0x100000. Within the address span extender’s address space there is a slave at base address 0x1100000. The slave appears to the Nios II processor as being at address:

\[
0x110000 - 0x100000 + 0x40000 = 0x050000
\]

The address span extender window is dynamic. For example, when the **Disable Slave Control Port** option is turned off, the Nios II processor is unable to see components on the slave side of the address span extender.

### 7.2. Error Response Slave

The Error Response Slave provides a predictable error response service for master interfaces that attempt to access an undefined memory region.

The Error Response Slave is an AMBA 3 AXI component, and appears in the Platform Designer IP Catalog under **Platform Designer Interconnect**.

To comply with the AXI protocol, the interconnect logic must return the **DECERR** error response in cases where the interconnect cannot decode slave access. Therefore, an AXI system with address space not fully decoded to slave interfaces requires the Error Response Slave.

The Error Response Slave behaves like any other component in the system, and connects to other components via translation and adaptation interconnect logic. Connecting an Error Response Slave to masters of different data widths, including Avalon or AXI-Lite masters, can increase resource usage.

An Error Response Slave can connect to clock, reset, and IRQ signals as well as AMBA 3 AXI and AMBA 4 AXI master interfaces without instantiating a bridge. When you connect an Error Response Slave to a master, the Error Response Slave accepts cycles sent from the master, and returns the **DECERR** error response. On the AXI interface, the Error Response Slave supports only a read and write acceptance of capability 1,
and does not support write data interleaving. The Error Response Slave can return responses when simultaneously targeted by a read and write cycle, because its read and write channels are independent.

An optional Avalon interface on the Error Response Slave provides information in a set of CSR registers. CSR registers log the required information when returning an error response.

- To set the Error Response Slave as the default slave for a master interface in your system, connect the slave to the master in your Platform Designer system.
- A system can contain more than one Error Response Slave.
- As a best practice, instantiate separate Error Response Slave components for each AXI master in your system.

**Related Information**
- AMBA 3 AXI Protocol Specification Support (version 1.0) on page 418
- Designating a Default Slave in the System Contents Tab on page 648

### 7.2.1. Error Response Slave Parameters

**Figure 159. Error Response Slave Parameter Editor**

If you turn on **Enable CSR Support (for error logging)** more parameters become available.
Figure 160. Error Response Slave Parameter Editor with Enabled CSR Support

Table 120. Error Response Slave Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXI master ID width</td>
<td>1-8 bits</td>
<td>Specifies the master ID width for error logging.</td>
</tr>
<tr>
<td>AXI address width</td>
<td>8-64 bits</td>
<td>Specifies the address width for error logging. This value also affects the overall address width of the system, and should not exceed the maximum address width required in the system.</td>
</tr>
<tr>
<td>AXI data width</td>
<td>32, 64, or 128 bits</td>
<td>Specifies the data width for error logging.</td>
</tr>
<tr>
<td>Enable CSR Support (for error logging)</td>
<td>On / Off</td>
<td>When turned on, instantiates an Avalon CSR interface for error logging.</td>
</tr>
<tr>
<td>CSR Error Log Depth</td>
<td>1-16 bits</td>
<td>Depth of the transaction log, for example, the number of transactions the CSR logs for cycles with errors.</td>
</tr>
<tr>
<td>Register Avalon CSR inputs</td>
<td>On / Off</td>
<td>When turned on, controls debug access to the CSR interface.</td>
</tr>
</tbody>
</table>

7.2.2. Error Response Slave CSR Registers

The Error Response Slave with enabled CSR support provides a service to handle access violations. This service uses CSR registers for status and logging purposes.

The sequence of actions in the access violation service is equivalent for read and write access violations, but the CSR status bits and log registers are different.

7.2.2.1. Error Response Slave Access Violation Service

When an access violation occurs, and the CSR port is enabled:

1. The Error Response Slave generates an interrupt:
   - For a read access violation, the Error Response Slave sets the Read Access Violation Interrupt register bit in the Interrupt Status register.
— For a write access violation, the Error Response Slave sets the Write Access Violation Interrupt register bit in the Interrupt Status register.

2. The Error Response Slave transfers transaction information to the access violation log FIFO. The amount of information that the FIFO can handle is given by the Error Log Depth parameter.

You define the Error Log Depth in the Parameter Editor, when you enable CSR Support.

3. Software reads entries of the access violation log FIFO until the corresponding cycle log valid bit is cleared, and then exits the service routine.
   - The Read cycle log valid bit is in the Read Access Violation Log CSR Registers.
   - The Write cycle log valid bit is in the Write Access Violation Log CSR Registers.

4. The Error Response Slave clears the interrupt bit when there are no access violations to report.

Some special cases are:
- If any error occurs when the FIFO is full, the Error Response Slave sets the corresponding Access Violation Interrupt Overflow register bit (bits 2 and 3 of the Status Register for write and read access violations, respectively). Setting this bit means that not all error entries were written to the access violation log.
- After Software reads an entry in the Access Violation log, the Error Response Slave can write a new entry to the log.
- Software can specify the number of entries to read before determining that the access violation service is taking too long to complete, and exit the routine.

### 7.2.2.2. CSR Interrupt Status Registers

#### Table 121. CSR Interrupt Status Registers

For CSR register maps: Address = Memory Address Base + Offset.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Bits</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>31:4</td>
<td>Reserved.</td>
<td>0</td>
<td>Reservation</td>
</tr>
<tr>
<td>3</td>
<td>RW1C</td>
<td>0</td>
<td>Read Access Violation Interrupt Overflow register Asserted when a read access causes the Interconnect to return a DECERR response, and the buffer log depth is full. Indicates that there is a logging error lost due to an exceeded buffer log depth. Cleared by setting the bit to 1.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>RW1C</td>
<td>0</td>
<td>Write Access Violation Interrupt Overflow register Asserted when a write access causes the Interconnect to return a DECERR response, and the buffer log depth is full. Indicates that there is a logging error lost due to an exceeded buffer log depth. Cleared by setting the bit to 1.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>RW1C</td>
<td>0</td>
<td>Read Access Violation Interrupt register Asserted when a read access causes the Interconnect to return a DECERR response. Cleared by setting the bit to 1.</td>
<td></td>
</tr>
</tbody>
</table>

continued...
7.2.2.3. CSR Read Access Violation Log Registers

The CSR read access violation log settings are valid only when an associated read interrupt register is set. Read this set of registers until the validity bit is cleared.

Table 122. CSR Read Access Violation Log Registers

<table>
<thead>
<tr>
<th>Offset</th>
<th>Bits</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x100</td>
<td>31:13</td>
<td></td>
<td></td>
<td>Reserved.</td>
</tr>
<tr>
<td></td>
<td>12:11</td>
<td>R0</td>
<td>0</td>
<td>Offending Read cycle burst type: Specifies the burst type of the initiating cycle that causes the access violation.</td>
</tr>
<tr>
<td></td>
<td>10:7</td>
<td>R0</td>
<td>0</td>
<td>Offending Read cycle burst length: Specifies the burst length of the initiating cycle that causes the access violation.</td>
</tr>
<tr>
<td></td>
<td>6:4</td>
<td>R0</td>
<td>0</td>
<td>Offending Read cycle burst size: Specifies the burst size of the initiating cycle that causes the access violation.</td>
</tr>
<tr>
<td></td>
<td>3:1</td>
<td>R0</td>
<td>0</td>
<td>Offending Read cycle PROT: Specifies the PROT of the initiating cycle that causes the access violation.</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>R0</td>
<td>0</td>
<td>Read cycle log valid: Specifies the validity of the read access violation log. This bit is cleared when the interrupt register is cleared.</td>
</tr>
<tr>
<td>0x104</td>
<td>31:0</td>
<td></td>
<td></td>
<td>Offending read cycle ID: Master ID for the cycle that causes the access violation.</td>
</tr>
<tr>
<td>0x108</td>
<td>31:0</td>
<td></td>
<td></td>
<td>Offending read cycle target address: Target address for the cycle that causes the access violation (lower 32-bit).</td>
</tr>
<tr>
<td>0x10C</td>
<td>31:0</td>
<td></td>
<td></td>
<td>Offending read cycle target address: Target address for the cycle that causes the access violation (upper 32-bit). Valid only if widest address in system is larger than 32 bits. Note: When this register is read, the current read access violation log is recovered from FIFO.</td>
</tr>
</tbody>
</table>

7.2.2.4. CSR Write Access Violation Log Registers

The CSR write access violation log settings are valid only when an associated write interrupt register is set. Read this set of registers until the validity bit is cleared.

Table 123. CSR Write Access Violation Log

<table>
<thead>
<tr>
<th>Offset</th>
<th>Bits</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x190</td>
<td>31:13</td>
<td></td>
<td></td>
<td>Reserved.</td>
</tr>
<tr>
<td></td>
<td>12:11</td>
<td>R0</td>
<td>0</td>
<td>Offending write cycle burst type: Specifies the burst type of the initiating cycle that causes the access violation.</td>
</tr>
<tr>
<td></td>
<td>10:7</td>
<td>R0</td>
<td>0</td>
<td>Offending write cycle burst length: Specifies the burst length of the initiating cycle that causes the access violation.</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Offset</th>
<th>Bits</th>
<th>Attribute</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6:4</td>
<td>R0</td>
<td>0</td>
<td>Offending write cycle burst size: Specifies the burst size of the initiating cycle that causes the access violation.</td>
<td></td>
</tr>
<tr>
<td>3:1</td>
<td>R0</td>
<td>0</td>
<td>Offending write cycle PROT: Specifies the PROT of the initiating cycle that causes the access violation.</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>R0</td>
<td>0</td>
<td>Write cycle log valid: Specifies whether the log for the transaction is valid. This bit is cleared when the interrupt register is cleared.</td>
<td></td>
</tr>
<tr>
<td>0x194</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle ID: Master ID for the cycle that causes the access violation.</td>
<td></td>
</tr>
<tr>
<td>0x198</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle target address: Write target address for the cycle that causes the access violation (lower 32-bit).</td>
<td></td>
</tr>
<tr>
<td>0x19C</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle target address: Write target address for the cycle that causes the access violation (upper 32-bit). Valid only if widest address in system is larger than 32 bits.</td>
<td></td>
</tr>
<tr>
<td>0x1A0</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle first write data: First 32 bits of the write data for the write cycle that causes the access violation. Note: When this register is read, the current write access violation log is recovered from FIFO, when the data width is 32 bits.</td>
<td></td>
</tr>
<tr>
<td>0x1A4</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle first write data: Bits [63:32] of the write data for the write cycle that causes the access violation. Valid only if the data width is greater than 32 bits.</td>
<td></td>
</tr>
<tr>
<td>0x1A8</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle first write data: Bits [95:64] of the write data for the write cycle that causes the access violation. Valid only if the data width is greater than 64 bits.</td>
<td></td>
</tr>
<tr>
<td>0x1AC</td>
<td>31:0</td>
<td>R0</td>
<td>Offending write cycle first write data: The first bits [127:96] of the write data for the write cycle that causes the access violation. Valid only if the data width is greater than 64 bits. Note: When this register is read, the current write access violation log is recovered from FIFO.</td>
<td></td>
</tr>
</tbody>
</table>

### 7.2.3. Designating a Default Slave in the System Contents Tab

You can designate any slave in your Platform Designer system as the error response default slave. The default slave you designate provides an error response service for masters that attempt access to an undefined memory region.

1. In your Platform Designer system, in the System Contents tab, right-click the header and turn on Show Default Slave Column.
2. Select the slave that you want to designate as the default slave, and then click the checkbox for the slave in the Default Slave column.
3. In the System Contents tab, in the Connections column, connect the designated default slave to one or more masters.

**Related Information**

Specify a Default Slave in a Platform Designer System on page 66
7.3. Tri-State Components

The tri-state interface type allows you to design Platform Designer subsystems that connect to tri-state devices on your PCB. You can use tri-state components to implement pin sharing, convert between unidirectional and bidirectional signals, and create tri-state controllers for devices whose interfaces can be described using the tri-state signal types.

Example 29. Tri-State Conduit System to Control Off-Chip SRAM and Flash Devices

In this example, there are two generic Tri-State Conduit Controllers. The first is customized to control a flash memory. The second is customized to control an off-chip SSRAM. The Tri-State Conduit Pin Sharer multiplexes between these two controllers, and the Tri-State Conduit Bridge converts between an on-chip encoding of tri-state signals and true bidirectional signals. By default, the Tri-State Conduit Pin Sharer and Tri-State Conduit Bridge present byte addresses. Typically, each address location contains more than one byte of data.

Figure 161. Tri-State Conduit System to Control Off-Chip SRAM and Flash Devices

Address Connections from Platform Designer System to PCB

The flash device operates on 16-bit words and must ignore the least-significant bit of the Avalon-MM address. The figure shows addr[0] as not connected. The SSRAM memory operates on 32-bit words and must ignore the two low-order memory bits. Because neither device requires a byte address, addr[0] is not routed on the PCB.

The flash device responds to address range 0 MB to 8 MB-1. The SSRAM responds to address range 8 MB to 10 MB-1. The PCB schematic for the PCB connects addr[21:0] to addr[18:0] of the SSRAM device because the SSRAM responds to 32-bit word address. The 8 MB flash device accesses 16-bit words; consequently, the schematic does not connect addr[0]. The chipselect signals select between the two devices.
Figure 162. Address Connections from Platform Designer System to PCB

Note: If you create a custom tri-state conduit master with word aligned addresses, the Tri-state Conduit Pin Sharer does not change or align the address signals.

Figure 163. Tri-State Conduit System in Platform Designer

Related Information
- Avalon Tri-State Conduit Components User Guide
- Avalon Interface Specifications
7.3.1. Generic Tri-State Controller

The Generic Tri-State Controller provides a template for a controller. You can customize the tri-state controller with various parameters to reflect the behavior of an off-chip device. The following types of parameters are available for the tri-state controller:

- Width of the address and data signals
- Read and write wait times
- Bus-turnaround time
- Data hold time

**Note:** In calculating delays, the Generic Tri-State Controller chooses the larger of the bus-turnaround time and read latency. Turnaround time is measured from the time that a command is accepted, not from the time that the previous read returned data.

The Generic Tri-State Controller includes the following interfaces:

- **Memory-mapped slave interface**—This interface connects to a memory-mapped master, such as a processor.
- **Tristate Conduit Master interface**—The tri-state master interface usually connects to the tri-state conduit slave interface of the tri-state conduit pin sharer.
- **Clock sink**—The component’s clock reference. You must connect this interface to a clock source.
- **Reset sink**—This interface connects to a reset source interface.

7.3.2. Tri-State Conduit Pin Sharer

The Tri-state Conduit Pin Sharer multiplexes between the signals of the connected tri-state controllers. You connect all signals from the tri-state controllers to the Tri-state Conduit Pin Sharer and use the parameter editor to specify the signals that are shared.
The parameter editor includes a **Shared Signal Name** column. If the widths of shared signals differ, the signals are aligned on their 0th bit and the higher-order pins are driven to 0 whenever the smaller signal has control of the bus. Unshared signals always propagate through the pin sharer. The tri-state conduit pin sharer uses the round-robin arbiter to select between tri-state conduit controllers.

**Note:** All tri-state conduit components connected to a pin sharer must be in the same clock domain.

**Related Information**
Avalon-ST Round Robin Scheduler on page 676

### 7.3.3. Tri-State Conduit Bridge

The Tri-State Conduit Bridge instantiates bidirectional signals for each tri-state signal while passing all other signals straight through the component. The Tri-State Conduit Bridge registers all outgoing and incoming signals, which adds two cycles of latency for a read request. You must account for this additional pipelining when designing a custom controller. During reset, all outputs are placed in a high-impedance state. Outputs are enabled in the first clock cycle after reset is deasserted, and the output signals are then bidirectional.

### 7.4. Test Pattern Generator and Checker Cores

The test pattern generator inserts different error conditions, and the test pattern checker reports these error conditions to the control interface, each via an Avalon Memory-Mapped (Avalon-MM) slave.
The data generation and monitoring solution for Avalon-ST consists of two components: a test pattern generator core that generates data, and sends it out on an Avalon-ST data interface, and a test pattern checker core that receives the same data and verifies it. Optionally, the data can be formatted as packets, with accompanying start_of_packet and end_of_packet signals.

The **Throttle Seed** is the starting value for the throttle control random number generator. Intel recommends a unique value for each instance of the test pattern generator and checker cores in a system.

### 7.4.1. Test Pattern Generator

**Figure 165. Test Pattern Generator Core**

The test pattern generator core accepts commands to generate data via an Avalon-MM command interface, and drives the generated data to an Avalon-ST data interface. You can parameterize most aspects of the Avalon-ST data interface, such as the number of error bits and data signal width, thus allowing you to test components with different interfaces.

The data pattern is calculated as: Symbol Value = Symbol Position in Packet XOR Data Error Mask. Data that is not organized in packets is a single stream with no beginning or end. The test pattern generator has a throttle register that is set via the Avalon-MM control interface. The test pattern generator uses the value of the throttle register in conjunction with a pseudo-random number generator to throttle the data generation rate.

### 7.4.1.1. Test Pattern Generator Command Interface

The command interface for the Test Pattern Generator is a 32-bit Avalon-MM write slave that accepts data generation commands. It is connected to a 16-element deep FIFO, thus allowing a master peripheral to drive commands into the test pattern generator.
The command interface maps to the following registers: `cmd_lo` and `cmd_hi`. The command is pushed into the FIFO when the register `cmd_lo` (address 0) is addressed. When the FIFO is full, the command interface asserts the `waitrequest` signal. You can create errors by writing to the register `cmd_hi` (address 1). The errors are cleared when 0 is written to this register, or its respective fields.

7.4.1.2. Test Pattern Generator Control and Status Interface

The control and status interface of the Test Pattern Generator is a 32-bit Avalon-MM slave that allows you to enable or disable the data generation, as well as set the throttle. This interface also provides generation-time information, such as the number of channels and whether data packets are supported.

7.4.1.3. Test Pattern Generator Output Interface

The output interface of the Test Pattern Generator is an Avalon-ST interface that optionally supports data packets. You can configure the output interface to align with your system requirements. Depending on the incoming stream of commands, the output data may contain interleaved packet fragments for different channels. To keep track of the current symbol's position within each packet, the test pattern generator maintains an internal state for each channel.

You can configure the output interface of the test pattern generator with the following parameters:

- **Number of Channels**—Number of channels that the test pattern generator supports. Valid values are 1 to 256.
- **Data Bits Per Symbol**—Bits per symbol is related to the width of `readdata` and `writedata` signals, which must be a multiple of the bits per symbol.
- **Data Symbols Per Beat**—Number of symbols (words) that are transferred per beat. Valid values are 1 to 256.
- **Include Packet Support**—Indicates whether packet transfers are supported. Packet support includes the `startofpacket`, `endofpacket`, and `empty` signals.
- **Error Signal Width (bits)**—Width of the error signal on the output interface. Valid values are 0 to 31. A value of 0 indicates that the error signal is not in use.

*Note:* If you change only bits per symbol, and do not change the data width, errors are generated.

7.4.1.4. Test Pattern Generator Functional Parameter

The Test Pattern Generator functional parameter allows you to configure the test pattern generator as a whole system.
7.4.2. Test Pattern Checker

Figure 166. Test Pattern Checker

The test pattern checker core accepts data via an Avalon-ST interface and verifies it against the same predetermined pattern that the test pattern generator uses to produce the data. The test pattern checker core reports any exceptions to the control interface. You can parameterize most aspects of the test pattern checker's Avalon-ST interface such as the number of error bits and the data signal width. This enables the ability to test components with different interfaces. The test pattern checker has a throttle register that is set via the Avalon-MM control interface. The value of the throttle register controls the rate at which data is accepted.

The test pattern checker detects exceptions and reports them to the control interface via a 32-element deep internal FIFO. Possible exceptions are data error, missing start-of-packet (SOP), missing end-of-packet (EOP), and signaled error.

As each exception occurs, an exception descriptor is pushed into the FIFO. If the same exception occurs more than once consecutively, only one exception descriptor is pushed into the FIFO. All exceptions are ignored when the FIFO is full. Exception descriptors are deleted from the FIFO after they are read by the control and status interface.

7.4.2.1. Test Pattern Checker Input Interface

The Test Pattern Checker input interface is an Avalon-ST interface that optionally supports data packets. You can configure the input interface to align with your system requirements. Incoming data may contain interleaved packet fragments. To keep track of the current symbol's position, the test pattern checker maintains an internal state for each channel.

7.4.2.2. Test Pattern Checker Control and Status Interface

The Test Pattern Checker control and status interface is a 32-bit Avalon-MM slave that allows you to enable or disable data acceptance, as well as set the throttle. This interface provides generation-time information, such as the number of channels and whether the test pattern checker supports data packets. The control and status interface also provides information on the exceptions detected by the test pattern checker. The interface obtains this information by reading from the exception FIFO.
7.4.2.3. Test Pattern Checker Functional Parameter

The Test Pattern Checker functional parameter allows you to configure the test pattern checker as a whole system.

7.4.2.4. Test Pattern Checker Input Parameters

You can configure the input interface of the test pattern checker using the following parameters:

- **Data Bits Per Symbol**—Bits per symbol is related to the width of readdata and writedata signals, which must be a multiple of the bits per symbol.
- **Data Symbols Per Beat**—Number of symbols (words) that are transferred per beat. Valid values are 1 to 32.
- **Include Packet Support**—Indicates whether data packet transfers are supported. Packet support includes the startofpacket, endofpacket, and empty signals.
- **Number of Channels**—Number of channels that the test pattern checker supports. Valid values are 1 to 256.
- **Error Signal Width (bits)**—Width of the error signal on the input interface. Valid values are 0 to 31. A value of 0 indicates that the error signal in not in use.

**Note:** If you change only bits per symbol, and do not change the data width, errors are generated.

7.4.3. Software Programming Model for the Test Pattern Generator and Checker Cores

The HAL system library support, software files, and register maps describe the software programming model for the test pattern generator and checker cores.

7.4.3.1. HAL System Library Support

For Nios II processor users, Intel provides HAL system library drivers that allow you to initialize and access the test pattern generator and checker cores. Intel recommends you use the provided drivers to access the cores instead of accessing the registers directly.

For Nios II IDE users, copy the provided drivers from the following installation folders to your software application directory:

- `<IP installation directory>/ip/sopc_builder_ip/altera_Avalon_data_source/HAL`
- `<IP installation directory>/ip/sopc_builder_ip/altera_Avalon_data_sink/HAL`

**Note:** This instruction does not apply if you use the Nios II command-line tools.

7.4.3.2. Test Pattern Generator and Test Pattern Checker Core Files

The following files define the low-level access to the hardware, and provide the routines for the HAL device drivers.
Note: Do not modify the test pattern generator or test pattern checker core files.

- Test pattern generator core files:
  - `data_source_regs.h`—Header file that defines the test pattern generator's register maps.
  - `data_source_util.h, data_source_util.c`—Header and source code for the functions and variables required to integrate the driver into the HAL system library.

- Test pattern checker core files:
  - `data_sink_regs.h`—Header file that defines the core's register maps.
  - `data_sink_util.h, data_sink_util.c`—Header and source code for the functions and variables required to integrate the driver into the HAL system library.

### 7.4.3.3. Register Maps for the Test Pattern Generator and Test Pattern Checker Cores

#### 7.4.3.3.1. Test Pattern Generator Control and Status Registers

**Table 124. Test Pattern Generator Control and Status Register Map**

<table>
<thead>
<tr>
<th>Offset</th>
<th>Register Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>base + 0</td>
<td>status</td>
</tr>
<tr>
<td>base + 1</td>
<td>control</td>
</tr>
<tr>
<td>base + 2</td>
<td>fill</td>
</tr>
</tbody>
</table>

**Table 125. Test Pattern Generator Status Register Bits**

<table>
<thead>
<tr>
<th>Bits</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[15:0]</td>
<td>ID</td>
<td>RO</td>
<td>A constant value of 0x64.</td>
</tr>
<tr>
<td>[23:16]</td>
<td>NUMCHANNELS</td>
<td>RO</td>
<td>The configured number of channels.</td>
</tr>
<tr>
<td>[30:24]</td>
<td>NUMSYMBOLS</td>
<td>RO</td>
<td>The configured number of symbols per beat.</td>
</tr>
<tr>
<td>[31]</td>
<td>SUPPORTPACKETS</td>
<td>RO</td>
<td>A value of 1 indicates data packet support.</td>
</tr>
</tbody>
</table>

**Table 126. Test Pattern Generator Control Register Bits**

<table>
<thead>
<tr>
<th>Bits</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]</td>
<td>ENABLE</td>
<td>RW</td>
<td>Setting this bit to 1 enables the test pattern generator core.</td>
</tr>
<tr>
<td>[7:1]</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[16:8]</td>
<td>THROTTLE</td>
<td>RW</td>
<td>Specifies the throttle value which can be between 0–256, inclusively. The test pattern generator uses this value in conjunction with a pseudo-random number generator to throttle the data generation rate.</td>
</tr>
<tr>
<td>[17]</td>
<td>SOFT RESET</td>
<td>RW</td>
<td>When this bit is set to 1, all internal counters and statistics are reset. Write 0 to this bit to exit reset.</td>
</tr>
<tr>
<td>[31:18]</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 127. Test Pattern Generator Fill Register Bits

<table>
<thead>
<tr>
<th>Bits</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]</td>
<td>BUSY</td>
<td>RO</td>
<td>A value of 1 indicates that data transmission is in progress, or that there is at least one command in the command queue.</td>
</tr>
<tr>
<td>[6:1]</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[15:7]</td>
<td>FILL</td>
<td>RO</td>
<td>The number of commands currently in the command FIFO.</td>
</tr>
<tr>
<td>[31:16]</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7.4.3.3.2. Test Pattern Generator Command Registers

Table 128. Test Pattern Generator Command Register Map

Shows the offset for the command registers. Each register is 32-bits wide.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Register Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>base + 0</td>
<td>cmd_lo</td>
</tr>
<tr>
<td>base + 1</td>
<td>cmd_hi</td>
</tr>
</tbody>
</table>

The cmd_lo is pushed into the FIFO only when the cmd_lo register is addressed.

Table 129. cmd_lo Register Bits

<table>
<thead>
<tr>
<th>Bits</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[15:0]</td>
<td>SIZE</td>
<td>RW</td>
<td>The segment size in symbols. Except for the last segment in a packet, the size of all segments must be a multiple of the configured number of symbols per beat. If this condition is not met, the test pattern generator core inserts additional symbols to the segment to ensure the condition is fulfilled.</td>
</tr>
<tr>
<td>[29:16]</td>
<td>CHANNEL</td>
<td>RW</td>
<td>The channel to send the segment on. If the channel signal is less than 14 bits wide, the test pattern generator uses the low order bits of this register to drive the signal.</td>
</tr>
<tr>
<td>[30]</td>
<td>SOP</td>
<td>RW</td>
<td>Set this bit to 1 when sending the first segment in a packet. This bit is ignored when data packets are not supported.</td>
</tr>
<tr>
<td>[31]</td>
<td>EOP</td>
<td>RW</td>
<td>Set this bit to 1 when sending the last segment in a packet. This bit is ignored when data packets are not supported.</td>
</tr>
</tbody>
</table>

Table 130. cmd_hi Register Bits

<table>
<thead>
<tr>
<th>Bits</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[15:0]</td>
<td>SIGNALED ERROR</td>
<td>RW</td>
<td>Specifies the value to drive the error signal. A non-zero value creates a signaled error.</td>
</tr>
<tr>
<td>[23:16]</td>
<td>DATA ERROR</td>
<td>RW</td>
<td>The output data is XORed with the contents of this register to create data errors. To stop creating data errors, set this register to 0.</td>
</tr>
<tr>
<td>[24]</td>
<td>SUPPRESS SOP</td>
<td>RW</td>
<td>Set this bit to 1 to suppress the assertion of the startofpacket signal when the first segment in a packet is sent.</td>
</tr>
<tr>
<td>[25]</td>
<td>SUPRESS EOP</td>
<td>RW</td>
<td>Set this bit to 1 to suppress the assertion of the endofpacket signal when the last segment in a packet is sent.</td>
</tr>
</tbody>
</table>
### 7.4.3.3.3. Test Pattern Checker Control and Status Registers

**Table 131. Test Pattern Checker Control and Status Register Map**

Shows the offset for the control and status registers. Each register is 32 bits wide.

<table>
<thead>
<tr>
<th>Offset</th>
<th>Register Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>base + 0</td>
<td>status</td>
</tr>
<tr>
<td>base + 1</td>
<td>control</td>
</tr>
<tr>
<td>base + 2</td>
<td>Reserved</td>
</tr>
<tr>
<td>base + 3</td>
<td></td>
</tr>
<tr>
<td>base + 4</td>
<td></td>
</tr>
<tr>
<td>base + 5</td>
<td>exception_descriptor</td>
</tr>
<tr>
<td>base + 6</td>
<td>indirect_select</td>
</tr>
<tr>
<td>base + 7</td>
<td>indirect_count</td>
</tr>
</tbody>
</table>

**Table 132. Test Pattern Checker Status Register Bits**

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[15:0]</td>
<td>ID</td>
<td>RO</td>
<td>Contains a constant value of 0x65.</td>
</tr>
<tr>
<td>[23:16]</td>
<td>NUMCHANNELS</td>
<td>RO</td>
<td>The configured number of channels.</td>
</tr>
<tr>
<td>[30:24]</td>
<td>NUMSYMBOLS</td>
<td>RO</td>
<td>The configured number of symbols per beat.</td>
</tr>
<tr>
<td>[31]</td>
<td>SUPPORTPACKETS</td>
<td>RO</td>
<td>A value of 1 indicates packet support.</td>
</tr>
</tbody>
</table>

**Table 133. Test Pattern Checker Control Register Bits**

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]</td>
<td>ENABLE</td>
<td>RW</td>
<td>Setting this bit to 1 enables the test pattern checker.</td>
</tr>
<tr>
<td>[7:1]</td>
<td></td>
<td></td>
<td>Reserved</td>
</tr>
<tr>
<td>[16:8]</td>
<td>THROTTLE</td>
<td>RW</td>
<td>Specifies the throttle value which can be between 0–256, inclusively.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Platform Designer uses this value in conjunction with a pseudo-random number generator to throttle the data generation rate. Setting THROTTLE to 0 stops the test pattern generator core. Setting it to 256 causes the test pattern generator core to run at full throttle. Values between 0–256 result in a data rate proportional to the throttle value.</td>
</tr>
<tr>
<td>[17]</td>
<td>SOFT RESET</td>
<td>RW</td>
<td>When this bit is set to 1, all internal counters and statistics are reset. Write 0 to this bit to exit reset.</td>
</tr>
<tr>
<td>[31:18]</td>
<td></td>
<td></td>
<td>Reserved</td>
</tr>
</tbody>
</table>

If there is no exception, reading the exception_descriptor register bit register returns 0.

**Table 134. exception_descriptor Register Bits**

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0]</td>
<td>DATA ERROR</td>
<td>RO</td>
<td>A value of 1 indicates that an error is detected in the incoming data.</td>
</tr>
</tbody>
</table>
Table 135. indirect_select Register Bits

<table>
<thead>
<tr>
<th>Bit(s)</th>
<th>Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[7:0]</td>
<td>INDIRECT CHANNEL</td>
<td>RW</td>
<td>Specifies the channel number that applies to the INDIRECT PACKET COUNT, INDIRECT SYMBOL COUNT, and INDIRECT ERROR COUNT registers.</td>
</tr>
<tr>
<td>[15:8]</td>
<td>Reserved</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[31:16]</td>
<td>INDIRECT ERROR</td>
<td>RO</td>
<td>The number of data errors that occurred on the channel specified by INDIRECT CHANNEL.</td>
</tr>
</tbody>
</table>

Table 136. indirect_count Register Bits

<table>
<thead>
<tr>
<th>Bit</th>
<th>Bits Name</th>
<th>Access</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[15:0]</td>
<td>INDIRECT PACKET COUNT</td>
<td>RO</td>
<td>The number of data packets received on the channel specified by INDIRECT CHANNEL.</td>
</tr>
<tr>
<td>[31:16]</td>
<td>INDIRECT SYMBOL COUNT</td>
<td>RO</td>
<td>The number of symbols received on the channel specified by INDIRECT CHANNEL.</td>
</tr>
</tbody>
</table>

7.4.4. Test Pattern Generator API

The following subsections describe application programming interface (API) for the test pattern generator.

Note: API functions are currently not available from the interrupt service routine (ISR).

data_source_reset() on page 661
data_source_init() on page 661
data_source_get_id() on page 661
data_source_get_supports_packets() on page 662
data_source_get_num_channels() on page 662
data_source_get_symbols_per_cycle() on page 662
data_source_get_enable() on page 662
data_source_set_enable() on page 663
data_source_get_throttle() on page 663
data_source_set_throttle() on page 663
7.4.4.1. data_source_reset()

Table 137. data_source_reset()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>void data_source_reset(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>void</td>
</tr>
<tr>
<td>Description</td>
<td>Resets the test pattern generator core including all internal counters and FIFOs. The control and status registers are not reset by this function.</td>
</tr>
</tbody>
</table>

7.4.4.2. data_source_init()

Table 138. data_source_init()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_init(alt_u32 base, alt_u32 command_base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave. command_base—Base address of the command slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Initialization is successful. 0—Initialization is unsuccessful.</td>
</tr>
<tr>
<td>Description</td>
<td>Performs the following operations to initialize the test pattern generator core: • Resets and disables the test pattern generator core. • Sets the maximum throttle. • Clears all inserted errors.</td>
</tr>
</tbody>
</table>

7.4.4.3. data_source_get_id()

Table 139. data_source_get_id()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_get_id(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Test pattern generator core identifier.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the test pattern generator core's identifier.</td>
</tr>
</tbody>
</table>
7.4.4.4. data_source_get_supports_packets()

Table 140. data_source_get_supports_packets()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_init(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Data packets are supported. 0—Data packets are not supported.</td>
</tr>
<tr>
<td>Description</td>
<td>Checks if the test pattern generator core supports data packets.</td>
</tr>
</tbody>
</table>

7.4.4.5. data_source_get_num_channels()

Table 141. data_source_get_num_channels()

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_get_num_channels(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of channels supported.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of channels supported by the test pattern generator core.</td>
</tr>
</tbody>
</table>

7.4.4.6. data_source_get_symbols_per_cycle()

Table 142. data_source_get_symbols_per_cycle()

<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_get_symbols(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_source_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of symbols transferred in a beat.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of symbols transferred by the test pattern generator core in each beat.</td>
</tr>
</tbody>
</table>

7.4.4.7. data_source_get_enable()

Table 143. data_source_get_enable()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_get_enable(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Value of the <code>ENABLE</code> bit.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the value of the <code>ENABLE</code> bit.</td>
</tr>
</tbody>
</table>

### 7.4.4.8. data_source_set_enable()

**Table 144. data_source_set_enable()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>void data_source_set_enable(alt_u32 base, alt_u32 value);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave. <code>value</code>—<code>ENABLE</code> bit set to the value of this parameter.</td>
</tr>
<tr>
<td>Returns</td>
<td><code>void</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enables or disables the test pattern generator core. When disabled, the test pattern generator core stops data transmission but continues to accept commands and stores them in the FIFO.</td>
</tr>
</tbody>
</table>

### 7.4.4.9. data_source_get_throttle()

**Table 145. data_source_get_throttle()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_source_get_throttle(alt_u32 base);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Throttle value.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the current throttle value.</td>
</tr>
</tbody>
</table>

### 7.4.4.10. data_source_set_throttle()

**Table 146. data_source_set_throttle()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>void data_source_set_throttle(alt_u32 base, alt_u32 value);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave.</td>
</tr>
</tbody>
</table>

---

```
continued...
```
### 7.4.4.11. `data_source_is_busy()`

**Table 147. `data_source_is_busy()`**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_source_is_busy(alt_u32 base);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Test pattern generator core is busy. 0—Test pattern generator core is not busy.</td>
</tr>
<tr>
<td>Description</td>
<td>Checks if the test pattern generator is busy. The test pattern generator core is busy when it is sending data or has data in the command FIFO to be sent.</td>
</tr>
</tbody>
</table>

### 7.4.4.12. `data_source_fill_level()`

**Table 148. `data_source_fill_level()`**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_source_fill_level(alt_u32 base);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>base</code>—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of commands in the command FIFO.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of commands currently in the command FIFO.</td>
</tr>
</tbody>
</table>

### 7.4.4.13. `data_source_send_data()`

**Table 149. `data_source_send_data()`**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_source_send_data(alt_u32 cmd_base, alt_u16 channel, alt_u16 size, alt_u32 flags, alt_u16 error, alt_u8 data_error_mask);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_source_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>cmd_base</code>—Base address of the command slave. <code>channel</code>—Channel to send the data.</td>
</tr>
</tbody>
</table>

*continued...*
### Information Type Description

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>size</strong></td>
<td>Data size.</td>
</tr>
<tr>
<td><strong>flags</strong></td>
<td>Specifies whether to send or suppress SOP and EOP signals. Valid values are <code>DATA_SOURCE_SEND_SOP</code>, <code>DATA_SOURCE_SEND_EOP</code>, <code>DATA_SOURCE_SEND_SUPPRESS_SOP</code> and <code>DATA_SOURCE_SEND_SUPPRESS_EOP</code>.</td>
</tr>
<tr>
<td><strong>error</strong></td>
<td>Value asserted on the error signal on the output interface.</td>
</tr>
<tr>
<td><strong>data_error_mask</strong></td>
<td>Parameter and the data are XORed together to produce erroneous data.</td>
</tr>
</tbody>
</table>

**Returns**

Returns 1.

**Description**

Sends a data fragment to the specified channel. If data packets are supported, applications must ensure consistent usage of SOP and EOP in each channel. Except for the last segment in a packet, the length of each segment is a multiple of the data width.

If data packets are not supported, applications must ensure that there are no SOP and EOP indicators in the data. The length of each segment in a packet is a multiple of the data width.

---

### 7.4.5. Test Pattern Checker API

The following subsections describe API for the test pattern checker core. The API functions are currently not available from the ISR.

- `data_sink_reset()` on page 666
- `data_sink_init()` on page 666
- `data_sink_get_id()` on page 666
- `data_sink_get_supports_packets()` on page 667
- `data_sink_get_num_channels()` on page 667
- `data_sink_get_symbols_per_cycle()` on page 667
- `data_sink_get_enable()` on page 667
- `data_sink_set_enable()` on page 668
- `data_sink_get_throttle()` on page 668
- `data_sink_set_throttle()` on page 668
- `data_sink_get_packet_count()` on page 669
- `data_sink_get_error_count()` on page 669
- `data_sink_get_symbol_count()` on page 669
- `data_sink_get_exception()` on page 670
- `data_sink_exception_is_exception()` on page 670
- `data_sink_exception_has_data_error()` on page 670
- `data_sink_exception_has_missing_sop()` on page 671
- `data_sink_exception_has_missing_eop()` on page 671
- `data_sink_exception_signalled_error()` on page 671
- `data_sink_exception_channel()` on page 672
7.4.5.1. data_sink_reset()

Table 150. data_sink_reset()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>void data_sink_reset(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>void</td>
</tr>
<tr>
<td>Description</td>
<td>Resets the test pattern checker core including all internal counters.</td>
</tr>
</tbody>
</table>

7.4.5.2. data_sink_init()

Table 151. data_sink_init()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_source_init(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Initialization is successful. 0—Initialization is unsuccessful.</td>
</tr>
</tbody>
</table>
| Description      | Performs the following operations to initialize the test pattern checker core:  
                   • Resets and disables the test pattern checker core.  
                   • Sets the throttle to the maximum value. |

7.4.5.3. data_sink_get_id()

Table 152. data_sink_get_id()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_get_id(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Test pattern checker core identifier.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the test pattern checker core’s identifier.</td>
</tr>
</tbody>
</table>
7.4.5.4. data_sink_get_supports_packets()

Table 153. data_sink_get_supports_packets()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_init(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Data packets are supported.</td>
</tr>
<tr>
<td></td>
<td>0—Data packets are not supported.</td>
</tr>
<tr>
<td>Description</td>
<td>Checks if the test pattern checker core supports data packets.</td>
</tr>
</tbody>
</table>

7.4.5.5. data_sink_get_num_channels()

Table 154. data_sink_get_num_channels()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_get_num_channels(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of channels supported.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of channels supported by the test pattern checker core.</td>
</tr>
</tbody>
</table>

7.4.5.6. data_sink_get_symbols_per_cycle()

Table 155. data_sink_get_symbols_per_cycle()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_get_symbols(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of symbols received in a beat.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of symbols received by the test pattern checker core in each beat.</td>
</tr>
</tbody>
</table>

7.4.5.7. data_sink_get_enable()

Table 156. data_sink_get_enable()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_get_enable(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
</tbody>
</table>

continued...
7.4.5.8. data_sink_set_enable()

Table 157. data_sink_set_enable()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>void data_sink_set_enable(alt_u32 base, alt_u32 value);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave. value—ENABLE bit is set to the value of the parameter.</td>
</tr>
<tr>
<td>Returns</td>
<td>void</td>
</tr>
<tr>
<td>Description</td>
<td>Enables the test pattern checker core.</td>
</tr>
</tbody>
</table>

7.4.5.9. data_sink_get_throttle()

Table 158. data_sink_get_throttle()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_get_throttle(alt_u32 base);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td>Returns</td>
<td>Throttle value.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the throttle value.</td>
</tr>
</tbody>
</table>

7.4.5.10. data_sink_set_throttle()

Table 159. data_sink_set_throttle()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>void data_sink_set_throttle(alt_u32 base, alt_u32 value);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
</tbody>
</table>

continued...
<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>Throttle value.</td>
</tr>
</tbody>
</table>

**Returns**

- void

**Description**

Sets the throttle value, which can be between 0–256 inclusively. The throttle value, when divided by 256 yields the rate at which the test pattern checker receives data.

### 7.4.5.11. data_sink_get_packet_count()

**Table 160. data_sink_get_packet_count()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_sink_get_packet_count(alt_u32 base, alt_u32 channel);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_sink_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave. channel—Channel number.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of data packets received on the channel.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of data packets received on a channel.</td>
</tr>
</tbody>
</table>

### 7.4.5.12. data_sink_get_error_count()

**Table 161. data_sink_get_error_count()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_sink_get_error_count(alt_u32 base, alt_u32 channel);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_sink_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave. channel—Channel number.</td>
</tr>
<tr>
<td>Returns</td>
<td>Number of errors received on the channel.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the number of errors received on a channel.</td>
</tr>
</tbody>
</table>

### 7.4.5.13. data_sink_get_symbol_count()

**Table 162. data_sink_get_symbol_count()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_sink_get_symbol_count(alt_u32 base, alt_u32 channel);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>No</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_sink_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td>base—Base address of the control and status slave.</td>
</tr>
</tbody>
</table>

*continued...*
### 7.4.5.14. data_sink_get_exception()

**Table 163. data_sink_get_exception()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prototype</strong></td>
<td>int data_sink_get_exception(alt_u32 base);</td>
</tr>
<tr>
<td><strong>Thread-safe</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Include</strong></td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>base—Base address of the control and status slave.</td>
</tr>
<tr>
<td><strong>Returns</strong></td>
<td>First exception descriptor in the exception FIFO. 0—No exception descriptor found in the exception FIFO.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Retrieves the first exception descriptor in the exception FIFO and pops it off the FIFO.</td>
</tr>
</tbody>
</table>

### 7.4.5.15. data_sink_exception_is_exception()

**Table 164. data_sink_exception_is_exception()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prototype</strong></td>
<td>int data_sink_exception_is_exception(int exception);</td>
</tr>
<tr>
<td><strong>Thread-safe</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Include</strong></td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>exception—Exception descriptor</td>
</tr>
<tr>
<td><strong>Returns</strong></td>
<td>1—Indicates an exception. 0—No exception.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Checks if an exception descriptor describes a valid exception.</td>
</tr>
</tbody>
</table>

### 7.4.5.16. data_sink_exception_has_data_error()

**Table 165. data_sink_exception_has_data_error()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prototype</strong></td>
<td>int data_sink_exception_has_data_error(int exception);</td>
</tr>
<tr>
<td><strong>Thread-safe</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Include</strong></td>
<td>&lt;data_sink_util.h &gt;</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>exception—Exception descriptor</td>
</tr>
<tr>
<td><strong>Returns</strong></td>
<td>1—Data has errors. 0—No errors.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Checks if an exception indicates erroneous data.</td>
</tr>
</tbody>
</table>
### 7.4.5.17. data_sink_exception_has_missing_sop()

**Table 166. data_sink_exception_has_missing_sop()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_exception_has_missing_sop(int exception);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>exception—Exception descriptor.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Missing SOP. 0—Other exception types.</td>
</tr>
<tr>
<td>Description</td>
<td>Checks if an exception descriptor indicates missing SOP.</td>
</tr>
</tbody>
</table>

### 7.4.5.18. data_sink_exception_has_missing_eop()

**Table 167. data_sink_exception_has_missing_eop()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_exception_has_missing_eop(int exception);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>exception—Exception descriptor.</td>
</tr>
<tr>
<td>Returns</td>
<td>1—Missing EOP. 0—Other exception types.</td>
</tr>
<tr>
<td>Description</td>
<td>Checks if an exception descriptor indicates missing EOP.</td>
</tr>
</tbody>
</table>

### 7.4.5.19. data_sink_exception_signalled_error()

**Table 168. data_sink_exception_signalled_error()**

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td>int data_sink_exception_signalled_error(int exception);</td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td>&lt;data_sink_util.h&gt;</td>
</tr>
<tr>
<td>Parameters</td>
<td>exception—Exception descriptor.</td>
</tr>
<tr>
<td>Returns</td>
<td>Signal error value.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the value of the signaled error from the exception.</td>
</tr>
</tbody>
</table>
7.4.5.20. data_sink_exception_channel()

Table 169. data_sink_exception_channel()

<table>
<thead>
<tr>
<th>Information Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prototype</td>
<td><code>int data_sink_exception_channel(int exception);</code></td>
</tr>
<tr>
<td>Thread-safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Include</td>
<td><code>&lt;data_sink_util.h&gt;</code></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>exception</code>—Exception descriptor.</td>
</tr>
<tr>
<td>Returns</td>
<td>Channel number on which an exception occurred.</td>
</tr>
<tr>
<td>Description</td>
<td>Retrieves the channel number on which an exception occurred.</td>
</tr>
</tbody>
</table>

7.5. Avalon-ST Splitter Core

Figure 167. Avalon-ST Splitter Core

The Avalon-ST Splitter Core allows you to replicate transactions from an Avalon-ST sink interface to multiple Avalon-ST source interfaces. This core supports from 1 to 16 outputs.

The Avalon-ST Splitter core copies input signals from the input interface to the corresponding output signals of each output interface without altering the size or functionality. This includes all signals except for the `ready` signal. The core includes a clock signal to determine the Avalon-ST interface and clock domain where the core resides. Because the splitter core does not use the `clock` signal internally, latency is not introduced when using this core.

7.5.1. Splitter Core Backpressure

The Avalon-ST Splitter core integrates with backpressure by AND-ing the `ready` signals from the output interfaces and sending the result to the input interface. As a result, if an output interface deasserts the `ready` signal, the input interface receives the deasserted `ready` signal, as well. This functionality ensures that backpressure on the output interfaces is propagated to the input interface.
When the **Qualify Valid Out** option is enabled, the `out_valid` signals on all other output interfaces are gated when backpressure is applied from one output interface. In this case, when any output interface deasserts its `ready` signal, the `out_valid` signals on the other output interfaces are also deasserted.

When the **Qualify Valid Out** option is disabled, the output interfaces have a non-gated `out_valid` signal when backpressure is applied. In this case, when an output interface deasserts its `ready` signal, the `out_valid` signals on the other output interfaces are not affected.

Because the logic is combinational, the core introduces no latency.

### 7.5.2. Splitter Core Interfaces

The Avalon-ST Splitter core supports streaming data, with optional packet, channel, and error signals. The core propagates backpressure from any output interface to the input interface.

**Table 170. Avalon-ST Splitter Core Support**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backpressure</td>
<td>Ready latency = 0.</td>
</tr>
<tr>
<td>Data Width</td>
<td>Configurable</td>
</tr>
<tr>
<td>Channel</td>
<td>Supported (optional).</td>
</tr>
<tr>
<td>Error</td>
<td>Supported (optional).</td>
</tr>
<tr>
<td>Packet</td>
<td>Supported (optional).</td>
</tr>
</tbody>
</table>

### 7.5.3. Splitter Core Parameters

**Table 171. Avalon-ST Splitter Core Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Legal Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Of Outputs</td>
<td>1 to 16</td>
<td>2</td>
<td>The number of output interfaces. Platform Designer supports 1 for some systems where no duplicated output is required.</td>
</tr>
<tr>
<td>Qualify Valid Out</td>
<td>Enabled, Disabled</td>
<td>Enabled</td>
<td>If enabled, the <code>out_valid</code> signal of all output interfaces is gated when back pressure is applied.</td>
</tr>
<tr>
<td>Data Width</td>
<td>1–512</td>
<td>8</td>
<td>The width of the data on the Avalon-ST data interfaces.</td>
</tr>
<tr>
<td>Bits Per Symbol</td>
<td>1–512</td>
<td>8</td>
<td>The number of bits per symbol for the input and output interfaces. For example, byte-oriented interfaces have 8-bit symbols.</td>
</tr>
<tr>
<td>Use Packets</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
<td>Enable support of data packet transfers. Packet support includes the <code>startofpacket</code>, <code>endofpacket</code>, and <code>empty</code> signals.</td>
</tr>
<tr>
<td>Use Channel</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
<td>Enable the channel signal.</td>
</tr>
<tr>
<td>Channel Width</td>
<td>0–8</td>
<td>1</td>
<td>The width of the <code>channel</code> signal on the data interfaces. This parameter is disabled when <strong>Use Channel</strong> is set to 0.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Legal Values</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max Channels</td>
<td>0-255</td>
<td>1</td>
<td>The maximum number of channels that a data interface can support. This parameter is disabled when Use Channel is set to 0.</td>
</tr>
<tr>
<td>Use Error</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
<td>Enable the error signal.</td>
</tr>
<tr>
<td>Error Width</td>
<td>0–31</td>
<td>1</td>
<td>The width of the error signal on the output interfaces. A value of 0 indicates that the splitter core is not using the error signal. This parameter is disabled when Use Error is set to 0.</td>
</tr>
</tbody>
</table>

7.6. Avalon-ST Delay Core

**Figure 168. Avalon-ST Delay Core**
The Avalon-ST Delay Core provides a solution to delay Avalon-ST transactions by a constant number of clock cycles. This core supports up to 16 clock cycle delays.

![Avalon-ST Delay Core Diagram](image)

The Avalon-ST Delay core adds a delay between the input and output interfaces. The core accepts transactions presented on the input interface and reproduces them on the output interface $N$ cycles later without changing the transaction.

The input interface delays the input signals by a constant $N$ number of clock cycles to the corresponding output signals of the output interface. The **Number Of Delay Clocks** parameter defines the constant $N$, which must be from 0 to 16. The change of the in_valid signal is reflected on the out_valid signal exactly $N$ cycles later.

7.6.1. Delay Core Reset Signal

The Avalon-ST Delay core has a reset signal that is synchronous to the clk signal. When the core asserts the reset signal, the output signals are held at 0. After the reset signal is deasserted, the output signals are held at 0 for $N$ clock cycles. The delayed values of the input signals are then reflected at the output signals after $N$ clock cycles.

7.6.2. Delay Core Interfaces

The Delay core supports streaming data, with optional packet, channel, and error signals. The delay core does not support backpressure.
Table 172. Avalon-ST Delay Core Support

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backpressure</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Data Width</td>
<td>Configurable.</td>
</tr>
<tr>
<td>Channel</td>
<td>Supported (optional).</td>
</tr>
<tr>
<td>Error</td>
<td>Supported (optional).</td>
</tr>
<tr>
<td>Packet</td>
<td>Supported (optional).</td>
</tr>
</tbody>
</table>

7.6.3. Delay Core Parameters

Table 173. Avalon-ST Delay Core Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Legal Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Of Delay Clocks</td>
<td>0 to 16</td>
<td>1</td>
<td>Specifies the delay the core introduces, in clock cycles. Platform Designer supports 0 for some systems where no delay is required.</td>
</tr>
<tr>
<td>Data Width</td>
<td>1–512</td>
<td>8</td>
<td>The width of the data on the Avalon-ST data interfaces.</td>
</tr>
<tr>
<td>Bits Per Symbol</td>
<td>1–512</td>
<td>8</td>
<td>The number of bits per symbol for the input and output interfaces. For example, byte-oriented interfaces have 8-bit symbols.</td>
</tr>
<tr>
<td>Use Packets</td>
<td>0 or 1</td>
<td>0</td>
<td>Indicates whether data packet transfers are supported.</td>
</tr>
<tr>
<td>Use Channel</td>
<td>0 or 1</td>
<td>0</td>
<td>The option to enable or disable the channel signal.</td>
</tr>
<tr>
<td>Channel Width</td>
<td>0–8</td>
<td>1</td>
<td>The width of the channel signal on the data interfaces.</td>
</tr>
<tr>
<td>Max Channels</td>
<td>0–255</td>
<td>1</td>
<td>The maximum number of channels that a data interface can support.</td>
</tr>
<tr>
<td>Use Error</td>
<td>0 or 1</td>
<td>0</td>
<td>The option to enable or disable the error signal.</td>
</tr>
<tr>
<td>Error Width</td>
<td>0–31</td>
<td>1</td>
<td>The width of the error signal on the output interfaces.</td>
</tr>
</tbody>
</table>

The width of the error signal on the output interfaces. A value of 0 indicates that the error signal is not in use. This parameter is disabled when Use Error is set to 0.
7.7. Avalon-ST Round Robin Scheduler

Figure 169. Avalon-ST Round Robin Scheduler

The Avalon-ST Round Robin Scheduler core controls the read operations from a multi-channel Avalon-ST component that buffers data by channels. It reads the almost-full threshold values from the multiple channels in the multi-channel component and issues the read request to the Avalon-ST source according to a round-robin scheduling algorithm.

In a multi-channel component, the component can store data either in the sequence that it comes in (FIFO), or in segments according to the channel. When data is stored in segments according to channels, a scheduler is needed to schedule the read operations.

7.7.1. Almost-Full Status Interface (Round Robin Scheduler)

The Almost-Full Status interface is an Avalon-ST sink interface that collects the almost-full status from the sink components for the channels in the sequence provided.

Table 174. Avalon-ST Interface Feature Support

<table>
<thead>
<tr>
<th>Feature</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backpressure</td>
<td>Not supported</td>
</tr>
<tr>
<td>Data Width</td>
<td>Data width = 1; Bits per symbol = 1</td>
</tr>
<tr>
<td>Channel</td>
<td>Maximum channel = 32; Channel width = 5</td>
</tr>
<tr>
<td>Error</td>
<td>Not supported</td>
</tr>
<tr>
<td>Packet</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

7.7.2. Request Interface (Round Robin Scheduler)

The Request Interface is an Avalon-MM write master interface that requests data from a specific channel. The Avalon-ST Round Robin Scheduler cycles through the channels it supports and schedules data to be read.

7.7.3. Round Robin Scheduler Operation

If a particular channel is almost full, the Avalon-ST Round Robin Scheduler does not schedule data to be read from that channel in the source component.
The scheduler only requests 1 bit of data from a channel at each transaction. To request 1 bit of data from channel \( n \), the scheduler writes the value 1 to address \( 4 \times n \). For example, if the scheduler is requesting data from channel 3, the scheduler writes 1 to address \( 0xC \). At every clock cycle, the scheduler requests data from the next channel. Therefore, if the scheduler starts requesting from channel 1, at the next clock cycle, it requests from channel 2. The scheduler does not request data from a particular channel if the almost-full status for the channel is asserted. In this case, the scheduler uses one clock cycle without a request transaction.

The Avalon-ST Round Robin Scheduler cannot determine if the requested component is able to service the request transaction. The component asserts waitrequest when it cannot accept new requests.

**Table 175. Avalon-ST Round Robin Scheduler Ports**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Direction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clock and Reset</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>clk</td>
<td>In</td>
<td>Clock reference.</td>
</tr>
<tr>
<td>reset_n</td>
<td>In</td>
<td>Asynchronous active low reset.</td>
</tr>
<tr>
<td><strong>Avalon-MM Request Interface</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>request_address (( \log_2 ) Max_Channels-1:0)</td>
<td>Out</td>
<td>The write address that indicates which channel has the request.</td>
</tr>
<tr>
<td>request_write</td>
<td>Out</td>
<td>Write enable signal.</td>
</tr>
<tr>
<td>request_writedata</td>
<td>Out</td>
<td>The amount of data requested from the particular channel. This value is always fixed at 1.</td>
</tr>
<tr>
<td>request_waitrequest</td>
<td>In</td>
<td>Wait request signal that pauses the scheduler when the slave cannot accept a new request.</td>
</tr>
<tr>
<td><strong>Avalon-ST Almost-Full Status Interface</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>almost_full_valid</td>
<td>In</td>
<td>Indicates that almost_full_channel and almost_full_data are valid.</td>
</tr>
<tr>
<td>almost_full_channel (Channel_Width-1:0)</td>
<td>In</td>
<td>Indicates the channel for the current status indication.</td>
</tr>
<tr>
<td>almost_full_data (( \log_2 ) Max_Channels-1:0)</td>
<td>In</td>
<td>A 1-bit signal that is asserted high to indicate that the channel indicated by almost_full_channel is almost full.</td>
</tr>
</tbody>
</table>

**7.7.4. Round Robin Scheduler Parameters**

**Table 176. Avalon-ST Round Robin Scheduler Parameters**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Legal Values</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of channels</td>
<td>2–32</td>
<td>2</td>
<td>Specifies the number of channels the Avalon-ST Round Robin Scheduler supports.</td>
</tr>
<tr>
<td>Use almost-full status</td>
<td>Enabled, Disabled</td>
<td>Disabled</td>
<td>If enabled, the scheduler uses the almost-full interface. If not, the core requests data from the next channel at the next clock cycle.</td>
</tr>
</tbody>
</table>
7.8. Avalon Packets to Transactions Converter

Figure 170. Avalon Packets to Transactions Converter Core
The Avalon Packets to Transactions Converter core receives streaming data from upstream components and initiates Avalon-MM transactions. The core then returns Avalon-MM transaction responses to the requesting components.

Note: The SPI Slave to Avalon Master Bridge and JTAG to Avalon Master Bridge are examples of the Packets to Transactions Converter core. For more information, refer to the Avalon Interface Specifications.

Related Information
Avalon Interface Specifications

7.8.1. Packets to Transactions Converter Interfaces

Table 177. Properties of Avalon-ST Interfaces

<table>
<thead>
<tr>
<th>Feature</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backpressure</td>
<td>Ready latency = 0.</td>
</tr>
<tr>
<td>Data Width</td>
<td>Data width = 8 bits; Bits per symbol = 8.</td>
</tr>
<tr>
<td>Channel</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Error</td>
<td>Not used.</td>
</tr>
<tr>
<td>Packet</td>
<td>Supported.</td>
</tr>
</tbody>
</table>

The Avalon-MM master interface supports read and write transactions. The data width is set to 32 bits, and burst transactions are not supported.

7.8.2. Packets to Transactions Converter Operation

The Packets to Transactions Converter core receives streams of packets on its Avalon-ST sink interface and initiates Avalon-MM transactions. Upon receiving transaction responses from Avalon-MM slaves, the core transforms the responses to packets and returns them to the requesting components via its Avalon-ST source interface. The core does not report Avalon-ST errors.
7.8.2.1. Packets to Transactions Converter Data Packet Formats

A response packet is returned for every write transaction. The core also returns a response packet if a no transaction (0x7f) is received. An invalid transaction code is regarded as a no transaction. For read transactions, the core returns the data read.

The Packets to Transactions Converter core expects incoming data streams to be in the formats shown in the table below.

Table 178. Data Packet Formats

<table>
<thead>
<tr>
<th>Byte</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Transaction code</td>
<td>Type of transaction.</td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>[3:2]</td>
<td>Size</td>
<td>Transaction size in bytes. For write transactions, the size indicates the size of the data field. For read transactions, the size indicates the total number of bytes to read.</td>
</tr>
<tr>
<td>[n:8]</td>
<td>Data</td>
<td>Transaction data; data to be written for write transactions.</td>
</tr>
</tbody>
</table>

Response Packet Format

<table>
<thead>
<tr>
<th>Byte</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Transaction code</td>
<td>The transaction code with the most significant bit inverted.</td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>[4:2]</td>
<td>Size</td>
<td>Total number of bytes read/written successfully.</td>
</tr>
</tbody>
</table>

Related Information

Packets to Transactions Converter Interfaces on page 678

7.8.2.2. Packets to Transactions Converter Supported Transactions

The Packets to Transactions Converter core supports the following Avalon-MM transactions:

Table 179. Packets to Transactions Converter Supported Transactions

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>Avalon-MM Transaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>Write, non-incrementing address.</td>
<td>Writes data to the address until the total number of bytes written to the same word address equals to the value specified in the size field.</td>
</tr>
<tr>
<td>0x04</td>
<td>Write, incrementing address.</td>
<td>Writes transaction data starting at the current address.</td>
</tr>
<tr>
<td>0x10</td>
<td>Read, non-incrementing address.</td>
<td>Reads 32 bits of data from the address until the total number of bytes read from the same address equals to the value specified in the size field.</td>
</tr>
<tr>
<td>0x14</td>
<td>Read, incrementing address.</td>
<td>Reads the number of bytes specified in the size parameter starting from the current address.</td>
</tr>
<tr>
<td>0x7f</td>
<td>No transaction.</td>
<td>No transaction is initiated. You can use this transaction type for testing purposes. Although no transaction is initiated on the Avalon-MM interface, the core still returns a response packet for this transaction code.</td>
</tr>
</tbody>
</table>
The Packets to Transactions Converter core can process only a single transaction at a time. The ready signal on the core's Avalon-ST sink interface is asserted only when the current transaction is completely processed.

No internal buffer is implemented on the datapaths. Data received on the Avalon-ST interface is forwarded directly to the Avalon-MM interface and vice-versa. Asserting the waitrequest signal on the Avalon-MM interface backpressures the Avalon-ST sink interface. In the opposite direction, if the Avalon-ST source interface is backpressed, the read signal on the Avalon-MM interface is not asserted until the backpressure is alleviated. Backpressuring the Avalon-ST source in the middle of a read can result in data loss. In this case, the core returns the data that is successfully received.

A transaction is considered complete when the core receives an EOP. For write transactions, the actual data size is expected to be the same as the value of the size property. Whether or not both values agree, the core always uses the end of packet (EOP) to determine the end of data.

### 7.8.2.3. Packets to Transactions Converter Malformed Packets

The following are examples of malformed packets:

- **Consecutive start of packet (SOP)**—An SOP marks the beginning of a transaction. If an SOP is received in the middle of a transaction, the core drops the current transaction without returning a response packet for the transaction, and initiates a new transaction. This effectively processes packets without an end of packet (EOP).

- **Unsupported transaction codes**—The core processes unsupported transactions as a no transaction.

### 7.9. Avalon-ST Streaming Pipeline Stage

The Avalon-ST pipeline stage receives data from an Avalon-ST source interface, and outputs the data to an Avalon-ST sink interface. In the absence of back pressure, the Avalon-ST pipeline stage source interface outputs data one cycle after receiving the data on its sink interface.

If the pipeline stage receives back pressure on its source interface, it continues to assert its source interface's current data output. While the pipeline stage is receiving back pressure on its source interface and it receives new data on its sink interface, the pipeline stage internally buffers the new data. It then asserts back pressure on its sink interface.

After the backpressure is deasserted, the pipeline stage's source interface is deasserted and the pipeline stage asserts internally buffered data (if present). Additionally, the pipeline stage deasserts back pressure on its sink interface.
Figure 171. Pipeline Stage Simple Register
If the ready signal is not pipelined, the pipeline stage becomes a simple register.

![Diagram of Pipeline Stage Simple Register]

Figure 172. Pipeline Stage Holding Register
If the ready signal is pipelined, the pipeline stage must also include a second "holding" register.

![Diagram of Pipeline Stage Holding Register]

7.10. Streaming Channel Multiplexer and Demultiplexer Cores

The Avalon-ST channel multiplexer core receives data from various input interfaces and multiplexes the data into a single output interface, using the optional channel signal to indicate the origin of the data. The Avalon-ST channel demultiplexer core receives data from a channelized input interface and drives that data to multiple output interfaces, where the output interface is selected by the input channel signal.

The multiplexer and demultiplexer cores can transfer data between interfaces on cores that support unidirectional flow of data. The multiplexer and demultiplexer allow you to create multiplexed or demultiplexed datapaths without having to write custom HDL code. The multiplexer includes an Avalon-ST Round Robin Scheduler.

Related Information
Avalon-ST Round Robin Scheduler on page 676
7.10.1. Software Programming Model For the Multiplexer and Demultiplexer Components

The multiplexer and demultiplexer components do not have any user-visible control or status registers. Therefore, Platform Designer cannot control or configure any aspect of the multiplexer or demultiplexer at run-time. The components cannot generate interrupts.

7.10.2. Avalon-ST Multiplexer

Figure 173. Avalon-ST Multiplexer

The Avalon-ST multiplexer takes data from a variety of input data interfaces, and multiplexes the data onto a single output interface. The multiplexer includes a round-robin scheduler that selects from the next input interface that has data. Each input interface has the same width as the output interface, so that the other input interfaces are backpressured when the multiplexer is carrying data from a different input interface.

The multiplexer includes an optional channel signal that enables each input interface to carry channelized data. The output interface channel width is equal to:

\[(\log_2 (n-1)) + 1 + w\]

where \(n\) is the number of input interfaces, and \(w\) is the channel width of each input interface. All input interfaces must have the same channel width. These bits are appended to either the most or least significant bits of the output channel signal.

The scheduler processes one input interface at a time, selecting it for transfer. Once an input interface has been selected, data from that input interface is sent until one of the following scenarios occurs:

- The specified number of cycles have elapsed.
- The input interface has no more data to send and the valid signal is deasserted on a ready cycle.
- When packets are supported, endopacket is asserted.
7.10.2.1. Multiplexer Input Interfaces

Each input interface is an Avalon-ST data interface that optionally supports packets. The input interfaces are identical; they have the same symbol and data widths, error widths, and channel widths.

7.10.2.2. Multiplexer Output Interface

The output interface carries the multiplexed data stream with data from the inputs. The symbol, data, and error widths are the same as the input interfaces.

The width of the channel signal is the same as the input interfaces, with the addition of the bits needed to indicate the origin of the data.

You can configure the following parameters for the output interface:

- **Data Bits Per Symbol**—The bits per symbol is related to the width of `readdata` and `writedata` signals, which must be a multiple of the bits per symbol.
- **Data Symbols Per Beat**—The number of symbols (words) that are transferred per beat (transfer). Valid values are 1 to 32.
- **Include Packet Support**—Indicates whether packet transfers are supported. Packet support includes the `startofpacket`, `endofpacket`, and `empty` signals.
- **Channel Signal Width (bits)**—The number of bits Platform Designer uses for the channel signal for output interfaces. For example, set this parameter to 1 if you have two input interfaces with no channel, or set this parameter to 2 if you have two input interfaces with a channel width of 1 bit. The input channel can have a width between 0-31 bits.
- **Error Signal Width (bits)**—The width of the error signal for input and output interfaces. A value of 0 means the error signal is not in use.

*Note:* If you change only bits per symbol, and do not change the data width, errors are generated.

7.10.2.3. Multiplexer Parameters

You can configure the following parameters for the multiplexer:

- **Number of Input Ports**—The number of input interfaces that the multiplexer supports. Valid values are 2 to 16.
- **Scheduling Size (Cycles)**—The number of cycles that are sent from a single channel before changing to the next channel.
- **Use Packet Scheduling**—When this parameter is turned on, the multiplexer only switches the selected input interface on packet boundaries. Therefore, packets on the output interface are not interleaved.
- **Use high bits to indicate source port**—When this parameter is turned on, the multiplexer uses the high bits of the output channel signal to indicate the origin of the input interface of the data. For example, if the input interfaces have 4-bit channel signals, and the multiplexer has 4 input interfaces, the output interface has a 6-bit channel signal. If this parameter is turned on, bits [5:4] of the output channel signal indicate origin of the input interface of the data, and bits [3:0] are the channel bits that were presented at the input interface.
7.10.3. Avalon-ST Demultiplexer

Figure 174. Avalon-ST Demultiplexer

That Avalon-ST demultiplexer takes data from a channelized input data interface and provides that data to multiple output interfaces, where the output interface selected for a particular transfer is specified by the input channel signal.

The data is delivered to the output interfaces in the same order it is received at the input interface, regardless of the value of channel, packet, frame, or any other signal. Each of the output interfaces has the same width as the input interface; each output interface is idle when the demultiplexer is driving data to a different output interface. The demultiplexer uses $\log_2 (\text{num_output_interfaces})$ bits of the channel signal to select the output for the data; the remainder of the channel bits are forwarded to the appropriate output interface unchanged.

7.10.3.1. Demultiplexer Input Interface

Each input interface is an Avalon-ST data interface that optionally supports packets. You can configure the following parameters for the input interface:

- **Data Bits Per Symbol**—The bits per symbol is related to the width of readdata and writedata signals, which must be a multiple of the bits per symbol.
- **Data Symbols Per Beat**—The number of symbols (words) that are transferred per beat (transfer). Valid values are 1 to 32.
- **Include Packet Support**—Indicates whether data packet transfers are supported. Packet support includes the startofpacket, endofpacket, and empty signals.
- **Channel Signal Width (bits)**—The number of bits for the channel signal for output interfaces. A value of 0 means that output interfaces do not use the optional channel signal.
- **Error Signal Width (bits)**—The width of the error signal for input and output interfaces. A value of 0 means the error signal is in use.

*Note:* If you change only bits per symbol, and do not change the data width, errors are generated.
7.10.3.2. Demultiplexer Output Interface

Each output interface carries data from a subset of channels from the input interface. Each output interface is identical; all have the same symbol and data widths, error widths, and channel widths. The symbol, data, and error widths are the same as the input interface. The width of the channel signal is the same as the input interface, without the bits that the demultiplexer uses to select the output interface.

7.10.3.3. Demultiplexer Parameters

You can configure the following parameters for the demultiplexer:

- **Number of Output Ports**—The number of output interfaces that the multiplexer supports. Valid values are 2 to 16.
- **High channel bits select output**—When this option is turned on, the demultiplexing function uses the high bits of the input channel signal, and the low order bits are passed to the output. When this option is turned off, the demultiplexing function uses the low order bits, and the high order bits are passed to the output.

Where you place the signals in your design affects the functionality; for example, there is one input interface and two output interfaces. If the low-order bits of the channel signal select the output interfaces, the even channels go to channel 0, and the odd channels go to channel 1. If the high-order bits of the channel signal select the output interface, channels 0 to 7 go to channel 0 and channels 8 to 15 go to channel 1.

Figure 175. Select Bits for the Demultiplexer

---

7.11. Single-Clock and Dual-Clock FIFO Cores

The Avalon-ST Single-Clock and Avalon-ST Dual-Clock FIFO cores are FIFO buffers which operate with a common clock and independent clocks for input and output ports respectively.
7.11.1. Interfaces Implemented in FIFO Cores

The following interfaces are implemented in FIFO cores:

Avalon-ST Data Interface on page 687
Avalon-MM Control and Status Register Interface on page 687
7.11.1.1. Avalon-ST Data Interface

Each FIFO core has an Avalon-ST data sink and source interfaces. The data sink and source interfaces in the dual-clock FIFO core are driven by different clocks.

Table 180. Avalon-ST Interfaces Properties

<table>
<thead>
<tr>
<th>Feature</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backpressure</td>
<td>Ready latency = 0.</td>
</tr>
<tr>
<td>Data Width</td>
<td>Configurable.</td>
</tr>
<tr>
<td>Channel</td>
<td>Supported, up to 255 channels.</td>
</tr>
<tr>
<td>Error</td>
<td>Configurable.</td>
</tr>
<tr>
<td>Packet</td>
<td>Configurable.</td>
</tr>
</tbody>
</table>

7.11.1.2. Avalon-MM Control and Status Register Interface

You can configure the single-clock FIFO core to include an optional Avalon-MM interface, and the dual-clock FIFO core to include an Avalon-MM interface in each clock domain. The Avalon-MM interface provides access to 32-bit registers, which allows you to retrieve the FIFO buffer fill level and configure the almost-empty and almost-full thresholds. In the single-clock FIFO core, you can also configure the packet and error handling modes.

7.11.1.3. Avalon-ST Status Interface

The single-clock FIFO core has two optional Avalon-ST status source interfaces from which you can obtain the FIFO buffer almost-full and almost empty statuses.

7.11.2. FIFO Operating Modes

- Default mode—The core accepts incoming data on the in interface (Avalon-ST data sink) and forwards it to the out interface (Avalon-ST data source). The core asserts the valid signal on the Avalon-ST source interface to indicate that data is available at the interface.

- Store and forward mode—This mode applies only to the single-clock FIFO core. The core asserts the valid signal on the out interface only when a full packet of data is available at the interface. In this mode, you can also enable the drop-on-error feature by setting the drop_on_error register to 1. When this feature is enabled, the core drops all packets received with the in_error signal asserted.

- Cut-through mode—This mode applies only to the single-clock FIFO core. The core asserts the valid signal on the out interface to indicate that data is available for consumption when the number of entries specified in the cut_through_threshold register are available in the FIFO buffer.

Note: To turn on Cut-through mode, the Use store and forward parameter must be set to 0. Turning on Use store and forward mode prompts the user to turn on Use fill level, and then the CSR appears.
7.11.3. Fill Level of the FIFO Buffer

You can obtain the fill level of the FIFO buffer via the optional Avalon-MM control and status interface. Turn on the Use fill level parameter (Use sink fill level and Use source fill level in the dual-clock FIFO core) and read the fill_level register.

The dual-clock FIFO core has two fill levels, one in each clock domain. Due to the latency of the clock crossing logic, the fill levels reported in the input and output clock domains may be different for any instance. In both cases, the fill level may report badly for the clock domain; that is, the fill level is reported high in the input clock domain, and low in the output clock domain.

The dual-clock FIFO has an output pipeline stage to improve $f_{\text{MAX}}$. This output stage is accounted for when calculating the output fill level, but not when calculating the input fill level. Therefore, the best measure of the amount of data in the FIFO is by the fill level in the output clock domain. The fill level in the input clock domain represents the amount of space available in the FIFO (available space = FIFO depth – input fill level).

7.11.4. Almost-Full and Almost-Empty Thresholds to Prevent Overflow and Underflow

You can use almost-full and almost-empty thresholds as a mechanism to prevent FIFO overflow and underflow. This feature is available only in the single-clock FIFO core. To use the thresholds, turn on the Use fill level, Use almost-full status, and Use almost-empty status parameters. You can access the almost_full_threshold and almost_empty_threshold registers via the csr interface and set the registers to an optimal value for your application.

You can obtain the almost-full and almost-empty statuses from almost_full and almost_empty interfaces (Avalon-ST status source). The core asserts the almost_full signal when the fill level is equal to or higher than the almost-full threshold. Likewise, the core asserts the almost_empty signal when the fill level is equal to or lower than the almost-empty threshold.

7.11.5. Single-Clock and Dual-Clock FIFO Core Parameters

Table 181. Single-Clock and Dual-Clock FIFO Core Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Legal Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bits per symbol</td>
<td>1–32</td>
<td>These parameters determine the width of the FIFO.</td>
</tr>
<tr>
<td>Symbols per beat</td>
<td>1–32</td>
<td>FIFO width = Bits per symbol * Symbols per beat, where: Bits per symbol is the number of bits in a symbol, and Symbols per beat is the number of symbols transferred in a beat.</td>
</tr>
<tr>
<td>Error width</td>
<td>0–32</td>
<td>The width of the error signal.</td>
</tr>
<tr>
<td>FIFO depth</td>
<td>$2^n$</td>
<td>The FIFO depth. An output pipeline stage is added to the FIFO to increase performance, which increases the FIFO depth by one. $&lt;n&gt; = n=1,2,3,4$ and so on.</td>
</tr>
<tr>
<td>Use packets</td>
<td>—</td>
<td>Turn on this parameter to enable data packet support on the Avalon-ST data interfaces.</td>
</tr>
<tr>
<td>Channel width</td>
<td>1–32</td>
<td>The width of the channel signal.</td>
</tr>
<tr>
<td>Avalon-ST Single Clock FIFO Only</td>
<td></td>
<td>continued...</td>
</tr>
</tbody>
</table>
### Parameter Legal Values Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Legal Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use fill level</td>
<td>—</td>
<td>Turn on this parameter to include the Avalon-MM control and status register interface (CSR). The CSR is enabled when Use fill level is set to 1.</td>
</tr>
<tr>
<td>Use Store and Forward</td>
<td>—</td>
<td>To turn on Cut-through mode, Use store and forward must be set to 0. Turning on Use store and forward prompts the user to turn on Use fill level, and then the CSR appears.</td>
</tr>
</tbody>
</table>

#### Avalon-ST Dual Clock FIFO Only

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Legal Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use sink fill level</td>
<td>—</td>
<td>Turn on this parameter to include the Avalon-MM control and status register interface in the input clock domain.</td>
</tr>
<tr>
<td>Use source fill level</td>
<td>—</td>
<td>Turn on this parameter to include the Avalon-MM control and status register interface in the output clock domain.</td>
</tr>
<tr>
<td>Write pointer synchronizer length</td>
<td>2–8</td>
<td>The length of the write pointer synchronizer chain. Setting this parameter to a higher value leads to better metastability while increasing the latency of the core.</td>
</tr>
<tr>
<td>Read pointer synchronizer length</td>
<td>2–8</td>
<td>The length of the read pointer synchronizer chain. Setting this parameter to a higher value leads to better metastability.</td>
</tr>
<tr>
<td>Use Max Channel</td>
<td>—</td>
<td>Turn on this parameter to specify the maximum channel number.</td>
</tr>
<tr>
<td>Max Channel</td>
<td>1–255</td>
<td>Maximum channel number.</td>
</tr>
</tbody>
</table>

**Note:** For more information about metastability in Intel devices, refer to *Understanding Metastability in FPGAs*. For more information about metastability analysis and synchronization register chains, refer to the *Managing Metastability*.

**Related Information**

- Managing Metastability with the Software
- Understanding Metastability in FPGAs

### 7.11.6. Avalon-ST Single-Clock FIFO Registers

#### Table 182. Avalon-ST Single-Clock FIFO Registers

The CSR interface in the Avalon-ST Single Clock FIFO core provides access to registers.

<table>
<thead>
<tr>
<th>32-Bit Word Offset</th>
<th>Name</th>
<th>Access</th>
<th>Reset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>fill_level</td>
<td>R</td>
<td>0</td>
<td>24-bit FIFO fill level. Bits 24 to 31 are not used.</td>
</tr>
<tr>
<td>1</td>
<td>Reserved</td>
<td>—</td>
<td>—</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>2</td>
<td>almost_full_threhold</td>
<td>RW</td>
<td>FIFO depth–1</td>
<td>Set this register to a value that indicates the FIFO buffer is getting full.</td>
</tr>
<tr>
<td>3</td>
<td>almost_empty_threhold</td>
<td>RW</td>
<td>0</td>
<td>Set this register to a value that indicates the FIFO buffer is getting empty.</td>
</tr>
<tr>
<td>4</td>
<td>cut_through_threhold</td>
<td>RW</td>
<td>0</td>
<td>0—Enables store and forward mode.</td>
</tr>
</tbody>
</table>

*continued...*
Greater than 0—Enables cut-through mode and specifies the minimum of entries in the FIFO buffer before the valid signal on the Avalon-ST source interface is asserted. Once the FIFO core starts sending the data to the downstream component, it continues to do so until the end of the packet.

Note: To turn on Cut-through mode, Use store and forward must be set to 0. Turning on Use store and forward mode prompts the user to turn on Use fill level, and then the CSR appears.

<table>
<thead>
<tr>
<th>32-Bit Word Offset</th>
<th>Name</th>
<th>Access</th>
<th>Reset Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>drop_on_error</td>
<td>RW</td>
<td>0</td>
<td>0—Disables drop-on error. 1—Enables drop-on error. This register applies only when the Use packet and Use store and forward parameters are turned on.</td>
</tr>
</tbody>
</table>

Table 183. Register Description for Avalon-ST Dual-Clock FIFO

The in_csr and out_csr interfaces in the Avalon-ST Dual Clock FIFO core reports the FIFO fill level.

Table 184. Document Revision History

The table below indicates edits made to the Platform Designer System Design Components content since its creation.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 2017.11.06 | 17.1.0  | • Changed instances of Qsys Pro to Platform Designer.  
• Changed instances of AXI Default Slave to Error Response Slave.  
• Updated topics: Error Response Slave.  
• Updated Figure: Error Response Slave Parameter Editor.  
• Added Figure: Error Response Slave Parameter Editor with Enabled CSR Support.  
• Updated topics: CSR Registers and renamed to Error Response Slave CSR Registers.  
• Added topic: Error Response Slave Access Violation Service. |
| 2016.10.31 | 16.1.0  | • Implemented Intel rebranding.  
• Implemented Qsys rebranding. |
| 2016.05.03 | 16.0.0  | Updated Address Span Extender  
• Address Span Extender register mapping better explained  
• Address Span Extender Parameters table added  
• Address Span Extender example added |
<p>| 2015.11.02 | 15.1.0  | Changed instances of Quartus II to Quartus Prime. |
| 2015.05.04 | 15.0.0  | Avalon-MM Unaligned Burst Expansion Bridge and Avalon-MM Pipeline Bridge, Maximum pending read transactions parameter. Extended description. |</p>
<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| December 2014   | 14.1.0  | • AXI Timout Bridge.  
• Added notes to *Avalon-MM Clock Crossing Bridge* pertaining to:  
— SDC constraints for its internal asynchronous FIFOs.  
— FIFO-based clock crossing. |
| June 2014       | 14.0.0  | • AXI Bridge support.  
• Address Span Extender updates.  
• Avalon-MM Unaligned Burst Expansion Bridge support. |
| November 2013   | 13.1.0  | • Address Span Extender                                                |
| May 2013        | 13.0.0  | • Added Streaming Pipeline Stage support.  
• Added AMBA APB support. |
| November 2012   | 12.1.0  | • Moved relevant content from the *Embedded Peripherals IP User Guide*. |

**Related Information**

**Documentation Archive**

For previous versions of the *Intel Quartus Prime Handbook*, search the documentation archives.
A. Intel Quartus Prime Pro Edition User Guides

Refer to the following user guides for comprehensive information on all phases of the Intel Quartus Prime Pro Edition FPGA design flow.

Related Information

- **Getting Started User Guide**
  Introduces the basic features, files, and design flow of the Intel Quartus Prime Pro Edition software, including managing Intel Quartus Prime Pro Edition projects and IP, initial design planning considerations, and project migration from previous software versions.

- **Platform Designer User Guide**
  Describes creating and optimizing systems using Platform Designer, a system integration tool that simplifies integrating customized IP cores in your project. Platform Designer automatically generates interconnect logic to connect intellectual property (IP) functions and subsystems.

- **Design Recommendations User Guide**
  Describes best design practices for designing FPGAs with the Intel Quartus Prime Pro Edition software. HDL coding styles and synchronous design practices can significantly impact design performance. Following recommended HDL coding styles ensures that Intel Quartus Prime Pro Edition synthesis optimally implements your design in hardware.

- **Compiler User Guide**
  Describes set up, running, and optimization for all stages of the Intel Quartus Prime Pro Edition Compiler. The Compiler synthesizes, places, and routes your design before generating a device programming file.

- **Design Optimization User Guide**
  Describes Intel Quartus Prime Pro Edition settings, tools, and techniques that you can use to achieve the highest design performance in Intel FPGAs. Techniques include optimizing the design netlist, addressing critical chains that limit retiming and timing closure, and optimization of device resource usage.

- **Programmer User Guide**
  Describes operation of the Intel Quartus Prime Pro Edition Programmer, which allows you to configure Intel FPGA devices, and program CPLD and configuration devices, via connection with an Intel FPGA download cable.

- **Block-Based Design User Guide**
  Describes block-based design flows, also known as modular or hierarchical design flows. These advanced flows enable preservation of design blocks (or logic that comprises a hierarchical design instance) within a project, and reuse of design blocks in other projects.
• **Partial Reconfiguration User Guide**
  Describes Partial Reconfiguration, an advanced design flow that allows you to reconfigure a portion of the FPGA dynamically, while the remaining FPGA design continues to function. Define multiple personas for a particular design region, without impacting operation in other areas.

• **Third-party Simulation User Guide**
  Describes RTL- and gate-level design simulation support for third-party simulation tools by Aldec*, Cadence*, Mentor Graphics*, and Synopsys that allow you to verify design behavior before device programming. Includes simulator support, simulation flows, and simulating Intel FPGA IP.

• **Third-party Synthesis User Guide**
  Describes support for optional synthesis of your design in third-party synthesis tools by Mentor Graphics*, and Synopsys. Includes design flow steps, generated file descriptions, and synthesis guidelines.

• **Debug Tools User Guide**
  Describes a portfolio of Intel Quartus Prime Pro Edition in-system design debugging tools for real-time verification of your design. These tools provide visibility by routing (or "tapping") signals in your design to debugging logic. These tools include System Console, Signal Tap logic analyzer, Transceiver Toolkit, In-System Memory Content Editor, and In-System Sources and Probes Editor.

• **Timing Analyzer User Guide**
  Explains basic static timing analysis principals and use of the Intel Quartus Prime Pro Edition Timing Analyzer, a powerful ASIC-style timing analysis tool that validates the timing performance of all logic in your design using an industry-standard constraint, analysis, and reporting methodology.

• **Power Analysis and Optimization User Guide**
  Describes the Intel Quartus Prime Pro Edition Power Analysis tools that allow accurate estimation of device power consumption. Estimate the power consumption of a device to develop power budgets and design power supplies, voltage regulators, heat sink, and cooling systems.

• **Design Constraints User Guide**
  Describes timing and logic constraints that influence how the Compiler implements your design, such as pin assignments, device options, logic options, and timing constraints. Use the Interface Planner to prototype interface implementations, plan clocks, and quickly define a legal device floorplan. Use the Pin Planner to visualize, modify, and validate all I/O assignments in a graphical representation of the target device.

• **PCB Design Tools User Guide**
  Describes support for optional third-party PCB design tools by Mentor Graphics* and Cadence*. Also includes information about signal integrity analysis and simulations with HSPICE and IBIS Models.

• **Scripting User Guide**
  Describes use of Tcl and command line scripts to control the Intel Quartus Prime Pro Edition software and to perform a wide range of functions, such as managing projects, specifying constraints, running compilation or timing analysis, or generating reports.